Software License Agreement

This is a legal agreement between you, the end user, and Scanalytics. The term “SOFTWARE” as used in this license agreement includes the **IPLab for Windows** program, Camera Controls, Optional Extensions, Libraries, Scripts and all accompanying documentation. CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. OPENING THIS PACKAGE OF THE SOFTWARE, OR ANY DOWNLOADING, REPRODUCTION, COPYING, OR OTHER USE OF THE SOFTWARE BY YOU WILL CONSTITUTE ACCEPTANCE BY YOU OF THE TERMS AND CONDITIONS HEREIN.

**LICENSE**

You, the user, acknowledge that the SOFTWARE is the sole and exclusive property of Scanalytics, Incorporated. You have the right to use the SOFTWARE as outlined in, and limited by, this agreement. This SOFTWARE may only be used on a single terminal connected to a single computer (*i.e.* CPU). You may transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used only on one computer at one time. You may not modify, translate, adapt, reverse engineer, decompile, disassemble, or create derivative works based upon this SOFTWARE. You agree to use your best efforts and take all reasonable steps to protect all aspects of the SOFTWARE from unauthorized reproduction, publication, disclosure, or distribution.

**COPYRIGHT**

Scanalytics, Incorporated owns all rights regarding the SOFTWARE, including the copyright. The SOFTWARE is valuable property of Scanalytics, Incorporated and the look and feel of the SOFTWARE are protected by the copyright laws of the United States and other countries. Under the copyright laws, the SOFTWARE, manuals, and product designs may not be copied, in whole or in part, via any means mechanical, electronic or otherwise, without the written consent of Scanalytics, Incorporated, except to make backup copies of the SOFTWARE, or to transfer the SOFTWARE to a hard disk. This exception does not allow copies to be made for other users. Under the law, copying includes translation to any other language or format. Unauthorized use of or copying of the SOFTWARE or the accompanying written material is an infringement of the copyright belonging to Scanalytics, Incorporated. Such infringement subjects the violator to civil and criminal penalties.

**LIMITATIONS ON WARRANTY AND LIABILITY**

If physical defects are discovered in the original media on which the SOFTWARE is distributed, Scanalytics, Incorporated will replace the media at no charge to you within a period of 90 days from the date of purchase. You must return the defective item(s) to Scanalytics, Incorporated. Scanalytics, Incorporated will replace the materials free of charge, provided you have previously returned your product registration card to Scanalytics, Incorporated. This warranty will be void if you have in any way modified the SOFTWARE, if you are in breach of this agreement, or if failure of the magnetic media has resulted from accident, abuse, or misapplication. The remedy for breach of this warranty shall be limited to replacement and shall not encompass any other damages. THESE REMEDIES ARE NOT AVAILABLE OUTSIDE OF THE UNITED STATES OF AMERICA. Other than the limited warranty described above, Scanalytics, Incorporated makes no warranty or representation, either express or implied, with respect to this SOFTWARE, its quality, performance, merchantability, or fitness for any particular purpose. In no event will Scanalytics, Incorporated or anyone else involved in the creation, production, or delivery of the SOFTWARE be liable for direct, indirect, special, incidental, or consequential damages resulting from any defect in the SOFTWARE. In particular, but without limiting the generality of the foregoing, Scanalytics, Incorporated shall have no liability for any damage to programs or data used with Scanalytics, Incorporated products, including the costs of recovering such programs or data. The warranty and remedies set forth above are exclusive and in lieu of all others, oral or written, express or implied. No dealer, agent, or employee of Scanalytics, Incorporated is authorized to make any modification, extension, or addition to this warranty. This warranty gives you specified legal rights. You may have additional rights, which vary from state to state.

**UPDATE POLICY**

In order to obtain updates of these programs, you must complete the registration card and return it to Scanalytics. If Scanalytics has not received your Registration Card, Scanalytics is under no obligation to make any updates available to you. All updates provided to you shall become part of the material governed by the terms of this agreement.

*IPLab* is a trademark of Scanalytics, Incorporated. Windows is a trademark of Microsoft Corporation.
# Table of Contents

1 Must-Read Section: Installing Software ............................................ 1
  1.1 What Equipment You Need................................................................. 1
  1.2 Setting Up IPLab ............................................................................. 2

2 Must-Read Section: The IPLab Interface ............................................ 3
  2.1 #1: The Menu Bar ........................................................................... 4
  2.2 #2: The Image Window ................................................................... 7
    2.2.1 #2a: The Image ......................................................................... 7
    2.2.2 #2b: The Region of Interest (ROI) ........................................... 9
    2.2.3 #2c & 2d: Segment and Drawing Overlays ................................ 11
    2.2.4 #2e: The Image Info Button (the i Button) .............................. 12
    2.2.5 #2f: Z and T Arrow Buttons .................................................. 16
    2.2.6 #2g: The Status Bar ................................................................. 16
  2.3 #3: The Main Toolbar .................................................................... 16
  2.4 #4: The ROI Tools Toolbar ............................................................. 17
    2.4.1 Scripting the ROI Tools ............................................................ 18
    2.4.2 Scripting the Segment Tools ...................................................... 20
  2.5 #6: The Drawing Tools Toolbar ....................................................... 21
    2.5.1 Scripting the Drawing Tools ..................................................... 25
  2.6 #7: The Status Window .................................................................. 25
  2.7 #8: The FKey (Function Key) Toolbar ............................................. 26
  2.8 #9: The Variables Window ............................................................... 27
  2.9 #10: The Device Toolbar ................................................................. 27
    2.9.1 Rec (Record) Button ................................................................. 28
    2.9.2 Filter Wheel Buttons .................................................................. 28
    2.9.3 Shutter Buttons ........................................................................ 28
    2.9.4 XY Stage Button ....................................................................... 29
    2.9.5 Z Stage Button ......................................................................... 29
    2.9.6 Objective Turret Buttons .......................................................... 30
    2.9.7 Lamp Buttons ........................................................................... 31
    2.9.8 Other Buttons ............................................................................ 31
  2.10 #11: The Message Bar ................................................................... 31
  2.11 #12: The Message Window ............................................................. 31

3 Tutorials: Quick-Start Guide to Using IPLab Now ......................... 33
  3.1 Setting Up IPLab to Store Acquisition Information and Parameters .... 33
  3.2 How do I add and set up a Filter Wheel ......................................... 33
  3.3 Setting Up Microscope Objectives .................................................. 35
  3.4 Calibrating the Objectives or Optical Path ..................................... 37
  3.5 Use IPLab to Control Your Camera and Microscope ....................... 41
  3.6 Image Enhancement ....................................................................... 42
    3.6.1 Pseudocoloring ....................................................................... 42
    3.6.2 Merging and Blending Images .................................................. 42
    3.6.3 Normalization, Contrast, Levels .............................................. 46
  3.7 Particle Segmentation and Measurement ......................................... 47
  3.8 Image Acquisition ......................................................................... 53
    3.8.1 Basic Image Acquisition ........................................................... 53
    3.8.2 Advanced Image Acquisition ................................................... 55
  3.9 Custom Device Linking “CDL” ......................................................... 70
  3.10 Tutorial on Scripting ................................................................. 72
7.1.9  Set Preferred Directory ........................................................................111
7.1.10 Set Image Info .....................................................................................111
7.1.11 Edit Image Info ....................................................................................112
7.1.12 Indexed Files ........................................................................................113
7.1.13 File Lists ................................................................................................115
7.1.14 Define Foreign Format ........................................................................118
7.1.15 Export ....................................................................................................120
7.1.16 Print ........................................................................................................123
7.1.17 Print Preview ........................................................................................123
7.1.18 Print Setup .............................................................................................123
7.1.19 Set Print Resolution ............................................................................123
7.1.20 Recent Images ......................................................................................123
7.1.21 Recent Scripts .......................................................................................123
7.1.22 Exit ..........................................................................................................123
7.2  Edit Menu ..................................................................................................124
  7.2.1 Undo .......................................................................................................124
  7.2.2 Purge Undo Buffer ................................................................................124
  7.2.3 Repeat Last Command .........................................................................124
  7.2.4 Cut .........................................................................................................124
  7.2.5 Copy .......................................................................................................124
  7.2.6 Paste ......................................................................................................124
  7.2.7 Clear ......................................................................................................125
  7.2.8 Select All ...............................................................................................125
  7.2.9 Define ROI ............................................................................................125
  7.2.10 Modify ROI ..........................................................................................126
  7.2.11 Set ROI Value .....................................................................................127
  7.2.12 Set ROI Color .....................................................................................128
  7.2.13 Insert Frames .......................................................................................128
  7.2.14 Delete Frames ......................................................................................129
  7.2.15 Transfer Frames ................................................................................130
  7.2.16 Convert Z series to T ..........................................................................131
  7.2.17 Assign Function Keys .........................................................................131
  7.2.18 Time Lapse - FKey .............................................................................132
  7.2.19 Set Row/Column Label .....................................................................133
  7.2.20 Transfer Attributes ............................................................................134
  7.2.21 Stamp Overlays On Image .................................................................135
  7.2.22 Preferences .........................................................................................136
7.3  View Menu ..................................................................................................138
  7.3.1 New View..............................................................................................138
  7.3.2 View Options ........................................................................................142
  7.3.3 Show/Hide Image ................................................................................146
  7.3.4 Home Image ........................................................................................146
  7.3.5 Select Frame ........................................................................................146
  7.3.6 Select Display Channels .......................................................................147
  7.3.7 Zoom ....................................................................................................147
  7.3.8 Show/Hide ROI ....................................................................................148
  7.3.9 Display ROI Only ................................................................................148
  7.3.10 Force Update ......................................................................................148
  7.3.11 Animate ..............................................................................................148
  7.3.12 Stop Animating Document ................................................................149
7.4  Enhance Menu ..............................................................................................149
  7.4.1 Normalization .......................................................................................149
| 7.4.2 | Color Balance | ................................................................. | 152 |
| 7.4.3 | Image Ratios | ........................................................... | 153 |
| 7.4.4 | Equalize Contrast | .................................................. | 154 |
| 7.4.5 | Invert | .............................................................. | 155 |
| 7.4.6 | Color To Grayscale | ............................................... | 156 |
| 7.4.7 | Pseudocolor | ........................................................ | 156 |
| 7.4.8 | Edit Color Table | .................................................. | 157 |
| 7.4.9 | Background Correction | ....................................... | 158 |
| 7.4.10 | Linear Filter | ........................................................ | 161 |
| 7.4.11 | Median Filter | ..................................................... | 164 |
| 7.4.12 | Edge Filter | ......................................................... | 165 |
| 7.4.13 | FFT Filter | .......................................................... | 166 |
| 7.4.14 | Flip | ............................................................... | 167 |
| 7.4.15 | Register | ............................................................. | 168 |
| 7.4.16 | Rotate & Scale | .................................................. | 169 |
| 7.4.17 | Mosaic | ........................................................... | 170 |
| 7.4.18 | Mosaic Sequence | .............................................. | 171 |
| 7.5 | Analyze Menu | .......................................................... | 172 |
| 7.5.1 | Segmentation | ....................................................... | 172 |
| 7.5.2 | Autosegment | ......................................................... | 174 |
| 7.5.3 | Set Measurements | ............................................. | 180 |
| 7.5.4 | Measurement Options | .................................... | 183 |
| 7.5.5 | Quantify Segments | ........................................ | 185 |
| 7.5.6 | Measure Seg/ROI | ............................................. | 186 |
| 7.5.7 | Classify Segments | ......................................... | 187 |
| 7.5.8 | Measure Angles | .................................................... | 191 |
| 7.5.9 | Measure Lengths | ................................................... | 193 |
| 7.5.10 | Define XY Units | ............................................ | 194 |
| 7.5.11 | Set XY Units | ....................................................... | 196 |
| 7.5.12 | Insert XY Units | .............................................. | 198 |
| 7.5.13 | Histogram | .......................................................... | 198 |
| 7.5.14 | Row/Col Plot | ..................................................... | 199 |
| 7.5.15 | Transforms | ....................................................... | 200 |
| 7.5.16 | Extract Image Info | ....................................... | 201 |
| 7.6 | Overlay Menu | .......................................................... | 203 |
| 7.6.1 | Show/Hide Segments | ....................................... | 203 |
| 7.6.2 | Segments | .......................................................... | 203 |
| 7.6.3 | Create Segment at Drawing Object | .................. | 208 |
| 7.6.4 | Change Segment Color | .................................. | 208 |
| 7.6.5 | Show/Hide Drawing Objects | ....................... | 209 |
| 7.6.6 | Show/Hide Drawing Objects List | .................. | 209 |
| 7.6.7 | Drawing Objects | .................................................. | 210 |
| 7.6.8 | Select Drawing Objects | .................................. | 213 |
| 7.6.9 | Create Drawing Object at ROI | ..................... | 213 |
| 7.6.10 | Transform Grid Cells to Objects | ................ | 213 |
| 7.7 | Math Menu | .......................................................... | 214 |
| 7.7.1 | Convert to 8/24 Bit | ....................................... | 214 |
| 7.7.2 | Unsigned <-> Signed | ..................................... | 214 |
| 7.7.3 | Change Data Type | ............................................. | 214 |
| 7.7.4 | Pixel Shift | ....................................................... | 215 |
| 7.7.5 | Sort Data | ........................................................ | 216 |
| 7.7.6 | Complex | .......................................................... | 217 |
7.7.7 Morphology .................................................................218
7.7.8 Encode-Decode ............................................................219
7.7.9 Binarize ..................................................................220
7.7.10 Set Pattern .................................................................221
7.7.11 Point Function ............................................................223
7.7.12 Image Arithmetic .........................................................224
7.7.13 Merge Color Channels ..................................................226
7.7.14 Split Color Channels .....................................................228
7.7.15 Convert Color Coordinates ..........................................228
7.7.16 Affine Color Transform ...............................................229
7.8 3D Menu ......................................................................231
7.8.1 3D Equalize ................................................................231
7.8.2 3D Filter ..................................................................233
7.8.3 3D ROI Sum Plot .........................................................237
7.8.4 3D Mosaic ..................................................................238
7.8.5 3D Extract Slices ..........................................................240
7.8.6 3D Extended Focus .......................................................242
7.8.7 Generate Kymograph .....................................................243
7.8.8 Measure Kymograph ......................................................245
7.8.9 Generate Axial View ......................................................247
7.8.10 3D Projector ................................................................248
7.8.11 3D Stacked View ........................................................250
7.8.12 3D Time Stacked View ...............................................251
7.8.13 3D Time Difference View ............................................253
7.9 Camera Menu ...............................................................253
7.9.1 Select Camera ................................................................253
7.9.2 Get Camera Info ..........................................................254
7.9.3 Acquire ...................................................................254
7.9.4 Acquire (Using Last Config.) ...........................................268
7.9.5 3 Pass Color .................................................................268
7.9.6 Multi Dimensional Acquire ............................................272
7.9.7 Set Color Balance Values .............................................290
7.9.8 Select TWAIN Device ..................................................291
7.9.9 TWAIN Capture ..........................................................292
7.9.10 Edit Acquire Info ........................................................292
7.9.11 Export Acquire Info ....................................................292
7.10 Control Menu ...............................................................293
7.10.1 Select Devices ............................................................293
7.10.2 Microscope Control ......................................................297
7.10.3 Stage Control .............................................................298
7.10.4 Record Position ..........................................................300
7.10.5 Move to Recorded Position ..........................................302
7.10.6 Array Setup ...............................................................302
7.10.7 Array Move ...............................................................307
7.10.8 Interfaces .................................................................310
7.11 Ext. Menu ....................................................................310
7.12 Script Menu .................................................................310
7.12.1 New Script ................................................................310
7.12.2 Open Script ................................................................310
7.12.3 Run Script ..................................................................310
7.12.4 Set Variable ..............................................................310
7.12.5 Set String Variable ......................................................314
7.12.6 String Variables................................................................. 315
7.12.7 Enter String Variables ..................................................... 317
7.12.8 Copy String Value .......................................................... 318
7.12.9 Record Timer ................................................................. 319
7.12.10 Wait For Timer ............................................................... 319
7.12.11 Script Commands .......................................................... 320

7.13 Window Menu ..................................................................... 327
7.13.1 Show/Hide Status Window ............................................... 327
7.13.2 Show/Hide Variables Window .......................................... 327
7.13.3 Show/Hide Message Window .......................................... 328
7.13.4 Dispose Window ............................................................. 328
7.13.5 Dispose All Views of Front Image ...................................... 328
7.13.6 Dispose All Windows ..................................................... 328
7.13.7 Rename Window ............................................................. 329
7.13.8 Duplicate Window .......................................................... 329
7.13.9 Change Window ............................................................. 330
7.13.10 Place Window ............................................................... 331
7.13.11 Frames to Sequence ..................................................... 332
7.13.12 Sequence to Frames ..................................................... 332
7.13.13 Cascade .......................................................................... 333
7.13.14 Tile ............................................................................. 333
7.13.15 Dual Monitor Setup ....................................................... 333
7.13.16 Arrange Icons .............................................................. 334
7.13.17 Toolbars ...................................................................... 334
7.13.18 Window List ................................................................. 334

8 Writing Extensions .................................................................. 335
8.1 Introduction ......................................................................... 335
8.2 The Basic Concepts of Extensions ........................................ 335
8.3 Create An Extension ............................................................ 335
  8.3.1 From Sample Projects ................................................... 335
8.3.2 Create Your Own Project ................................................ 336
8.4 Callback Functions .............................................................. 338

9 Appendix .............................................................................. 343
9.1 Numeric Variables Reserved by IPLab ................................. 343
9.2 IPLab/Windows Image File Format ...................................... 344
  9.2.1 Tagged blocks of information ........................................ 344
9.2.2 Required Tags and Their Order ...................................... 345
9.2.3 Optional Tags ................................................................. 347
9.3 Format of Array Window Data ............................................ 353

10 Index .................................................................................... 355
1 Must-Read Section: Installing Software

1.1 What Equipment You Need

The material in this User’s Guide is self-contained. Although it is helpful to have an understanding of image processing methods and terminology in order to develop scripts for your own algorithms, it is not necessary for an understanding of the manual.

IPLab for Windows uses the standard Windows interface. This manual assumes that you are familiar with standard computer techniques: clicking the mouse, dragging, using the keyboard, accessing menus, interacting with dialogs, manipulating windows, handling files, and other Windows fundamentals. If you are unfamiliar with these techniques, please consult your Windows OS manual for descriptions of their use.

To use IPLab version 3.7, you need the following:

• Any computer which is capable of running the Windows XP, 2000, or 98 operating system, or a later version. Performance is better on computers with Pentium processors or better.

• At least 256 megabytes of memory. The Windows operating systems use a slow virtual memory scheme if you do not have enough physical memory in your computer for running IPLab. Be aware that image processing requires a lot of memory to store the image data, so the more memory you have in your computer, the better performance you will see from IPLab.

• A video display card and monitor set to display 24-bit color or greater using 800 x 600 resolution or greater.

• A hard disk with at least 10 megabytes of space and a CD-ROM drive.

• To acquire images, your computer will need to have either a free PCI slot or FireWire port. Most new computers will have these.
  • FireWire: Some cameras connect to the computer's FireWire port. These are also called IEEE-1394 or iLink ports.
  • PCI: Other cameras come with a frame grabber or other interface card that fits into a PCI slot.

IPLab also allows you to create custom functions, called extensions, which you can integrate into the main application. In order to develop your own extensions, you need appropriate development software. Consult the Writing Extensions chapter in the IPLab Extensions manual.

You do not need any special boards or monitors in order to display and process high quality image data with IPLab. However, if you wish to capture live images from a digital or video camera, IPLab does provide optional support for a variety of frame grabber boards. Consult the chapters on camera controls in the IPLab Extensions manual.
1.2 Setting Up IPLab

Before you start, we recommend that you make a backup copy of all the CDs and disks in your IPLab package. NOTE: IPLab is not copy protected. You may make as many backup copies as you wish for use on only one computer at a time. Please read the Software License Agreement for complete details.

The standard IPLab package contains a single CD-ROM. This contains all of the software you purchased (e.g. IPLab, Motion Control, MultiProbe, and the camera controls that came with IPLab). To install your software:

• If you are running Windows XP, or Windows 2000, the Sentinel drivers for the IPLab key must be installed in order for IPLab to work. Log in as an administrator before installing the software. Otherwise, the drivers cannot be installed.

  The IPLab 3.7 installer activates the Sentinel installer. Do not cancel or exit the Sentinel installer; allow it to load the drivers that make the IPLab key work.

  If the key drivers are not installed on an NT, Win 2000, or Win XP machine, then IPLab will report that the key could not be found, and IPLab will only run in evaluation mode.

  If your installation was interrupted because you were not logged into an administrative account, then simply log back in as an administrator and run the IPLab installer again.

• Double-click on every installer you purchased (e.g. the files "Install IPLab 3.7.exe," "Install MultiProbe.exe," "Install IPLab Acquires.exe"…). *

• Make certain you install IPLab, the extensions, and the camera controls to the same directory. Extensions and camera controls need to be inside the main IPLab directory.

• Some camera hardware comes with special drivers that we do not install. You will need to install these drivers, following the instructions that came with them.

• If you installed any camera controls or camera drivers, you must restart your computer.

* If you do not see the ".EXE" file extensions, look at the directory’s contents in list mode, and look at the Type column. The executable (.EXE) files will have the type "Application."

You are now ready to use IPLab.
Chapter 2 describes the most important parts of the IPLab environment. Becoming familiar with the features numbered in the image below will help you start using IPLab quickly. Each bracketed feature in the figure below is described in a numbered part of this chapter. For example, the image window, feature #2, is described in the section named, "#2: The Image Window."

The Important Parts of the IPLab Interface
2.1 #1: The Menu Bar


The chapter of this manual is organized according to menu. So, for example, if you want information about a command in the \textbf{Enhance} menu, go to the section of the chapter that describes the commands in that menu. If you want to perform a measurement but don’t know what command to use, look in the section of the manual about the \textbf{Analyze} menu. As you would expect, all measurement and analysis commands are grouped there. Read the Processing Extensions chapter, found in the \textit{IPLab Extensions} manual.

To find the command you need, look for the menu that describes the basic operation you want to perform:

- Archive images and analysis results in \textbf{Files} and recover them.
- \textbf{Edit} images: copy and paste, and modify the ROI, sequences, variables, function keys, and more.
- \textbf{View} images and/or data in various ways.
- \textbf{Enhance} images to make them look better.
- \textbf{Analyze} the image data to extract information about the image as a whole or about parts of the image.
- Add and modify image \textbf{Overlays} used for image analysis and for annotation.
- Perform \textbf{Math} upon measurement results or image data.
- Process and visualize \textbf{3D} data.
- Acquire images from a \textbf{Camera}.
- \textbf{Control} microscope hardware.
- Record sequences of commands in \textbf{Scripts} to be repeated later with ease.
- Readily move, duplicate, and organize \textbf{Windows} on the screen.

The menus in \textit{IPLab} are organized around these different kinds of operations.
### Must-Read Section: The IPLab Interface

This is the complete list of IPLab commands:

<table>
<thead>
<tr>
<th><strong>File Menu</strong></th>
<th><strong>Edit Menu</strong></th>
<th><strong>View Menu</strong></th>
<th><strong>Enhance Menu</strong></th>
<th><strong>Analyze Menu</strong></th>
<th><strong>Overlay Menu</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>New Data (Ctrl+N)</td>
<td>Undo (Ctrl+Z)</td>
<td>New View</td>
<td>Normalization</td>
<td>Segmentation</td>
<td>Show/Hide Segments</td>
</tr>
<tr>
<td>Open (Ctrl+O)</td>
<td>Purge Undo Buffer</td>
<td>Image</td>
<td>Color Balance</td>
<td>Autosegment</td>
<td>Segments</td>
</tr>
<tr>
<td>Close (Ctrl+W)</td>
<td>Repeat Last Command (Ctrl+R)</td>
<td>Text</td>
<td>Image Ratios</td>
<td>Set Measurements</td>
<td>Add</td>
</tr>
<tr>
<td>Save (Ctrl+S)</td>
<td>Cut (Ctrl+X)</td>
<td>Plot</td>
<td>Equalize Contrast</td>
<td>Measurement Options</td>
<td>Modify</td>
</tr>
<tr>
<td>Save As</td>
<td>Copy (Ctrl+C)</td>
<td>Histogram</td>
<td>Invert</td>
<td>Quantify Segments</td>
<td>Delete</td>
</tr>
<tr>
<td>Save All Files</td>
<td>Paste (Ctrl+V)</td>
<td>Linear Profile</td>
<td>Color to Grayscale</td>
<td>Measure Seg/ROI</td>
<td>Cut</td>
</tr>
<tr>
<td>Revert to Saved</td>
<td>Clear</td>
<td>Skewed 3D</td>
<td>Pseudocolor</td>
<td>Classify Segments</td>
<td>Copy</td>
</tr>
<tr>
<td>Delete File</td>
<td>Select All (Ctrl+A)</td>
<td>Contours</td>
<td>Edit Color Table</td>
<td>Measure Angles</td>
<td>Paste</td>
</tr>
<tr>
<td>Set Preferred Directory</td>
<td>Define ROI</td>
<td>View Options</td>
<td>Background Correction</td>
<td>Measure Lengths</td>
<td>Create Segment at Drawing Object</td>
</tr>
<tr>
<td>Set Image Info</td>
<td>Modify ROI</td>
<td>Text</td>
<td>Linear Filter</td>
<td>Draw XY Units</td>
<td>Change Segment Color</td>
</tr>
<tr>
<td>Edit Image Info</td>
<td>Set ROI Value (Ctrl+Enter)</td>
<td>Plot</td>
<td>Median Filter</td>
<td>Set XY Units</td>
<td>Show/Hide Drawing Object</td>
</tr>
<tr>
<td>Indexed Files:</td>
<td>Set ROI Color</td>
<td>Show/Hide Image</td>
<td>Edge Filter</td>
<td>Insert Calibration Bar</td>
<td>Objects List</td>
</tr>
<tr>
<td>Set Index Info</td>
<td>Insert Frames</td>
<td>Home Image</td>
<td>FFT Filter</td>
<td>Histogram</td>
<td>Drawing Objects</td>
</tr>
<tr>
<td>Save As Indexed</td>
<td>Delete Frames</td>
<td>Select Frame</td>
<td>Flip</td>
<td>Row/Col Plot</td>
<td>Add</td>
</tr>
<tr>
<td>Open Indexed</td>
<td>Transfer Frames</td>
<td>Select Display Channels</td>
<td>Register</td>
<td>Transforms</td>
<td>Modify</td>
</tr>
<tr>
<td>File Lists</td>
<td>Convert Z series to T</td>
<td>Zoom</td>
<td>Rotate and Scale</td>
<td>Extract Image Info</td>
<td>Delete</td>
</tr>
<tr>
<td>Select File List</td>
<td>Convert T series to Z</td>
<td>Zoom In</td>
<td>Mosaic</td>
<td>Color Table</td>
<td>Select Drawing Objects</td>
</tr>
<tr>
<td>Edit File List</td>
<td>Assign Function Keys</td>
<td>Zoom Out</td>
<td>Mosaic Sequence</td>
<td>Rect ROI to 1D</td>
<td>Select Previous</td>
</tr>
<tr>
<td>Open File from Selected File List</td>
<td>Time Lapse - FKey</td>
<td>Show/Hide ROI</td>
<td>Linear ROI to 1D</td>
<td>Linear ROI to 1D</td>
<td>Select Next</td>
</tr>
<tr>
<td>Save File using Selected File List</td>
<td>Set Row/Column Label</td>
<td>Display ROI Only</td>
<td>ROI Boundary</td>
<td>Image Sizes</td>
<td>Select All</td>
</tr>
<tr>
<td>Delete using Selected File List</td>
<td>Transfer Attributes</td>
<td>Force Update</td>
<td>Acquire Info</td>
<td>Acquire Info</td>
<td>Select</td>
</tr>
<tr>
<td>Define Foreign Format</td>
<td>Stamp Overlay on Image Preferences</td>
<td>Animate</td>
<td></td>
<td></td>
<td>Create Drawing Object at ROI</td>
</tr>
<tr>
<td>Export</td>
<td></td>
<td>Stop Animating</td>
<td></td>
<td></td>
<td>Transform Grid Cells to Objects</td>
</tr>
<tr>
<td>Sequence to Movie</td>
<td></td>
<td>Document</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Math Menu</strong></td>
<td><strong>3D Menu</strong></td>
<td><strong>Camera Menu</strong></td>
<td><strong>Control Menu</strong></td>
<td><strong>Script Menu</strong></td>
<td><strong>Window Menu</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Convert to 8/24 Bit (Ctrl+T)</td>
<td>3D Equalize</td>
<td>Select Camera</td>
<td>Select Devices</td>
<td>New Script</td>
<td>Show/Hide Status Window (Ctrl+U)</td>
</tr>
<tr>
<td>Unsigned &lt;-&gt; Signed Change Data Type</td>
<td>3D Filter</td>
<td>Get Camera Info</td>
<td>Microscope Control</td>
<td>Open Script</td>
<td>Show/Hide Variables Window Show/Hide Message Window</td>
</tr>
<tr>
<td>Pixel Shift</td>
<td>3D ROI Sum Plot</td>
<td>Acquire</td>
<td>Stage Control</td>
<td>Run Script</td>
<td>Dispose Window (Ctrl+M)</td>
</tr>
<tr>
<td>Sort Data</td>
<td>3D Mosaic</td>
<td>Acquire (Using Last Config.)</td>
<td>Record Position</td>
<td>Set Variable</td>
<td>Dispose All Views of Front Image</td>
</tr>
<tr>
<td>Complex</td>
<td>3D Extract Slices</td>
<td>3 Pass Color</td>
<td>Move to Recorded Position</td>
<td>Set String Variable</td>
<td>disposing all views of front image</td>
</tr>
<tr>
<td>Morphology</td>
<td>3D Extended Focus</td>
<td>Multi Dimensional Acquire</td>
<td>Array Setup</td>
<td>Enter String Variables</td>
<td>Show/Hide Variables Window</td>
</tr>
<tr>
<td>ROI Tools</td>
<td>Generate Kymograph</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Array Move</td>
<td>Copy String Value</td>
<td>Window Show/Hide Message Window</td>
</tr>
<tr>
<td>Draw Layer</td>
<td>Measure Kymograph</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Record Timer</td>
<td>Dispose All Views of Front Image</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Generate Axial View</td>
<td>3D Projector</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Wait for Timer</td>
<td>Dispose All Windows Rename Window</td>
</tr>
<tr>
<td>Affine Color Transform</td>
<td>3D Stacked View</td>
<td>3D Time Stacked View</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Script Commands</td>
<td>Change Window Place Window</td>
</tr>
<tr>
<td>Split Color Channels Convert Color</td>
<td>3D Time Difference View</td>
<td></td>
<td></td>
<td>Run</td>
<td>Frames to Sequence</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Math Menu</strong></th>
<th><strong>3D Menu</strong></th>
<th><strong>Camera Menu</strong></th>
<th><strong>Control Menu</strong></th>
<th><strong>Script Menu</strong></th>
<th><strong>Window Menu</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert to 8/24 Bit (Ctrl+T)</td>
<td>3D Equalize</td>
<td>Select Camera</td>
<td>Select Devices</td>
<td>New Script</td>
<td>Show/Hide Status Window (Ctrl+U)</td>
</tr>
<tr>
<td>Unsigned &lt;-&gt; Signed Change Data Type</td>
<td>3D Filter</td>
<td>Get Camera Info</td>
<td>Microscope Control</td>
<td>Open Script</td>
<td>Show/Hide Variables Window Show/Hide Message Window</td>
</tr>
<tr>
<td>Pixel Shift</td>
<td>3D ROI Sum Plot</td>
<td>Acquire</td>
<td>Stage Control</td>
<td>Run Script</td>
<td>Dispose Window (Ctrl+M)</td>
</tr>
<tr>
<td>Sort Data</td>
<td>3D Mosaic</td>
<td>Acquire (Using Last Config.)</td>
<td>Record Position</td>
<td>Set Variable</td>
<td>Dispose All Views of Front Image</td>
</tr>
<tr>
<td>Complex</td>
<td>3D Extract Slices</td>
<td>3 Pass Color</td>
<td>Move to Recorded Position</td>
<td>Set String Variable</td>
<td>Dispose All Views of Front Image</td>
</tr>
<tr>
<td>Morphology</td>
<td>3D Extended Focus</td>
<td>Multi Dimensional Acquire</td>
<td>Array Setup</td>
<td>Enter String Variables</td>
<td>Copy String Value</td>
</tr>
<tr>
<td>ROI Tools</td>
<td>Generate Kymograph</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Array Move</td>
<td>Copy String Value</td>
<td>Record Timer</td>
</tr>
<tr>
<td>Draw Layer</td>
<td>Measure Kymograph</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Wait for Timer</td>
<td>Dispose All Views of Front Image</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Generate Axial View</td>
<td>3D Projector</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Script Commands</td>
<td>Run</td>
</tr>
<tr>
<td>Affine Color Transform</td>
<td>3D Stacked View</td>
<td>3D Time Stacked View</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Run</td>
<td>Single Step</td>
</tr>
<tr>
<td>Split Color Channels Convert Color</td>
<td>3D Time Difference View</td>
<td>3D Time Difference View</td>
<td>&lt;List of dialog boxes for interfaces and settings&gt;</td>
<td>Run Selected</td>
<td>Continue</td>
</tr>
</tbody>
</table>

**Window Menu**

- Show/Hide Status Window (Ctrl+U)
- Show/Hide Variables Window Show/Hide Message Window (Ctrl+M)
- Dispose Window (Ctrl+K)
- Dispose All Views of Front Image
- Dispose All Windows Rename Window Duplicate Window (Ctrl+D)
- Change Window Place Window Frames to Sequence Sequence to Frames
- Cascade Tile Dual Monitor Setup
- Arrange Icons Toolbars
  - Main Status Bar ROI Tools
  - Segment Layer Tools Drawing Layer Tools F Keys
  - Device Bar
- <List of Open Windows>
2.2 #2: The Image Window

The image window contains the image, image overlays, and several special tools (Z and T buttons for stepping through sequences, an image information button, and a status bar).

Image windows are also called data windows. Data of any kind can be displayed in an image window. The active window is the one with the highlighted title bar and which appears to be in front. It is also referred to as the first image.

2.2.1 #2a: The Image

Your data is the image. In the example above, the image includes the fluorescent label as well as the black background.

As far as the IPLab program is concerned, the image is an array of numbers. An image is an orderly arrangement of pixels, and each pixel has a numeric intensity value. Hence, an image is an array of numbers. The easiest way to see this is to open two views of the image as both an image and as text by using the New View command (View menu).

IPLab handles four kinds of arrays: 1-dimensional, 2-dimensional, 3-dimensional, and 4-dimensional data. Any array of data, even a 1D array, is called an “image.”

- 1D data is a single row or column of numbers. 1D data typically is the result of some analysis, but you can also create a 1D data set.
- 2D arrays of numeric data are common images. 2D data may also result from some measurements or calculations of statistics or other information.
3D image data consists of a collection of 2D image frames. The third dimension can be either time \((x,y,t)\) or the third spatial dimension \((x,y,z)\).

4D image data consists of a time sequence of \((x,y,z)\) data.

3D and 4D data are also called image sequences. You can click the Z and T buttons to switch between the 2D image frames in a multi-dimensional image. Page 16, "2f," gives more information about moving through image sequences.

Examples of image windows:

**Image Coordinates**

The individual elements of all images are referred to in this manual as *pixels*. The image's *coordinate system* pinpoints the location of each pixel. The \(x\) and \(y\) coordinates of any pixel are measured from the upper left-hand corner of the image. For multi-dimensional data, each image in the sequence is called a *frame*. 
The coordinates of the top-left pixel in any image (or any frame of an image sequence) are (0,0). The first pixel to its right has coordinates (1,0); the first pixel below it has coordinates (0,1), etc. The bottom-right pixel has coordinates (Width-1, Height-1). This coordinate system is independent of how the data is zoomed or scrolled.

For multi-dimensional data, the first frame is frame number 0. Therefore, if the sequence has n frames, the last frame is frame number n-1. There are several ways that data can contain more than 2 dimensions:

1. The data can be a time series of 2D images.
2. The data can be a 3D spatial data set which consists of a single 2D image at multiple focal or time points.
3. The data can be a 4D data set which consists of a time series of 3D images.

### 2.2.2 #2b: The Region of Interest (ROI)

The Region of Interest is what it sounds like: the region or area of the image that you are most interested in. In practice, the ROI is the area of the image, the collection of connected pixels, that you have selected. The ROI is synonymous with the blinking, dashed selection line that surrounds the selected region. Other programs also call the ROI the selection box, the AOI (area of interest), the guard region, and the rubber band. The image only has one ROI at a time.

When viewing an image window as an image, the ROI is shown as a moving, dashed outline encircling the data elements (pixels) within the ROI. When viewing an image window as text, those data elements within the ROI are shown as highlighted text. The **Show/Hide ROI** command (View menu) controls the visibility of the ROI's dashed line.

The "ROI Tools Toolbar" section on page 17 describes how to draw an ROI.

### Uses of the ROI

You use the ROI for two reasons:
• To limit the area that will be processed or filtered.
• To define the area that will be measured or quantified.

Processing the ROI alone, instead of processing the entire image, allows you to apply different processing methods to different portions of an image. ROI processing is also much faster than processing the entire image. Many IPLab commands only affect the ROI, the selected region of the image.

**Boundaries of the ROI**

A rectangular ROI is specified by the left, right, top and bottom boundaries. Rectangular ROIs consists of all those pixels whose horizontal and vertical coordinates \((h,v)\) satisfy:

\[
\text{left} \leq h < \text{right} \quad \text{All horizontal locations between the left and right boundaries, including the left boundary but not the right boundary}
\]

\[
\text{top} \leq v < \text{bottom} \quad \text{All vertical locations between the top and bottom boundaries, including the top boundary but not the bottom boundary}
\]

A rectangle, called the *bounding rectangle*, is associated with any non-rectangular ROI. It is the smallest rectangle enclosing all of the points in the ROI. The bounding rectangle is not directly visible in normal operation. The Status Window reports it as the bounds of the ROI.
For Advanced Users: Remember that the bottom and right bounds are not included within the selection. If, for example, the Status Window gives the right bound as 100 and the bottom bound as 50, then the pixel (100, 50) is just outside the bottom-right corner of the ROI.

Example: A Close-up of an Image

In this example, the left edge of the pixel at (100, 50) defines the right boundary of the ROI. The top edge of the pixel at (100, 50) defines the bottom boundary of the ROI.

Moving and Resizing the ROI

In a data window being viewed as an image or as text, you can move the ROI with the arrow keys on the keyboard.

When viewing data as an image, and when an ROI tool is selected on the toolbar (described on page 19), then you can move and resize the ROI by holding down the Control key. When you hold down the Control key, black handles will appear at the corners and sides of the ROI.

• To move the ROI:
  1) Hold down the Control key,
  2) Click in the center of the ROI, and
  3) Drag it to its destination.

• To change the size and shape of the ROI:
  1) Hold down the Control key,
  2) Click down on one of the handles. The cursor will change to a single, double-headed arrow
  3) Drag the handle to move that side or corner of the ROI.

2.2.3 #2c & 2d: Segment and Drawing Overlays

Two layers sit on top of the IPLab image: the segment layer and the drawing layer. These two layers contain two different types of overlays that you can use to define measurement regions and to annotate images. In the diagram of an image window on page 7, item #2c is a segment defining a region to be measured, and item #2d is a drawing object annotating the image.

The segment and drawing overlays do not affect the data underneath them. You can draw graphics and text on top of your images without destroying the underlying data. You can think of these overlays as being like latex paint: you can paint the overlays on top of the data, and peel them off again without altering the data.

The segment layer is like an image that lies on top of the real image data. Within its own layer, it colors each individual pixel one of 6 different colors. It is used primarily for defining regions to be measured. Unlike the ROI, segments can define non-contiguous regions to be measured.

The drawing layer contains drawing objects which you can select and move. It is primarily used for annotation. It is also like an image that lies on top of the real image data.
You can draw segments and drawing objects by using the Segment Tools and Drawing Tools toolbars:

The Segment Tools and Drawing Tools Toolbars

You can also use the Overlay menu commands to add, edit, and delete segments and drawing objects. The Segmentation command (Analyze menu) adds segments over regions defined by thresholds. The Measurement Options command can be set to automatically annotate the image with drawing objects when the image is measured.

Overlays are only saved in the IPLab format. To see segment or drawing layers in TIFF-formatted images, use the Stamp Overlays on Image command (Edit menu). This command DOES overwrite image data in the regions of the overlay.

You can transfer the segment and/or drawing layers from one image to another using the Transfer Attributes command found in the Edit menu. You can use this feature to analyze the same regions in multiple images in a study: Define specific regions to analyze using segments in one image, and then transfer the segments definition to all other images in your study.

2.2.4 #2e: The Image Info Button (the i Button)

Another toolbar built into the image window is the Image Info button, i. The i button displays a window of information about the image. Like any other toolbar, you can drag the i button around and re-dock it elsewhere within the same window.

Clicking the i button opens the image information window. Click this button again to close the image info window.

General Tab

The General tab displays the Descriptor and Notes fields and information about the image window.
The **Descriptor** and **Notes** fields display information about the image. You enter this information by using the **Set Image Info** and **Edit Image Info** commands (File menu). You can use the **Descriptor** and **Notes** information to keep track of important information about each image, such as the identity of the sample, probes, and researcher; the date; or the experimental conditions during acquisition.

The status information at the bottom of the image info window describes the image's **X**, **Y**, **Z**, and **T** dimensions, its data type, and its **XY** units (set by the **Analyze** menu's **Set XY Units** command). This information is updated whenever the image is redrawn (e.g. when you change the window's size).
**Acquire Tab**

*IPLab* stores acquisition settings in images acquired by the **Acquire** and **Multi Dimensional Acquire** commands. You can view this information in the **Acquire** tab:

![Image Info Window's Acquire Tab](image)

**Image Info Window's Acquire Tab**

This is the same information exported by the **Extract Image Info: Acquire Info** command (**Analyze** menu).
**Ratio Tab**

The **Ratio Plus** acquisition commands store data about the ratio experiment in new images. These commands, **Ratio Acquire** and **Single Wavelength Acquire**, store the information in a tag within the image file. You can view this information in the **Ratio** tab:

![Ratio Tab of the Image Info Window](image)

The information about the ratio or FRET experiment is shown at the top. This information comes from the acquisition command and the **Ratio** or **FRET Constant Calculations** command.

The **Markers** field lists the first twenty events that you marked during the experiment, such as the additions of reagents. You can edit the comment that follows the time. To do so, use the **Ratio Plot Editor** command (**Ratio** menu) and click its **Edit Markers** button. Please note that long comments may not be shown in full within this field.

The comments field displays additional information that you can store within your image. Edit this information using the **Ratio Comment Edit** command (**Ratio** menu).
Note: The ratio and FRET commands mentioned here are part of the Ratio Plus extension, which is sold separately. See the Extensions Manual for a description of the Ratio Plus extension.

2.2.5 #2f: Z and T Arrow Buttons

Image windows have their own toolbars built into the edges of the windows. The Z and T arrows change which frame of the image sequence is being viewed. Like any other toolbar, you can drag this toolbar around and re-dock it elsewhere within the same window.

Next- and Previous-Frame Arrows for Z and T

The up and down Z arrows move the image sequence to the next or previous Z frame, respectively. The right- and left-wards T arrows move the image sequence to the next or previous time frame, respectively. You can see the current Z and T frame numbers in the status bar at the bottom of the image window.

You can animate image sequences by holding down any of these buttons. Holding down the down Z button, for example, will play Z sequences in reverse. Sequences will play at the speed (frames per second) set in the Animate dialog box (View menu).

2.2.6 #2g: The Status Bar

Status Bar at the Bottom of a Window

The status bar at the bottom of each window displays the intensity value of the pixel at the cursor's location. After that, the bar shows the X, Y, Z, and T coordinates of the cursor. It also shows the magnification level of the image (that is, if you click the Zoom In button once, the magnification level will be 200%).

You can hide the active window's status bar by deselecting Status Bar in the Toolbars command (Window menu).

2.3 #3: The Main Toolbar

This toolbar contains buttons for some commonly used File and Edit menu functions:

- New Data: Clicking this button to create a new image window as described on page 107.
- New Script: Click this button to create a new script. Read about scripting on page 99.
- Open: Open an image from disk.
Save Data: Save the front image.

Export to Excel: Export data directly to Excel

Cut: Cut the selection and store it on the Clipboard.

Copy: Copy the selection and store it on the Clipboard.

Paste: Insert the contents of the clipboard into the front image window.

Print: Print the front image.

About: Display IPLab program information, including the version number and copyright date.

You can make this toolbar into a floating palette by clicking on its edge and dragging it off the side of the application window. You can re-dock it elsewhere by moving it over the application window's border.

2.4 #4: The ROI Tools Toolbar

To create a Region of Interest, first click on the appropriate tool in the ROI Tools toolbar. Then use the mouse to draw the ROI. Notice that the ROI is drawn on top of the image. It does not affect the image data itself. You may also define rectangular, oval, and linear ROI shapes via the Define ROI command in the Edit menu. Within text-viewed windows, clicking and dragging will only create rectangular ROIs.

Within an image view, you may move the entire ROI by holding down the Control key on the keyboard while left-clicking and dragging the mouse. You may also change the size of the ROI by holding down the Control key and selecting one of the ROI-resize handles with the mouse.

You can define one ROI at a time. The ROI can have a variety of shapes, depending on the tool you use to draw it:

Rect ROI: Click this button to draw rectangular regions of interest. Hold down the Shift key while drawing to select square regions.

Oval ROI: Use this tool to draw elliptical regions of interest. Hold down the Shift key while drawing to select circular regions.

Polygon ROI: Use the polygon selection tool to select closed, polygonal regions. Click on each point of the polygon and double-click at the end to automatically close the polygon.

Freehand ROI: Click this button to freely draw closed, curved shapes. This tool gives you the greatest ability to follow an object's outline. To draw, click once and drag. The shape will be closed for you when you let go of the mouse button.

Line ROI: Draw linear regions of interest using this tool, which is also called a multi-line or linear ROI tool. (This is like a closed polygon, except that the shape will not be closed after you double-click to end the drawing.)
Use the multi-line tool only to create open curves or piecewise linear ROIs. You would use this tool with the **Analyze** menu command **Extract Line**, for example.

**Select All ROI:** Use this button to reset any ROI back to the full image size.

You cannot draw an ROI and paint a segment (with the segment tools, described below) or draw a drawing object (with drawing tools, described below) at the same time. After selecting a segment tool or a drawing tool, you will have to click on one of the ROI tools to draw an ROI again.

Use the **Zoom In** and **Zoom Out** buttons to magnify or de-magnify the image.

**Zoom In:** Clicking this button once doubles the image’s magnification, making details appear larger and easier to see. The image window will expand to fit the image, if possible.

**Zoom Out:** Clicking this button once de-magnifies (minifies) the image, halving its magnification.

You can magnify up to 16 times the original image size. There is no limit to the demagnification factor.

There are two other ways to zoom in and out on an image:

- Click the right mouse button on the image to zoom in. Hold down the **Control** key and click the right mouse button on the image to zoom out.
- Use the **Zoom In** or **Zoom Out** commands in the **View** menu.

You can make the **ROI Tools** toolbar into a floating palette by clicking on its edge and dragging it off the side of the application window. You can re-dock it elsewhere by moving it over the application window’s border.

### 2.4.1 Scripting the ROI Tools

When you click on one of the magnifying glass tools while recording a script, the **Zoom In** or **Zoom Out** command will be recorded in your script. When the script runs that command, it will zoom in or zoom out on the front image. When you script one of the other ROI tools, the **Select Tool** dialog box opens:
The ROI Tools portion of the Select Tool Dialog Box

The Select Tool dialog box lists all of the ROI, segment, and drawing tools. Click on the radio button for the tool you want and then click OK. When the script runs the Select Tool command, that tool will become active. Your script can then prompt the user to select a region of interest.

#5: The Segment Tools Toolbar

IPLab’s seven segment tools let you manually create segments like those created by the Segmentation command (Analyze menu). These tools look similar to the ROI and drawing tools, but the icons are red. Use these segments as the basis for measurements conducted by the Analyze menu commands (see page 172). Before manually adding a segment, pick the segment color from the pop-up menu on the right.

You can set the pen size for any tool by double clicking on its button. The pen size is the width, in pixels, of the line painted by the segmentation tool (or of the line removed by the eraser). Also, double clicking on the first four segment tools lets you choose to paint a filled segment or not.
Rect Segment: The first tool lets you paint rectangular segments. Hold down the Shift key while you draw the rectangle to get a square segment.

Oval Segment: The second tool paints elliptical segments. Hold the Shift key down to paint circular segments.

Polygon Segment: The third tool paints a closed polygonal segment. Click on each point of the polygon and double click at the end to automatically close the polygon.

Freehand Segment: The rounded, potato-shaped tool freely paints closed, curved shapes. To use this, click once and drag. The shape will be closed for you when you let go of the mouse button. This tool gives you the greatest ability to follow an object's outline.

Line Segment: Paint linear segments using the fifth tool, which is also called a multi-line or linear segment tool. (This is similar to a closed polygon, except that the shape is not closed after you double click to end the drawing.)

Segment Eraser: The brick-shaped tool is a segment eraser. When you click on this tool and then drag the cursor over the image, you will erase any segments under or around the point of the cursor. The eraser's pen size determines the size of the eraser.

Segment Paintbrush: When the Segment Paintbrush tool is selected, segments will be painted wherever you click or drag the cursor.

Clear Segment Layer: Deletes all segments on the current image.

Color menu: The pop-up menu sets the color of the new segments to be made. Pick a color and then use the segment tools to add segments. Segment colors include red, yellow, green, cyan, blue, magenta, and white.

The segment color selected is important when performing blob analysis with the Ratio Plus extension. If you need to change the color of existing segments, use the Change Segment Color command (Overlay menu).

You can make the Segment Tools toolbar into a floating palette by clicking on its edge and dragging it off the side of the application window. You can re-dock it elsewhere by moving it over the application window's border.

2.4.2 Scripting the Segment Tools

When you script one of the segment tools (besides the color menu), the Select Tool dialog box opens:
The Segment Tools portion of the Select Tool Dialog Box

The Select Tool dialog box lists all of the ROI, segment, and drawing tools. Click on the radio button for the tool you want and then click OK. When the script runs the Select Tool command, that tool will become active. Your script can then prompt the user to add a segment to the image.

When you select a segment color while recording a script, the script records that selection as a command: for example, "Segment Tool Color - Red". Then, when the script runs that command, the segment color will change to your chosen color (for example, red). All segments subsequently created by the script will be that color.

2.5 #6: The Drawing Tools Toolbar

IPLab’s seven drawing tools give you the ability to manually create drawing objects. These tools look similar to the ROI and segment tools, but the icons are blue. Add drawing objects to annotate and to highlight or outline special regions of your image. Selected drawing objects, including newly drawn objects, will appear gray because they are selected.

Drawing Object Selector:
Use this tool to select individual drawing objects. The cursor will change tohand when it is over a selected drawing; you can then use the drawing selector to move the selection around the image.
By holding down the keyboard’s Control key, you can use the selector tool to resize the selected drawing object(s). Handles (black squares) will appear around the selected drawing(s); drag the handles to change the size of the drawing(s).

![An example of a drawing object with its handles shown.](image)

**Rect Drawing Object:**

Click this button to draw rectangular drawing objects. Hold down the **Shift** key while you draw to get a square object.

Double clicking on this button opens a dialog box that lets you fill the drawing with the drawing color, choose the width of the drawing object’s outline, and pick the color of the drawing object (red, yellow, green, cyan, blue, or magenta).

![Drawing Tool Attributes](image)

Double click on a drawing tool button to set its attributes

**Oval Drawing Object:**

Use this tool to draw elliptical drawing objects. Hold down the **Shift** key while drawing to create a circular object.

Double-click on this button to see its **Attributes** dialog, as shown for the **Rect Drawing Object** tool.

**Polygon Drawing Object:**

This tool draws a closed polygon. Click on each point of the polygon and double click at the end to automatically close the polygon.
Double-click on this button to see its Attributes dialog, as shown for the Rect Drawing Object tool.

**Freehand Drawing Object:**
Click this button to freely draw closed, curved shapes. To draw, click once and drag. The shape will be closed for you when you let go of the mouse button.

Double-click on this button to see its Attributes dialog, as shown for the Rect Drawing Object tool.

**Line Drawing Object:**
Draw linear regions of interest using this tool, which is also called a multi-line or linear drawing object tool. (This is like a closed polygon, except that the shape will not be closed after you double-click to end the drawing.)

Double-click on this button to see its Attributes dialog, which is similar to the Rect Drawing Object tool's dialog, but has options for arrowheads, too. You can add arrowheads to the start and/or the end of the line. Arrows are good for pointing to parts of images.

**Grid Drawing Object:**
The Grid tool allows you to draw a grid object -- grid cells -- on an image. This creates a grid of rectangular, oval, or crosshair drawing objects, which you can use to overlay the spots in a microarray or the wells in a multi-well plate.

Double-click the Grid Drawing Object button to set the tool's attributes:

The Type of object drawn in the grid can be Quadrilaterals, Rectangles, Circles or Crosshairs. The Quadrilaterals option draws rectangles and gives you control of the space between rows and columns. The size of the rectangles will depend on the size of the grid, while the space between rectangles remains constant as you draw the grid. For Rectangles, Circles, and Crosshairs, Row Spacing and Column Spacing become Height and Width. The space between the cells will depend on the size of the grid, while the size of the cells remains constant as you draw the grid.
To draw the grid, click the **Grid Drawing Object**, click down on your image, and drag the mouse. The four corner cells will appear as you drag your mouse. The rest of the grid will appear when you release the mouse button.

**Text Drawing Object:**
Click on the eighth button to add annotation text. Set up your text in the dialog box that appears:

![Text Drawing Object Tool's Dialog Box]

Use this dialog box to set the **Font**, **Size**, **Color**, and **Style** of your annotation. The **Spacing** option will squeeze your text together or stretch it out. The **Alignment** option lines up the edge of the text relative to the **Position** you specify.

When the **Text** radio button is filled, type your message in the text box. You can also choose to place the time, date, or both on the image. Your computer provides the time and date to **IPLab**. Choose the **Value** option to draw a number or numeric variable. Choose **String Var** to draw the text from a string variable.

**Registration Drawing Object:**
The final tool is a **Registration** tool. It allows you to place registration marks onto two different images so that you can line up the images. Click on this tool and then click on landmarks within your images. All registration marks within an image will automatically be lettered in order of placement. Please see the **Register** and **Mosaic** commands in the **Enhance** menu (Pages 168 and 170, respectively).

**Clear All Drawing Objects:**
Click this button to delete all drawing objects on the active image.
You can make this toolbar into a floating palette by clicking on its edge and dragging it off the side of the application window. You can re-dock it elsewhere by moving it over the application window's border.

### 2.5.1 Scripting the Drawing Tools

When you click on the text annotation tool while recording a script, its dialog will open just as it always does. When you click **OK**, the command **Draw Text** will be recorded in your script. When the script runs that command, it will add that text to the front window.

When you script one of the other drawing tools, the **Select Tool** dialog box opens:

![Select Tool Dialog Box]

**The Drawing Tools portion of the Select Tool Dialog Box**

The **Select Tool** dialog box lists all of the ROI, segment, and drawing tools. Click on the radio button for the tool you want and then click **OK**. When the script runs the **Select Tool** command, that tool will become active. Your script can then prompt the user to add a drawing object to the image.

### 2.6 #7: The Status Window

The **Status Window** displays detailed information about the active data window. You can also look for information on the status bar at the bottom of each window (described on page 16) and in the image info window (the button is described on page 12).

Use the **Show/Hide Status Window** command in the **Window** menu to display and to put away the **Status Window**. You may also close the **Status Window** by clicking in its go-away (x) box. The **Status**
Window's Document tab shows the data window's name, data type, and dimensions, and the coordinates of the sides of the ROI. The Quick Stats tab shows the minimum, maximum, mean and standard deviation of pixel values in the image. In both, the XY Units field shows the distance represented by each pixel width (or height).

The Quick Stats tab displays dynamic information that changes when the data is altered. Click the Update button to get current information. When looking at color data, the Quick Stats tab will show three groups of numbers in each field: one for the red, one for the green, and one for the blue values at each pixel.

2.7 #8: The FKey (Function Key) Toolbar

The function key (FKey) toolbar's buttons represent the twelve function keys on the PC keyboard. You can assign IPLab commands to the function keys using the Assign Function Keys command (Edit menu). Assign scripts to the F-keys by assigning the Run Script command (Script menu).

Part of the F-Key Toolbar, as Seen on the Window Border
Instead of pressing the function key to perform the command or script, you can click on the **F-Key Toolbar** instead. Clicking **F1** would perform the same function as pressing the **F1** key. This can be very convenient in a dark microscope room.

You can make the **FKey Toolbar** into a floating palette by clicking on its edge and dragging it off the side of the application window. You can re-dock it elsewhere by moving it over the application window's border.

### 2.8 #9: The Variables Window

The **Variables** window lists all of **IPLab**'s numeric variables. Variables are storage places for values used in commands. For example, **IPLab** stores the last-used exposure time in numeric variable #255. You can then use that variable as the exposure time within an acquire command (**Camera** menu). Variables are described in detail starting on page 83.

The **Variables** window is a special type of 1D data window. It provides you with 256 numbered variables of floating point data type that are always available. You cannot change the data type of the **Variables** window. However, in most other respects, these variables can be processed in the same way as any other data.

Variables are numbered from 0 to 255 (e.g. variable #0, variable #255). These identifying numbers are *indices* to the variables, and are listed in gray as the row numbers, to the left of the values. If you double-click on any variable's value, the **Set Variable** dialog appears so you can enter a value (**Set Variable** is in the **Script** menu, and is described on page 312).

The **Variables** window is always available, but it may be hidden. Use the **Show/Hide Variables Window** command (**Window** menu) to open and to bring this window to the front.

### 2.9 #10: The Device Toolbar

The **Device Toolbar** provides readily available interfaces for the motorized microscope hardware attached to your computer. Click on one of the **Device Toolbar** buttons to open the interface for that hardware. You can use any other **IPLab** command while leaving the interface open. Click on the button again to hide the interface.
The Device Toolbar

Installing new devices such as shutters and XY stages adds new buttons to the toolbar. Just add new devices within the Select Devices dialog (Control menu).

You can hide and show this toolbar with the Toolbars command in the Window menu. You can also hide and show the button's text labels using the appropriate option in the Preferences dialog (Edit menu).

2.9.1 Rec (Record) Button

The Record button lets you record Device Toolbar actions to a script. Normally, you could use the Device Toolbar to control your hardware without affecting a script you were writing at the same time. You might use this feature to move the hardware into the right position for recording the script.

When you press the Rec button, every action you do with the Device Toolbar will be recorded in the script. When pressed, the Rec button is a lighter gray and looks like it is down. Press the Rec button again to stop recording your use of the Device Toolbar.

2.9.2 Filter Wheel Buttons

A filter wheel button can control filter wheels, filter cube turrets, and liquid crystal tunable filters like the CRI Micro*Color.

Each filter position has a button. Click the button to move to that filter. You can typically change the button's color by clicking the Set Filter Color button. Use the Select Devices command (Control menu) to change the button's label (the name of the filter).

2.9.3 Shutter Buttons

These let you open and close your motorized shutters.
2.9.4 XY Stage Button

This interface will both move the XY stage and read its position for you.

The XY Stage Button and Its Interface

The arrows at the top of the interface move the stage. To set the size of that movement, enter a step size in Step X and Step Y. Click Set Step Size to use the current distance from the origin as the step size.

The central button, with the red circle on it, sets the origin to the current position. You can see the position being used as the origin in the Origin field at the bottom.

The X and Y fields will display the stage's current location when you click the Get button. Type a position into those fields and click Set to move the stage to that position.

When you check the Poll XY Position checkbox, you can move the stage with its joystick and see its current position in the X and Y fields.

The Row and Col (column) fields are useful when looking at multi-well plates and other arrayed samples. Assuming that the Step X and Step Y fields contain the distances between wells or samples, the Row and Col fields will display the stage's current position within the array.

All distances are in the units to which your stage is calibrated (typically microns).

2.9.5 Z Stage Button

This interface will move the Z stage (focus motor) and read its position for you.
The Max and Min settings provide some security for you by limiting the Z stage's range of motion, to prevent it from ramming the objective into the sample. Therefore, the first thing you should do is move the Z stage to the acceptable limits of motion and click the Set Max and Set Min buttons.

You can then use the up and down arrows or the slider to move the stage between these limits. The up and down arrows will move the Z stage by the distance entered in the Step Size field.

When you click the Get button, the Z field (above the Get button) will display the motor's current position. You can also type a position into the Z field and click the Set button; the Z stage will move to that position.

When you check the Poll Z Position checkbox, you can move the Z stage with its joystick and see its current position in the Z field.

2.9.6 Objective Turret Buttons

Use this interface to rotate motorized objective turrets.

Each objective has a button. Click the button to move to that objective. Use the Select Devices command (Control menu) to change the button's label (the name of the objective).
2.9.7 Lamp Buttons

Use this interface to control your microscope lamps.

Using the **Source** buttons, choose your reflected/epi-fluorescent lamp or your transmitted/diaphot lamp. These buttons may be labeled differently depending on your microscope.

Turn the lamps on and off using the **Power** buttons.

Finally, set the lamp's voltage level: you can move the slider, or you can type a voltage level into the value field and click the **Set** button. You can also click the **Get** button to view the lamp's current power level.

2.9.8 Other Buttons

Other buttons may be added for specific microscope hardware. The **Motion Control** chapter of this manual will give any necessary additional information.

2.10 #11: The Message Bar

Short descriptions or names of commands and tools appear in the bottom-left corner of the application window when you move your mouse through a menu or toolbar. This is just like the message bar at the bottom of an Internet browser.

2.11 #12: The Message Window

The **Messages** window lists all alerts and error messages generated by **IPLab**. Normally, alerts and error messages will pop up in an error dialog box. However, You can set the **Message Level** settings in the **Preferences** command (Edit menu) high enough to hide low or medium priority alerts. In that case, you would only see the alerts and errors by looking at the **Messages** window.

If an error message is not displayed to you in a dialog box (because of the **Message Level** settings), it will be displayed in Italics in the **Messages** window. Otherwise, the error message will be displayed in normal text in the **Messages** window.
3 Tutorials: Quick-Start Guide to Using IPLab Now

3.1 Setting Up IPLab to Store Acquisition Information and Parameters

This new version of IPLab will both store and report the image acquisition parameters. For example, IPLab can record the exposure time and CCD region used to grab the image; the name of the objective, its N.A., and refractive index; and the sample's position on the microscope stage. The acquisition parameters may not only be reported but are now used in the InFocus line of IPLab deconvolution extensions.

The method of calibrating the optical path for each microscope objective has also been updated. Once each objective has been calibrating using a 1 x 1 binning camera setting, IPLab will automatically apply the correct image calibration if the binning has been changed when the image is acquired. In addition, it is now easier to change the calibration setting for acquiring new images.

To set up automated or manual microscope devices and calibrate IPLab, you need to perform the following step:

1. Install IPLab onto your computer
2. If you are using automated microscope hardware: install the appropriate device controls from either the "Shutters & Filters" or "Motion Control" IPLab extension.
3. Set up the installed devices in IPLab. In this step, the details or description for each device will be entered, along with any relevant information regarding the device such as emission filter wavelength or the numerical aperture of the objective.
4. Calibrate each microscope objective using a 1x1 binning camera setting.

(Even if you do not have a motorized microscope, you can tell IPLab which objective and filter you are manually using, and IPLab will record the information with the image.)

The directions for this step start on page 37.

3.2 How do I add and set up a Filter Wheel

1. First, add the filter wheel(s) to the list of hardware that IPLab will control. (If you did this earlier, skip this step.)
   a. Choose Select Devices from the Control menu.
Select Devices **Dialog Box**

b. Click the **Add** button to see a list of hardware.

The **Add** dialog lists all of the available hardware

c. Select the filter wheel and click **OK** in the **Add** dialog box.

- If you have a manual microscope, or if your filter wheel is not controlled by **IPLab**, then add the Virtual Filter device. This lets you tell **IPLab** which filter you are using.

d. If you have multiple filter wheels, repeat steps b and c.

2. Next, describe each of the filters.

a. In the **Select Devices** dialog box, select the filter wheel and click the **Setup Device** button or double-click on the filter wheel. You will now be looking at the **Setup Device** dialog box, which lists all of the filter positions. If a particular has fewer actual filter positions then the number listed in the setup dialog box, extra positions may be removed and will not be shown in the device toolbar.

To remove a filter position, select the last position first by clicking on it. Once the filter position has been selected, press the **Remove** button. To add a position, highlight the first open line and press the **Add** button.
Set up Device Dialog Box

b. Select a filter position from the list by double clicking on it or by selecting the filter position and pressing the Edit button.

The Dialog Box for Editing Filter Info

c. Enter the details for the filter position.

Enter the filter's name, its numbered position in the filter wheel or turret, and the wavelength of light it passes (in nanometers). If the filter position is for an emission filter, entering the correct wavelength will be important if the images will be deconvolved later.

d. Click OK in the Edit dialog box.

e. Enter information for each filter and then click OK within the Setup Device dialog box.

3. Click OK within the Select Devices dialog box.

3.3 Setting Up Microscope Objectives

1. First, add the objective turret to the list of hardware that IPLab will control. (If you did this earlier, skip this step.)
You should only add one objective turret to the **Select Devices** dialog box.

a. Choose **Select Devices** from the **Control** menu.

b. Click the **Add** button to see a list of hardware.

c. Select the objective turret and click **OK** in the **Add** dialog box.

   • If you have a manual microscope, or if your objective turret is not controlled by **IPLab**, then add the Virtual Objective device. This lets you tell **IPLab** which objective you are using and assign the correct image calibrate for newly acquired images.

2. Next, enter the parameters or details for the objective.

   a. In the **Select Devices** dialog box, select the objective turret and click the **Setup Device** button. You will now be looking at the **Setup Device** dialog box, which lists all of the objectives.

   ![Device Setup](image)

   **Setup Device Dialog Box**

   b. Select an objective from the list by double clicking on it or by selecting the objective and pressing the **Edit** button.
The Dialog Box for Editing Objective Info

c. Enter the details for that objective.

Please enter the objective's name, numerical aperture, and refractive index of the media you will be using for the objective. For example if the objective is an oil objective, please enter the refractive index of the oil you will be using with the objective.

d. Click OK in the Edit dialog box.

e. Enter information for each filter and then click OK within the Setup Device dialog box.

Note: Please make sure that the objective name corresponds to the physical position in the microscope when using an automated microscope to ensure proper functioning of the system.

f. Leave the XY spacing fields unchanged at this time. When the objectives are calibrated using the Define XY Units command in the next step, the XY spacing fields will be automatically updated with the correctly calibrated XY units.

3. Click OK within the Select Devices dialog box.

3.4 Calibrating the Objectives or Optical Path

1. Acquire an image of a stage micrometer with the first objective to be calibrated.

2. Draw a point-to-point single line ROI over the image of the stage micrometer.

Line ROI Tool
Image of a stage micrometer with a line ROI

3. Choose **Define XY Units** from the **Analyze** menu.
4. The **Define XY Units** list includes the names of the objective positions previously set up. Select the objective to be calibrated.

5. Press the **Get Line ROI Pts.** button, to fill in the pixel ROI line length. Enter in the corresponding calibrated distance and units.
Example of calibrating the 20x objective

**Note:** All objectives should be calibrated using a camera binning of 1 x 1. *IPLab* will automatically scale the units of new images to account for binning.

6. Click **OK** in the **Define XY Units** dialog box.

*(optional) To make *IPLab* automatically scale the units of new images to account for binning, check the **Automatically Scale XY Units with Binning** option in the **Preferences** command (Edit menu).*
7. If opening previously calibrated images from a different IPLab system, *IPLab* can create a new calibration file using the *Get Front Windows Units* button. Please see the *IPLab* manual for further information.

### 3.5 Use IPLab to Control Your Camera and Microscope

For *IPLab* to use the objective and filter information that you entered, you must use *IPLab* to switch the filters and objectives. This is also the easiest way to use and automate your motorized microscope.

1. Switch objectives and filters by clicking on the appropriate button in the **Device** toolbar.

![Device Toolbar Image]

2. When you click on the button, a small palette appears. Click on the objective or filter wheel button again to close the palette.

**Note**: Images acquired through *IPLab* will be calibrated based on the objective selected when the images are acquired or captured.

3. Clicking the buttons next to each filter name or objective name will change to that position.

You can also use the **Microscope Control** command (**Control** menu). The *IPLab* User's Guide describes the **Microscope Control** command in the Menu Reference chapter's **Control** menu section.
3.6 Image Enhancement

3.6.1 Pseudocoloring

How do I pseudocolor an image or an image sequence?

1. Start by opening or capturing an image or image sequence.
2. Select the Pseudocolor command from the Enhance menu.

Pseudocolor Dialog Box

3. Choose the appropriate color or fluoroscope for the image and press the OK button.
4. If you wish to make this a permanent change and create a color image, select the Change Data Type command from the Math menu.
5. Select the correct color image type (Color 24 or Color 48) and press the OK button.

3.6.2 Merging and Blending Images

In the first part of this tutorial, you will learn how to merge individual grayscale images into a color image. In the second part of the tutorial, you will learn how to blend a fluorescent image with a DIC, phase or other grayscale image.

Note: The merging and blending commands will also work with image sequences. For example, if you have acquired a time-lapse image sequence of a GFP experiment and have a corresponding DIC image of the same field, you can combine the GFP sequence with the DIC image and play it over time. You can then export the new image sequence as an AVI movie.

How do I merge up to three different images to create a color image?

1. Open up to three images of the same data type and size. They can be sequences or single-frame images.

For example, you could open these images from the "Images" directory located in the directory "IPLab 3.7 Folder":

   • "Blend_Dapi.IPL"
2. Select the **Merge Color Channels** command from the **Math** menu.

![Merge Color Channels Dialog Box](image)

**Merge Tab in Merge Color Channels Dialog Box**

3. Use the pop-up menus to select the appropriate image for each color channel.

   For example, pick:
   
   - the TRITC image for **Red**,  
   - the FITC image for **Green**, and  
   - the DAPI image for **Blue**.

4. Check the **New Window** checkbox to put the merged image in its own window, and give it a name in the **Destination** field.

5. Press **OK** to generate the new image.
How do I blend my GFP time-lapse sequence with a DIC image or sequence?

The Merge Color Channels command also allows you to blend a fluorescent image or sequence with a DIC or other grayscale image or sequence. The blending of images or sequences allows you to see where proteins are located, while retaining the cell morphology.

1. Open the images to be blended.
   
   For example, open these images from the "Images" directory located in the directory "IPLab 3.7 Folder".
   
   • "Blend_DIC.IPL"
   
   • "Blend_Fitc.IPL" in place of a GFP time-lapse sequence.

2. Select the Merge Color Channels command from the Math menu.
3. Choose the **Blend** tab.

4. Use the pop-up menus to select the appropriate images.

   For example, pick:
   - the FITC image for the **Fluorescent** source window,
   - the DIC image for the **Brightfield** source window.

5. Enter the **Blend %** value to control the degree of blending of the two images.

   The higher the blending percentage, the fainter the background bright field image will be and the brighter the fluorescent image will be.

6. Check the **New Window** checkbox to put the blended image into its own window, and type its name in the **Destination** field.

7. Press **OK** when done.

**How do I merge and blend many fluorescent images?**
**How do I assign specific colors to them?**
**How do I combine them with a DIC or phase image?**

Please use the **MultiProbe** extension to do all of those things.

The **MultiProbe** extension lets you interactively merge up to six grayscale images to make a new color image. Use this extension when acquiring images of a sample at multiple wavelengths.

- You can merge fluorescent images with DIC or phase images.
• You can assign your own custom color to each channel.
• You can merge sequences with other sequences.
• You can manipulate the contrast of each color to obtain a desired color balance.
• You can blend each channel into the composite image.
• You can also shift the component images to account for misaligned filters.

3.6.3 Normalization, Contrast, Levels

How do I adjust the image’s normalization or brightness, contrast and gamma?

Open a monochrome or color image. It can be a single-frame image or a sequence.

1. Select the Normalization command from the Enhance menu. If you do not see the full dialog box, click on the Advanced arrow at the dialog box’s bottom-left corner.

2. To adjust the image by using the histogram method, press the Manual button.
   • For color images, you may adjust the sliders separately for the red, green, and blue channels. Choose the option All the Same to apply the same values throughout.
   • Monochrome images will only have one choice and the sliders may be adjusted in the same way.

3. You may also use the Brightness, Contrast, and Gamma buttons to modify the normalization.
3.7 Particle Segmentation and Measurement

How do I automatically count areas, cells or objects?

Use the following commands to measure objects, cells, or areas. You will find all of these commands in the Analyze menu.

1. Use the Autosegment or Segmentation command. This step identifies the parts of the image to measure.
The AutoSegment and Segmentation commands let you set thresholds around the interesting regions of your sample. They cover those regions in colored overlays, called segments, which do not affect the data. The measurement commands measure the data under these segments.

**AutoSegmentation**

- **Dark Field**
- **Bright Field**

**Segment Color**
- **Yellow**
- **Component**
- **Intensity**

**Background Estimation**
- Automatic segment
- Iterative
- Segment Layer
- Fill holes
- Ratio: 2.94
- Threshold: 1458

**Contrast Ratio Limit**
- Minimum Ratio: [ ]

**Split**
- Distance Contour
- Number of Iterations: 17

**Area Limit**
- Minimum Area: [ ]
- Image Units: 0.160256 um per pixel

[Create New Window] [Boundary only]

[Apply] [Restore]

[Cancel] [OK]

**AutoSegmentation using object splitting**

2. Use the **Set Measurements** command to pick the measurements to be done.

You only need to use this command once, unless you want to change the measurements being performed.
3. You may also want to use the **Measurement Options** command for some additional control over which segments are measured, annotation, and the name of the resulting data window.

This command, too, only needs to be set once until you want to use different settings.
4. Use one of these automated measuring commands:

- **Quantify Segments**: This command performs a fixed set of statistical measurements on the selected segments.

- **Measure Segments/ROI**: This command measures each segment or the selection. It will perform all measurements chosen in the Set Measurements command.

- **Classify Segments**: This measures each segment and groups (classifies) the segments according to the sizes of the measurements. This is typically used for particle distribution types of experiments.

**How do I perform a particle distribution analysis?**

Setting up a particle distribution analysis is very simple within *IPLab*. In addition, if multiple images are analyzed, the data table will automatically be updated.

1. Open the image or images to be analyzed.

2. Select either the Autosegment or Segmentation command from the Analyze menu and segment/threshold the objects to be measured.

3. Choose Set Measurements from the Analyze menu and pick measurements to be performed.

4. Select the Classify Segments command from the Analyze menu.
5. Press OK. The data table and histogram will be generated.

**Note:** If you need to analyze more images, simply:

a. Select another image and segment it.

b. Select the **Classify Segments** command and press OK. It will use the same settings as before.

**How do I do an analysis using batch processing?**

You can analyze multiple images as a batch by using indexed files or file lists, and scripts.

- Indexed files are files that have a base name and a number which help to organize them. Examples are “New Study0000”, “New Study0001”, etc.

  You set up indexed files using **Set Index Info**, a subcommand within the **Indexed Files** command (File menu). Then you can control those files using the **Save As Indexed** and **Open Indexed** subcommands.

- File lists are just what they sound like: lists of image files.
You can create file lists with **Edit File List**, a subcommand within the **File Lists** command (File menu). The other **File Lists** commands let you pick an appropriate list and open, save, or delete files named within that list. These commands would obtain the names and locations of the files from the named file list instead of from their dialogs.

The Menu Reference chapter of the *IPLab* User's Guide describes these commands in detail, along with notes on how to use them.

To batch process your images, please follow these steps:

1. Set up your indexed files or file lists using the **Set Index Info** or **Edit File List** command.
2. Start recording a script.
3. Record a label at the top of the script; name it “Top”. This will be the start of the loop that will do all of your work for you.
4. Record one of these **File** menu commands near the beginning of the script:
   - The **Indexed Files: Open Indexed** command
     (that is, the **Indexed Files** command, **Open Indexed** subcommand)
   - The **File Lists: Open File from Selected File List** command
     (that is, the **File Lists** command, **Open File…** subcommand)
   This will open the image for processing.
5. Record your analysis commands.
   For example, record these commands:
   a. Record the **Autosegment** command from the **Analyze** menu.
      Set it up to automatically segment interesting regions of your samples. Because this is only an example, do not worry much over the thresholds.
   b. Record the **Classify Segments** command from the **Analyze** menu.
6. Record a **Loop** command at the end of the script to loop back to the label “Top”.
   Each time the script runs through the loop, it will automatically open and process the next file.
   You can also make the script save files using indexed names and file lists, and even delete files using file lists.
3.8 Image Acquisition

3.8.1 Basic Image Acquisition

How do I set up my camera?

1. Install the Camera Control.
2. Install the camera.

If you need help with steps 1 or 2, please contact Scanalytics or read the Camera Controls section of the IPLab User's Guide. (You can contact us at 703-208-2230, or info@scanalytics.com.)

3. Run IPLab.

4. Choose Select Camera from the Camera menu.
   a. The Select Camera dialog box appears. It contains a pop-up menu of all installed camera controls.
   b. Choose the camera or frame grabber you are using.
   c. Click OK.

5. Select the next command, Get Camera Info, from the Camera menu.

   This will display options that are specific to your camera or frame grabber. For each type of acquisition device, these options are described in the following chapters.

The information entered above will be saved when you exit IPLab. Unless you switch cameras, you will not need to repeat this procedure.

In order to acquire an image, simply choose any of the acquisition commands in the Camera menu.

How do I acquire an image?

Here are simple instructions for grabbing an image. When you feel comfortable acquiring images, feel free to play around with the rest of the settings in the Acquire command.

1. Choose the Acquire command from the Camera menu.
2. From Configuration, choose Custom1.

Playing around with the settings will change the configuration. If you change the Custom1 configuration, then the Focus, Single, and Full configurations will remain unchanged.

3. Click on the General tab.
   
a. Check the Preview checkbox.
   
   This will show you a live view of the image before grabbing it.

4. Click on the Exp. tab.
   
a. In the Exposure Time field, enter a time in milliseconds.
   
   If you do not know what time to use, start out with 10 milliseconds.

5. If you do not have a motorized shutter, please go to the next step.

   If you do have a motorized shutter, then click on the Devs tab.
a. From the **Device Name** pop-up menu, choose your motorized shutter. If it does not appear, then you need to choose the **Select Devices** command from the **Control** menu and add the motorized shutter. Return to the **Acquire** command when you finish.

b. Choose appropriate positions from the **Open** and **Closed Position** boxes.

6. Click **OK**.

   Because you checked the **Preview** box, the **Acquire Preview** palette will now appear.

7. In the **Acquire Preview** palette, change the exposure time if necessary. You can learn the other features later.

8. Click **OK**.

You have now grabbed an image. You can go back to the **Acquire** command and change any of the settings for more control over your new images.

### 3.8.2 Advanced Image Acquisition

**How do I acquire a time-lapse image?**

Please follow the above instructions for acquiring a single image (starting on page 53). This time, however, also click on the **Time Lapse** tab. Again, these are basic instructions; you can explore the **Acquire** command's features after you are familiar with grabbing a time-lapse image.
1. Choose the **Acquire** command from the **Camera** menu.

2. From **Configuration**, choose **Custom1**.

3. Click on the **General** tab. Check the **Preview** checkbox.

4. Click on the **Exp.** tab. In the **Exposure Time** field, enter a time in milliseconds.

5. If you do not have a motorized shutter, please go to the next step.

   If you do have a motorized shutter, then click on the **Devs** tab and set up your shutter.

6. Click on the **Time Lapse** tab.

   ![Multi Dimensional Acquire](image)

   **Time Lapse tab of the Acquire Dialog Box**

   a. Click the **Use Time Lapse** checkbox to enable the time-lapse mode.

   b. Select the radio button for the value **IPLab** will calculate based on your inputs.

      For this example, click the **Experiment Length** radio button.

   c. Enter the number of frames that you want to acquire in the **Frames** field.

   d. Enter the length of time between the starts of each acquisition in the **Interval** field.

      **IPLab** will then calculate the total elapsed experiment time.
7. Press **OK** to enter the live preview.

8. The **Acquire Preview** palette appears. Adjust the exposure time as necessary.

9. Click **OK** on the **Acquire Preview** palette.

10. A progress bar palette appears.

   This unique feature allows you to monitor your experiment and adjust your experiment if necessary. You can toggle between displaying the last image acquired and a live display of the experiment.

After the time-lapse acquisition, you will have an image sequence of your time-lapse experiment.

11. Click on the T buttons 📥 on the window's edge to scroll through the frames of your time sequence. You can also use the **Animate** command from the **View** menu.

---

**How do I stream images to memory in IPLab?**

Stream images to memory means you are acquiring images to RAM as fast as the camera can read them out. This speed is based on the exposure time and the camera's read-out speed.

This is a lot like acquiring a single image. However, this time we will change two settings to make the camera acquire data as fast as possible. Again, these are basic instructions; you can explore the **Acquire** command's features after you are familiar with grabbing a time-lapse image.

1. Choose the **Acquire** command from the **Camera** menu.

2. From **Configuration**, choose **Custom1**.

   Playing around with the settings will change the configuration. If you change the **Custom1** configuration, then the **Focus**, **Single**, and **Full** configurations will remain unchanged.

3. Click on the **General** tab.

   a. Check the **Preview** checkbox.
      
      This will show you a live view of the image before grabbing it.

   b. Check the **Fast Capture Mode into Z** checkbox.
      
      This checkbox sets up the image streaming-to-memory feature. If your camera does not have the Fast Capture mode, then it will still grab images as fast as possible. However, cameras that do have this feature will capture even faster when this box is checked.
4. Select the **Size** tab.
a. In the **Z Depth** field, enter the number of frames to acquire.

5. In order to stream to memory as fast as possible, do not use the time-lapse feature. On the **Time Lapse** tab, leave the **Use Time Lapse** option unchecked.

6. Click **OK**.

   Because you checked the **Preview** box, the **Acquire Preview** palette will now appear.

7. In the **Acquire Preview** palette, change the exposure time if necessary. You can learn the other features later.

8. Click **OK** on the **Acquire Preview** palette.

   After the fast-capture acquisition, you will have an image sequence.

9. Click on the Z buttons on the window’s edge to scroll through the frames of your sequence. You can also use the **Animate** command from the **View** menu.

**How do I acquire time-lapse images of multiple wavelengths?**

These instructions are simple. After using them, please feel free to play around with the rest of the settings in the **Multi Dimensional Acquire** command.

1. Select the **Multi Dimensional Acquire** command from the **Camera** menu

2. Click on the **General** tab.

   a. Check the **Preview** checkbox.

      This will show you a live view of the image before grabbing it.

3. Click on the **Shutter & Filters** tab
Shutter & Filters tab of the Multi Dimensional Acquire Dialog Box

a. If you do not have a motorized shutter, please go on to step b.

If you do have a motorized shutter, please choose the Shutter(s) and the Open and Close positions from the appropriate pop-up boxes.

You can use two shutters for switching between two light sources, such as multi-mode imaging, acquiring both fluorescence and bright field data. If you do not have one or the other, simply choose "None" for that device.

b. Choose your filter wheel from the Filter Wheel pop-up menu.

c. Select which filter positions to use during the image acquisition.

1. Click an Enable checkbox for each filter you want to use.

2. Pick the filters from the Filter Name boxes in the order you want them used.

3. Pick whether shutter 1 or 2 will be opened when IPLab switches to this filter. This controls which light source is used.

4. You can use a different exposure time (in milliseconds) with each filter.

4. Click on the Time Lapse tab.
Time Lapse Tab of the Multi Dimensional Acquire Dialog Box

a. Click the Use Time Lapse checkbox to enable the time-lapse mode.

b. Select the radio button for the value *IPLab* will calculate based on your inputs.

   For this example, click the Experiment Length radio button.

c. Enter the number of frames that you want to acquire in the Frames field.

d. Enter the length of time between the starts of each acquisition in the Interval field.

   *IPLab* will then calculate the total elapsed experiment time.

5. Press OK to enter the live preview.

6. The Acquire Preview palette appears. Adjust the exposure time as necessary.

7. Click OK on the Acquire Preview palette.

8. A progress bar palette appears.

   This unique feature allows you to monitor your experiment and adjust your experiment if necessary. You can toggle between displaying the last image acquired and a live display of the experiment.

After the multi-D acquisition, you will have an image sequence of your experiment.

9. Click on the Z and T buttons on the window’s edge to scroll through the frames of your time sequence. You can also use the Animate command from the View menu.
**How do I acquire a Z-sequence of images of multiple wavelengths?**

These instructions are simple. After using them, please feel free to play around with the rest of the settings in the Multi Dimensional Acquire command.

1. Select the Multi Dimensional Acquire command from the Camera menu

2. Click on the General tab.
   a. Check the Preview checkbox.

   This will show you a live view of the image before grabbing it.

3. Click on the Shutter & Filters tab.

   ![Multi Dimensional Acquire dialog box](image)

   **Shutter & Filters tab of the Multi Dimensional Acquire Dialog Box**

   a. If you do not have a motorized shutter, please go on to step b.

   If you do have a motorized shutter, please choose the Shutter(s) and the Open and Close positions from the appropriate pop-up boxes.

   You can use two shutters for switching between two light sources, such as *multi-mode imaging*, acquiring both fluorescence and bright field data. If you do not have one or the other, simply choose "None" for that device.

   b. Choose your filter wheel from the **Filter Wheel** pop-up menu.
c. Select which filter positions to use during the image acquisition.

1. Click an **Enable** checkbox for each filter you want to use.

2. Pick the filters from the **Filter Name** boxes in the order you want them used.

3. Pick whether shutter 1 or 2 will be opened when **IPLab** switches to this filter. This controls which light source is used.

4. You can use a different exposure time (in **milliseconds**) with each filter.

4. Select the **Z-Steps** tab.

![Z-Steps Tab of the Multi Dimensional Acquire Dialog Box](image)

Z-Steps **Tab of the Multi Dimensional Acquire Dialog Box**

a. Check the **Use Z Step** box to acquire 3D sequences.

b. Click the **Relative** radio button to set the starting and stopping positions relative to the Z-motor's current position.

c. Enter the starting and stopping positions for the 3D acquisition in the **Start Pos.** and **Stop Pos.** fields. We recommend moving upwards, to avoid any adverse effects of the microscope's momentum.

d. In the **Step by** field, enter the interval distance between image planes. This is also called the Z-step size.
5. Click the **OK** button.

6. The **Acquire Preview** palette will appear.
   
a. Press **Continue** to start the live image preview.

   b. Adjust your exposure time if necessary for the individual wavelengths.

   c. To change filters, select the desired filter position through the pop-up menu.

7. Select the **Z-Stage** tab.

   ![Acquire Preview Palette](image)

   **Z-Stage Tab of the Acquire Preview Palette**
a. The Z-sequence’s endpoints will be measured relative to the motor’s current position. Move the motor to the desired starting position.

You can also easily change your range now, if you like, by using the **Z-Stage** tab’s controls.

b. Press the **Get** button. This will display the current position.

8. Press the **OK** button to start the acquisition.

When the acquisition finishes, you will have a Z-sequence for each wavelength.

9. Click on the Z buttons on the window’s edge to scroll through the frames of your time sequence. You can also use the **Animate** command from the **View** menu.

**Note:** During the preview, you may move up and down in the Z direction (requires a motorized Z-stepper) by:

- Moving the Z-stepper/focus knob, or
- Using the Z-Stage tab’s controls during the live preview, or
- By the Device Bar toolbar’s Z-stepper control. Click the Z-stage icon:

![Z Stage Image]

You can use this control during preview mode.

- If you wish to acquire a Z-stack based on the top and bottom of your sample, press the “Stop Pos” button when focused on the top and the press the “Start Pos” button when focused on the bottom of the sample.

**How do I save an image sequence as an AVI file?**

Now that you have acquired all of these sequences, you might want to export them as a movie in the AVI format.

1. Open either a Z-sequence or time-lapse image in **IPLab**.

2. Select the **Export** command from the **File** menu. Pick the **Sequence to Movie** sub-command.
3. Using the Browse button, select where you wish to store the new AVI file.

4. Enter the movie's speed in frames per second.

5. Choose the Compression method.

   Note: The compression engines on any particular computer depend on the ones loaded with the Windows operating system and other installed programs, which may have loaded addition compression engines. Be aware that the compression engine you choose must be available on any computer you play the AVI movie on.

6. Adjust the desired compression quality, if applicable.

How to Analyze Particle Motion with a Kymograph

A kymograph is used to analyze particle motion or perform cell tracking. In order to use the kymograph features in available in IPLab, you will need a time-lapse image of the particles/cells you wish to analyze. There are three primary steps to analyze time series images: 1) generate a time stacked view or extended depth of focus images to identify the object paths, 2) generate a kymograph image using the Generate Kymograph command and 3) measure the object(s) path(s) with the Measure Kymograph feature.

1. Open image “A-48GH_Fig2A.ipl” from the “Images” directory located in the directory “IPLab 3.7 Folder”: 
Time series image of GFP labeled mRNA particles in human COS cells

2. Generate a maximum view image using the **3D Time Stacked View** command, located under the **3D** menu.

3. Draw a line using the line drawing tool on the maximum view image along the object path. If you wish to analyze more than one path, you will need to draw a line for each path.

**3D Time Stacked View** using the Maximum option.
4. Create the kymograph with the **Generate Kymograph** command, located under the **3D** menu. Once the kymograph image is created, draw a line along the object’s path. This image will be used to measure parameters such as distance traveled, direction and velocity.
5. With the kymograph image active, select the **Measure Kymograph** command to analyze the object's path. If the time lapse image was acquired using **IPLab v3.7**, the acquisition parameters are stored with image and the "Use Image Tag" option should be selected. If the images were acquired using an earlier version of **IPLab**, select the "Custom Kymo Tag" option and enter the required parameters. Please note, the active image must be the image you wish to measure.

**Measure Kymograph Dialog Box**

**Data table generated by the Measure Kymograph command.**
3.9 Custom Device Linking “CDL”

CDL is a special feature only available with the IPLab Motion Control extension. The primary purpose of CDL is to create custom positions for your automated hardware in which each position can move up to eight different devices to a specific location. CDL has the ability to create up to 40 different positions for use in your experiments. For example, your microscope has automated excitation and emission filter wheels and an automated cube changer for the dichroic mirrors. With CDL you can create a custom position to move all three devices to any position automatically by linking them together. Once the positions are created, you may access them as a device in the Device Toolbar, use them in Multi-D Acquisition and use them in a script.

To set up the CDL, follow these steps:

1. Install the Linking Device option available in the Motion Control extension. If you have not already done so, all other automated devices should be installed and tested at this point.
2. Under the Control Menu, select the Linking Device-Settings

   ![IPLab Control Menu]

   - Select Devices...
   - Microscope Control...
   - Stage Control...
   - Record Position...
   - Move to Recorded Pos...
   - Array Setup...
   - Array Move...
   - Linking Device-Settings...
   - Nikon90i-Settings...
   - Virtual Device Settings...

3. In this dialog box, you can set up to four general/generic devices. For each device, you can set up to 10 unique positions. The devices, once fully set up, will be displayed in the Device Tool Bar. The CDL devices are also scriptable and available in the Multi-D Acquisition command.

   In the Device drop down menu, you have the choice of four unique linking devices, number 1 through 4. Linking device 1 is based on moving an objective and other devices of your choosing. Linking devices 2 and 3 are filter based and meant for moving automated filter wheels, cubes and shutters. Linking device 4 is generic and can be used with any device you have control of through IPLab. Although the devices will have their own unique icons and names in the Device Tool Bar, any automated device available within IPLab may used. The device may also be renamed to a name of your choosing.
4. To select and set up a position, begin by double clicking on position 1. The following dialog box will allow up to eight device positions to be linked together.

Starting from the top, use the drop down menu to select a device. Once the device is selected, use the position drop down to select the correct position. Up to eight devices can be linked in any unique combination. Depending on the any particular device response rate, the Wait Until Done option should be checked. This will ensure all devices are properly in place before the image is acquired.

The Position Name may also be given a unique or relevant name. Press the “OK” button when done. After all to the desired positions and device are linked, they must now be added to IPLab as a device.
Creating a CDL position to move two filter wheels and a motorized filter cube changer.

5. Under the Control Menu, select the Select Devices command and press the "Add" button to select the previously set up Linking-Device. If the Linking-Device has been renamed, the new name will appear in the list of available devices.

3.10 Tutorial on Scripting.

3.10.1 Basic Scripting

IPLab scripting allows you to customize the software to your own needs, by grouping together commands that describe your protocols and algorithms. Scripts may be saved and run with a few keystrokes, creating powerful new "commands" which are customized to your specific application.
Often, researchers need to create their own protocols, teachers and students need to experiment with alternative methods, and technicians need to automate repetitive tasks. Scripting provides a powerful and versatile tool for these tasks. In this first tutorial, you will learn how to make and edit a basic script in order to familiarize yourself with the tools. The second tutorial will introduce additional concepts for working with more than a single image. For more information on specific scripting features not covered in the tutorial, please refer to the Script menu section of the User's Guide.

Let us start with a new script and set up a simple method to count the number of objects in an image.

1. Locate and open the "Chromosomes.IPL" image from the Images folder located in the "IPLab 3.7 Folder" directory. Although it is not necessary to have an open image at this time, it is useful to have an image to work with once you start testing and editing the script.

   Find This Image in the: "IPLab 3.7 Folder\Images\10x Blood and Bacteria.IPL"

2. From the Script menu, select the New Script command.
A new script window will appear

To record a script, make sure the **On/Off** button is depressed. When this button appears down, then the script is on and can be edited, and commands can be added.
3. From the **Analyze** menu, select the **Segmentation** command.

![Segmentation Dialog Box](image)

**Segmentation Dialog Box**

3a. Confirm that the **Segment Color** is set to **Red**.

3b. For this exercise, enter 124 for the minimum intensity value (**Min**) and 255 for the maximum intensity value (**Max**). All pixels that have intensity values between 124 and 255 (e.g. bright objects) have now been segmented or thresholded from the other pixels in the image. The pixels that are in this range will be shown in red.

**Note:** *IPLab* is capable of segmenting multiple ranges of intensity values or colors. To analyze multiple ranges of objects, select the first range and then change the segment color for a different range.

3c. Click on **Done**.

4. From the **Analyze** menu, select the **Set Measurements** command.
4a. Select the following measurement for this analysis:

**Shape Tab:** Area, Radial S.D., Major Axis, Minor Axis and Eccentricity.

**Position Tab:** Centroid X, Centroid Y.

*Note:* You may also apply limits to each measurement in order to filter out objects that do not meet your criteria for analysis.

4b. Click **OK**.

5. From the **Analyze** menu, select the **Measurement Options** command.
For the purpose of this exercise, set this dialog’s options to the settings shown above.

5a. The **Segment Color** is set to **Red** because this is the color of the segments previously defined when segmenting the objects of interest.

5b. The **Results Window** options define a specific window in which the data will be placed when the image is analyzed. For example, if you are doing multiple range segmentation, the results may be placed in a unique data table for each of the different color segments or classes of objects.

5c. Click **OK**.

6. From the **Analyze** menu, select the **Measure Seg/ROI** command.
Measure Seg/ROI Dialog Box

To measure the Red Segments, select the Red Segments in ROI from the drop-down list and then press OK.

7. From the View menu, select the Force Update command.

Force Update Dialog Box

Type in "Mean Results" and press OK. This command will update the “Mean Results” data table to show only the data from the analysis and not all of the placeholders for data previously created in the Measurement Options command.

Note: To simplify some scripting, you may want to manually step through the analysis and generate various tables you want to display, modify or select for further analysis. If the correct windows are still present when recording a script, you can simply select them from the drop-down window instead of typing in the names.
Your script should now look like this:

![Image of script window]

Your Current Script

If you run the current script by clicking **Run** and the "Chromosomes" images is open, the script will automatically run through the recorded steps and generate the "Mean Results" data table. Press the "On/Off" button to turn off script recording.

8. Press the **Save As** button, located on the side of the script window.
3.10.2 Interactive Dialog Boxes

In some cases, you may wish to change the segmentation settings or the measurement choices as you start a new experiment. The scripting tool allows you to have the commands open and become interactive.

Using the same script, now called "Count Objects", we will now modify the script to make the segmentation and measurement selections interactive.

1. Turn the script On/Off button to off or the next set of steps will be recorded.

2. Close all open windows except for the script and chromosomes image.

3. Turn the script On/Off button to on. Click on the Segmentation line in the script window to highlight it and make it active.

4. Double click under the + column next to Segmentation. A + symbol will now appear next to Segmentation. The + symbol indicates that this command is interactive. When you run the script, this command's dialog box will appear, letting you change its settings.

5. Highlight the Set Measurements line in the script and double click in the + column. The script should now look like the following script with + next to the Segmentation and Set Measurements lines of the script:

Name the script “Count Objects” and save it in the “Scripts” folder in the directory "IPLab 3.7 Folder".
6. Press the **Save** button on the script window to resave the script with the changes.

7. With the "Chromosomes" image open, press the **Run** button to start the script.

   With the changes now in place, the **Segmentation** command will open the **Segmentation** dialog box and allow you change the segmentation values.

   After pressing the **Done** button, the **Set Measurement** dialog box will open automatically. Now a different set of measurements may be made.

**Note:** The changes made to the settings when the script is run are not permanent and does not change the saved script settings. To make changes to the script or the settings in the recorded commands, open the script, press the On/Off button to turn it on, double click on the command to open that command, and make changes to the settings. Once the changes have been made to the script, either Save it or perform a Save As to give the script a new name.

### 3.10.3 **Linking an F-Key to a Script**

Once a script has been created and saved, it can be linked to the keyboard’s function keys and to the F-Keys toolbar located on the **IPLab** desktop.

1. To assign a script to a function key, select **Assign Function Keys** from the **Edit** menu.
2. Choose the function key to which you want to assign the script. Click on one of the buttons, F1-F12, on the left side of the dialog box.

3. Select Run Script from the Script menu. Then select a script from the Run Script dialog. Browse to where the script has been saved and select it.

   The selected script is now assigned to the F-Key.

   From now on, pressing the function key on the keyboard or pressing the button on the F-Keys toolbar will run this script.

4. When you double click on any command in the dialog, you get the Edit Function Key dialog box. This allows you to edit the descriptive Comment that appears in the Assign Function Keys dialog box.
4 Should-Read Section

The information in this chapter is very useful, but not crucial to your use of IPLab. Feel free to start using IPLab without reading this chapter and then return and read this chapter to become a more powerful IPLab user.

Chapter 2, the Must-Read chapter, describes the most important parts of the IPLab environment. Chapter 0, chapter, details the inner workings of IPLab.

4.1 # / V Buttons, L / SV Buttons

These buttons let you use variables for the dialog box's parameters. You will see these buttons in IPLab dialogs next to text-entry boxes.

The # / V button: # stands for number, and V means numeric variable. Click on the # button to change it to a V, and vice versa.

![# symbol](image)

The # symbol means that this value is a simple number, the number 216.

![V symbol](image)

The V symbol means that this is the index to a numeric variable. Variable #216 holds the value that the dialog box will use.

The L / SV button: L stands for literal, and SV stands for string variable. Click on the L symbol to change it to an SV, and vice versa.

![L symbol](image)

The L symbol means that this is the literal value the command will use. In this example, the field is referring to the literal name of the window, "RhodFiles.tif."

![SV symbol](image)

The SV symbol means that "My Window Name" is the name of a string variable. The command will use the value of that string variable as the name of a window.

Numeric and string variables, and their buttons, are described in much more detail in the IPLab Variables section, below.

4.2 IPLab Variables

4.2.1 What Are IPLab Variables?

Variables are storage places for values used in commands. For example, you can store the values for a new image's width and height (e.g. 640 pixels and 480 pixels) in two variables. You can then use those two variables in the New Data command (File menu) to make a new image with that size (640 x 480). IPLab has two kinds of variables: numeric and string. Numeric variables allow you to store numbers, like the width of an
image or an exposure time. String variables allow you to store text, like the identity of a shutter. (The appellation “string” comes from “string of characters.”)

You will almost always use variables within scripts. Scripts often require specific information at the time that they are executed. For example, the script may ask the user what image width or which filter wheel to use. The script would store the user’s response in a variable. When it came time for the script to create an image or move the filter wheel, it would use the stored response. This IPLab Variables section describes IPLab variables and how to use them.

The main use of variables is in creating a custom user interface in scripts. First, your script should set the values of some variables. Then it should use those variables to set the values of parameters in dialog boxes. This provides a simple way to change key command parameters without the need for the user to interact with each dialog. For example, you may assign a certain value to variable #5, and then use that variable as a new image's height. Then, you could alter the image height for future images simply by changing the variable, without having to show the New Data dialog to the user.

It is very useful to remember that the exposure time used in the last acquisition is always stored in variable 255.

4.2.2 Numeric Variables

Numeric variables, as described above, are storage places for numbers used in IPLab commands. Whenever the IPLab manual refers to the generic term “variables,” it is talking about numeric variables. The numeric variables and their values can be found in the IPLab Variables window, described on page 27. To see this window, choose the Window menu command Show Variables.

The values of numeric variables are not saved when you quit IPLab. However, you can save the IPLab Variables window in Text format and, later, copy the values from the saved file back to the IPLab Variables window.

Setting Numeric Variables

You can use the Set Variable command in the Script menu to manipulate the values of any numeric variable, even if the Variables window is hidden. When the Variables window is showing, you can double-click on any row of the Variables window to bring up the Set Variable dialog.
Double clicking on the **Variables** window brings up the **Set Variable** dialog box

For the sake of example:

1. Show the **Variables** window.
2. Double-click on variable number 5. The **Set Variable** dialog box will appear.
3. Type the number 480, as shown above.

In this example, you are setting variable #5 to equal 480, which will be used as the height of a new image in the next example. You can read more about how to use the **Set Variable** command in the **Script** section of this manual (page 312). Also, please note that there are other ways to assign values to numeric variables, including the immensely helpful **Enter Variables** command, found in the **Script** menu.

**Using Numeric Variables in Dialogs (# / V)**

Most command dialogs that accept numerical values have special symbols next to the boxes where you enter the values.

**Example of #/V Toggle Buttons**

These # and V icons represent either *number* or *variable*. You toggle the symbol between # and V by clicking on it. If the # symbol is showing, then the value in the corresponding text edit box is used directly for that parameter in executing the command. If the V symbol is showing, then the value in the corresponding text edit box indicates a variable number. When the command is executed in this case, the value of the variable is
used for that parameter. The example figure shown above is the Custom Size section of the New Data dialog box. The width of the new image will be the number of pixels given: 640. The height of the new image will be taken from variable number 5.

Again for the sake of example:

1. Choose the New Data command from the File menu.
2. Click the Custom Size radio button.
3. Type 640 for the Width, and make certain that the button beside the Width field has a # symbol on it.
4. Next, click on the button beside the Height field, so that it reads V.
5. Now type the number 5 in the Height field.

You already set variable #5 to equal 480 in the previous example, so when you click OK in the New Data dialog, the new image’s size will be 640 x 480 pixels.

4.2.3 String Variables

String variables are storage places for text, or “strings of characters,” which can be used within commands.

For example, when recording an Open Shutter command in a script, you would need to identify the shutter in the command’s dialog box. When recording the script, you may not know which of several shutters the user will want to open. To solve this ambiguity, you can refer to the shutter with the name of a string variable, such as "Excitation Shutter". The script would then prompt the user to pick some text (a string value) to give to that string variable. The user could be prompted to choose from a list of available shutters, e.g. "Uniblitz-Shutter" or "Ludl-Shutter 1".

String variables are made up of two components: the string name and the string value. The string name is equivalent to the numeric variable number; this is how you identify the variable. The string value is the text stored within that variable. The names and values of all string variables are listed in the String Variables dialog box. In order to see this, choose String Variables from the Script menu.

String names and values are each limited to 31 characters.

Creating, Setting String Variables

You can set string variables using several different commands. The most prominent of them are:

**String Variables:** This Script menu command is most useful for creating new string variables, and for viewing all string variables.

The String Variables dialog box contains a list of user-defined string names and a list of preset string names. The only difference between the two is that you cannot delete the preset string names. IPLab allows you to add up to 50 user-defined string variables.

**Set String Variable:** This command, also from the Script menu, is just like the numeric Set Variable command. It gives you a flexible interface for setting values for string variables.
Enter String Vars: This Script menu command is very useful for interactively creating and editing string variables.

String Variables Dialog Box,

In the above picture of the String Variables dialog, you can see that the user has already added one string variable named Initial Shutter Position. That string name has the value Open. The user is adding a second string variable named Final Shutter Position, with the value Close. If you click on the Add button, you can enter a string variable of your own.

Note: The spellings of the string name and value are very important. Since the string value in this example is a shutter position, Close, the spelling of that position must be exactly the same as the position listed in the Select Devices dialog (Control menu).

The Set String Variable dialog lets you set an existing variable to the front window name, to a user-defined value, or to the name of any device or position listed in the Device Info dialog (Control menu). User-defined values can be text or concatenations of text, string variables, and numeric variables. The Set String Variable command is described in detail on page 314.

The Script menu’s Enter String Variable command has an interactive dialog box that makes it easy for a script’s user to assign values to string variable names. Using this command, the script user could pick from a list of possible hardware positions. This command decreases the possibility of entering the wrong string value. Please see the Script menu section of this manual (starting on page 99) for more detail on this immensely helpful command.

Using String Variables in Dialogs (L/SV)

Command dialogs that can accept string variables will have L/SV toggle buttons beside one or more pull-down boxes.
Example of L/SV Toggle Buttons

The L stands for literal, and the SV stands for string variable. Clicking on these toggle buttons switches them from L to SV and back again.

The default position of these buttons is L or Literal, meaning that whatever text you see in the box is the value that the command will use. In the example, Microscope Control dialog box pictured above, the Set Device field contains the literal name of the device being controlled.

Below that, you can see that the Position: Name field contains a string variable’s name. A literal position would have been Open or Close. Instead, the L/SV button was clicked once to make it read SV. The pop-up box then gave a list of all string variables that had been defined. The Initial Shutter Position string variable was selected. When the user clicks the Do It button, the Microscope Control command will move the device (the Uniblitz shutter) to the position stored in that variable.

4.3 Keyboard Keys

4.3.1 Control Key

You can use the Control (Ctrl) key to change the shape and size of ROIs and drawing objects. When you hold down the Control key, eight black handles appear at the corners and sides of the selection. Clicking and dragging these moves the sides or corners of the ROI or drawing.

Moving, resizing, and reshaping an ROI is described in detail on page 11. Just hold down the Control key while an ROI tool is selected. Click inside the ROI and drag it to move it. Click and drag on one of the handles to change its size or shape.

Resizing and reshaping a drawing object is described in detail in the Drawing Object Selector section on page 21. As with ROIs, hold down the Control key, then click, and drag on one of the object's handles.

4.3.2 Arrow keys

Use the arrow keys on the keyboard to move the ROI within the active image. This is described above, in the Control Key section.

You can also use the arrow keys to position the paste region after you use the Paste command and while the paste region is still “live.” This ability gives you control over where the pasted image will sit.
The Control and arrow keys will move you through sequences:

To change the Z-plane: When the data in the active window contains a Z-sequence, hold down the Control key and use the up/down arrow keys to change the Z-plane displayed by the image window.

To change the T-plane: When the data in the active window contains a time (T) sequence, you can change the T-plane displayed in the image window by holding down the Control key and pressing the left/right arrow keys.

### 4.3.3 Escape Key

Generally, the Escape (Esc) key is used to cancel or stop an operation. You may press Escape to cancel from any dialog, thereby closing the dialog without making any changes. You may press Escape to stop a running script. The Escape key is also used to cancel pasting after you have used the Paste command but while the paste region is still "live" and floating above the image.

### 4.4 Batch File Processing

**IPLab** allows you to apply your lab protocols interactively, to one image at a time, so that you can see the effects immediately. However, you can also apply your protocols to multiple images as a batch. This is accomplished by using indexed files, file lists, and scripts.

Indexed files: Indexed files are files that have a base name and a number which help to organize them.

- You set up indexed files using **Set Index Info**, a subcommand within the **Indexed Files** command (File menu). Then you can control those files using the **Save As Indexed** and **Open Indexed** subcommands.

- For more information on indexed files, read about the **Indexed Files** command on page 113.

File lists: File lists are just what they sound like: lists of image files.

- You can create file lists with **Edit File List**, a subcommand within the **File Lists** command (File menu). The other **File Lists** commands let you pick an appropriate list and open, save, or delete files named within that list. These commands would obtain the names and locations of the files from the named file list instead of from their dialogs.

- For more information on file lists, please see the **File Lists** description on page 115.

Indexed files and file lists let you manage a large number of files one at a time. To batch process files, you would use indexed files or file lists to open the images within a script, which would then process the data. All you need to do is:

1. Record an **Indexed Files: Open Indexed** or **File Lists: Open File...** command near the beginning of a script, and
2. Record a **Loop** command at the end of the script to loop back to the image-opening command.
Each time the script runs through the loop, it will automatically open and process the next file. The section starting on page 99 describes scripting in detail.

4.5 IPLab Text Files

This section describes IPLab text files so you may import and export text files to and from IPLab.

4.5.1 Importing Text Files

Two types of text files are handled: those which contain row labels, and those which do not. Both files have a simple “header” followed by the data.

No row labels: For a text file without labeled rows, IPLab expects this format:

<table>
<thead>
<tr>
<th>integer width</th>
<th>integer height</th>
<th>“I” or “F”</th>
<th>(Integer or Floating Point data --described below)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A blank line</td>
<td>data(0,0)</td>
<td>data(1,0)</td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>data(0,1)</td>
<td>data(1,1)</td>
<td>...</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>data(0,height-1)</td>
<td>data(1,height-1)</td>
<td>... + data(width-1,0)</td>
</tr>
<tr>
<td></td>
<td>data(0,height-1)</td>
<td>data(1,height-1)</td>
<td>... + data(width-1,1)</td>
</tr>
</tbody>
</table>

With row labels: For a text file with labeled rows, IPLab expects this format:

<table>
<thead>
<tr>
<th>integer width</th>
<th>integer height</th>
<th>“IR” or “FR”</th>
<th>(Integer or Floating Point data --described below)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this row, column labels are saved with a tab as the first character</td>
<td>row label string</td>
<td>data(0,0)</td>
<td>data(1,0)</td>
</tr>
<tr>
<td></td>
<td>row label string</td>
<td>data(0,1)</td>
<td>data(1,1)</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td></td>
<td>row label string</td>
<td>data(0,height-1)</td>
<td>data(1,height-1)</td>
</tr>
</tbody>
</table>

For either type of text file, all of the entries are ASCII. The width and height parameters tell IPLab how much data to read and the dimensions of the resulting data window when performing the Open command. These are integers (they do not have a decimal point) and are positive (greater than 0). The type flag (in the third row) tells the Open command whether to place the data into a long integer or a floating-point image. The file uses either an ASCII “I” to designate integer type or an ASCII “F” to designate floating point. If the file includes row labels, “IR” or “FR” must be used to designate integer or floating point. If you designate that the data is integer type by using “I” or “IR” in the header, the file is read into an image of type long integer. If you wish to make the data byte or short integer type after opening the file, use the Change Data Type command from the Math menu. If there are no column labels, the next row should be blank, but it must be present.

If the file uses “IR” or “FR” in the data type field, IPLab expects to see row labels at the beginning of each row of data, followed by a tab character. Each row after the first three (width, height, I or F) must be terminated with a tab, including the row containing the row labels.

90

Should-Read Section
The data samples themselves should be tab delimited, although *IPLab* will accept space-delimited values also. Since the dimensions of the data come from the first two lines of the text file, *IPLab* ignores carriage returns and line feeds. Integer data must not contain decimal points.

**Note:** When reading text files imported from the Macintosh, append " .txt " to the file name so that Windows knows what type of file it is. In addition, it is often helpful to cut text files into small pieces in order to open them quickly in *IPLab*.

### 4.5.2 Exporting Text Files

One of the most common questions is, “How do you export text files to Microsoft Excel?” This is actually quite easy.

If you have Microsoft Excel 2002 ® installed on your computer, then you can use the special **Export: Export to Excel** command in the **File** menu.

If you have an older version of Excel, please do the following. Use similar steps when exporting to any other spreadsheet program:

1. First, save the data as text.
   a. Select **Save As** from the **File** menu, and
   b. In the **Save As Type** box, choose **Text**. The file is now a text file with the format described above.
2. When you open the text file in Excel, the Text Import Wizard will automatically appear. The default settings will open the file correctly.
   • The original data type is Delimited.
   • You can start the import at any row you like, but row 5 (the first data row) is good.
   • The file origin is Windows (ANSI).
   • *IPLab* text files are tab delimited.

If you like, you can click the Finish button immediately, without going all the way through the Text Import Wizard.

### 4.6 Data Views

There are a number of ways to view data:

- As Image
- As Text
- As Plot
- As Histogram
- As Linear Profile
- As Skewed 3D
- As Contours
The **New View** command in the **View** menu allows you to generate a new window displaying the active window as any one of these views. The data will remain the same, but the display of the data will change.

The text view displays all the image data as numbers in a spreadsheet-styled window. Each cell in this spreadsheet contains the intensity value(s) of the corresponding pixel in the image. Instead of being represented by a color or shade, the pixel is now represented as a number.

The plot view displays a graph of up to 10 columns from the data. To alter the text or plot views, use the corresponding commands in the **View Options** sub-menu in the **View** menu.

The histogram view displays a plot of the intensity versus the pixel count at each intensity value. The linear profile view displays the intensity at every point along a linear ROI drawn on an image. The skewed 3D view displays all the frames of a sequence image in a three-dimensional view. The contour view displays the image as a range of contours based on different gray level values in the image.

All of these views are described in more detail on page 138, in the **New View** command's section.

### 4.7 Saving IPLab Settings

Each time you quit the **IPLab** application, it saves the current parameters for all commands in the file "Persist.IPZ" except for the function key settings, which are stored in "FKeys.IPZ". These are located within the **IPLab** folder at:

```
C:\Program Files\IPLab 3.7 Folder\IPLab User Folder\IPLab Preferences\
```

**IPLab** reads the contents of these files and restores from them each command’s parameters. This removes the need for you to constantly re-enter values that you often use. If the file does not exist, **IPLab** assigns default settings to each command.
5 Operation

5.1 File Formats

*IPLab* allows you to save and read images in a variety of file formats. Usually you will use the commands *Open*, *Save*, and *Save As*, which are all found in the *File* menu.

For saving and reading 2D data, *IPLab* supports most common TIFF (Tagged Image File Format) formatted files, which are often used to transport images among various computer platforms. *IPLab* can read most non-compressed TIFF files that conform to the TIFF 6.0 specification. This includes monochrome 8-bit, 16-bit signed and unsigned, 32-bit signed, and floating point images; and color images (8-, 24-, and 48-bit color). *IPLab* does not support compressed TIFF files.

For multiple-framed data, *IPLab* reads and writes Stacked TIFF images. Normally, you should simply save your TIFFs using the normal TIFF option. However, if you are exporting images to the *Exhaustive Photon Reassignment (EPR)* program, you should use the EPR Raw or EPR PSF file formats. That will save the images as Stacked TIFFs with extensions that *EPR* will recognize.

*IPLab* also uses its own file format, referred to as IPL or IPLab format. *IPLab* can save any data type as an IPLab file. The IPLab format is described in this manual's Appendix (page 344).

To open *IPLab for Macintosh* files that were saved on the Macintosh, append "*.IPMI*" to the end of the file name. (The extension stands for "IPLab/Mac Image"). *IPLab* will open *IPLab for Mac* files in IPLab format.

*IPLab* also allows you to read foreign image files, including image files, which may have been created under other operating systems. You should use the *Define Foreign Format* and *Open* commands (both from the *File* menu) to open files of type *Foreign*. The *Define Foreign Format* command is described on page 118, and the *Open* command is detailed on page 108.

Script files have a special format, which can be read only by *IPLab*. Scripts are saved using the *Save As* button within the script window itself.

5.2 Data Types

Image data may be one of seven data types. These data types determine how much and what range of information can be stored in each pixel.

**Byte:** 1 byte (8 bits) per pixel; values in the range [0, 255]

**Short Integer:** 2 bytes per pixel; values in the range [-32768, 32767]

**Unsigned 16:** 2 bytes per pixel; values in the range [0, 65535]

**Long Integer:** 4 bytes per pixel; values in the range [-2^{31}, 2^{31}-1]

**Floating:** 4 bytes per pixel; values approximately in the range [-3.4E38, 3.4E38]
**Color 24:** 3 bytes per pixel; with 8 bits assigned to the intensity of each color: Red, Green, and Blue

**Color 48:** 6 bytes per pixel; with 16 bits assigned to the intensity of each color: Red, Green, and Blue

The same data type represents all of the pixels in an image window.

The first five data types (byte, short integer, unsigned16, long integer, and floating) are referred to as *indexed color types*. Indexed color data types rely on a Color Look Up Table, or CLUT, to convert data values into displayed colors.

The last two types, color 24 and color 48, are referred to as *direct color types* because they can be displayed directly without a color table. The concepts of color tables and direct display are explained in the following sections.

The **MultiProbe** extension to **IPLab** creates an eighth data type, the MultiProbe data type. This data type is only created and used by the MultiProbe commands. When saving a MultiProbe type image, it is important to save it using the IPL file format in order to store all of the image’s information. See the Extensions Manual for a description of the **MultiProbe** extension

### 5.2.1 Indexed Color

**Color Tables**

Indexed color type files (described above) require a correspondence table to translate the data values into displayed colors. This color table is sometimes also called the Color Look Up Table, or CLUT. The color table has 256 entries, each of which contains three numbers, which correspond to red, green, and blue \((R,G,B)\). Each of these numbers can have a value between 0 and 255. Each indexed color image window has a color table assigned to it as part of its data.

**Displaying Indexed Color Images**

When an image is displayed, each pixel value in the image is represented by an entry in the color table. The R, G, and B numbers in that location of the color table are sent to the display electronics. The display electronics use these values to control the relative intensities of groups of red, green, and blue dots at each pixel location on the display.

By mixing various combinations of R, G and B, you can potentially display \(2^{24}\) possible colors. However, you cannot utilize more than 256 combinations of red, green and blue intensities at one time, because there are only 256 entries in the color table. If the color table is constructed so that each \((R,G,B)\) entry in the table has \(R = G = B\), then only black, white and grays can be displayed. (Equal measures of red, green, and blue light make gray.) If \(R = G = B = \text{index value ("row number")}\) of the color table, then the grayscale intensity on the display is proportional to the pixel value in the image, as black for 0-valued pixels and white for 255-valued pixels.

In order to vary the displayed color or grayscale intensity for pixels in an indexed color image, you can change the value of the pixel data, which changes the color table entry used by that pixel.

**IPLab** performs display normalization to transform the raw data values into values in the range 0-255. This
process sends the normalized data values to the color table for display. **IPLab** performs display normalization without destroying the original values of your data.

Options for display normalization are provided in the **Normalization** command found in the **Enhance** menu. If you have a pseudocolor color table attached to an image, most changes in the **Normalization** command will also affect which displayed colors are assigned to which data values.

---

**Built-In Color Tables**

**IPLab** gives you direct access to the color table associated with each image window. You can change the color table associated with the active data window by using the **Pseudocolor** command in the **Enhance** menu. **IPLab** provides you with several color tables from which to choose.

- In the **Monochrome** color table, as the value of an image pixel increases from 0 to 255, the image intensity increases from black through the gray levels up to white.
- In the **Monochrome, Reversed** color table, the image intensity decreases through the gray levels as the pixel value increases.

The other color tables provide you with simple options for pseudocolor (also called false color) image enhancement.

- The **Saturated Pixels** color table is the **Monochrome** table with 0 and 255 set to blue and red, respectively. Using this color table lets you see immediately if the image is badly saturated. (Badly saturated images should not be used for intensity analysis.)

Other color tables are described in the description of the **Pseudocolor** command (on page 156), within the **Enhance** menu section of the Menu Reference chapter.

---

**5.2.2 Direct Color**

The last two data types, Color 24 and Color 48, contain enough information within the pixel values themselves to display the image data in color. These data types are called "direct color types" because no color table is required when they are displayed. In Color 24 image data there are three bytes (24 bits) assigned to each pixel. So each pixel in a color 24 image actually contains three values. These three values correspond directly to the intensities of the red, green and blue components (RGB) of the pixel’s color. It is as if three different images were contained within the one Color 24 image, each one controlling one of the three basic color components. We call these three sub-images the **components** of the color image.

Color 48 pixels are similar to Color 24 pixels, but each color component is represented as an Unsigned 16 type value. This means that each color component in Color 48 images can have thousands of intensity levels, which gives much better control over display quality.

You may think of the red, green, and blue values of color pixels as parts of a 3D vector. Then, by transforming the vectors for each pixel, you can arrive at many alternative ways of representing the color information in each pixel. These transformed coordinate systems provide other ways of looking at the data, which may improve your ability to extract information from the image. **IPLab** directly supports three color coordinate systems: RGB, HSV, and R<sub>s</sub>G<sub>s</sub>B<sub>s</sub>.
Each of these color coordinate systems is discussed more fully below. You can work in any of these coordinate systems to split a color image into its components or merge color components to form a color image. In the descriptions below, we provide the algorithms for transforming from RGB into each of the other coordinate systems.

**RGB**

RGB, of course, stands for *Red, Green, Blue*. This is the default color coordinate system. It corresponds directly to the red, green and blue components used by the computer to display each pixel. RGB cameras also exist which provide these three components directly as outputs. Certain color frame grabbers can accept these inputs to allow you to bring color images into your computer as live video.

**HSV**

The *(Hue, Saturation, Value)* coordinate system is a nonlinear transformation of RGB. HSV corresponds more closely to the way humans perceive color than the other color systems do. Hue ranges in value from 0 for red, through 85 for green, through 170 for blue, to 255, which corresponds to a very reddish violet. Saturation tells how much white is mixed with the color. A value of 255 for Saturation provides a “pure” hue. As Saturation decreases to 0, more and more white is mixed with the color. (Keep in mind that mixing with white means mixing equal amounts of all the primary colors.) The Value component of HSV provides intensity information. Various intensities of gray can be obtained by setting the Saturation component to 0 and varying the Value component.

The following algorithm is used to transform RGB coordinates into HSV coordinates:

\[
V = \max(R, G, B)
\]

\[
S = \frac{\max(R, G, B) - \min(R, G, B)}{\max(R, G, B)}
\]

\[
rc = \frac{\max(R, G, B) - R}{\max(R, G, B) - \min(R, G, B)} \quad \text{[measures distance to red]}
\]

\[
gc = \frac{\max(R, G, B) - G}{\max(R, G, B) - \min(R, G, B)} \quad \text{[measures distance to green]}
\]

\[
bc = \frac{\max(R, G, B) - B}{\max(R, G, B) - \min(R, G, B)} \quad \text{[measures distance to blue]}
\]

if \( R = \max(R, G, B) \) then \( H = bc - gc \)

if \( G = \max(R, G, B) \) then \( H = 2 + rc - bc \)

if \( B = \max(R, G, B) \) then \( H = 4 + gc - rc \)

Once \( H, S \) and \( V \) are computed by these formulas, they are scaled so that they are in the range \([0, 255]\).
$R_sG_sB_s$

The $R_sG_sB_s$ color space is also referred to as XYZ. This is a normalized color space, which ignores the effects of brightness. It is tremendously useful for examining histology sections and similar images. The transformation from RGB to $R_sG_sB_s$ is:

\[
R_s = 255 \cdot \frac{R}{R + G + B}
\]
\[
G_s = 255 \cdot \frac{G}{R + G + B}
\]
\[
B_s = 255 \cdot \frac{B}{R + G + B}
\]

This transformation is not reversible; i.e. you cannot recover RGB if all you know is $R_sG_sB_s$.

### 5.3 Copy-Paste Operations

There are three kinds of paste buffers in *IPLab*: the paste buffers for the data, script, and segment layers.

Data is always copied to the data paste buffer as raw data (that is, as binary pixel values) with the same data type as the data window you copied it from. Data is never copied to the buffer as text. This way, you can paste data into other windows of the same type.

You copy and paste lines in a script using the **Copy** and **Paste** buttons within the script window.
6 Scripting

6.1 What is a Script?

An *IPLab* script is like a flexible “macro-maker” tool. It is a recording of a sequence of commands. It is effectively a program that you create as if you were applying menu operations interactively to your image data. When you run a script, the scripted commands are executed in the order you placed them. *IPLab* scripting allows you to customize the software to your own needs, by grouping together commands that describe your protocols and algorithms. Scripts may be saved and run with a few keystrokes, creating powerful new “commands” which are customized to your specific application.

6.2 How to Script

1. Create new scripts by choosing the **New Script** command from the **Script** menu. You can also use the **Open Script** and **Run Script** commands to read an existing script file from disk.

2. Record commands for your script by using *IPLab* normally:
   - Picking commands from the menus
   - Clicking buttons on the side of the script window
   - Pressing key combinations (like CTRL+O for **Open**)

   As you record commands, you will see the command names appear in the command list on the left side of the script window. New commands will appear above the first highlighted command, or at the top of the script if there are no highlighted commands.

   There are a few interactive commands that cannot be recorded in a script. When you record your script, these commands will be dimmed within their menus.

3. Set up the command parameters for each command just as you would normally do. When you record a command, its dialog box, if it has one, appears. Set its parameters and click **OK**. The script saves the parameters you set.

   You can alter recorded settings by double-clicking on a command in the command list. The dialog box will open again, letting you change the parameters.

4. You have the option of adding comments to your script. Comments explain the purpose of the recorded commands, making it easier to use and edit the script.

   Commands can be made interactive:
   
   + = Interactive

   Recorded commands

   Comments can be added to document your script.

After that, save your script by clicking **Save** or **Save As** on the **Script Commands** palette. When you run your script, the list of commands will run in order from top to bottom.
The rest of this chapter tells you how to use each of IPLab's scripting tools. If you like, you can skip around this chapter to learn only the details you need right now.

6.3 Recording the Script

Recording commands adds them to the command list when the script is the front window. You can make some commands interactive, so their dialog boxes appear for the user. You can also add comments to explain your script.

You must first turn the script on to record commands into a script window. Click the On/Off button so it is down and highlighted. (For more detail, please see page 101.)

Normally, when a script is the front window, every command you select from one of the menus goes into the script. If you are concerned about users accidentally altering your scripts, turn scripting off. You can turn scripting off for individual scripts by clicking the On/Off button, described below. You can protect all of your scripts by turning off all scripting. Do that by deselecting the Permit Script Editing option in the Preferences command (Edit menu).

6.3.1 Command List

The command list is the sequence of recorded commands listed on the script window's left side. Every command recorded by the script is added to the command list.

To record a command, use it as you would normally:
  • Pick the command from a menu
  • Click a button on the left side of the script window
  • Use a key combination (like CTRL+O for Open)

You will see the scripted command appear in the script window. Recording commands adds them above the first highlighted line. If you want to add the command to the bottom of the script, select the END command; the new command will be added above that. If no command lines are highlighted, then the new command will be added to the top of the script.

To highlight a command in a script, simply click on it. To highlight several commands, hold down the Shift key and click on either end of the selection. Because you control the new command's insertion point, you do not have to record the entire script in order, from top to bottom, which would require much planning. Instead, you can always return to an earlier point in the script and add or change commands.

A few commands are meant to be interactive, and thus cannot be scripted (Preferences, for example). These commands will be grayed out (unavailable) when a script is open with recording turned on. You can temporarily toggle the On/Off button to Off to use these commands.

You will notice that every script ends with the END command. Highlight the END line to record commands immediately above it. When a running script reaches the END command, the script returns control of IPLab to you.

Note: "Recording a command in a script" and "scripting a command" mean the same thing.

You can change a command's parameters after the command is scripted. Double-click on the scripted command's name. Its dialog box will open again, and you can change its settings.
6.3.2 Interactivity: Making Dialogs Open

You can make scripted commands interactive, so that their dialog boxes, if any, appear when the user runs the script.

Double-click beneath the “+” heading and to the left of a command to toggle the presence of a “+” symbol beside that command. When the script is run, the dialog box for that command will appear. The user can then make changes to the dialog box. When the user clicks the box’s OK button, the script will continue with the next recorded command.

If a command does not have a dialog box, then making it interactive will have no effect.

6.3.3 Commenting Your Script

You can enter a comment for every command in the script. Comments make editing scripts easier, and they help users understand exactly what scripts do. Comments can identify portions of the script, explain the reasoning behind a group of commands, and reveal the settings for a command so that the reader does not have to open the command.

To enter a comment, double-click in the Comments column to the right of the command. Type the comment and click OK.

6.4 Using the Script Window Buttons

These buttons allow you to edit and run scripts, and to enter commands, which are special for scripts. Many of these commands are duplicated in the Script menu. The Script menu also contains some additional, specialized commands not found within the script window.

6.4.1 Turning the Script On and Off

The first button in the window, the On/Off button, activates and deactivates the script window. The script is on when this button appears down and lighter, and commands can be added. You will notice that all of
the script window buttons are active and available. When the On/Off button is up and darker, then the script is off and cannot be edited or added to. Most of the script window buttons become grayed out. Turn a script off when you want to use commands without adding them to the script.

To prevent users from editing any scripts at all, deselect the Permit Script Editing option in the Preferences dialog box from the Edit menu.

6.4.2 Saving the Script

Use these buttons to save the script.

**Note:** If you try to save the buttons using the Save and Save As commands in the File menu, you will record the Save and Save As commands in the script.

6.4.3 Editing the Script

Use these four buttons to Cut, Copy, Paste, and Clear the highlighted commands in the script.

**Note:** In order to perform these editing operations on a script, you can use the buttons in the script window or from the script menu. If you try to select the Cut, Copy, Paste, or Clear commands from the Edit menu when a script window is the active window, those commands will be inserted into the script itself.

Cut and Copy place the highlighted commands into a special script paste buffer, along with the dialog parameters associated with each of the commands and the comments on each of the highlighted command lines. Cut also clears the highlighted lines in the script. When Pasting, all the information in the script paste buffer is inserted before the first highlighted command in the script. If no command in the script is highlighted, the new commands go at the top of the script. You can also Cut or Copy a sequence of commands from one script and Paste them into another script.

6.4.4 Script Control

These buttons insert commands within the script. These five commands are control structures; they control which of the script's commands will run next.

The Script menu section describes these commands in detail, starting on page 320.

**Label**

This button lets you label a line within the script. Labels mark positions in a script, which are referred to by the If, Jump, and Loop commands. You must enter a unique text string to identify the label. Labels then appear with a special tag in the first column, under the “*” heading. In the example script on page 99, "Top" and "AcquireLoop" are labels.

**Jump**

This button allows you to place an unconditional jump in the script. A dialog prompts you for the label of the
position where control is transferred when this command is encountered. You can jump to any label in the script. You can see the Jump dialog on page 321.

**Loop**

This button provides simple backward looping capability in the script. You can control the number of times the script will return to the same label. This is described in more detail on page 321.

**Pause**

This button allows you to insert a time delay into your script. The delay is measured in seconds. When the running script encounters this Pause command, the script stops running for the delay period. You may stop the script during this pause by pressing the Escape key on the keyboard.

Pause is described in more detail on page 322.

**If**

This button provides a conditional jump control structure. That just means that the If function will consider whether or not the given equation is true, and if it is, then the script will continue from the chosen label.

Since you can jump to a label located anywhere in the script, it is possible to use the If button along with the Query button to make your script interactive. For example, you could use Query to ask the user if he wants to animate a sequence. A different number is returned depending on whether the user answers Yes or No. You would then use an If statement, such as: If the variable holding the answer equals 1 (which may mean No), then Jump over the Animate command.

If is described in much more detail on page 323.

**6.4.5 Script Interaction**

These three buttons let the script and the user interact. The Query and the Enter Variables buttons let the user give information back to the script, controlling the script and what values it uses. The Alert button gives messages to the user, and can be used to stop the script (or to let it continue).

The Script menu section describes these commands in detail, starting on page 320.

**Note:** The Enter String Variables command (Script menu) also lets the user interact with the script. Please see page 317 for a description of Enter String Variables.

**Query**

Click the Query button to create a prompt that asks the user to choose from two or three options. The Query prompt returns a value to the script that depends on which button the user clicks. If statements in the script can then control what the script does in response to that event.

The Query command is detailed on page 325.
**Alert**

An alert is a simple dialog box that contains a message to the user and **Abort** and **Continue** buttons. When you insert the **Alert** command into a script, you will type the message into the dialog box. When the script is run, the user will see the message along with the two buttons. If the user clicks ** Abort**, the script will end immediately. If the user clicks **Continue**, the script will continue executing.

This is an excellent method for informing the user what the script is doing, or for telling the user to move a non-motorized piece of the microscope.

You can see example **Alert** dialogs on page 324.

**Enter Var.**

The **Enter Variables** button is used in scripting to prompt the user for experimental parameters, which will be stored in numeric variables. The user will see your questions and prompts, and be able to type numbers in response. These will be stored in variables that you specify. You can then use these numbers in the rest of your script.

The **Enter Variables** command is described on page 326.

**6.4.6 Run, Step, Run Select, and Continue**

When a script window is the active window, you may run the script at any time using one of four control buttons found in each script window.

- Click on the **Run** button to start the script at the first command.
- Click on the **Step** button to execute only the next command in the script.
- Click on the **Run Select** button to execute only those commands in the script that are highlighted.
- Click on the **Continue** button to start the script at the first highlighted command.

When the active window is **not** a script, you may also run a script directly with the **Run Script** command from the **Script** menu. (If a script is the active window, that script would record the **Run Script** command.) The **Run Script** command asks you to select a script. **IPLab** opens that script file and immediately starts to execute the commands in that file.

In all cases, the script immediately becomes minimized while each of its commands is executed. If an error occurs, which stops the script, the script window is shown with the offending line highlighted. If you press **Escape** to stop the script, the next command to be executed is highlighted so that you may press the **continue** button.

After you start a script running, it continues to run until one of three things happen:

- The **END** command is reached,
- You stop the script by hitting the **Escape** key, or
- An error condition is encountered.
When the script stops running, the script window is opened so that you may edit it or run it again. Note that the script window is not opened if you run a script using the **Run Script** command from the **Script** menu.

If you stop a script by hitting the **Escape** key, the script finishes the command it is executing when the interrupt occurs, and then stops. The script window appears with the next command highlighted. At this point, you may activate other windows and perform any interactive operations you wish. Use the **Continue** button in the script to continue running from the point at which the script was stopped.

### 6.4.7 Closing a Script

Close a script by clicking in its go-away box (the X at the upper right corner). If you have performed any operation on the script, **IPLab** will ask you if you wish to save the script before closing it.

**Note:** If you select the **Close** command from the **File** menu when a script window is the active window, that command will be inserted in the script.

### 6.5 Run One Script from Another Script

The **Run Script** command in the **File** menu may be placed within a script. When the **Run Script** command is encountered, the named script is opened and run. This provides a kind of “subroutine” operation, with many possible uses.
7 Menu Reference

7.1 File Menu

7.1.1 New Data

Use this command to create a new, empty data window. You can also type Ctrl + N.

![New Data Dialog Box]

**Name:** Enter any text name for the image.

**Data Type:** Use the radio buttons to select one of the data types. These are described in the Data Types section of the Operation chapter, on page 93.

**View As:** The initial view may be either as image or as text. Data viewed as text appears as an array or spreadsheet of pixel intensity values.

**Initially Minimized:** Check this box if you want to create the new image minimized, i.e. it will appear as an icon at the bottom of the application window. Minimized images do not require updating, so creating them is faster.

**Dimensions:** You can create an image of any width and height, or you can select one of the preset dimensions.
...Clipboard Image: If you had previously copied an image into the clipboard, this option will make a new image window of exactly that size.

...Video Frame: This option makes a new image the size of a video frame, 640 x 480 pixels.

...Front Window ROI: The Size of Front Window ROI option creates an image that is the same size as the selection on the current front image.

Custom Size: You can specify exactly how large (in pixels) you want the new image to be. When the # buttons are toggled to V, that size parameter will come from a variable.

Number of Frames: You can make the new image with any size Z depth and/or Time (T) depth. Use Z depth to store sequences of images taken at different focal planes, and T depth to store sequences of images taken at different times.

7.1.2 Open

This command allows you to open a data file or a script file. The standard Open File dialog box is used to help you find the file you wish to open. The keyboard shortcut for Open is Ctrl + O.

Look In: Find the folder (directory) where the file is located.

File List: Find the file name in the list of files and double click on it to open it. Alternatively, click once on the name of the file in the file list and then click on the Open button.

File Name: You can also type the file name in this box and click on the Open button to open the file.

Files of Type: IPLab considers the following types of files “readable”:

IPL  
IPLab for Windows files with the extension *.IPL

TIFF  
Tagged Image File Format, which has the extension *.TIF

Text  
Specially prepared text files. (For the exact format, see the section called “IPLab Text Files” in the Operation chapter of this manual.) These have the extension *.TXT

Script  
IPLab scripts with the extension *.IPS

Jpeg  
Jpeg files with the extension *jpg, *jpeg or *jpe

Bitmap  
Bitmap files with the extension *bmp

Foreign  
These are non-standard files made by other programs. You must first specify the file name extension using the Define Foreign Format command (described on page 118) in order to open foreign files.

EPR  
RAW and PSF files are Stacked TIFFs for use with Scanalytics’ Exhaustive Photon Reassignment deconvolution program. The extension for unprocessed specimen stacks is *.RAW, and the extension for point spread functions is *.PSF
IPMI

*IPLab for Macintosh* files with the extension *.IPMI.

FITS

Flexible Image Transport System, which has the extension *.FIT

You can also choose to view Files of Type: Readable Files, which are all files of the above types, or All files, which will include any file type. Those two settings will let you see *IPLab for Macintosh* and FITS files in the File List, since those two formats are not in the Files of Type list.

Before opening Macintosh files, you will probably have to add the extension to the name. If you cannot open a TIFF file created on the Macintosh, check to make sure you have added the *.TIF extension.

When you open a file, *IPLab* creates a new active window labeled with the filename and displays the image or script in the new window.

### 7.1.3 Close

This command closes the active data window. You can also type Control-W. If the data has been changed since the last time you performed Save or Save As, then *IPLab* gives you the opportunity to save the window contents before closing it. This happens even if the Close command is executed from a script that you are running. In order to avoid this interruption in a script, you may wish to use the Dispose Window command. (However, this will not save the image!)

### 7.1.4 Save

This command saves the contents of the active data window in the file from which the window's data has been read. You can also type Ctrl + S. If the active window was not read from a file (if, for example, you created it with the New Data or Acquire command or renamed an existing window), the Save As command is executed instead. This happens even if the Save command is executed from a script that you are running.

### 7.1.5 Save As

This command saves the contents of the active data window into a new file. A dialog prompts you for:

**Save In:** The folder (directory) where you wish to save the file.

**File Name:** The name you wish to assign to the file.

**Save As Type:** You must save the data file as one of the types supported by *IPLab*:

- **IPLab-Window** with the extension *.IPL
- **TIFF** with the extension *.TIF
- **Jpeg** Jpeg files with the extension *.jpg , *.jpeg or *.jpe
- **Bitmap** Bitmap files with the extension *.bmp
- **Text** with the extension *.TXT
- **EPR Raw** *EPR* specimen files with the extension *.RAW
- **EPR PSF** *EPR* point spread functions with the extension *.PSF
Do not save images as text files unless you need to, since this is slow and requires a large amount of disk space.

Multiple Z planes can be saved in an **IPLab** Stacked TIFF, but only images where $T = 0$ (the first time point) will be saved.

### 7.1.6 Save All Files…

The **Save All Files** command saves all of the open files, except for the Variables window, using their current window names.

![Save All Files Dialog Box](image)

**Save Location:** Type the path to the destination directory where you want the files stored.

**Browse:** You can also click the **Browse** button to find the directory, instead of typing the path.

**IPL/TIF:** The drop-down box next to the **Browse** button lets you choose the file type. This command will save all open files in the IPLab or TIFF formats.

**Create Sub-Directory with Current Time:** When this option is checked, a new directory will be created inside the **Save Location** directory. The time will be used as the name of this new sub-directory. For example, if the time is 2:49 and 59 seconds, then the directory will be named `02_49_59`.

### 7.1.7 Revert To Saved

The active window’s contents are replaced with data from the most recently saved version of that window. All changes are lost. If there is no saved file for the active window, then this command will not be available.

### 7.1.8 Delete File…

Since image data requires a lot of disk space, you may find yourself in a situation where there is no room on the hard drive to save another file. **IPLab** allows you to review the names of files on a disk and delete unneeded ones. This command’s dialog prompts you to pick the file you wish to delete. The selected file(s) is deleted when you click on the **Delete** button in the dialog.
7.1.9 Set Preferred Directory…

This command controls the default locations to which your images and scripts are saved and from which they are opened. It sets the default directories for these commands:

- Save
- Save As
- Sequence to Frames
- Save All Files
- Open
- Open Script
- Run Script

**Set Preferred Directory Dialog Box**

**Enable:** Check a box to set a default directory.

**Path:** Type a directory path, or **Browse** to a directory.

**Add String Variable:** You can opt to add a string variable to the directory path. In the example dialog above, if the string variable "Initials" contains the value "MG," then the full path name would be C:\ImagesMG.

**Note:** Set Preferred Directory will not create new directories. The directory named in the Path field, or the directory named by the combination of Path plus a string variable, must already exist.

7.1.10 Set Image Info…

The Set Image Info command defines descriptive information that will be stored with all new images. Descriptive information for your data can include, for example, the date and the identities of the sample, probes, and researcher. All new images created by acquisition commands and by the New Data command will have this text stored in their image info.
In the example dialog shown above, the date has been typed into the Descriptor field. All newly acquired images or images newly created by the New Data command will contain this date in their image info. You could then view the acquisition date of the images by clicking the button on the image window. On each new day, you would update the Descriptor information.

The Descriptor field can contain up to 64 characters. By clicking the L / S button to S, string variables can be used for the Descriptor (string variables, however, can only hold up to 32 characters).

7.1.11 Edit Image Info...

The Edit Image Info command lets you type descriptive information for the active (front) image window. Where the Set Image Info command defines the information for all new images, the Edit Image Info command defines the information for the existing, currently active image.
The **Descriptor** field is good for storing information about a group of images, such as the date on which a group of images were acquired, or the name of the researcher who acquired them. The **Descriptor** field can contain up to 64 characters.

The **Notes** field is good for storing information specific to this single image. The **Notes** field can contain up to 512 characters.

You can view the active image's info by clicking the  button on the image window's border.

### 7.1.12 Indexed Files

Indexed files are structured file names that make it easier to open and save a large number of files.

This hierarchical menu allows you to set, save and open indexed files. Indexed files have a base name and a count, or index, value. Examples are "New Study0000", "New Study0001", etc. To make it easier to manage a large number of files, the **Open Indexed** and **Save As Indexed** commands automatically increment the index part of the file name. This lets you cycle through a large number of files in sequence for processing. Separate base names and indexes can be maintained for use by these commands. So, for example, when you open an indexed file, the index value for saving will not be affected.

The index number that is appended to the base name is stored in a variable of your choice. That way, you can access the index value at any time through the **IPLab Variables** window. You can set the number of digits for the index in the **Preferences** dialog box (**Edit** menu). In order to reset an index, use the **Set Variable** command (**Script** menu).

Here is how indexed files work on saving:

1. You specify a base name and folder for the files you want to save.
2. Then, whenever you use the command **Save As Indexed**, **IPLab** will append a number (or index) to that base name and save it in the specified folder.
3. The number will automatically be incremented so that the next time you choose **Save As Indexed**, that next image will be saved with the same base name plus the new number.

This is a convenient way to save many files sequentially. Using the **Open Indexed** command follows the same process.

These three commands, **Set Index Info**, **Save as Indexed**, and **Open Indexed**, are available from the **Indexed Files** option under the **File** menu.

**Set Index Info**

This command allows you to set the information for opening and saving indexed files.
Set Index for: You can choose to set the index information for either Saving or Opening indexed files.

Path and Base Name: Enter an absolute path and base name. It is important to use the Browse button to make certain that the file is saved and opened as expected. The Browse button will bring up a standard Save/Open dialog from which you can select the directory path, the base file name, and the file type to use.

Use IPLab Directory: Using this option, you need only specify the base name. This name will be appended to the IPLab directory to give the full path. The base name may be a literal name or a string variable. For more information about string variables, please see page 86.

Variable To Use For Index: Enter a number between 0 and 255. This is the location in the IPLab Variables array where the index for the files will be stored. Select different variables for saving and for opening in order to have different indices for the two actions.

Save As Indexed

This command immediately saves the data in the active window into a file whose name and path are constructed from the information you specified in the Set Index Info command. The number that is appended to the base name is obtained from the IPLab variable you specified in the Set Index Info command. The value of that variable is automatically incremented by one after the command is performed. This command is tremendously useful in scripts.

Open Indexed

This command immediately opens the file whose name and path are constructed from the information you specified in the Set Index Info command. The number that is appended to the base name is obtained from the IPLab variable you specified in the Set Index Info command. The value of that variable is automatically incremented by one after the command is performed. This command is tremendously useful in scripts.
### 7.1.13 File Lists

A special feature of **IPLab** is its ability to process a collection of data files as a batch. **IPLab** offers two ways of accessing a collection of files, through indexed files (see the Indexed Files commands, on page 113) and through file lists.

The names and locations of the files you wish to process can be stored in a file list. The commands that can be used on file lists are:

- **Open File from Selected File List**,  
- **Save File using Selected File List**, and  
- **Delete using Selected File List**.

These file list commands are very powerful when used within a script. To apply a sequence of operations to a collection of files, you need to

1. Place the **Open File from Selected File Lists** command at the beginning of a script, and
2. Use the **Loop** command at the end of a script to cycle through the list of files.

As an example, a slide show script is shown below:

```
Select File List (Specify which file list to use)  
Top (A label marking the top of the loop)  
Open File from Selected File List (Use the file list option)  
Pause (Use a long default delay, such as 3600, i.e. 60 seconds, for viewing)  
Loop (Loop back to the line labeled Top)  
```

Each time the **Open** command accesses the file list within the loop, **IPLab** increments the file list's internal pointer to point to the next file in the list. Thus, each time the loop is run, the next file in the list is opened and operated upon.

Instead, you may want to use a file list to capture a sequence of images with your frame grabber and save them with special names. If your processing steps create intermediate temporary files on your hard disk, you may want to use a file list to automatically delete those files after they have been used.

**Select File List**…

You may have many different file lists. Use **Select File List** to select the list to be used by these commands:

- **Open File from Selected File List**  
- **Save File using Selected File List**  
- **Delete using Selected File List**

To create and edit file lists, use the **Edit File List** command, described on page 116.
Select File List Dialog Box

Reset to Top of List: You can also use this command to reset the file list pointer to the top of the list. This command is scriptable, so you may switch between file lists in the middle of a script. If you wish to start from the top (first entry) in the file list each time you select it, click the Reset to Top of List checkbox.

Store File Count…: If you want to store the number of the list’s files in a numeric variable, check the Store File Count in IPLab Variable checkbox and enter the variable number into the box. This can be used in a script to loop through all of the files in a file list. (Loop as many times as there are files in the list.)

Edit File List…

Use the Edit File List command to create and edit a file list. The Edit File List dialog box has two sides. The right-hand side is used for browsing through files on your computer. Use this side to select the images to add to the file list. The left-hand side contains the name of the file list and the file list itself.

Edit File List Dialog Box
To use **Edit File List**:

1. Create or pick a file list from the **File Lists** pop-up box.
   - To create a new file list, click the **New File List** button. You will probably have to do this the first time you use **Edit File Lists**.
   - To see the names of the existing file lists, click on the **File Lists** box. This box will be blank if you have not selected a file list. Each of the existing file lists is stored in special files in the *IPLab* folder:
     ...\IPLab 3.7 Folder\ IPLab User Folder\ IPLab Preferences\ File Lists\ *.IPF
     Pick one of the existing file lists from this list.

   Once you have created or selected a file list, the **File Lists** box should display its name.

2. Select images within the file list on the right.

   The right side of the dialog box lets you view the files on your computer. The right side is just like a standard Windows file navigation dialog.

   Find your images and select them. You can select multiple images within a folder by holding down the Control and/or Shift keys.

3. Click the Add and Remove buttons to edit the files shown in the **Files in File List** box. New files will be added above the currently selected list item.
   - **Add File(s)** will add the file or files that are selected on the right.
   - **Add All Files** will add every image present in the directory displayed on the right.
   - **Remove File** will clear the file selected within the **Files in File List** box.
   - **Remove All** will clear the entire file list so that you can start over.

   Adding and removing will not affect the image files on the computer.

4. You can also add a file to the file list by simply typing its name.
   a. Type the file’s name in the text box below the **Files in File List** box.
   b. Click on the **^Add File^** button to add that file.

   In this way, you can enter names of files, which do not even exist at the time you are creating the file list. This is useful, for example, when you expect to run a script that first creates a new window and then saves that window with a specific name.

5. Click **Done** when you are finished editing the file list.

**About File Paths:** Information about the location of the file, including the folder and volume name, is also stored in the list. This information is always obtained from the folder and volume that are shown on the right side of the dialog. You cannot change the path that is stored with a name once it is on the file list. However, you can delete the name from the list, change the directory in the right hand list, and then re-insert the name into the file list.
About Scripting: The Edit File List command is not scriptable. However, the Select File List command is scriptable and allows you to select a different file list and reset the pointer to the top of the file list. Make your file lists outside of the script, and then script the Select File List command to pick the appropriate one.

Open File from Selected File List

Choose this command to open the next file on the selected file list.

You specify the file list currently in use by using the Select File List command.

The count that tracks which file is next is the same for opening, saving, and deleting. This means that successive uses of the Open File..., Save File..., and Delete using... commands would open file #0, save file #1, and delete file #2.

Save File from Selected File List

Choose this command to save the next file on the selected file list.

You specify the file list currently in use by using the Select File List command.

The count that tracks which file is next is the same for opening, saving, and deleting. This means that successive uses of the Open File..., Save File..., and Delete using... commands would open file #0, save file #1, and delete file #2.

Delete using Selected File List

Choose this command to open the next file on the selected file list.

You specify the file list currently in use by using the Select File List command.

The count that tracks which file is next is the same for opening, saving, and deleting. This means that successive uses of the Open File..., Save File..., and Delete using... commands would open file #0, save file #1, and delete file #2.

7.1.14 Define Foreign Format

IPLab can read image files with data saved in a wide variety of formats. The Define Foreign Format command tells IPLab about these formats. We call these “foreign files.” In the dialog for this command, you specify the details of the foreign file format, plus a filename extension that IPLab can use to identify files of this format.
In order to read the data contained in foreign files, IPLab makes some assumptions about the file format. It is assumed that the file may contain a header that is followed by the image pixel data. The data is assumed to be stored as a sequence of horizontal lines, with one or more extra bytes at the end of each. This is a common format for exchanging image data among various computer platforms, so you generally should have no problem obtaining the information you need in order to read such files. If the data is 4D, then IPLab assumes the z coordinate changes faster than the time coordinate (i.e. you get a time sequence of 3D images, as opposed to a z sequence of x-y-t images.).

**Definition Number:**
This is the pull-down box in the upper left corner of the dialog box. You can define five foreign file formats at any one time.

**Extension:**
Make up a unique, 3-character extension to assign to this foreign file format, and type it into this text box. IPLab uses this extension to recognize the format defined in this dialog box. You should then rename the documents to have this extension. For example, after defining the EPI foreign file format, you should change the end of your file names: "MyFile.EPI".

**Width, Height:**
The **Width** and **Height** refer to the size in pixels of a single frame of image data.

**Extra Bytes/Line:**
Enter a number greater than zero if there are extra bytes at the end of each line of data, such as end-of-record marks.

**Z, T Depth:**
Specify a **Z Depth** and/or **T Depth** greater than 1 if the data contains multiple image frames.

**Explicit / From File:**
Most binary data files contain the information about file size in their headers. If you know where in the header the width and height information is located, you may instruct IPLab to get that information directly out of the header.
To do so, click on the button labeled **Explicit**, changing it to **From File**. The text boxes will now refer to locations within the header. The **Number** column will become the **Location** column, and the **Size** column will appear beside it.

You can then enter the byte locations (measured from the start of the file, with the first byte in the file equal to byte 0) for the **width**, **height**, **Z Depth** and **T Depth** parameters. These parameters will most often take up two bytes each in the header, but you may select 1, 2 or 4 bytes for the **Size** parameter. For the **Z Depth** and **T Depth** parameters you may also select the **0 (Do not use)** option if the file does not contain multi-dimensional data. These parameters are all read using the same byte order as the data, Intel or Motorola.

**Data Starts at...:** In the **Data Starts at Byte #** field, you must specify the byte number in the file at which the data starts.

**Data Type:** Select the **Data Type** from the options in the pop-up list. **IPLab** will read foreign data of type byte, signed 16 bit integers, unsigned 16 bit integers, long integer, floating point (IEEE-format floating point only), color 24 and color 32. In addition, **IPLab** can read color images which are stored as planar RGB (8 bits per channel) (i.e. all the red pixels, followed by all the green pixels, followed by all the blue pixels).

If you are importing color image data, you must know something about the order in which the color components are stored. If your foreign color image data is stored so that the red, green and blue components for each pixel are stored together (i.e. the pixel data is ordered as RGB, RGB, RGB...) then select the **Color 24** option. For data stored as AlphaRGB, AlphaRGB, ... (where Alpha is an extra byte), use the **Color 32** option. If your foreign color image data is stored so that the red, green and blue components for each pixel are stored separately, then you should select the **Planar RGB** option.

Do not worry if your image data is stored with the red, green and blue components in an order different than R-G-B. Go ahead and read the image data, and then use the **Split Color Channels** and **Merge Color Channels** commands (from the **Math** menu) to split the image up into its color components and put it back together properly.

**Byte Order:** Specify which **Byte Order** to use in reading two or four byte/pixel data: **Intel** (Windows and other operating systems) or **Motorola** (Macintosh and others).

### 7.1.15 Export

This hierarchical command converts data to forms readable by other programs. This supplements the **Save As** command.

**Sequence to Movie**

The **Export: Sequence to Movie** command translates **IPLab** sequences into the AVI movie format.
Sequence to Movie Dialog Box

To use this command, the front window must be a 3D sequence. It must have multiple Z or T frames, but not both.

Output Path…: Enter the file name of the movie, along with the path of directories that will contain it. To do this easily, click the Browse button, which will bring up a Save As dialog box. Choose the directory you want to save the movie in, and give it a name. That path and file name will then be shown in this text box.

Frames Per Second: The movie will be shown at this rate. Video rate is 30 frames per second.

Compression: Choose the compression algorithm to use (or None). Click About to see the information provided with the compression package. You can set the Quality to 0 (the most loss) or 100 (the least loss).

Export to Excel

This command exports text data to Microsoft Excel®. You must have Excel 2002 or a later version installed on your computer.
Export to Excel Dialog Box

**Window to Export:** Choose any open data window.

**Sheet:** You can rename the first sheet in the Excel document. Type the name here.

**L/SV buttons:** If you set the L/SV icon to SV, the window name or sheet name will come from the specified string variable. Otherwise, it will just be the literal name you select or type.

**Append Data…:** You can add the data below or to the right of any data that is already in the spreadsheet.

**Increment Data By:** Shift the insertion point within the Excel spreadsheet by this many rows and columns. When you export the data, it will be inserted in the spreadsheet relative to the current selection.

This option gives you more control than the Append options. For example, if you repeatedly export a single row of data, you could increment the data by 2 rows and 0 columns. That would result in a blank row between each row of data.

**Include … Labels:** Check these boxes to export the row and column labels to the spreadsheet.

**If you do not have Excel 2002 or later:**

This is actually quite easy. Use similar steps when exporting to any other spreadsheet program:

1. First, save the data as text.
   a. Select **Save As** from the **File** menu, and
b. In the **Save As Type** box, choose **Text**. The file is now a text file with the format described on page 90.

2. Allow Excel's Text Import Wizard to open the data.
   - When you open the file in Excel, the Text Import Wizard will automatically appear.
   - The default settings will open the file correctly.
   - The original data type is Delimited.
   - You can start the import at any row you like, but 4 or 5 are good.
   - The file origin is Windows (ANSI).
   - **iPLab** text files are tab delimited.

### 7.1.16 Print

The **Print** command sends the current view of the data window to the printer. The keyboard-shortcut is Ctrl + P.

### 7.1.17 Print Preview

The **Print Preview** command displays a view of what the printed image will look like.

### 7.1.18 Print Setup

This command sets up the printing parameters. The dialog will depend on which printer driver you are using.

### 7.1.19 Set Print Resolution

Use this command to change the print resolution for the active image. The dialog asks you for the horizontal and vertical resolution in dots per inch.

### 7.1.20 Recent Images

Click on this "command" to see a list of open images. You cannot script this command nor assign it to a function key.

### 7.1.21 Recent Scripts

Click on this "command" to see a list of open scripts. You cannot script this command nor assign it to a function key.

### 7.1.22 Exit

This commands **iPLab** to quit. Before **iPLab** quits, though, it asks if you want to save any windows that have not been saved since they were last changed. You may then choose to save them, not save them, or cancel the **Exit** command.
The **Exit** command is scriptable. If you select the **Exit** command while a script window is active, a dialog appears to prompt you for a delay time in seconds. This is the amount of time the **iPLab** will wait before actually quitting. During this delay, you may continue to work normally in **iPLab** to perform any clean-up operations you think are necessary.

You can type Ctrl + Q to quickly exit **iPLab**.

**7.2 Edit Menu**

**7.2.1 Undo**

Use this command to undo the last operation that you applied to an image. If the command is dimmed, the operation is not "**Undo-able.**" **Undo-able** commands include most commands in the **Enhance** menu. Use **Repeat Last Command** together with **Undo** to toggle between two views of an image--one with and one without processing. Since **Undo** uses the command key combination Ctrl-Z, and **Repeat Last Command** uses Ctrl-R, you can quickly toggle between the pre- and post-processing views with two keystrokes.

**7.2.2 Purge Undo Buffer**

Use this command to free up any memory that has been assigned to the undo buffer. If you perceive slow computer performance, you may want to use this command since a large undo buffer can affect the speed of operation of **iPLab**.

**7.2.3 Repeat Last Command**

Use this command to re-apply the last command you executed. The advantage to using this command is that the dialog for the command does not appear. Use **Repeat Last Command** together with **Undo** to toggle between two views of an image--one with and one without processing. Since **Undo** uses the command key combination Alt-Z and **Repeat Last Command** uses Alt-R, you can quickly toggle between the pre- and post-processing views with two keystrokes.

**7.2.4 Cut**

The **Cut** operation applies to data windows. It is used simultaneously to copy information to a paste buffer and to clear the data selected by the ROI. First, the data within the ROI is copied, as if the **Copy** command were applied (see **Copy** command below). Then the data values of all the pixels within the ROI are set to the value 0.

**7.2.5 Copy**

The **Copy** operation applies to data windows. It is used to copy information to a paste buffer so you can place it in another window with the **Paste** command. The image data within the ROI is copied.

The image data is copied to a paste buffer so you can paste the sub-image onto another image within **iPLab**. When you copy text data, the copied text goes to the Clipboard so you can paste that data into another application (such as a word processor or a spreadsheet).
7.2.6 Paste

The Paste command places the contents of the paste buffer into the active image and allows you to drag the pasted clip around within the new image using the mouse by placing the cursor inside the pasted clip, holding the mouse button down, and dragging. Once you double-click the mouse anywhere outside the pasted data, or press the enter key, the new data replaces the data in the pixels which it overlays.

After performing the Paste command on an image, the paste region will be the ROI.

7.2.7 Clear

The Clear operation applies to data windows. Use it to set all the pixels within the ROI to the value 0 (black).

7.2.8 Select All

The Select All operation applies to the active data window. Use this command to set the ROI to the entire image. When this is done, you will see the moving dotted line around the edges of the image window.

7.2.9 Define ROI

This command allows you to specify a rectangular, oval or linear region of interest (ROI) for an open window. It is an especially useful command to insert into a script where you may wish to set a particular ROI without interrupting a running script.

[Image: Define ROI Dialog Box]
**Window:**
Type in the name of an open window, or choose file name from the combo box. You can also choose the **First Image** (the active, front-most window), **Last Image**, or the **Second Image**, which let you pick windows without knowing their names. That is very useful when scripting the Define ROI command.

**ROI Shape:**
Make an ROI (select an area) in the shape of a rectangle, oval, or line, or in the shape of a selected drawing object.

You can think of line ROIs as boxes with widths of a single pixel.

Choose Selected Drawing Object after you use the Drawing Object Selector tool (the black arrow button) to click on a drawing object. This will create an ROI with the same shape as the drawing.

**Define Bounds:**
The Define Bounds radio button allows you to enter the bounds of the selected ROI as left, right, top and bottom values. The ROI will include the left and top edges, but will not include the pixels on the right and bottom edges. For example, if you want to define a region 40 pixels wide and tall, extending from the point \((x,y) = (10,20)\), and to include that point, you should use left = 10, top = 20, right = 50, and bottom = 60.

If you enter boundary parameter values (or if the IPLab variables generate such values) resulting in an ROI larger than the image, then the ROI will be clipped to the dimensions of the data. If, for example, you want to process all of an image except the top row, but you do not know the exact dimensions of the image, set the Define Bounds to left = 0, top = 1, right = 32767, bottom = 32767.

**Centered At:**
The Centered At radio button allows you to select an ROI with a specified center point. Notice that selecting this radio button changes the parameter boundary fields. For example, if your image is 256 x 256 and you want to define an ROI that is 20 pixels tall and wide in the center of the image, you should use \(x = 128, y = 128,\) height = 20, width = 20.

**Entire Image:**
This places the edges of your new ROI at the absolute edges of the image.

**Within ROI Bounds:**
This will draw the ROI shape within the boundaries of the current selection box. If the current ROI is a rectangle, then choose an oval shape to replace the rectangle with an oval. The boundaries of the current ROI are displayed below the Within ROI Bounds option.

### 7.2.10 Modify ROI

The Modify ROI command can:
- Move the ROI by a specific translational shift (moving it side to side, up and down), and
- Make the ROI smaller (inset) or bigger by specific amounts.
For the Translate parameters, positive values for X and Y move the ROI rightward and downward. Negative values move it leftward and upward. For the Inset parameters, positive values make the ROI smaller, while negative values make it bigger (the opposite of insetting).

If the translation parameters you specify would move the ROI off the top or bottom edge, an error will be generated and the region would not be translated.

### 7.2.11 Set ROI Value

The Set ROI Value command sets the pixel intensity of the region of interest.

Enter the intensity value in the Parameters field. This is also called a fill value, since the entire ROI will be filled with this value.

You may enter integer or floating point values for the fill value. However, if you enter values outside the dynamic range of the data type, the exact value used may be unpredictable.

In color images, all three channels will be filled with the same intensity, producing a gray color. Use the Set ROI Color command to fill a region with color.

The keyboard shortcut for this command is Ctrl + Enter.
7.2.12 Set ROI Color

The Set ROI Color command sets the color of the region of interest within a color image. Like the Set ROI Value command, the Set ROI Color sets the color components of each pixel in the ROI.

Set ROI Color Dialog Box

In Window: Choose the target window whose ROI will be filled with color. Choose *First Image* (the active window) or any open window.

Red, Green, Blue: Pick the color you want by moving these three sliders, or by typing values in the text boxes.

ROI Color: This box contains the color made by the RGB values in the three text boxes. This color will be displayed using the image window's normalization values, when possible, so that this preview will look like the final result.

7.2.13 Insert Frames

The Insert Frames command adds one or more image frames to a single image or to an image sequence.
1. In the **Insert** field, you can type the number of frames to add, or you can enter a variable that contains that number.

2. You may insert image frames into an image window’s Z- or T-series.

3. Select which image window gets the frames.

4. Finally, determine where in the target sequence you want to place the image frames.

### 7.2.14 **Delete Frames**

The **Delete Frames** command removes one or more image frames from an image sequence.
The dialog lets you choose the image sequence and specify the range of frames to be deleted. Toggle the # buttons to V to obtain the range of frames from IPLab variables.

Deleting the last frame closes the window immediately, so be sure to save any desired changes before deleting the last frame. Your file will still contain all the data from when you last saved it, as images cannot really have zero frames.

### 7.2.15 Transfer Frames

The **Transfer Frames** command copies a series of image frames from one image sequence to another.

![Transfer Frames Dialog Box](image)

**Transfer From:** Choose the open window that holds the desired frames.

**Frames Through of the Z or T Series:** This is the range of frames to be transferred. When transferring Z frames, this command keeps both image sequences at their current T frame, and vice versa.

**Transfer To:** Choose the open window that will receive the frames.

**Frame:** Choose whether you want to **Insert Before** this frame number, or **Replace Frames Starting at** this frame number.

You can retrieve these parameters from variables by toggling the # button to V.
### 7.2.16 Convert Z series to T

The Convert Z series to T command allows you to change the dimension in which your images were stored. This command changes an image sequence where all the frames are in the Z dimension to one where all the frames are in the T dimension. This could be useful if you acquired the data into the wrong dimension, or if you needed to match the dimensions of two image sequences, or if you wanted to use a processing command that only worked on time-lapse image sequences.

**Convert T series to Z**

The Convert T series to Z command allows you to change the dimension in which your images were stored. This command changes an image sequence where all the frames are in the T dimension to one where all the frames are in the Z dimension. This could be useful if you acquired the data into the wrong dimension, or if you needed to match the dimensions of two image sequences, or if you wanted to use a processing command that only worked on through-focus Z image sequences.

### 7.2.17 Assign Function Keys

Use this command to assign menu commands and scripts to your keyboard's function keys. Once the keys are assigned, pressing the key executes the command or script.

![Assign Function Keys dialog](image)

To assign a command to a particular key, click on the key name, then select a command from the menus and fill out its dialog normally. When you click **OK** in the command's dialog, it will be assigned to the function key, replacing any previously assigned command. To remove a command assignment from a key, click on the key name, and then click on the **Clear Selected** button.
You can also assign commands to **Shift**-function key combinations by selecting the **Shift** modifier option. To do this, select **Shift** from the pull-down box at the top of the dialog box. When the pull-down box at the top of the dialog reads **Shift**, then only commands assigned to **Shift**-function key combinations will be displayed. To perform these commands, press the **Shift** and function keys at the same time. Conversely, when the pull-down box reads **Unmodified**, then only commands assigned to the lone function keys will be displayed. The **Shift** modifier doubles the effective number of function keys.

To assign a script to a function key, select **Run Script** from the **File** menu and then select a script from the **Run Script** dialog. When you press the key, the script will be run as if you had selected **Run Script** from the **File** menu.

When you double click on any command in the dialog, you get the **Edit Function Key** dialog box. This allows you to edit the descriptive **Comment** that appears in the **Assign Function Keys** dialog box. You can also click on the **Params** button and edit the command assigned to the function key.

![Edit Function Key Dialog Box](image)

**Show Dialog:**

Check this box if you want the command dialog to appear when you press the function key. If this box is not checked, pressing the function key will execute the command with the parameter values that you entered when you attached the command to the function key.

**Params:**

Click on this button to bring up the command’s dialog so you can change the parameter values.

**Comment:**

Enter a comment that will appear on the same line as the command in the **Assign Function Keys** dialog box.

**7.2.18 Time Lapse - FKey**

A time-lapse process is simply the repetition of one or more commands with some dead time between each repetition. The **Time Lapse - FKey** command repeats the action of a function key with dead time between each repetition. This enables you to turn any sequence of commands into a simple time-lapse script.
To use this command, you must first assign a command to a function key. This would be the command that you want to repeat over time. Do this using the Assign Function Keys command (Edit menu). Then open the Time Lapse - FKey dialog box and choose the desired function key (a.k.a. F-key). You can choose to use unmodified F-keys (which just means that you do not press any other buttons) or Shift - F-key combinations.

There are three parameter values in the Calculated Value section of the dialog box: Iterations, Interval, and Experiment Length. The number of Iterations is the number of times you want the process to be repeated. Interval is the length of time between the starts of two iterations. Experiment Length is the total amount of time taken by the time-lapse experiment.

You may choose which value will be calculated. The value that you select will be grayed out because it will be calculated for you. You must enter numbers for the other two. If you click on Experiment Length, for example, then it will be grayed out. You would then have to enter the number of repetitions into the Iterations field and the length of time between iterations into the Interval field. The dialog box would automatically calculate the Experiment Length.

Changing the units used for Interval and Experiment Length does have an effect on the calculated values. The available units of time are milliseconds (ms), seconds, minutes, and hours. You can choose for any parameter (except the one to be calculated) to be taken from a numeric variable. Do this by toggling the # button so it reads V. Then enter the number of the variable where the parameter is stored. When a variable has been given for a parameter, the grayed out calculated value field will disappear. This is because the result of a calculation dependent on a variable cannot be completed until the command is executed.

7.2.19 Set Row/Column Label

The Set Row/Column Label applies a character label to a specific row or column in a text view window.
Set Row/Column Label

You can alter the label of a row or a column and click the Apply button to review your changes. You can enter a maximum of 20 characters, including spaces.

7.2.20 Transfer Attributes

The Transfer Attributes command copies certain useful image characteristics from one image to another. These useful characteristics are not part of the image itself, but are information that has been added to the image to improve its display and utility, such as the Color Table (CLUT) and Normalization values.

This command is grayed out when no images are open.

Transfer Attributes

In the From Window drop-down box, select the source window that already contains the desired attributes. When First Image is selected, the attributes will be copied from the front, or highlighted, window. When choosing the transfer's destination, you can choose to copy the attributes To: All windows or To: a specific window. You pick the specific, open window from the To: Window drop-down box.
These are the attributes that can be transferred:

**ROI Definition:** This selects the same Region of Interest on every window of the same size as the source window. Windows of a different size will not be affected.

**Length Units:** The Define XY Units command (Analyze menu) lets you define measures of length for an image. That lets IPLab report measurements in your units of choice (microns, centimeters, etc.). Transferring the length units from one image to another lets you define the XY units in one image and then use them in others.

**Norm... Settings:** The Normalization Settings option transfers the display parameters set by the Normalization command (Enhance menu).

**Color Table:** Transferring the color table means that both the source and the destination images will be displayed using the same colors.

*IPLab* uses the color table (also called the CLUT) to assign colors to pixel values in indexed color images. (Please see the Operation chapter for more detail on the color table and indexed color images.)

If you pseudocolor the source image (using the Enhance menu command Pseudocolor), then you can transfer that pseudocoloring by transferring the color table.

**Exp Log:** "Exp Log" stands for the "Experiment Log" produced by several acquisition commands.* The experiment log records how data was captured, including the exposure times and filter wheel positions. You can view the experiment log by clicking on the image’s I (info) button.

The Extract Image Info: Acquire Info command places the same information into variables.

* Acquire and Multi Dimensional Acquire from the Camera menu; and Ratio Acquire and Single Wavelength Acquire from the Ratio Plus extension.

**Segment Layer:** This replaces the segments in the destination window with the segments from the source window. This is extremely useful when you want to pick which regions to measure within one image, and then perform those measurements on multiple images.

**Plot Settings:** This transfers the display parameters for plot views (graphs). Set those parameters using the command View Options: Plot, from the View menu.

**Drawing Objects:** This transfers all the drawing objects from the source to the destination window.

**Registration Marks:** This transfers all the registration marks from the source to the destination window.

**OK/Cancel:** The selected attributes will be transferred when you click OK. No changes will be made if you click Cancel.

### 7.2.21 Stamp Overlays On Image

This command transforms the segment and drawing layers into parts of the image, creating a new Color 24 image. This also removes the overlays from the image.
Stamp Overlays on Image also applies normalization and pseudocoloring to the data (by replacing the data with its CLUT values). What was the display becomes the data. (This resembles the function performed by the Convert to 8/24 Bit command in the Math menu.)

This command creates a new Color-24 image with "_STAMP" appended to the original image name.

Note: Data beneath the overlays will be obliterated! Save your original data before using this command.

7.2.22 Preferences

Use this command to set certain global abilities in IPLab.

Preferences Dialog Box

Message Level: Enter value 0 if you want to see every possible error message IPLab can generate. Enter 9 to see only the most severe error messages. Values between 0 and 9 allow various levels of error messages to pass through to the user. This is useful for blocking out unwanted information or expected messages. All messages will be reported in the Messages window, however.

Message Level (Script): As above, but this applies to error messages generated while running scripts. Errors can still stop a script even if you do not see the message.
Number of Digits…: The Number of Digits to Append to Indexed Files can be from 1 to 9. This is the number of zero-filled digits that will be added to the end of the base name in an indexed file (e.g. "FileName00006" has a 5-digit index added to its base name). See the description of the Indexed Files command under the File menu.

Save New Files As: This is the file format to use by default save new images.

XY Units: Using the Define XY Units command (Analyze menu) upon an image, you can define distances within the image in units other than pixels. These three options (described immediately below) allow you to determine when locations and distances will be displayed in those units.

- **Always Display Units:** When this radio button is selected, locations and distances will always be displayed with the units you defined for the image.
- **Caps Display Units:** When this radio button is selected, locations and distances will be displayed with the units you defined whenever the Caps Lock key on your keyboard is down, and in pixels when it is up.
- **Caps Display Pixels:** When this radio button is selected, locations and distances will be displayed in pixels whenever the Caps Lock key is down, and in the units you defined when it is up.

Open Data Windows Minimized: When this box is checked, all new data windows are created minimized. Since minimized windows take much less time to display and update, using this option can increase the speed of many image processing operations in a script.

Permit Script Editing: With this box checked, you can edit scripts; otherwise, you cannot. With this box unchecked, you can be sure that the users of your scripts cannot accidentally modify those scripts.

Data Undoable: With this box checked, you will be able to undo most changes to data within IPLab. This does not affect changes to normalization, CLUTs, or segments. Since Undo requires more memory processing time, you may want to uncheck this box when time or memory is critical.

Use the CLUT for Text View: Data viewed as text appears as an array of pixel intensity values. When this box is checked, each cell in the array is colored according to the color look up table (CLUT). This visually relates the number with the intensity that it represents.

Open TIFF Stacks… TIFF image sequences (stacks) do not contain information about whether the third dimension is time or depth. By default, IPLab treats the third dimension in a TIFF stack as Z. The Open TIFF Stacks as T-Sequence not Z option changes this default so that TIFF stacks can be opened as time sequences.

Save: Replace Without Warning: Checking this box prevents the alert dialog that appears when you save new files overttop old files. With this checked, you can save new files, replacing the old ones, without being interrupted by warning dialogs. Of course, be careful not to overwrite valuable data.
Use Indexing for Captured Images:  When this is unchecked, newly acquired images will have the name set by the Acquire command, in the General tab’s Image Destination: New field. When this option is checked, however, newly acquired images will get that name plus an index number. This makes it easier to identify and sort your data.

Show Device Toolbar Labels:  Adds text to the icons on the Device Toolbar. When this option is unchecked, the Device Toolbar buttons are smaller.

7.3 View Menu

7.3.1 New View

Use this set of commands to make a new window containing the image data displayed as Image, Text, Plot (graph), Histogram, Linear Profile, Skewed 3D and/or Contours. You can make as many such windows as you wish; however, each window is a view of the same data. Therefore, if you make a change to one of the views of an image, you will see the results in all the other views. You can animate the image, and see it move in all views of that data.

Plot View

The plot view is used for histograms and intensity slices. You can use this view for any kind of data, even images, but the data is presented as plotted columns. The View Options: Plot command allows you to configure the plot settings. You can also zoom in on a portion of the plot by dragging a selection box over that portion.

Right-click on a plot to open the Plot Options dialog, which is described on page 142. There, you can choose the data to graph and set the graph’s appearance.

Histogram View

The histogram view is a bar graph that shows the frequency with which pixel intensities occur. The normalization indicator (the dashed, pink line) graphs the gamma curve being used to display the image data. You can use this to judge the best gamma value for displaying your data.

Right-click on the histogram view to see its options dialog:
The histogram divides the pixel intensities into groups called "bins." You can define the smallest and the highest intensities that you want graphed. To do so, check the Use Data Min/Max box to use the minimum and maximum values within the data, or enter values in the Min. Bin and Max. Bin fields. Next, enter the number of bins (No. Bins), which divides the range of intensities into bins. To have one bin for each intensity, check (Max - Min) + 1.

Uncheck Show Normalization Indicators to hide the dashed, pink gamma curve. Uncheck Show Title and Axis Labels to hide the histogram's text and axis numbering.

**Linear Profile View**

The Linear Profile view displays the average intensity at every point along a linear ROI.

1. First, select using the Line ROI tool.
2. Then use this command.

   The profile will open in its own window.
   
   - To zoom in on the plot, select part of the linear profile.
   - To zoom out and view the entire plot, click on the profile again.
   - To set its parameters, right-click on the linear profile. The parameters are described below.
Options for the Linear Profile View

**Line Width:** Measure the average intensity of a thick line whose width is centered on the linear ROI. The line width is limited by the ROI's distance from the window's edge. If the linear ROI is 35 pixels from the edge, then the line width cannot be more than 70 pixels wide (35 pixels on each side of the ROI).

**Show Entire Line:** Uncheck this to define which part of the line to show.

**Use Data Min/Max:** Uncheck this to define your own limits to the plotted intensities.

**Display Image Slide:** The image slice is the data within the ROI. **Show Actual Data** displays the real pixels along one of the borders of the window. **Show Plot Data** places the averaged intensities behind the plot.

**Horiz. Orientation:** When checked, the profile is horizontal, with intensity plotted along the Y-axis. Unchecked, the profile will be plotted vertically.

**Invert Profile:** Flip the average intensity values, so that higher numbers are closer to the plot's origin. You may want to do this when looking at bright-field images, so that spikes in the plot, and not pits, represent higher-absorbance regions.

**Extract Plot:** Clicking this button puts the linear profile data in a new window. This data will be displayed as a plot of Length vs. Intensity.

- You can see the numerical data by choosing **New View: Text** from the View menu.

View Menu
• You can export the data to Excel using the **Export: Export to Excel** command (File menu).

• You can also save the extracted data as text and open it up in other programs.

**Skewed 3D**

The skewed 3D view shows you a spatial representation of your three-dimensional (x,y,z) image sequences. This view displays your data as a plane within a column; its height within the column represents its position within the Z stack. If your image has multiple time points, the Z stack for the current time point will be displayed.

**Contour View**

The contour view divides your image into regions of intensity ranges.

Right-click on the contour view to display its options:

![Options for Contour View](image)

**Options for Contour View**

- **Min, Max:** Enter the range of intensities you want to see in the Min and Max fields.
- **No. Levels:** Split that range of intensities into this number of steps.
- **Outline Only:** Check this to see the outlines of the contour regions on top of a black background. Uncheck this to see the filled, posterized regions.
- **Apply, OK, Cancel:** Click **Apply** to see your results while the dialog box is open. Click **OK** to apply the parameters and close this dialog. Click **Cancel** to close without changing the parameters.
7.3.2 View Options

Text Options

The View Option: Text command controls the appearance of the text view.

These options do the following:

• Set the number of decimal places that will be displayed.
• Display the numbering for the rows and columns (the indices).
• Show the zeroes that pad the fronts of numbers.

For example, the datum "3" in a Byte image would normally be shown as "003." Without padding, it would be shown simply as "3."

Plot Options

Use this command to customize the appearance of a plot view window. A plot view contains a graph of the columns of data in a data window. The Plot Options dialog consists of a series of tabs: Gallery, X-Axis, Y-Axis, and Columns.
Gallery Tab in the View Options: Plot Dialog Box

**Gallery Tab:**

**Plot Type:** This radio button group allows you to select the type of plot. **IPLab** offers you two types of plots: **Lines** and **Bars**.

**Title:** Type in the title that you wish to display on the plot.

**X Axis:** Type in the label for the X-axis in this editable text box.

**Y Axis:** Type in the label for the Y-axis in this editable text box.

**Font:** To change the font of any of the labels (Title, X-axis or Y-axis) click on the **Font** button next to it.

**Grid Color:** Clicking on this patch of color allows you to set the color of the grid on the plot.
Background Color: Clicking on this patch of color allows you to set the background color of the plot.

X-Axis Color: Clicking on this patch of color allows you to set the color of the X-axis.

Y-Axis Color: Clicking on this patch of color allows you to set the color of the Y-axis.

X-Axis Tab in the View Options: Plot Dialog Box

Tick Spacing: This radio button group allows you to customize the tick spacing along the X-axis of your plot. If you select the Automatic tick spacing, IPLab will determine the optimum tick spacing based on the limits of your data. If you select Delta, you should enter the tick spacing that you wish to use in the editable text box provided.

Tick Label: This radio button group allows you to customize the tick label along the X-Axis of your plot. Selecting Fixed will display the tick labels in fixed numeric notation (e.g. 10, 20, 30 etc.). Selecting Scientific will display the tick labels in scientific notation (e.g. 1e+2, 2e+2, 3e+2 etc.) You may choose the number of decimal points to which
you wish to display the tick labels by entering this number in the Decimal Places editable text box.

**Range:** If you check Use Data Min/Max, then IP Lab computes the minimum and maximum values for that coordinate and uses those values as the endpoints for that axis. Alternatively, you may enter Min and Max value for the endpoints of each axis.

**Scale:** You can select to display the plot in either a linear or a logarithmic scale.

**Use Y Axis Settings:** Clicking on this button will make the settings of the X-axis the same as those for the Y-axis.

**Set Y Axis the Same:** Clicking on this button will make the settings of the Y-axis the same as those for the X-axis.

**Y-Axis Tab:**

The Y-Axis tab is just like the X-Axis tab.

![Plot Options](image)

Columns Tab in the View Options: Plot Dialog Box
**Columns Tab:**

Use this tab to specify which columns of the data set are to be plotted. You must tell IPLab which columns of data to use. You may plot up to 35 columns simultaneously. Only those columns identified with a check will be plotted.

**Line Width:** You can type in the line width of the plot here.

**Line Color:** Clicking here allows you to set the line color.

**Token:** Clicking here allows you to select a token for your plot.

**Token Color:** Clicking here allows you to select a color for your token.

**Clear/Select All:** Click these to empty or check all of the checkboxes, clearing or drawing all of the plots.

**Arrows:** The dialog box can only display 10 rows at a time. Click these arrows to scroll through all 35.

### 7.3.3 Show/Hide Image

The **Show/Hide Image** command is used to display data in an active window, which shows “...Image Data Not Displayed.” Once this command is executed, all changes to the data resulting from any commands are also displayed.

If your data is currently displayed, you can use this command to hide the image or plot in the active window. Once this command is executed, all changes to the data are also hidden. Hiding data avoids the added delay of display normalization each time a change occurs. When you do not need to see the intermediate results of a sequence of processing commands, leave the data hidden to obtain significantly faster performance, especially with floating point manipulations.

### 7.3.4 Home Image

The **Home** command scrolls the image down and to the right as far as it will go so that the (0,0) point in the images lies at the top left corner of the window.

### 7.3.5 Select Frame

This command applies only to a multi-dimensional image set, *i.e.* an image window that has more than one Z and/or more than one T frame. This command selects which frame you want to view. You can use the arrow buttons on the left side of any image window to navigate through a multi-dimensional image interactively; however, this command provides a scriptable way for you to do the same thing. This means that you can set up a script to step through each frame in a multi-dimensional image for processing or image capture.
You can select the Z and T planes separately or both at once by clicking a radio button in each column.

**Do Not Change:** Set this if you want a dimension, either Z or T, to remain constant.

**Select Previous:** Set this to change to the frame before the current one. This decreases the Z or T value by one.

**Set Z/T To:** Use this option to jump to any specified frame in the data set. Enter the value directly with the # option, or use the V option to choose a variable number.

**Select Next:** Set this to change to the frame after the current one. This increases the Z or T value by one.

### 7.3.6 Select Display Channels

When viewing color images, you can use the **Select Display Channels** command to select which of the three color channels (red, green, or blue) you want to view. This command merely hides channels; it does not change the data at all.

### 7.3.7 Zoom

Script the **Zoom** commands to make an image look larger (**Zoom In**, or magnify) or smaller (**Zoom Out**, or de-magnify). Each zoom changes the magnification by a factor of two. The window will expand or contract to fit the image, if possible.

You can magnify up to 16 times the original image size. There is no limit to the demagnification factor.

There are two other ways to zoom in and out on an image:
- Click the right mouse button on the image to zoom in. Hold down the **Control** key and click the right mouse button on the image to zoom out.
- Use the magnifying glass tool buttons (🔍🔍) to zoom in and out.

You can make the **ROI Tools** toolbar into a floating palette by clicking on its edge and dragging it off the side of the application window. You can re-dock it elsewhere by moving it over the application window's border.
7.3.8 Show/Hide ROI

When the ROI is showing, a thin, blinking, dotted line outlines the ROI in data windows. The Show/Hide ROI command shows the dotted line if it is currently hidden and hides the dotted line if it is currently showing. It does not affect the actual location of the ROI. All commands that operate on the ROI work the same whether the ROI is shown or hidden. This command also hides the ROI within text views.

7.3.9 Display ROI Only

Use this command to limit the display of the image to only what is within the bounding box of the ROI. The surrounding portion of the image is then displayed as black. This is especially useful when trying to focus during image acquisition. When you display only an ROI that is much smaller than the entire image, the image update is much faster.

7.3.10 Force Update

Use this command to force the image display to update.

This is generally not needed unless you encounter a problem when running a script where the image display is not updated. While a script is running, some processing and analysis commands may not always update an image because this takes extra time.

A dialog prompts you for the name of the window you wish to update. It may be the front window or any other window.

7.3.11 Animate

Use this command to simulate a movie by rapidly cycling through and displaying all of the frames in an image sequence. You can animate either the Z or the T dimension while holding the other dimension constant.

You can also animate an image by clicking on and holding down one of the Z or T arrow buttons on the image’s window border. When doing so, sequences will play at the speed (frames per second) set in the Animate dialog.

[Image of Animate Dialog Box]

Animate Dialog Box
You can either animate the images **Forward** (increasing values of Z or T) or in **Reverse** (decreasing values of Z or T). When the end of the image sequence is reached, the animation resumes at its starting point. If you select **Oscillate**, the animation starts by increasing Z or T, and then reverses when the upper limit is reached.

You can specify how long to continue the animation in the upper right corner of the dialog box. If you select **Until User Stops**, then the animation will repeat until you halt it by hitting the Escape key or by using the command **Stop Animating** (View menu). If you click the radio button beneath that one, you can enter the exact number of **Times** that you want the animation to repeat.

Specify the speed of animation you want in the field labeled **Frames/Sec**. If you enter a speed faster than **IPLab** can produce on your computer, it will animate at the fastest possible speed. Other software running on the computer will affect the animation speed.

**Animate** works on image sequences of any data type, although in order to animate images of non-byte type, each frame must be normalized, which can slow down the animation speed substantially. To help this speed issue, you should consider setting custom normalization parameters. This normalization option reduces the time it takes to do normalization by eliminating the step that finds the minimum and maximum pixel values in each frame.

### 7.3.12 Stop Animating Document

This command stops the animation of the front image. It is only available when the **Animation** command is being used. Pressing the **Escape** key also stops animation of the front image.

### 7.4 Enhance Menu

#### 7.4.1 Normalization

The **Normalization** command improves the display of the image without changing the data.

In order to display non-Byte images, which can have thousands or even millions of gray levels, the data must be mapped into values between 0 and 255. **Normalization** does this by controlling the mapping of the data values to display values. This provides you with two entities: the data, on which the program performs measurements, and the display of the data, which you visually judge.
Normalization Dialog Box for a Grayscale Image

Normalization Dialog Box for a Color Image
Normalization Methods

All of the normalization methods work by defining the black and the white points, which are the data values that will be shown as black and as white. All data values in between will be shown according to their gamma value.

Frame: This is the default method for image data. In this case, *IPLab* will normalize the image based on the minimum and maximum pixel values of the image frame.

ROI: In this case, *IPLab* finds the minimum and maximum value of the image pixels within the ROI. This allows you to concentrate your attention in a specific region of the image. When you select this option, other parts of the image may appear saturated, *i.e.* all black or white, but the pixels within the ROI will be displayed with the maximum contrast possible.

Sequence: This option will normalize the image based on the minimum and maximum values within an image sequence.

Saturated Frame: This option produces a histogram of the image frame and sets the Normalization values so that 1.0% of the histogram's extremes are saturated.

Saturated Sequence: This option produces a histogram of the image sequence and the Normalization values so that 1.0% of the histogram's extremes are saturated.

Manual: Normalize the image manually by using the Brightness, Contrast, and Gamma arrow buttons, or by setting the parameters in the Advanced section at the dialog box's bottom. Click the Advanced arrow and an extended dialog box will open, revealing several additional Normalization features.

Brightness, Contrast, and Gamma Arrow Buttons

The buttons let you manually adjust the brightness, contrast, and gamma of the image. The double-headed arrows cause big changes; the single arrows cause small changes. The circle in the middle returns the setting to its default in the middle.

If you open the Advanced section, you will see that increasing Brightness lowers the white point and the black point, showing more of the image as white and less of it as black. Increasing Contrast moves the two points together. Increasing the Gamma increases the gamma and Mid At values, of course. That results in dimming the lower data values.

The Advanced Section: Manual Control

Click the Advanced arrow to show or hide the manual-control section of the dialog.

R, G, B, All the Same: When working with a Color 24 or Color 48 image, you can set the Normalization parameters separately for the red, green, and blue channels. With the option All the Same, you can adjust the three channels simultaneously.

Grayscale Intensity: This radio button appears if you are working with grayscale images (specifically, data types other than color 24 or color 48).
Enhance Menu

152

View Saturated…:
When you check the View Saturated Pixels box, the minimum display value will be colored blue, and the maximum display value will be colored red. You can see this both in the image and in the grayscale bar atop the dialog box.

Black At, White At:
Set the black and white points using the sliders or text-entry boxes. All data values less than and equal to the black point will be shown as black. All data values greater than and equal to the white point will be shown as white (or the brightest shade of the channel's color).

Mid At:
The mid point controls how evenly the whole ranges of data values are normalized. A mid point of 50 corresponds to a gamma of 1.00. Increasing the Mid value increases the gamma, which dims the appearance of lower-intensity data.

The mid point represents where medium gray (50% gray) should be displayed between the black and white points. A mid point of 50 creates a linear scale, centering medium gray between white and black. Changing this value to less than 50 would skew medium gray towards black, increasing the contrast between darker values (by compressing darker values) and decreasing the contrast between lower data values (by stretching the range for lighter values).

Gamma (mid point) correction is often used to correct for the effects of nonlinearities in the image acquisition or display process. Any gamma setting other than 1.00 creates a non-linear mapping of the form:

\[
\text{Displayed value} = \left(\frac{(\text{normalized value} - \text{min})}{(\text{max} - \text{min})}\right)^\gamma
\]

Histogram:
The histogram plots the pixel count (Y-axis) against the pixel intensities (X-axis). This is a good tool for judging the population sizes of data values.

Apply:
You may experiment with your settings by clicking on the Apply button at any time. This performs the Normalization but leaves the dialog open for you to try different settings.

7.4.2 Color Balance
The Color Balance command removes unwanted tint from a color image.

For example, it will fix an image that comes out too pink or green. To balance the colors, first select a small region of the image. Pick an area that should be white, black, or a shade of gray. Then choose the Color Balance command. When you click OK, the undesired tint will be gone from the entire image.

Note: You should save your data first because this command does alter it.

Color Balance measures the mean of the red, green, and blue channels within the selection. It then scales the values of each channel to make their means equal. The ROI will be white, gray, or black, and the colors in the rest of the image will be scaled to match. This modification removes the undesired tint from the colors outside the ROI. The weight factors for the red, green, and blue channels are placed in variables #220, 221, and 222, respectively.
Color Balance **Dialog Box**

Remember, you should select a gray, white, or black region of interest before choosing this command.

Check the **Apply to All Frames** checkbox to color balance an entire image sequence using the same values.

### 7.4.3 Image Ratios

**Image ratios** are used in a variety of applications to correct or calibrate image data. **IPLab** provides a single command with options for three different forms of the ratio. The formula for the selected option is displayed beneath the radio buttons. You may apply the command to any open image window, not just the active window.

**Image Ratios** **Dialog Box**

<table>
<thead>
<tr>
<th>Ratio Method</th>
<th>Formulae Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Flat Field</strong></td>
<td>Mean(Uniform - Dark Uniform) * (Data - Dark Data)</td>
</tr>
<tr>
<td><strong>Ratio Only</strong></td>
<td>Numerator - Dark Numerator</td>
</tr>
<tr>
<td><strong>Optical Density</strong></td>
<td>Denominator - Dark Denominator</td>
</tr>
</tbody>
</table>

Enhance Menu
**Optical Density:** \[ \log \left( \frac{\text{Numerator} - \text{Dark Numerator}}{\text{Denominator} - \text{Dark Denominator}} \right) \]

**Flat Field** is generally used to correct for defects or non-uniformities in an imaging detector array and non-uniform lighting. Such non-uniformity is really a “multiplicative noise” problem, so it requires a division operation to correct defects. This correction method is more accurate than simply subtracting the background, although background subtraction is often performed to correct for uneven illumination because it is so simple.

The **Flat Field** option is performed “in place;” that is, it changes the values in the data window, and leaves the image in the same data type as the original. To perform a flat field operation on a given image, you should capture three images:

1. A dark current image, such as an image taken with the camera shutter closed,
2. A uniform field, such as an image of an evenly illuminated field (a blank field without a specimen in the field of view), and
3. A data image, such as the image to be corrected.

If you are using a camera that has a programmable integration time, be sure all three images have been captured with the same integration time. Although you get the best results if you have both the dark current image and the uniform field image, you can do some illumination correction with background subtraction only. If you do not have a uniform field image, you can just leave that name field blank, in which case the denominator is set to a value of 1.

The **Ratio Only** option produces a new image that is Floating Point type. Use this option to produce a more accurate flat field result, or to perform ratios for images taken at two different wavelengths, such as for fluorescence ratio imaging studies. In the latter case, instead of a uniform image, you should use an image taken at one of the wavelengths. To get the best results, you should take two dark current images, one at each wavelength. If you do not have the dark images, you can just leave those names blank.

The **Optical Density** calculation is similar to the **Ratio Only** calculation, except that a base 10 logarithm is performed after, the ratio is taken.

### 7.4.4 Equalize Contrast

This command enhances the image’s contrast by computing the “optimum” transformation on the color table or the image data.
To use **Equalize Contrast**, please do the following:

1. Choose the window whose contrast is to be equalized. You can choose from all open images.

2. Choose to equalize either the **Image Data** or the **CLUT** (color look-up table):
   - **Image Data:** Equalizing the data values themselves changes the data in the ROI. If you change the data values, then the CLUT is not affected.
     - You should change the data values if
       - you want to make part or all of the image look better, and
       - you do not care about specific data values, particularly if you plan to export the image to another computer.
   - **CLUT:** Equalizing the CLUT does not affect the image data values at all.
     - You should change the CLUT if you want to maintain the data values for quantitative analysis.

The **Equalize Contrast** command does the following:

1. Computes the histogram of the image.

2. Integrates the histogram to form the cumulative distribution.

3. Scales the cumulative distribution to a mapping, which has values between 0 and 255.

4. Applies the resultant mapping to either the image data or the CLUT.

### 7.4.5 Invert

Some image files brought from other computers or programs may use the convention that 0 = white and 255 = black. This command lets you invert those images. The formula used to invert the data is:

\[ \text{new value} = \text{old data max} - \text{old value} + \text{old data min} \]
For Byte type data, that is:

\[ \text{new value} = 255 - \text{old value} \]

This command modifies the data in the entire image frame that is being displayed. This command works on 2D images and on entire sequences.

### 7.4.6 Color To Grayscale

This command operates only on color images. It creates a new image window that is the grayscale (luminance) equivalent of the color image data. The new window will have "._Gr" added to the end of its file name.

### 7.4.7 Pseudocolor

Use the **Pseudocolor** command to change the Color Lookup Table (CLUT) associated with the active window. The dialog gives you a pop up list of standard CLUTs from which to choose.

**Pseudocolor** Dialog Box

- **Monochrome**: **Monochrome** is a smooth transition from black through shades of gray to white. There are **Monochrome**, **Red**, **Green**, **Blue**, **Cyan**, **Magenta**, and **Yellow** CLUTs, too. Each of these is a transition from black through shades of the color to the pure color (e.g. pure, bright red).

- **Monochrome, Reversed**: This is the opposite of **Monochrome**: a smooth transition from white to black. This produces the equivalent appearance of a photographic negative.

- **Blue Green Red**: This is a gradient from black to blue to green to red.

- **Classify**: **Classify** is a gradient from blue to cyan to green to yellow and finally to red. It is good for highlighting differences in intensity values.

- **Rainbow**: **Rainbow** goes from red (0) to yellow, green, cyan, blue, magenta, and to red again (255). It, too, is very good for highlighting intensity differences where the lowest and highest intensities are not right next to each other.
Saturated Pixels: This is the same as the Monochrome CLUT, except that the lowest values are pseudocolored blue, and the highest values are pseudocolored red.

Use this CLUT to show whether or not an image is saturated. Saturation happens when the camera received either no light or too much light in an area. When this happens, the camera has not recorded any data about that area of the image. It is okay to have some saturated pixels, but it is very important to have none in the area of the sample you are interested in.

Pseudocolor also includes a number of CLUTS meant to look like the dyes being imaged:

- DAPI-BFP-Hoescht-AMCA
- FITC-GFP-Cy2-DiO
- TRITC-Cy3-Dii
- YFP
- TxRed-PI

7.4.8 Edit Color Table

The Edit Color Table allows you to create your own custom color lookup table (CLUT), in addition to letting you view the built-in color tables.

The large color bar at the top of the dialog represents the color table being edited. You can view pre-built color table in this bar, or you can use this bar to edit a custom color table.
First, pick a color table from the pop-up menu below the color bar's right end. This menu lists ten custom CLUTS as well as all of the pre-built color tables that come with IPLab.

- Click the Copy button to turn a custom color table into a duplicate of a pre-built color table. Then you can edit the custom color table.
- Click Rename to give the custom color table a new name.

When you have selected a custom color table in the pop-up menu, anchor triangles will appear below the color bar. Anchors set the color of part of the color table. You can:

- Add new anchors by clicking under the color bar.
- Select an anchor by clicking on it or by using the Anchor Select spinner above the color bar.
- Move the anchor's position by using the text box on the lower right end of the color bar.
- Set the anchor's color by changing the Red, Green, and Blue sliders or intensity values. The intensity values in the three text boxes can range from 0 to 255. The color of a slider indicates what color you will create if you move the slider in that direction.
- Make the color change smoothly by clicking Ramp. The color will change smoothly between this anchor and the anchor to its left.
- Make the color change sharply by clicking Solid. The color will change sharply after the anchor to the left, and continue up to the selected anchor.
- Delete the selected anchor by clicking the trashcan button.
- Adjust the gamma within a color ramp by moving the gamma diamonds, which are above the color bar. Click on a gamma diamond and drag it, or set its position using the text box to the upper-right of the color bar.

The image uses the newly edited color table in real-time when you check the Auto Apply option. Otherwise, you can click the Apply option to employ the chosen color table. Click OK to apply the chosen color table and to save any changes. Click Cancel to leave the dialog box without applying anything more.

### 7.4.9 Background Correction

Background Correction removes the unevenness from an image's background. It can also produce an image of the background for use by other commands. This command works for images containing any data type except Color 48.

Please refer to the following article for more information on how we perform background correction:


**Background Correction's Effects**

These plots give you an example of Background Correction's effects:
These plots show the background level

These lines show the image data

The above images have uneven background

The same images with corrected backgrounds

**Background Correction Dialog Box**

This dialog box opens when you choose the command:
Background Correction Dialog Box

Generate Background: This option stores the active image's background in a new window. You can use the background image to correct images acquired in a similar fashion.

Subtract Correction: This option removes the background from the active window.

Note: This option does change the active window's data!

Roll Ball Radius: Background Correction uses a rolling ball estimate to calculate the background. The Roll Ball Radius corresponds to the size of image objects. Small radii detect small changes in background, and large radii detect large changes.

The Roll Ball Radius should be larger than the object size. Otherwise, Background Correction may remove desired objects along with the background. The upper limit of the Roll Ball Radius slider is one-third the image width. You can enter larger numbers in the text box.

Dark Field, Brightfield, DIC/Phase: Choose the type of image you are correcting.

When Subtract Correction is selected, the resulting image's data values will be forced to remain between the original image's minimum and maximum data values.

Dark Field: Subtraction will be used to remove background from dark field images. The data's new base line will be the minimum original data value. The resulting image is calculated by the following equation:

\[ \text{Result}_{x,y} = \text{Original}_{x,y} - \text{Background}_{x,y} \] for all points \((x,y)\)

where \(\text{Min}_{\text{Original}} \leq \text{Result}_{x,y} \leq \text{Max}_{\text{Original}}\)

Brightfield: Addition will be used to remove background from bright field images. The data's new base line will be the maximum original data value. The resulting image is calculated by the following equation:

\[ \text{Result}_{x,y} = \left(\text{Max}_{\text{Background}} - \text{Background}_{x,y}\right) + \text{Original}_{x,y} \] for all points \((x,y)\)
DIC/Phase: The difference from the mean will be used to remove the background from DIC/phase images. The data's new base line will be the average original data value. The resulting image is calculated by the following equation:

\[ Result_{x,y} = \left( Mean_{\text{Background}} - Background_{x,y} \right) + Original_{x,y} \]

for all points \((x,y)\)

where \(Min_{\text{Original}} \leq Result_{x,y} \leq Max_{\text{Original}}\)

Apply to Sequence: Normally, the command would only correct the first frame of a sequence. Check this box to correct the background in the entire sequence (all Z and T frames).

Apply / Restore: Click Apply to generate or subtract the background while leaving the dialog box open. You can click Apply repeatedly to try out different settings. Click Restore to revert to the original data.

OK / Cancel: Click OK to generate or subtract the background (and close the dialog box). Click Cancel to close the dialog box without doing anything.

7.4.10 Linear Filter

Linear filtering changes each pixel in an image's ROI based upon the values of nearby pixels. You can use the Linear Filter command to pick a pre-defined linear filter, or to create your own filter kernels in a separate image window or within the Define Linear Filter dialog.

This command modifies only the data in the ROI of the 2D image-frame that is being displayed. It does not affect other frames in a multi-dimensional data set.
Apply To: Pick the image you wish to filter.

Use Filter in Window: You can create your own, arbitrarily sized kernel in a separate image window. Use this drop-down box to pick that window. When using this option, the filtered selection will always be placed in a new window.

The data type of the kernel must be Float or Long Integer. You can use the Change Data Type command (Math menu) to change the kernel's data type.

Divide by… : Divide by Filter Sum helps make certain that the results will fit into the image window's data type. It is a good idea to leave this checked by default when using Long Integer kernels.

Use Predefined Filter: IPLab supplies you with a number of kernels that are ready for use.

Put Result… : The Put Results in New Window option creates a new window that holds the entire image, including both the filtered ROI and any unfiltered regions.

Define: The Define button opens the Define Linear Filter dialog box, in which you can define your own filter kernel. Once you have defined your filter, you can use it by picking it from the Use Predefined Filter drop-down list.

Click Do It or OK to apply the filter to the pixels within the ROI. So long as you are not creating a new window, clicking Do It repeatedly will apply the filter over-and-over to the same pixels. The OK and Cancel buttons will close the dialog box.

If you click the Define button, the Define Linear Filter dialog opens:
When you define a filter, you can either create your own from scratch, or you can copy an existing filter and edit it. Either way, you will use the filter list box.

Filter List Box: This drop-down box at the top of the dialog lists all of the filters. You will notice that you cannot edit the pre-defined filters (the first thirteen in the list.)

If you want to create a new filter, choose the name of an unused filter, such as “filter 14,” and click the Rename button.

If you want to copy an existing filter and edit it, choose the existing filter’s name and click the Copy button.

Rename: The Rename button lets you enter a new name for the currently selected filter.

Copy: The Copy button copies the filter properties from the currently selected filter to another one. When you click this button, you will be asked to pick the destination filter. That filter will then be the selected filter, ready to be edited.

Kernel Size: Pick the size of the filter kernel. The maximum kernel size is 5x5.
Moving Average Component: These boxes represent the kernel's weight values. This kernel is applied to the input data. To change a weight value, simply click in a box and type in a new number. To remove all values (except for a one at the center), click the Clear button.

This produces a finite response filter, described below on page 164.

Divide By: You can divide the results by the sum of the kernel (the sum of the weight values within the moving average component), or by a number you enter yourself.

You would divide by the sum of the kernel to maintain the approximate intensity values of the original image. Using a divisor controls the relative scale of the results and can prevent the results from overflowing the bounds of the image's data type.

OK: When you click OK, the filter will be defined and added to the Use Predefined Filter list. Make sure it is selected, and click the Do It or OK buttons in the Linear Filter dialog.

Finite Impulse Response Filters

Finite Impulse Response (FIR) filters use only a weighted sum of the neighboring data in the input image to produce each output pixel. These weight values are entered in the Moving Average Component section of the Define Linear Filter dialog. If you label the moving average coefficients as follows:

$$
\begin{align*}
\alpha_{-2,-2} & \quad \alpha_{-1,-2} & \quad \alpha_{0,-2} & \quad \alpha_{1,-2} & \quad \alpha_{2,-2} \\
\alpha_{-2,-1} & \quad \alpha_{-1,-1} & \quad \alpha_{0,-1} & \quad \alpha_{1,-1} & \quad \alpha_{2,-1} \\
\alpha_{-2,0} & \quad \alpha_{-1,0} & \quad \alpha_{0,0} & \quad \alpha_{1,0} & \quad \alpha_{2,0} \\
\alpha_{-2,1} & \quad \alpha_{-1,1} & \quad \alpha_{0,1} & \quad \alpha_{1,1} & \quad \alpha_{2,1} \\
\alpha_{-2,2} & \quad \alpha_{-1,2} & \quad \alpha_{0,2} & \quad \alpha_{1,2} & \quad \alpha_{2,2}
\end{align*}
$$

where 0,0 represents the center value of the moving average kernel, then for an input image X, the output Y at location (h,v) is given by

$$
Y_{h,v} = \frac{1}{\text{Divide By parameter}} \sum_{i=-2}^{2} \sum_{j=-2}^{2} \alpha_{i,j} X_{h+i,v+j}
$$

After applying this formula, the result is clipped so that the resulting values fall in the range of values allowed by the data type of the image:

- Byte Type: (0, 255)
- Integer Type: (-32768, 32767)
- Unsigned16 Type: (0, 65535)
- Long Integer Type: (-2^{31}, 2^{31} - 1)

7.4.11 Median Filter

The median filter acts like the linear filter, in that each pixel in the ROI is changed based on the values of nearby pixels. In the case of the median filter, the pixel value is changed to have the median value of the pixels within the neighborhood, i.e. half the pixels in the neighborhood will have values above the median and half will have values below the median.
The median filter is often used to remove salt-and-pepper noise in images. It eliminates isolated bright pixels that may be due to cosmic rays hitting the detector of your camera, for example. The dialog also prompts you for the width and height of the filter size, or mask. Normally you will use a small mask size, such as 3x1 or 3x3. If your image has a lot of noise, you may want to experiment with 3x5 or 5x5 masks.

This command modifies only the data in the ROI of the 2D image-frame that is being displayed. It does not affect other frames in a multi-dimensional data set.

### 7.4.12 Edge Filter

The Edge Filter command lets you apply one of several built-in, nonlinear filters designed to detect edges in an image. The edge filter changes the value of each pixel in the ROI based on the values of nearby pixels. The command may be applied to any open window.

![Edge Filter Dialog Box](image)

**Edge Filter Dialog Box**

The Roberts edge filter applies the following 2×2 linear filter kernels to the original image and sums the absolute value of the results for each pixel:

\[
\begin{bmatrix}
-1 & 0 \\
0 & 1 \\
\end{bmatrix}
\begin{bmatrix}
0 & -1 \\
1 & 0 \\
\end{bmatrix}
\]

The Sobel edge filter applies the following 3×3 linear filter kernels to the original image and sums the absolute value of the results for each pixel:

\[
\begin{bmatrix}
-1 & -2 & -1 \\
0 & 0 & 0 \\
1 & 2 & 1 \\
\end{bmatrix}
\begin{bmatrix}
-1 & 0 & 1 \\
-2 & 0 & 2 \\
-1 & 0 & 1 \\
\end{bmatrix}
\]

The Sobel filter is a little less noise-sensitive than the Roberts filter, because the Sobel filter takes into account the values of more neighborhood pixels.

The Morphological Gradient computes the difference between the original image and a 3×3 eroded version of the image. This is an excellent and fast alternative to the other edge filters.
7.4.13  FFT Filter

After taking the Fourier transform of an image (using the Analyze menu's Transforms command), you can use this command to apply Fourier-domain filtering techniques.

FFT Filter Dialog Box

Data Windows: The Transforms command creates two windows that are either the Real and Imaginary or the Magnitude and Phase representations of the Fourier transform.

If you are working with Real and Imaginary windows, open both images and select them from the Data Windows drop-down boxes. Both windows will be operated on in the same way.

If you are working with Magnitude and Phase windows, open the Magnitude window and select it from the Real/Magnitude box. Only the magnitude needs to be processed.

Operation: Choose the FFT filtering technique you wish to apply. Choices are:

Clear Inside ROI Symmetrically
Clear Outside ROI Symmetrically
Low Pass
High Pass
Band Pass

Applications of these operations follow:

A common use of FFT filtering is to eliminate periodic noise. Below is the magnitude FFT of an image that was captured from a composite color camera with a grayscale frame grabber. The image has periodic noise due to the chroma signal in the composite image. This periodic noise appears as bright points away from the DC term in the magnitude FFT.

A common use of FFT filtering is to eliminate periodic noise. Below is the magnitude FFT of an image that was captured from a composite color camera with a grayscale frame grabber. The image has periodic noise due to the chroma signal in the composite image. This periodic noise appears as bright points away from the DC term in the magnitude FFT.
Eliminating Periodic Noise

The key to filtering out noise spikes in the Fourier domain is to apply the masks symmetrically about the DC term. To do this, you use one of the ROI tools to outline one of the noise areas, and apply the FFT filter command with the option **Clear Inside ROI Symmetrically**. The result is shown next to the original FFT. In this case, you would perform the same operation on the noise terms in the other quadrants of the FFT. Then take the inverse transform to see the results in the image plane.

You can also use this command to specify **Low Pass**, **High Pass** and **Band Pass** filters as a percentage of the full spectrum.

It is also possible to define an almost arbitrary **Low Pass** filter. First, use the freehand ROI tool to roughly outline the region you want to pass. Then apply the **FFT Filter** command with the **Clear Outside ROI Symmetrically** operation. This makes the region properly symmetric before clearing.

**7.4.14 Flip**

The **Flip** command performs several geometric transformations of the data, rotating and turning-over the image. These operations are reversible, because no interpolation is performed, and only the position of the data is being changed.

The **Flip** command always places the results in a new window with "_f" appended to the window's name. All frames in multi-dimensional image sequences are flipped.
Enhance Menu

168

Flip Dialog Box

**Window:** Pick the open image window to be flipped.

**Dispose Original…:** The Dispose Original Window option closes the window, which was flipped, leaving the resulting window in its place. This prevents a large number of windows from accumulating.

**Transpose:** Transposition flips the image horizontally and then turns it 270 degrees. The effect is equivalent to flipping the image around a diagonal axis.

Use this option to turn 1D column data into 1D row data.

**Vertical, Horizontal:** Vertical flips turn the image over in the vertical direction (upside-down); horizontal flips turn the image over in the horizontal direction (right becomes left…).

**90 deg…** These options rotate the image in the clockwise direction.

To flip your image, simply click the image-button for the operation you want, and click OK.

You may apply any geometric operation to 1D data as well as 2D data. However, in some cases you may not see any effect. For example, doing a horizontal Flip on a 1D column of data has no effect.

### 7.4.15 Register

Use this command to shift, rotate, and scale an image in relation to a second image while maintaining the window size. This allows you to align two images so that other commands can be used to compare them. The Register command puts the registered image into a new window that has the same size as the original (Source) window.

Before using the Register command, you must place at least two registration marks on both images using the Registration tool from the Drawing Tools toolbar: ![Registration tool](image).
Register Dialog Box

Windows: Pick the Source window that will be registered. Then pick the Reference window that the Source window will be forced to match.

Calculate Values…: Click this button to make IPLab automatically calculate the Shift, Scale, and Rotation values. IPLab does this by comparing the registration marks, in alphabetical order, from the Source and Reference images. If you like, you can type these values in yourself, instead.

Method: These are two interpolation methods for calculating the new, registered image. The Nearest Neighbor method is faster, while the Bilinear Interpolation method often gives a visually more pleasing result, because it smoothes jagged edges. Generally, doing the "inverse" operation cannot reverse either of these methods.

Shift: Positive values move the source data down and to the right.

Scale: Positive scale factors increase the size, of course. A scale factor of two doubles the size of the image.

Rotation: Positive values rotate the image in a clockwise direction.

7.4.16 Rotate & Scale

This command performs geometric rotation and scaling and places the result into a new image window. The new window is created with "_RnS" appended to the original name. This command applies to the entire multi-frame data set.
**Rotate & Scale Dialog Box**

**Scale:**
The size of the image will be increased by the factor entered here. The value 1 indicates no change, whereas the value 2 would indicate doubling the size. You may scale the X and Y coordinates together by checking the **Maintain Aspect Ratio** box, or separately by un-checking the box and entering different values in the X and Y text boxes.

**Method:**
Some form of interpolation must be used whenever fractional scaling and rotation are performed (scaling by non-integer factors, or rotating by increments other than 90°). You have two options: The **Nearest Neighbor** option is faster, while the **Bilinear Interpolation** option often gives a visually more pleasing result, because it smooths jagged edges. In general, the interpolation operations are not reversible. You cannot retrieve the exact original image by performing the “inverse” operations.

**Rotation:**
Enter a rotation angle in degrees. The image is rotated around the center of the window. Positive rotations turn the image clockwise.

**Maintain Image Size:**
When this box is unchecked, the new window is created big enough to hold the modified image. When this box is checked, then the new window is created the same size as the original, and the new image will be centered in the new window and will be clipped to fit.

**7.4.17 Mosaic**

This command provides a convenient way to join data windows into one larger data window. The **Mosaic** command is also useful for joining measurements or histograms from the analysis of multiple images.
The dialog provides three methods for placing the two source windows in the new window. **Horizontal** creates a new window, which is wide enough to hold all of the columns of both source windows. **Vertical** creates a new window that is high enough to hold all of the rows of both source windows.

Alternatively, you may use registration marks (the **Reg. Marks** option) in the two source images to place them in the new window. In this case, the registration marks are lined up in the new image. This command does not perform any rotation or scaling when lining up the registration marks. Simple shifting aligns the centroids of the two sets of registration marks.

When the mosaic is created, the first image is drawn in the new window, then the second image is drawn in the new window. This has two implications:

1. If areas of the image overlap when using the registration marks, the second image will be drawn on top of the first.

2. If the two images have different CLUTs, then the CLUT of the second image will survive and will be the one used for the new image. If you wish to mosaic two images with different CLUTs and still preserve the colors, you should first use the **Change Data Type** command (Math menu) to make both images Color24, and then use the **Mosaic** command.

The source windows need not be the same dimensions for any of the placement options; however, both source windows must be of the same data type.

### 7.4.18 Mosaic Sequence

The **Mosaic Sequence** command creates a single image that displays all frames of a sequence. You can display a Z-series, T-series or a Z- and T- series.
You will need to enter the name of the window sequence being mosaiced, the type of mosaic function (Z-series, T-series, or Z- and T-series), and the number of rows and columns within the new data window. For the Z&T Mosaic option, Z entries are mosaiced top to bottom, and T entries left to right.

7.5 Analyze Menu

7.5.1 Segmentation

The process of separating background pixels from pixels that are in a target area is called segmentation. Measurement and analysis often use segmentation to pick the areas to be examined. Often the background and target differ in intensity, so one of the most important ways of performing segmentation is by thresholding the intensity value. The Segmentation command lets you interactively determine the proper thresholds to separate the target and background in your images.
Segmentation Dialog Box

**Segment Color:** From this pop-up list, select the color that will be used in the overlay to denote pixels that are within the threshold parameters.

**Radio button:** To the left of the Reverse checkbox(es) are one or more circular radio buttons. These let you choose between different components when you use more than one. The component with the active radio button in front of it is the one whose thresholds are shown in the Min/Max part of the dialog, and whose histogram is displayed.

**Reverse:** This checkbox affects whether the pixel values between the Min and Max thresholds or outside of the Min and Max thresholds are segmented. When this box is not checked, then values between the Min and Max settings will be segmented. When this box is checked, then values outside of that window will be segmented.

**Components:** For grayscale images, the only component available is Intensity. Since nothing else can be selected, this box appears gray.

For color images, there is a list of possible color components to use. These color components provide various ways of analyzing color images. Which component to use depends on the application. Usually the most helpful components will be Red, Green, Blue, or their intensity-normalized counterparts, Rs, Gs, and Bs. These are described in detail in the Direct Color section of the Operations chapter, on page 95.
Combine: Sometimes you need to use more than one component to isolate objects from the background. After each component, there is a pull-down menu that lets you select None, And, or Or. If you select either And or Or, you can choose an additional component to threshold. With And between these two components, a pixel must satisfy both sets of threshold conditions before it will be labeled with the segment color. With Or selected, any pixel that satisfies one or the other sets of thresholds will be colored in the overlay.

You can combine as many as three component thresholds. For example, you may want to include in one segment only those pixels that have both a high red content and a low blue content. Then you would select the Red component with the And combining option, and select the Blue component with the None combining option. The component with the active radio button in front of it is the one whose thresholds are shown in the Min/Max part of the dialog.

When you switch from combining three component thresholds to only one, switch both of the Combine fields to None.

Min/Max: These are the thresholds. You can set them by using the sliders or by typing in values. Alternatively, when the #/V button has been toggled to show V, the Min and Max values will come from the indicated variables.

Histogram: The histogram displays the number of pixels (on y) with each pixel value (on x). It also displays the Min and Max values as threshold bars. Use the histogram to help you bracket regions of values.

Try It: Use this button to see the effects of the values you type in. If you click the Cancel button after Try It, the thresholds will revert to their previous values.

Do It: Use this button to apply the values you type in. After clicking the Do It button, you may select another segment color and proceed with further segmentations on the same image without destroying the segments of other colors that you have already applied.

Cancel: If you click the Cancel button after Do It, the thresholds will revert to the values they had before the Segmentation command was called.

Done: When you click Done, an overlay is created and the segments are filled with the segment color(s) you have selected.

You can analyze the segments using the Measure Seg/ROI and Quantify Segments commands from the Analyze menu.

7.5.2 Autosegment

First, open your image. Autosegment works with images of all data types except Floating Point. Then choose the Autosegment command.
Dark / Bright Field: It is important that you specify the type of image being segmented. **Autosegment** will segment the image based upon this setting.

Z and/or T Frame: Select individual frames within a Z-stack or time-lapse sequence for testing the **Autosegmentation** settings. This feature simplifies setting the correct parameters for batch processing image sequences by allowing to test the settings within the sequence.

Segment Color: Choose the segment color you want to modify. If some objects are already segmented, you can modify them by choosing the **Segment Layer** option under **Background Estimation**.

Component: The segmentation operation is performed on only one channel (also called a component). For grayscale images, it uses only intensity. For color images, the user can specify the channel.

Background Estimation: **Autosegment** will use this method for segmenting the foreground apart from the background.
Segment Layer: This option uses the information on the segment layer of the front image. The segment layer must contain the foreground objects of the image.

Automatic Segment: All the automatic thresholding algorithms rely on the histogram of the image. The histogram of the image is smoothed using a $1 \times 5$ filter (smoothing only along pixel intensity frequencies) to minimize the error due to the presence of local maxima and minima. The final estimated threshold value is displayed in the dialog box next to the ‘threshold intensity’ text. The threshold value is also stored in variable #232 if you click the OK button.

- Iterative is conservative when identifying the foreground. Choose Iterative first, before trying Triangle or Midpoint; it is good to see the most minimal result you can get.

  Iterative is more universal than Triangle and Midpoint, because it does not depend upon the image’s histogram. It is good for noisy images and for situations more complex than given for Triangle and Midpoint.

- Choose Triangle algorithm for images with relatively few foreground pixels compared to background pixels, as in this example histogram:

  ![Histogram Example 1](image1.png)

  Use Triangle when image has histogram like this

- Choose the Midpoint algorithm for images with roughly equivalent numbers of foreground and background pixels, and with relatively few intermediate intensities, as in this example histogram:

  ![Histogram Example 2](image2.png)

  Use Midpoint when image has histogram like this

Please read page 178 for detailed information about these algorithms.
Threshold Intensity:  **Autosegment** will display the threshold when you click **Apply**.

It will store this value in variable #232 when you click **OK**.

**Fill Holes:**  The option will fill in all of the holes within each segment.

**Contrast Ratio Limit:**  In some images with low contrast or no objects of interest, the background may be detected as objects. The Contrast Ratio Limit prevents detection of the background as objects when properly set. Use the slider to set the value based on sample data. The current contrast ratio value, based on the active image, is displayed above the slider. Objects with a value below the set limit will not be counted.

**Definitions of Contrast Ratio:**

For Darkfield (DF) Images

DF Ratio = Mean Foreground / Mean Background

For Brightfield (BF) Images

BF Ratio = [Image Max - Mean Foreground] / [Image Max - Mean Background]

**Split:**  The **Split** function will determine if a segment should be split into multiple parts.

**Intensity Contour:**  Choose this algorithm when your objects have a gradient of intensity from the edge to the center.

**Distance Contour:**  Choose this algorithm when

a. the intensity within your objects has a random characteristic, and

b. the percentage of shared or touching boundaries is small compared to the object's boundary with the background. This will ensure that an effective distance map is created.

**Number of Iterations:**  The higher the number of iterations, the more meticulous the **Split** function will be.

**Area:**  The **Area** function eliminates regions from the segment layer when they have less area than specified in the **Minimum Area** field. The **Minimum Area** value must be in terms of the image units and not pixels.

This operation can be performed under different conditions:

1. This operation performs the area elimination on the segment layer of the original image if the segment layer option is selected.

2. If the automatic segment option is chosen then this operation is performed after the threshold is estimated.

3. This operation is performed again after a split operation (if chosen). This ensures that small objects are eliminated if big foreground objects are broken during the split operation. Therefore selecting split objects options performs the area operation 'twice.'
You can set the image units using the **Define XY Units** and **Set XY Units** commands (Analyze menu).

**Create New Window:**  When you choose this, the segmented image will appear in a new window, while the original image will not be segmented.

**Boundary Only:**  When you check this option, only the edges of objects will be segmented.

You can fill the boundaries in by using the **Segments: Modify** command (Overlay menu). Choose the **Fill Holes** option while modifying the same segment color as the boundary segments.

**Apply, Restore:**  Click **Apply** to test the **Autosegment** settings on the ROI.

Click **Restore** to return the image back to its original status before you close the **Autosegment** command.

**OK, Cancel:**  Click **OK** to autosegment your image. Click **Cancel** to close the dialog box without affecting anything.

**Automatic Segment Algorithms: Iterative Algorithm**

This algorithm employs an iterative process to converge at the optimal threshold intensity.

1. For the first iteration, it assumes the threshold at half dynamic range (equation 1).

2. Based on this threshold, it calculates the sample means for the foreground \( m_f \) and the background \( m_b \) pixels.

3. The new threshold value \( T_1 \) for the next iteration is computed as the mean of the foreground and background sample means (equation 2).

4. This process is repeated until there is no significant change in the thresholds.

Equation 1:  
\[
T_0 = \frac{I_{\text{max}} + I_{\text{min}}}{2}
\]

Equation 2:  
\[
T_n = \frac{m_{f,n-1} + m_{b,n-1}}{2} \quad \text{until } T_n = T_{n-1}
\]

**Automatic Segment Algorithms: Midpoint Algorithm**

The midpoint algorithm finds the highest local maxima in a histogram. The midpoint between this peak and the next highest peak is chosen as the threshold for the image. This method is also referred to as mode method. The bimodality of the histogram does not guarantee optimal segmentation because the objects may be located on a background of different gray-levels.

**Automatic Segment Algorithms: Triangle Algorithm**

This histogram of the data’s intensities (I) illustrates the triangle algorithm:
The triangle algorithm is based on finding the intensity value (I) that gives the maximum distance (d)

1. The algorithm connects a line from the histogram's maximum (I_{max}) to the image's lowest value (I_{min}).
2. It calculates the distance between that line and the histogram, h(I), for all intensity values from I_{min} to I_{max}.
3. The threshold equals the brightness value b_o where the distance between the histogram and the line is greatest.

This algorithm is particularly effective when the histogram contains a weak (low) peak.

**Split Algorithms: Intensity Contour**

This algorithm utilizes the intensity values for the foreground objects for computation. It assumes the following with regards to intensity profile of the foreground objects:

1. The center region of the object has the highest intensity value for the object.
2. Two touching objects have a region of low intensities separating them.
3. The image has dark field characteristics. (Bright field images are inverted internally to perform this operation.)

Initially, it creates an intensity contour of the image based upon the image max and number of iterations (I_n). The foreground objects are then separated using this intensity contour by employing a modified inverted watershed algorithm.

I_n is directly proportional to the sensitivity of the algorithm. Thus, the user can vary I_n to get the optimal result.
**Split Algorithms: Distance Contour**

This algorithm computes a distance map by applying the distance transform to the segment layer mask of the input image. Thus this algorithm is intensity independent as the distance transform is only applied on the segment layer mask.

The result of the distance transform is a grayscale image that looks similar to the input image, except that the grayscale intensities of points inside foreground regions are changed to show the distance to the closest boundary from each point.

These varying grayscale intensities in the distance map create a contour effect. The intensity contour algorithm is now applied to this distance contour image. The number of iterations corresponds to the number contour gradients created from the center of an object to the nearest boundary.

### 7.5.3 Set Measurements

The **Set Measurements** command lets you pick which measurements you want displayed, and lets you limit the results for each measurement. After using this command, use the **Measure Seg/ROI** command (also in the **Analyze** menu).

**Set Measurements Dialog Box (Showing the Densitometry Tab)**

In the **Set Measurements** dialog, there are three columns next to each measurement name: **Limit?**, **Min**, and **Max**. Click the checkbox next to any measurement you wish to perform. Then, if you want to restrict the results to within certain bounds, click the **Limit?** checkbox beside the measurement name. Then enter the
lower and upper bounds in the Min and Max text boxes. If you limit the results, then only measurements that fall between the Min and Max values will be recorded in the Measurement Results window. Min and Max values can be normal numbers (#) or numeric variables (V).

The first column of the results window will be the Measurement #, which will start with zero. The rest of the measurement results are described below.

Sum, Mean, Min, Max, RMS, Stand. Dev.: Sum refers to the sum of all pixel intensity values in the region measured. Mean is the mean intensity value; Min and Max are the lowest and highest intensity values, respectively.

These measurements will give different values for red, green, and blue channels. The value for each color channel will be given in a separate column (e.g. Sum R, Sum G, Sum B) within the Measurement Results table.

The formulas used to compute the density measurements are as follows.

Let $N = \text{Number of pixels in the region}$, and $I_{xy} = \text{pixel values within the region}$. Then:

\[
\text{Sum} = \sum I_{xy} \quad \text{Mean} = \frac{\sum I_{xy}}{N}
\]

\[
\text{RMS} = \left(\sum I_{xy}^2 / N\right)^{1/2} \quad \text{Standard Deviation} = \left(\sum I_{xy}^2 / N - \text{Mean}^2\right)^{1/2}
\]

Area, Perimeter: Area and Perimeter calculations treat a particle as an aggregate of square pixels. A segment consisting of a single pixel has an area of 1 and a perimeter of 4. This definition of perimeter gives the most consistent results across all scales of magnification; however, it may give results you do not expect for a particle with many diagonal sides. Both Area and Perimeter calculations are reported in the XY units defined for the image.

Diamond-Shaped Particle with 20 Pixel Perimeter

Shown above is a segment at high magnification. If you think of this segment as a pixelated version of a true diamond that has only 4 sides, each of length $\sqrt{8}$ pixels, you would conclude that the segment has perimeter $4 \cdot \sqrt{8} = 11.3$ pixels. However, if you consider all the obviously visible sides to this segment, its perimeter is clearly 20 pixels, and this is how the Measure Segments command computes the perimeter.

Radial S.D.: The Radial Standard Deviation is the standard deviation of the distance from the centroid to the outer edge of the ROI or segment, reported as a percentage of the mean radius. It is a measure of how much like a smooth circle the ROI or segment is. Below are two particles that can be distinguished by this parameter. The Radial S.D. for the particle on the right, which is nearly a circle, is close to 0. The particle on the left is also nearly a circle, but its edge is substantially rougher, so its Radial S.D. is somewhat larger. In general, a Radial S.D. value of less than 2 - 3% can be considered a smooth circle.
Particles that can be differentiated by Radial S.D.

2nd Mom.-x, 2nd Mom.-y, 2nd Mom.-xy: These are the second order moments of the shape. They are computed as follows:

\[ M_x = \frac{\sum((x-c_x)^2 S_{xy})}{\text{area}} \]
\[ M_y = \frac{\sum((y-c_y)^2 S_{xy})}{\text{area}} \]
\[ M_{xy} = \frac{\sum((x-c_x)(y-c_y) S_{xy})}{\text{area}} \]

where \( S_{xy} \) has value 1 inside the particle (ROI or segment), and value 0 outside, and \((c_x, c_y)\) is the position of the particle (that is, the shape centroid).

Major Axis, Minor Axis, Angle, Eccentr.: These parameters are derived from an ellipse that is fitted to the object (ROI or segment). The Major Axis result is the length of the longest cord that goes through the center of the ellipse, and the Minor Axis is the length of the cord that is perpendicular to the major axis. You can use the Minor Axis as a measure of the minimum diameter of a particle. (It is actually a measure if the minimum diameter of the fitted ellipse, which may differ slightly in size from the particle itself.)

The Angle (also called the Major Angle) parameter is the angle between the major axis and the x-axis (horizontal) for the fitted ellipse. It has values between 0 and 90°. The Eccentricity is a measure of the circularity of the ellipse. It is 0 for perfect circles and approaches 1 for extreme ellipses.

The Eccentricity for a given shape may be near 0, while the Radial S.D. may be very large. Such a situation tells you that the shape is basically a circle with a rough edge, like the shape shown in the picture above next to the circle. If on the other hand, both Eccentricity and Radial S.D. are large then the shape is far from a circle.

The formula for Eccentricity is:

\[ e = \frac{\sqrt{a^2 - b^2}}{a} \]

where \(a\) is the major axis and \(b\) is the minor axis of the ellipse.

Centroid, Min and Max Location: The position measurements Centroid, Min, and Max Loc. report the x and y locations of the centroid, and the locations of the minimum and maximum intensity values.

Weighted Centroid and 2nd Moments: These are similar to the centroid and shape moments, except that the actual pixel intensities on the particle are used in forming the sums. The formulas are:
Analyze Menu

\[ a_x = \left[ \sum x l_{xy} \right]/S \] (x-Centroid)

\[ a_y = \left[ \sum y l_{xy} \right]/S \] (y-Centroid)

\[ M_x = \left[ \sum (x-a_x)^2 l_{xy} \right]/S \]

\[ M_y = \left[ \sum (y-a_y)^2 l_{xy} \right]/S \]

\[ M_{xy} = \left[ \sum (x-a_x)(y-a_y) l_{xy} \right]/S \]

where \( l_{xy} \) is the pixel value at location \((x,y)\), and \( S \) is the sum of the pixel values: \( \sum l_{xy} \).

After you have chosen the measurements you want applied, use the Measure Seg/ROI command (Analyze menu) to measure the region(s).

### 7.5.4 Measurement Options

The measurement commands use these options. This command only sets up internal parameters; it does not affect the data.

**Measurement Options Dialog Box**

This dialog box controls what *IPLab* will do with Segments, Annotations, and the Results Window.

Analyze Menu 183
Segments:

**Erase Segments Falling Criteria:** If the segments do not match the limits set in the Set Measurements command, then the segments will be erased when you measure them. IPLab will not record their measurements.

Please see page 180 for a description of how to set limits in Set Measurements.

**Include Interior Holes in All Meas.:** Segments may surround empty, unsegmented spaces. Check this box to include the interior spaces in measurements. Uncheck this box to measure only the segment. This can make large differences to area measurements.

**Ignore Segments Touching ROI…:** Use this option to guarantee that you measure only whole segments. Ignored segments will not be measured, of course.

Segments that touch the region of interest may extend beyond the area that will be measured. (Measuring specific segment colors only measures them within the ROI.)

You can pick the sides of the ROI (Left, Right, Top, and Bottom) at which you will ignore segments.

**Annotation:** Annotation adds drawing objects to the image to mark the segments that you have measured.

Because the annotations are added to the drawing layer, the outlines and numbers can be deleted or altered later without affecting your data.

**Outline, Number Segments Passing Criteria:** Only segments passing the limit criteria you set in Set Measurements will be numbered or outlined.

Segments will be numbered in the order they are found and measured, which is always from left to right, top to bottom. These numbers match the segment numbers in the first column of the measurement results window.

**Outline Color:** You can set the outline color to any thing (for example, to a color that contrasts well with the segment color).

**Results Window:** The measurement results window will store all of the data from the measuring command.

**Name:** specify the name of the window in which to place the results of the Measure Seg/ROI command

**Max. Number of Meas. to Store:** This sets the size of the results window.

**Results Labels:** These options add text to the row labels displayed on the left side of the results window. Check these options to identify each row of data.
When the **Measure Seg/ROI** command is run, it looks for a window with this name, having the width and height that match the number of measurements you wish to perform. If such a window is not found, those commands create a window with the name you have specified in this dialog.

### 7.5.5 **Quantify Segments**

The **Quantify Segments** command performs a fixed set of measurements on the selected segments.

![Quantify Segments Dialog Box](image)

When the dialog appears,

1. Select the image to measure. Choose from all open windows.
2. Choose the segment color to measure (for example, the red segments in the ROI).
3. Give a name to the results window.

When you click **OK**, the segments within the ROI will be measured, and the results will be reported in the results window.

The same measurements are performed every time. This set of measurements includes: **Count, Total Area, Average Area, % of ROI, Sum, Mean, Min, Max, RMS, and Standard Deviation**.

- **Count:** This is the number of segments found in the ROI.
- **Total Area:** This is the sum of the area of all segments found within the ROI.
- **Average Area:** The average area of the segments found within the ROI is the **Total Area** divided by the **Count**.
- **% of ROI:** This number is the percent of the area of the ROI that is occupied by segments.

\[ \text{% of ROI} = \frac{\text{Total Area}}{\text{Area of ROI}} \]

**Sum, Mean, Min, Max, RMS, Stand. Dev.** These are also described above for the **Set Measurements** command, on page 181. These are the sum and the mean of the intensities of the pixels under the segments;
the minimum and maximum pixel values under the segments, and the RMS and standard deviation for the same.

This command is unaffected by the Set Measurements dialog box.

7.5.6 Measure Seg/ROI

The Measure Segments/ROI command computes density, shape, and location statistics for segments and regions of interest within the active image window.

To use this command, you should use the following Analyze menu commands:

1. First use the Set Measurements command to pick the measurements to be done.
   You may also want to use the Measurement Options command for some additional control.
2. Use the Segmentation command to make the segments.
   You could manually create them using the segment tools, instead.
3. Then choose the Measure Seg/ROI command.

Measure Seg/ROI Dialog Box

Pick whether to measure:

- the entire image,
- the entire ROI, or
- segments of a specific color within the ROI.

When you click OK, the measurements you selected in the Set Measurements dialog will be performed, and the results stored in a measurement results window. If the results window does not already exist, it will be created and minimized to the bottom of the window. If the results window does already exist, then the new measurements will be appended to the list.

Show/Hide Columns in the Results Window

Here is how to hide and show columns of data in the measurement results window.

1. When you hold the mouse over the line between columns, the cursor will change to a vertical line with an arrow pointing left and right.
2. Click on a line between columns and drag it left to the next line. That column will now be hidden.

3. Double click on a line where a column is hidden to make the column visible again. This is useful for changing how your table of data is displayed.

**Measurement Troubleshooting**

If you try to measure segments and get the message, “No segments found in ROI,” it is probably because of one of two reasons.

- You may have clicked within the image and unintentionally made a small ROI that does not contain any segments.
- In the Measure Seg/ROI dialog box, you may have chosen to measure the wrong color segment.

If you measure segments and the Measurement Results window is empty of everything except the Meas. # column, then you have forgotten to select any measurements from the Set Measurements dialog box.

**7.5.7 Classify Segments**

This command groups segments into bins (classes) based on a primary measurement. It lets you quickly count and measure segments whose measurements fall within a certain range.

For example, you might want to count bacterial colonies that fell into different size ranges. You would use Classify Segments to:

- measure the average size (for example) and standard deviation for each range of colony sizes,
- calculate, for each range, the averages of any other densitometry and shape measurements you choose,
- count the colonies that fell into each range, and
- display the measurements in a table and a plot.

For each class of objects, Classify Segments will report the average and the standard deviation of the chosen measurement, and it will report the average of all other measurements chosen within the Set Measurements command’s Densitometry and Shape tabs.

Classify Segments uses the Limit settings from Set Measurements. Please see page 180 for more information on limits.

Classify Segments does not use settings from Measurement Options. Classify Segments will ignore all segments that touch the edges, and it will not include holes within segments.
To use **Classify Segments**: 

1. Pick the **Measurement** and **Segment Color** to classify. 
2. Set up the **Ranges**. 
3. Click **OK**.

You will probably make use of the other settings as well. All of the settings are described here:

**Configuration:** You can store the settings for **Classify Segments** in one of three configurations. Choosing a configuration will change all of the settings. When you have a configuration set up properly, all you will have to do is choose it and click **OK**.

Use the **Rename** button to change a configuration's name. Use the **Copy** button to copy the settings from one configuration to another.

**Channel:** Use this image when classifying intensity (densitometry) measurements on a color image. This option does not do anything when used with a grayscale image.
When classifying intensity measurements (Sum, Mean, Min, Max, RMS, Stand Dev.) on a color image, you must choose the channel to measure: Red, Green, or Blue.

**Measurement:** Pick the measurement to be used to divide the segments into classes. Classify Segments will report the average and the standard deviation of this measurement for each class. You can choose from all of the densitometry (intensity) and shape measurements:

**Densitometry:** Sum, Mean, Min, Max, RMS, and Stand Dev.

**Shape:** Area, Perimeter, Radial SD, 2nd Mom X, Y, and XY; Major and Minor Axes, Major Angle, and Eccentricity.

Keep the Measurement the same if you use Classify Segments repeatedly. A results window that contains the same measurement must be open.

To use Classify Segments repeatedly, keep the Measurement option the same and keep open a results window that contains the same measurement.

Classify Segments will also report the average for each class of any other measurements chosen from the Set Measurements command's Densitometry and Shape tabs. However, it will not group the segments based on these other measurements.

**Results Window Name:** Type the name of the windows that will hold the table of data and the bar graph.

If you set the L/SV icon to SV, the window name will come from the specified string variable.

If a window with this name does not already exist, then a new one will be made. If it does already exist, then the segment count will be added to the existing window (please see "Accumulating Results" on page 190).

**Classify Segment Color:** Choose the segment color that will be measured and classified.

**Outline Color:** Classify Segments outlines the segments with drawing objects after measuring them. Choose the outline color.

**Display Against Range:** Check this option to display the range (class) measurements on the bar graph's X axis.

**Range:** This section contains the ranges, or classes. The segments will be divided into these ranges.

**Enable:** To create another range, check the Enable box. The Min and Max boxes next to it will appear next to it. Uncheck the Enable box to remove that range.

**Min/Max:** These two text fields contain the low and high ends of the range. Segments whose measurements fall within this range will be grouped as one class.
If you set the #/Var icon to Var for Min or Max, that parameter’s value will come from the specified variable.

**Results Windows: Table and Plot**

When you click OK, Classify Segments will create two results windows: a table of measurements and a plot of that table.

![Classes Table Output](image)

**The Classes Table Output by Classify Segments**

This Floating Point table displays the measurements for each class. The row labels along the left edge list the classes. The Average and the Std. Dev. are the average and standard deviation of the measurement being classified. If any other Densitometry or Shape measurements are chosen in the Set Measurements command, their averages will be listed in columns to the right of Std. Dev.

Please note that the units for Average and Std. Dev. will depend on the image’s units and on the measurement being done. The Count is always a number of segments, and % is always a percentage of the total number of segments.

![Classes Bar Graph](image)

**The Classes Bar Graph Output by Classify Segments**

This bar graph is a plot view of the classes table. Both of these windows display the same data. To create a similar plot, choose the New View command from the View menu and select Plot. You can modify the view by right-clicking on the plot. Please see page 142 for details on these plot options.

**Accumulating Results**

You use Classify Segments on multiple images, one after another. To accumulate data this way, use Classify Segments on one image, bring another image to the front, and use Classify Segments again. You can use a script to batch-classify segments from a large number of images.

To use Classify Segments repeatedly:

- Measurement must remain set to the same measurement.
• The options within the **Set Measurements** command must not change.

• The results window given in the **Results Window Name** field must be open. This can be either the table or the plot, or both.

  It is possible to have two (or more) different results windows open. You can use either one.

Otherwise, *IPLab* will balk and tell you, "The output window has results from a different measurement" and "Cannot find the specified window."

Here is an example script for batch measurement of images using **Classify Segments**. It opens images from a file list, automatically segments them, and then classifies the segments:

![Example Script Using Classify Segments](image)

**Example Script Using Classify Segments**

The results window will accumulate the counts of segments from every image in the file set.

You can read more about file lists starting on page 115.

### 7.5.8 Measure Angles

The **Measure Angles** command allows you to interactively measure the angle of objects or structures in an image window.
To use the Measure Angles command:

1. Open the image you wish to measure.

2. Choose the Line Drawing Object tool from the Drawing Tools toolbar.

   Make sure you have the drawing object tool, which is blue, and not the ROI or segment tool.

3. Draw an angle on your image by clicking two points and double clicking at the third point.

   If your line has too many points, Measure Angles will report its angle as zero degrees.

4. Click the Get Angle button to see the width of the angle you just drew, in degrees.

   Measurements are always done on the selected drawing -- usually the three-point line that you just drew.

You can also store that measurement in a text window.

1. First, use the Angle Report Window to choose an existing text window or to name a new one.

2. Next, click the Create Report button to record the measured angle to the report window.

3. Later, you can save the report window and process the information within IPLab or import it into a spreadsheet program.

When you click the Create Report button, it numbers all of the image's line drawings in the order of their creation. It does this by naming them with numbers. It then displays the numbered names of each line drawing. You can hide these names again by choosing the Drawing Objects: Modify command (Overlay menu), and unchecking Show Name.
7.5.9 Measure Lengths

The **Measure Lengths** command allows you to interactively measure the length of objects or structures in an image window. Click **Get Line Length** to see one length. Click **Create Report** to record the length of all line drawings into a text window.

![Measure Lengths Dialog Box](image)

To use the **Measure Lengths** command, please do the following:

1. Open the image you wish to measure.
2. Choose the **Line Drawing Object** tool from the **Drawing Tools** toolbar. Make sure you have the drawing object tool, which is blue, and not the ROI or segment tool.
3. Draw a line on your image along the object you want to measure. It can have any number of points.
4. At the end, double-click to finish the line.
5. Click the **Get Line Length** button to see the length of the line you just drew.

The length will be given in the image's units, as set by the **Set XY Units** command (**Analyze** menu). Measurements are always done on the selected drawing -- usually the line that you just drew.

You can also store your measurements in a text window.

1. First, use the **Length Report Window** field to choose an open text window or to name a new one.
2. Next, click the **Create Report** button, which records the lengths of all line drawings to the report window.

Analyze Menu
3. Later, you can save the report window and process the information within IPLab or import it into a spreadsheet program.

When you click the Create Report button, it numbers all of the image's line drawings in the order of their creation. It does this by naming them with numbers. It then displays the numbered names of each line drawing. You can hide these names again by choosing the Drawing Objects: Modify command (Overlay menu), and unchecking Show Name.

### 7.5.10 Define XY Units

Use the Define XY Units command to assign units other than pixels to an image.

For example, it is often much more useful to measure using millimeters or microns than pixels. You will also be able to see the cursor position, the window size, and the ROI size displayed in the units you define, when you look at the Status Window. Please see page 136 for a description on of how to do that using the Preferences command (Edit menu).

The quick-start directions for defining XY units are as follows:

1. Using the Line ROI tool, draw an ROI with only two points across a known distance (e.g. an object with a known width). Click once on the first point, and double-click on the second point.

2. Click Get Line ROI Pts.

3. Enter the appropriate distance into the right half of the equation (e.g. 10 um, as in the example dialog box).

4. Click Save to save this distance information for later use. Give your units a unique name.

5. Finally, click OK. You can use the Set XY Units command (Analyze menu) to apply these units to an image.

Detailed descriptions of this command’s features are given below:
Define XY Units **Dialog Box**

Get Front Window Units:  
Click this button to display the current units used by the active window.

Get Line ROI Pts:  
Clicking this button calculates the length of the ROI line segment.

Before clicking **Get Line ROI Pts**, draw a line segment on your image (click once, and then double-click to finish the line) using the Line ROI tool: Left-click. Draw the line segment across an object whose size you know. Then click this button.

_ Pixels = _ Units:  
This is where you actually define the units. These fields relate the pixels in the image to the units you are defining. After you click the **Get Line ROI Pts** button, the line's length in pixels will be displayed on the left. Type in the real-world distance on the right, and select the appropriate units (pixels, µm, mm, cm, m, in, or ft).

In the example dialog shown above, a 10 micron object was 36 pixels wide in the image. After clicking the **Get Line ROI Pts** button, "36 pixels" was displayed on the left. We typed "10" into the box on the right, and selected "um" for micrometers.
Save: Click the Save button to preserve this definition of units. You can apply this units definition to any number of images.

Delete: Click the Delete button to get rid of old or inaccurate units definitions.

After defining the units, you should use the Set XY Units (Analyze menu) command to apply these units to your image(s).

7.5.11 Set XY Units

Use the Set XY Units command to apply units to an open image and all new images. This will make it possible for you to measure using millimeters or microns, for example, rather than pixels. You will also be able to see the cursor position, the window size, and the ROI size displayed in the units you define, when you look at the Status Window.

In addition to setting the units for the image named in the Window Name field, this command sets the units for all new images acquired with a Camera menu command or created by the New Data command (File menu).

This command sets the units for

- The open image named in the Window Name field
- All new images captured using Camera menu commands
- All new images created by the New Data command (File menu)
Set XY Units Dialog Box

**Window Name:** Choose the image for which you want to set the units. This box lists all open windows.

As noted above, these units will be used for all new images made after running this command, whether they were made with the New Data command or an image capture command.

**Defined Units:** Pick a definition of units. You can use the Define XY Units command (Analyze menu) to create (or delete) these definitions.

The relation between image pixels and real-world units will be displayed below the Defined Units list.

**…Calibration Bar:** The Insert Calibration Bar option adds a calibration bar to the image’s drawing overlay. The calibration bar is a horizontal line labeled with the length of the line. The Size and Line Width fields control the length and thickness of the calibration bar. The Color and Location fields control its color and placement.
7.5.12  **Insert XY Units**

The **Insert Calibration Bar** option adds a calibration bar to the image's drawing overlay. The calibration bar is a horizontal line labeled with the length of the line. The **Size** and **Line Width** fields control the length and thickness of the calibration bar. The **Color** and **Location** fields control its color and placement.

![Insert Calibration Bar Dialog Box](image)

**Insert Calibration Bar Dialog Box**

7.5.13  **Histogram**

The **Histogram** command creates a new data window with a plot of the histogram of the data. A histogram is a frequency chart. It tells how many pixels in the image have each possible value. The pixels are grouped in “bins,” where each bin is a group of pixels having certain values. Normally, there are as many bins as there are pixel values, but you can define fewer bins, which would then contain a range of pixel values.

![Histogram Dialog Box](image)

**Histogram Dialog Box**
This dialog gives you several options for computing a histogram of the data within the active data window:

**Bins:** You must specify the value of the Min and Max Bins. These are the minimum and maximum pixel values that you want included in the histogram. Pixels with values outside the values of the Min Bin and Max Bin will be ignored. If you check Use Data Min or Use Data Max, the corresponding value will be taken from the entire image, or the ROI, depending on which portion is specified by the X-Y Limit radio buttons. Alternately, you may enter any floating point value you wish for the locations of the Min and Max Bins. These numbers can also come from IPLab’s numeric variables (by toggling the # buttons to V).

You must specify the number of bins to use (No. Bins). If you check the (Max - Min) + 1 box, then the command will produce one bin for each intensity value from Min to Max Bin:

\[ \text{No. Bins} = (\text{Max Bin} - \text{Min Bin}) + 1 \]

**X-Y Limit:** You may compute the histogram on the entire image or only on the data within the ROI.

**Sequence Option:** When the image window contains multi-dimensional data, you have two options on how to create the histogram.

- **Sum Frames:** Sum Frames creates a single histogram that is the sum of the histograms of all the data in the image sequence.
- **Maintain Sequence:** This creates a separate histogram for each frame in the multi-dimensional data set, so that the resulting plot window is actually a sequence of histogram plots that you can navigate in the same way as a multi-dimensional image sequence.

When you click OK, the histogram is displayed in a new window with the name name-Hist where name is the name of the active image window. The histogram data is displayed as a plot. If you view it as text, the first column shows the histogram bin value. The other column(s) show the number of image pixels with that value (i.e., in that histogram bin). Histograms of color images have three columns of pixel counts, one each for red, green, and blue.

The plot view of the histogram can be edited by using the View Options: Plot command in the View menu (described on page 142).

### 7.5.14 Row/Col Plot

This command sums or averages the intensity values within each row or column of the image or ROI. The command displays the results in a plot of summed or averaged intensity value versus distance along the axis.
Row/Col Plot Dialog Box

The dialog has three pop up sets of options.

**Sum/Average:** You may get the sum or the average of all the pixels.

**Rows/Columns:** You may operate on the pixel values in each row or in each column.

**Entire/ROI:** You may get the result on the entire image (independent of the ROI) or on just the data within the ROI.

Row/Col Plot can be used with any shape of ROI.

**Process All Frames:** When this box is checked, the plot will contain one frame describing each frame of the image. If this box is unchecked, then the plot is generated only on the data in the displayed frame.

The results are placed in a new window with the name `name_RCPlot` where `name` is the name of the active image window.

7.5.15 Transforms

The Transforms command performs Fourier or Cosine transforms and their inverses.
Transform Type: Choose from Fourier (Magnitude & Phase), Fourier (Real & Imaginary), Cosine, Inverse Fourier (Magnitude & Phase), Inverse Fourier (Real & Imaginary), and Inverse Cosine.

Windows: These boxes list all the open windows. Choose the image(s) needed to perform the transform. The Cosine and Inverse Cosine transforms require only one window name. The dialog prompts you for names of two windows if you are doing a Fourier transform.

If you want to do a forward Fourier transform on a single window, you can enter a single window name. If you leave both window names blank on the forward transform, then IPLab uses the active image window as the real part in a complex forward Fourier transform. The forward transform may be applied to any of the data types except Color24 and Color 48.

**7.5.16 Extract Image Info**

The Extract Image Info command is a hierarchical menu, which gives several options for getting information about the active data window and displaying it in a text window. These options include Color Table, Rect ROI to 1D, Linear ROI to 1D, ROI Boundaries, Image Sizes, and Acquire Info.

**Extract Image Info: Color Table**

This command creates a 3 x 256 data window of Byte type containing the red, green and blue values for the window’s color table.

**Extract Image Info: Rect ROI to 1D**

This command extracts the intensity values and \((x,y)\) positions of every selected pixel. The results are put into a new window named \(OriginalName_{1D}\).

When viewed as text, this information is a vertical list of positions and intensities. Each row contains the X and Y positions of a pixel and its intensity value(s). The first row of pixels is listed first, followed by the second, and so on. Extracting the ROI from color images produces three columns of intensity values from the red, green, and blue channels.

**Extract Image Info: Linear ROI to 1D**

This command extracts the data values along a linear ROI through an image. You may create the linear ROI with the mouse by using the Line ROI tool (\(\text{Edit}\)), or with the Define ROI command using the Line shape (Edit menu). Extract: Linear ROI to 1D places the results in a window named \(name_{Line}\), where \(name\) is the name of the active image window.

This command is useful for real time analysis while you are capturing images.

**Extract Image Info: ROI Boundary**

This command creates an image window that has 3 columns, which contain the data values along the ROI’s boundary. The first two columns contain the X and Y coordinates of the pixels along the ROI boundary. The
The third column contains the data values at each of the points on the boundary. The name of the new window is \textit{OriginalName\_ROI}Bnd.

This command works best with grayscale images. When working with color images, use \textbf{Split Color Channels} (\textit{Math} menu) to divide the data into three grayscale images. You can then extract the ROI boundary from each color channel.

\textbf{Extract Image Info: Image Sizes}

Extracting image sizes puts a lot of useful information about the image window into a text window. This information includes:

- the positions of the sides of the ROI,
- the width and height of the ROI,
- the width and height of the image,
- the currently-displayed Z frame, and the number of Z frames,
- the currently-displayed T frame, and the number of T frames, and
- the coded data type of the image, where:
  - 0=Byte
  - 1=Integer
  - 2=Long Integer
  - 3=Floating point
  - 4=Color16
  - 5=Color24
  - 6=Unsigned16

The new window will be named \textit{Name\_.Sizes}, where \textit{Name} is the name of the active data window.

The \textbf{Extract Image Info: Image Sizes} command places its results in numeric variables, as well. Column 0 = var. 100, column 1 = var. 101, column 2 = var. 102, \textit{etc}. This makes it very easy to pass information about a window to an \textit{IPLab} command, such as the \textbf{Acquire} or \textbf{New Data} commands.

\textbf{Extract Image Info: Acquire Info}

Use this command to get the settings used to acquire an image. You can then edit and re-use them.

Several acquisition commands* store acquisition settings in the image file in a new tag. The \textbf{Extract Image Info: Acquire Info} command puts those settings into variables.

<table>
<thead>
<tr>
<th>Variable #</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>ROI Left (X-coordinate of left boundary of the acquired ROI)</td>
</tr>
<tr>
<td>201</td>
<td>ROI Top (Y-coordinate of top boundary of the acquired ROI)</td>
</tr>
<tr>
<td>202</td>
<td>ROI Right (X-coordinate of right boundary of the acquired ROI)</td>
</tr>
<tr>
<td>203</td>
<td>ROI Bottom (Y-coordinate of bottom boundary of the acquired ROI)</td>
</tr>
<tr>
<td>214</td>
<td>Horizontal bin size (in pixels)</td>
</tr>
<tr>
<td>215</td>
<td>Vertical bin size (in pixels)</td>
</tr>
<tr>
<td>235</td>
<td>Current Row</td>
</tr>
</tbody>
</table>

202 Analyze Menu
You can use these variables in other commands. For example, you can use these variables in the **Acquire** command to grab another image using the same settings. You can also use commands from the **Edit** and **Script** menus to manipulate these variables.

Acquire and Multi Dimensional Acquire from the Camera menu; and Ratio Acquire and Single Wavelength Acquire from the Ratio Plus extension.

### 7.6 Overlay Menu

**IPLab** images contain two layers that are kept apart from the image data: the segment layer and the drawing layer. When you use the **Segmentation** command or the segment tools, the segments are placed in the segment layer. When you use the drawing tools or any annotation features, the drawing objects and annotations are placed in the drawing layer. Because these two layers lie on top of the image data, you can change the segments and drawings without affecting any of the data.

#### 7.6.1 Show/Hide Segments

Use this command to temporarily hide all segments or to re-display hidden segments. The segments are not altered. You can still perform measurements on the segments when they are hidden.

#### 7.6.2 Segments

These commands let you add, delete, and edit segments, just as the **Segment Toolbar** tools do. With these commands, you can script the same actions as you might perform with the **Segment Toolbar** tools.

**Add**

The **Segments: Add** command gives you a scriptable way to place a well-defined segment on an image.
Segments: Add (Define Segment) Dialog Box

The four text-entry boxes at the top of the dialog box let you enter the locations of the left, top, right, and bottom edges of the segment. These locations are defined as the distance in pixels from the upper-left corner. By toggling the button so it reads V, a numeric variable can be used for the location of an edge.

In the example dialog shown above, the top edge of the segment will be at y=0 (the top of the image), and the bottom edge of the segment will border y=200 (200 pixels from the top edge, so that the segment will be 200 pixels in height. The left and right edges of the segment in this example will be at the locations stored in variables 50 and 52. The number stored in variable 50 must be less than the number in variable 52, of course.

If the numbers entered for the edges of the segment do not make sense, then an "Invalid Bounds" error message will be generated. This would occur when the given numbers make the width or height of the segment equal to zero or less.

Modify

Segments: Modify provides binary morphology operations for editing the segment layer of an image. Modifying the segment layer lets you make sure that the correct regions get measured and that the segments accurately represent the regions.
Segments: Modify Dialog Box

These filters will only look at and modify the segments with the color chosen in the field named **Color of Segment to Modify**. The results will be placed in the window named in the **Put Results In** field.

**MASKED FILTERS:**

The Erode, Dilate, Open, Close, and Hit or Miss filters operate as convolution filters and require a mask (some call it a structuring element). The mask is used to recognize patterns in the segment overlay, and to change the segments based on those patterns. Click on the boxes in the mask to change them from the segment color to transparent (“X”). For the Hit & Miss filter, click again to change to a "Don't Care" circle.

To recognize patterns in the segment overlay, the mask is passed over the entire segment layer, pixel by pixel. The mask is compared to the segment pixels under it. The conditions for that filter type are used to determine when a match has been made. The pixel under the mask's center is set to the chosen segment color if the pattern of the mask and the segments match. If not, then the center pixel's with the chosen color are made transparent. The mask is then moved over to the next pixel.
A Simple Mask. Striped areas indicate masking

Segment Layer, Seen up close

Case A

Case B

Filter Type: Conditions & Behaviors:

Erode: Set center to segment color if: all the colored locations in the mask cover segment pixels in the image's segment layer. The segment pixels also have to be the color chosen in the Color of Segment... field.

Examples: In Case A, all of the colored locations in the mask cover segment pixels. The pixel under the center of the mask will be set to the chosen segment color. In Case B, the right-most colored location in the mask does not cover a segment pixel. The center pixel will be made transparent-- which will result in the segment's edge eroding away.

Dilate: Set center to segment color if: at least one colored location in the mask covers a segment pixel in the image's segment layer. The segment pixels also have to be the color chosen in the Color of Segment... field.

In both Case A and Case B, the mask's colored locations cover at least one segment pixel. In both cases, the pixel under the center of the mask will be set to the chosen segment color. What's more interesting is that if only the left-most colored location in the mask covered a segment pixel, then the pixel under the mask's center would still be set to the segment color, widening the segment's right edge. The end result is that the segment would grow, or dilate.

Open: The Open operation is an Erode followed by a Dilate, all using the same mask. This is good for separating segments that touch but which should be separate for the purpose of analysis.

Close: The Close operation is a Dilate followed by an Erode, all using the same mask. This is good for closing gaps between segments that should be joined for the purpose of analysis.

Hit & Miss: Set center to segment color if: the colored and "X" locations in the mask match the pattern of pixels with and without that segment color. The segment pixels also have to be the color chosen in the Color of Segment... field. You can ease these conditions by clicking on a location in the mask until a circle appears. These "don't care" locations can contain segment color or be blank within the image; the mask will not care.

For the pixel in question to be set to the segment color:

1. The segments in the image below the mask’s colored regions must be the same color, and

2. The pixels in the image below the mask's "X" (transparent) regions must be without segmentation or have a different segment color;
3. However, the image pixels below "Don’t Care" locations can be segmented or not.

   **Examples:** In the picture of the simple mask, above, the large square delineates the edges of the mask. The area between that square and the colored cross is transparent. In Case A, the mask does not match the image because some segments lie under the transparent regions of the mask. In Case B, the segment pixels do not match either the "X" or the blank locations. In both cases, the central pixel will be changed from the chosen segment color to transparent (not segmented). This restrictive mask would pass only small cross-shaped segments.

**OTHER FILTERS:**

The last six options do not use a mask. Each of these filters applies only to the segment color chosen in the **Color of Segment**... field.

**Thin** removes one layer of the boundary pixels from each segment, and **Thick** adds a layer of boundary pixels to each segment. **Fill Holes** fills in all of the holes within each segment. **Complement** switches the segment color and blank areas within the entire overlay. **Skeletonize** removes boundary pixels until only a linear path is left within each segment. **Boundary Only** leaves only the outside outline pixels in the segment layer. (If a segment has interior holes, the boundaries of those interior holes are not preserved by the **Boundary Only** option.)

You can use a combination of **Complement** and **Skeletonize** to obtain the boundaries of objects or grains:

1. Segment the objects from the background with the **Segmentation** command (Analyze menu). (The "Grains.ipl" image is a good image for practicing this.)
2. Choose the **Segments: Modify** command from the Overlay menu. Make certain that **Color of Segments**... is set to the same color used by the **Segmentation** command.
3. Pick the **Complement** option and click **Do It**.
4. Choose **Skeletonize** and click **Do It** or **OK**.

**Delete**

This command deletes the entire segment layer from the active window. It removes all colors of segments from the overlay.

**Cut**

This command cuts the segment layer from the active window's ROI. It cuts all colors of segments from the overlay. If you want to cut all segments from the entire image, choose **Select All** from the **Edit** menu and then choose this command. Use the **Segments: Paste** command to add these segments back to the overlay.

**Copy**

**Segments: Copy** copies the segmentation layer within the ROI. Segments of all colors will be copied.
**Paste**

Segments: Paste reproduc the section of segment layer that was copied or cut. To paste segments, draw a ROI where you want the segments placed. The entire section of copied segment layer will be pasted, starting from the upper left corner of the ROI.

### 7.6.3 Create Segment at Drawing Object

The Create Segment at Drawing Object creates segments that have the same shape as drawing objects. That is called “segmenting the drawing objects.” Simply pick any drawing object and choose the Create Segment at Drawing Object command. A new segment with the same shape is made. You can then use the Measure Seg/ROI command (Analyze menu) to measure the region under this segment.

![Segment Drawing Objects Dialog Box](image)

Segment Drawing Objects Dialog Box

The top section of the dialog box lets you choose which drawings you want to segment. The Color combo box in bottom section lets you dictate the color of your new segments. The Dispose Objects option deletes the segmented drawing objects, which otherwise would obscure the new segments.

### 7.6.4 Change Segment Color

The Change Segment Color command changes the color of some or all of the existing segments.
You can change the color of segments at pixels where the image intensities (values) are within a specified range, or you can change the color of all segments of a certain color. You can also limit the color change to the confines of the ROI by clicking ROI Only.

### 7.6.5 Show/Hide Drawing Objects

This command displays or hides all of the drawing objects within the active window. This is useful if the drawings are obscuring your view of the data. You can hide individual drawing objects by using the Drawing Objects: Modify command, described on page 211.

### 7.6.6 Show/Hide Drawing Objects List

This command displays a list of all of the active window's drawing objects, and allows you to edit them. The Drawing Objects window is a kind of "browser" for drawing objects, giving you a lot of powerful control over the drawings.

**The Drawing Objects List**

The name of the currently active window is displayed above the list. While this dialog is open, you can click on any open window to make it the active window, and to see a list of its objects.

The Drawing Objects list is a list of all drawing objects within the active window. Clicking on a drawing object in the list selects that drawing object in the image. Hold down the Shift key and click on two objects in the list to select a range of drawing objects. Hold down the Control key and click on two drawing objects to select them without also selecting the objects listed between them.

The drawings are ordered from bottom to top in the order they were drawn. The first to be drawn is numbered 0. You can use the Move Up and Move Down buttons to move a single, selected object up and down the list. The numbered order of drawing objects can help control them from within a script, which might not know the names of the objects.
The **Add**, **Modify**, and **Delete** buttons open up the corresponding dialog boxes:

- **Drawing Objects: Add**, described on page 210,
- **Drawing Objects: Modify**, described on page 211, and
- **Drawing Objects: Delete**, described on page 212.

### 7.6.7 Drawing Objects

The **Drawing Objects** commands give you a scriptable interface to add, remove, and edit your drawings, with a very fine level of control.

#### Drawing Objects: Add

This command can add drawings to the image's drawings overlay.

![Add a Drawing Object Dialog Box](image)

**Drawing Objects: Add Dialog Box**

**Name:**
You can use this field to change the name of the selected drawing object. You can use this name to target drawing objects from other commands.

**Top…Right:**
These four fields contain the boundaries of the drawing object's edges. In the example dialog shown above, the locations of the left and right edges are stored in the variables #10 and #11.

**Type:**
You can add either rectangular or oval drawings using this command.

**Color:**
Set the color of the new drawing.

**Line Width:**
This is the thickness of the new drawing's edge, given in pixels.
Filled: When this box is checked, the drawing will be a solidly colored object. When this box is unchecked, the object will be hollow.

**Drawing Objects: Modify**

The **Drawing Objects: Modify** command lets you view and edit the different parameters of a selected drawing object: name, position, size, type, color, line width, and whether it is filled or hollow. This command brings up a dialog box similar to the **Drawing Objects: Add** dialog, through which you can change the selected drawing object.

In addition to the options described for the **Drawing Objects: Add** command (see above, on page 210), the **Drawing Objects: Modify** command offers the following options:

- **Show Name:** When this is selected, the object's name will be displayed in the center of the object (over the object's centroid, actually). This can help you distinguish objects.
- **Show Object:** The object will be visible when this option is selected. Deselecting this option will hide individual drawing objects, instead of hiding the entire drawing overlay with the **Show/Hide Drawing Objects** command.
- **Col., Row Spacing:** When the selected object is a grid, these text boxes replace the **Top...Right** boxes. They control the number of pixels between every column and row within the grid. You will also see **Quadrilaterals** as an option under **Type** of drawing object.
- **Arrowhead:** When modifying an open line, the **Arrowhead** options let you make the start and/or the end of the line into an arrow.
Modify a Drawing Object Dialog Box

If you select more than one drawing object, then the dialog box will only let you change the Show Name, Show Object, and Color options.

Drawing Objects: Delete

This command deletes drawing objects from the entire drawing overlay. You can delete All drawings or only Selected drawings; or you can delete drawing objects by number or name. (Drawing objects are numbered by the order in which they were drawn.)
7.6.8 Select Drawing Objects

These commands allow you to easily move from one drawing object to another. This set of commands is highly effective when scripting, since it lets you more easily select and modify a given drawing object. The commands are Select Previous, Select Next, Select All and a Select… command.

Select Drawing Objects: Select

The Select Drawing Objects: Select command’s dialog box gives you options to select All, Previous, or Next drawings, and to select drawing objects by number or by name. (Drawing objects are numbered by the order in which they were drawn.)

![Select Drawing Object: Select Dialog Box](image)

Select Drawing Object: Select Dialog Box

The pop-up box at the top lets you manage a precise group of drawing objects. You can Select, Add to Selection, and Remove from Selection.

7.6.9 Create Drawing Object at ROI

This command will create a drawing object around the ROI of an active image window.

7.6.10 Transform Grid Cells to Objects

This command creates individual drawing objects from each cell of the selected grid. For instance, if you select a grid that is three cells wide and three cells high, then this command will create nine individual drawing objects. All of the new, individual objects will be polygon objects.
7.7 Math Menu

7.7.1 Convert to 8/24 Bit

This command changes grayscale images to 8-bit Byte type, and color images to 24-bit Color 24 type, while retaining the appearance of the data. It does so by replacing the data with the displayed values, which are set by the Normalization command. The keyboard shortcut is Control + T. (Note: this command replaces the To Byte As Shown command.)

**Convert to 8/4 Bit** is most useful when you want to export data to another program that does not understand 16-bit or 48-bit data. First, use **Convert to 8/24 Bit** on the image. Then save the resultant image in a format that the other program understands, such as TIFF.

**Note:** **Convert to 8/24 Bit** always changes the image data, even if you apply it to a Byte or Color 24-type image.

7.7.2 Unsigned <-> Signed

This command changes the data type of a Short Integer (a.k.a. Signed 16) image to Unsigned 16 (a.k.a. Unsigned Short), and vice versa.

The Short Integer and Unsigned 16 data types both use 16 bits to represent data values. The range of values for Short Integer is \([-32768,32767]\) and for Unsigned 16 \([0,65535]\).

You will generally use Short Integer when you need 16 bits of dynamic range; however, some camera systems are capable of creating Unsigned16 data directly. When **IPLab** imports image data, it assumes that any 16-bit data is Short Integer. If you import an image that you know is really Unsigned16, use this command to tell **IPLab** that it should change the way it thinks of the data. The data values are not changed (i.e. no bits of the data are changed); only the way **IPLab** treats the data is changed.

7.7.3 Change Data Type

This command allows you to give a new data type to any data window.
When you select a new data type that uses fewer bytes to represent the data, some of the data values in the window may be out of range. Use the **Normalization** options to handle the out-of-range data:

**Clip:** When using this option, the out-of-range data is clipped when it is changed to the new data type. That is, any pixel values that are outside the range of the new data type are set to the minimum or maximum values for that data type.

**Scale:** When using this option, all of the data is scaled to fit within the new data type’s range of values.

When changing between 16-bit signed and unsigned data, the bit representation of the data is not changed at all. Only how that bit representation is interpreted is changed.

You can also change between grayscale and color data types. When going from color to grayscale, this command creates a new image that is the luminance equivalent of the color image data, as does the **Color to Grayscale** command (**Enhance** menu).

### 7.7.4 Pixel Shift

Use this command to move all of the data in the active window to one side or up and down.
Types of shift: If you choose the Circular Shift option, then the portion of the image that is vacated by the shift is replaced with the portion that is shifted off the image. It behaves as if the window was a cylinder, and the image is wrapping around. This is also called a "barrel shift."

If you choose the option Fill With 0, then the portion of the image that is vacated by the shift is replaced with zero-valued pixels, and the portion that shifted off the image is lost.

Distance to move: The Pixels to Shift... fields prompt you for the amount of shift in each direction. Negative values shift the image left or up, while positive values shift the data right or down.

Current frame/sequence: Check the Do Sequence box to shift every frame within a sequence. Leave this unchecked to only shift the current frame.

7.7.5 Sort Data

The Sort Data command can be used to sort tables of data. You specify which column to sort, and the rows of the table will be re-arranged so that the column's data is in ascending or descending order.

Note: In addition to using the Sort Data feature, you may also double left click on any column header to launch the Sort Data feature.
IPLab assumes that complex data is stored in a pair of separate windows of Floating Point type. That is how the Fourier Transform option in the Transform command generates its output. The two windows may contain either the real and imaginary parts or the magnitude and phase components of the complex data.

The dialog for the Complex command allows you to perform one of three operations on the data in these window pairs:
### A x B (Multiplication):

Complex multiplication requires you to enter the names of four windows that hold the real and imaginary parts of two complex images. The multiplication result overwrites the data in the two **A Operand** windows. Neither of these **A Operand** windows need to be the active window to perform this command.

The formulas for complex multiplication are as follows:

- \( \text{Real}(A) = \text{Real}(A) \cdot \text{Real}(B) - \text{Imaginary}(A) \cdot \text{Imaginary}(B) \)
- \( \text{Imaginary}(A) = \text{Real}(A) \cdot \text{Imaginary}(B) + \text{Real}(B) \cdot \text{Imaginary}(A) \)

### Magnitude/Phase, Real/Imaginary:

If you choose to convert from a magnitude and phase representation to the real and imaginary representation or vice versa, you need only enter the names of two windows.

Note, however, that one of the results of this option is that the source data are overwritten by the results obtained. For example, in converting from magnitude/phase to real/imaginary, the image containing the magnitude data ends up containing the real part while the image containing the phase information now contains the imaginary part. Similarly, a conversion from real/imaginary to magnitude/phase results in the original real window containing the resultant magnitude and the original imaginary window the resultant phase.

The conversions between real-imaginary and magnitude-phase use the following formulas:

- \( \text{Real} = \text{Magnitude} \cdot \cos(\text{Phase}) \)
- \( \text{Imaginary} = \text{Magnitude} \cdot \sin(\text{Phase}) \)
- \( \text{Magnitude} = \sqrt{(\text{Real})^2 + (\text{Imaginary})^2} \)
- \( \text{Phase} = \arctan(\text{Imaginary}/\text{Real}) \)

The phase results from the last conversion are in the range \((-\pi, \pi)\).

Although complex division is not provided as a separate option, it can be performed using a combination of complex multiplication and **Image Arithmetic**.

You choose operands for the **Complex** command by either typing in a window name or using the drop-down menus provided. You may use this command on any two windows. They do not need to be generated by the **Fourier Transform** option in the **Transform** command.

**With Script window active:** You may enter any window name for an operand, even if the named window does not exist at the time of editing the script. This allows the script to use windows that are created earlier in the script.

### 7.7.7 Morphology

Mathematical morphology provides several nonlinear filters that help enhance and analyze images. Each filter acts like a linear filter, in that each pixel in the ROI is changed based on the values of nearby pixels.
Morphology Dialog Box

This command lets you choose among four types of nonlinear filters:

- **Erode:** Erosion computes the minimum value of pixels within the neighborhood.
- **Dilate:** Dilation computes the maximum value of pixels within the neighborhood.
- **Open:** Opening performs an erosion over the whole image, then a dilation.
- **Close:** Closing performs a dilation over the whole image, then an erosion.

The options in the **Kernel Size** rectangle let you set the size of the kernel, the neighborhood around each pixel. The new, filtered pixel value will be based upon the original values within this neighborhood.

- **X, Y:** These are the width and height of the kernel.
- **Kernel boxes:** These squares demonstrate the size and shape of the kernel, or neighborhood.

**7.7.8 Encode-Decode**

**Encode-Decode** is used to apply an arbitrary function to your data. This array describes how to map values from 0-255 into output values in the same range.
To understand the operation of this command, it may help to consider the selected 1D data as a function \( y = f(x) \). The result for each data element (pixel) in the entire image is then given by:

\[
\text{result} = f(\text{data value}) \quad \text{for Encode}
\]
\[
\text{result} = f^{-1}(\text{data value}) \quad \text{for Decode}.
\]

The inverse function is defined as follows:

\[
f^{-1}(y) = \text{smallest value of } y \text { such that } f(x) \geq y, \text{ if } f(0) \leq f(255), \quad i.e. \text{ non-decreasing functions.}
\]
\[
f^{-1}(y) = \text{smallest value of } y \text { such that } f(x) \leq y, \text{ if } f(0) \geq f(255), \quad i.e. \text{ decreasing functions.}
\]

### 7.7.9 Binarize

The **Binarize** command creates a 1-bit image of the segmented regions in your image. Areas under the chosen segmentation color will be white, with the value 1. All other areas will be black, with the value 0.
Use the **Window Name** field to pick any open window to binarize.

Areas under the color chosen in **Segmentation Color** will be given the value 1. All other areas will be set to zero.

If **Create New Window** is unchecked, then the binarized image will replace the original data. Check **Create New Window** to preserve your old data and to create a new, binarized image at the same time.

### 7.7.10 Set Pattern

Use **Set Pattern** to either
- add a pattern of values to the region of interest, or
- replace the ROI with the pattern.

This command is most useful for creating a known image for testing results.

**Set Pattern** changes the data in the selected window. This command developed from the old **Add Pattern** command.
Window Name: Choose an open window to receive the pattern. You can type the literal window name (L) or use a string variable (SV).

Next, choose a pattern to add. You control the patterns of values by entering the parameters, a, b, and c.

Horizontal Ramp, Vertical Ramp: The values change linearly between a/c and b/c. If a/c < b/c, the ramp increases in intensity from left to right or top to bottom. Otherwise, the ramp decreases in the same direction.

Uniform Noise: Uncorrelated, uniform random noise is added to each pixel in the ROI (replacing the old data if Add to Data is unchecked). Each random value is in the interval [a/c, b/c].

The seed for the random number generator is taken from the system clock when you execute the command. This produces a different noise result each time you execute the command.

In order to use the same noise data for different experiments, you should add a noise pattern to a blank window and save the window. You could then add the noise to other windows using the Image Arithmetic command. The length of the pseudorandom sequence is approximately $2^{32}$; that is, $2^{32}$ uncorrelated numbers are generated before the sequence starts to repeat itself.

Gaussian Noise: Uncorrelated Gaussian random noise is added to each pixel in the ROI (replacing the old data if Add to Data is unchecked). The distribution of the Gaussian noise is described by a bell curve. The mean and standard deviation of the Gaussian noise source are a/c and b/c, respectively.

As with Uniform Noise, The seed for the random number generator is taken from the system clock when you execute the command. This produces a different noise result each time you execute the command.
In order to use the same noise data for different experiments, you should add a noise pattern to a blank window and save the window. You could then add the noise to other windows using the **Image Arithmetic** command. The length of the pseudorandom sequence is approximately $2^{32}$.

**a, b, c:**  
**Set Pattern** uses these three parameters to calculate the desired pattern of values.

**Add to Data:**  
When this is checked, the pattern of values will be added to the existing data. The new data values are literally summed with the original values. For example, adding a horizontal ramp to an image would increase the image's intensity from one side to the other.

When **Add to Data** is unchecked, the pattern of values will replace the existing data. This is a good way to add intensity ramps to images.

**Do Sequence:**  
Normally, **Set Pattern** only affects the front frame of an image. When **Do Sequence** is selected, the pattern is added to every frame in the image.

### 7.7.11 Point Function

The **Point Function** command changes the value of each pixel in the ROI. The **Point Function** dialog box is designed so that a large variety of functions may be performed on each point of your data.

![Point Function Dialog Box](image)

**Window Name:** Choose which open window to operate upon.

**AbsoluteValue:** Check this option to take the absolute value of the result, and to use that absolute value as the new pixel value.

**Function Type:** You can apply four types of functions, each of which presents a different interface:

- **Algebraic:**  
  \[
  \text{Result} = \text{Multiplier} \times \text{Operator} \left( \text{Multiplier} \times \pi \text{Option} \times \text{PixelValue}^{\text{Exponent}} + \text{Operand} \right)
  \]
  
  ...where the Operator combo box lets you pick from trigonometric and log functions, square root, the logical NOT operator, and modulus (NOT and modulus are not available for use with floating point images);
and where the $\pi$ Operator lets you choose 1, $\pi$, or $2\pi$. The $\pi$ Operator field is only available when using the SIN, COS, or TAN operators.

**Threshold 1:**

$\text{Result} = \text{Result#1 if } \text{Operand1} \leq \text{PixelValue} \leq \text{Operand2}$  
$\text{else } \text{Result} = \text{Result#2}$

**Threshold 2:**

$\text{Result} = \text{PixelValue if } \text{Operand1} \leq \text{PixelValue} \leq \text{Operand2}$  
$\text{else } \text{Result} = \text{Result#2}$

**Bit Value:**

$\text{Result} = (\text{Operand})^{th} \text{ Bit of PixelValue}$

You do not have to apply this command to an entire image of pixels; you can apply it to a single value. When viewing a text window, for example, you can use the Define ROI command (Edit menu) to select a single cell in the spreadsheet-view (really, it is a single pixel in the image). You can then perform calculations upon this value. This is a fantastic way to script your post-acquisition data analysis.

If you cannot create the function you need from these options, please contact Scanalytics (support@scanalytics.com); we want to hear about it!

### 7.7.12 Image Arithmetic

Use this command to perform arithmetic on two images to produce a third image. These arithmetic operations produce a single output by performing point by point operations on the ROIs of two input data windows. The operations are of the form:

$$\text{output} = \text{Multiplier1} \times \text{Image1} \text{ (operator)} \times \text{Multiplier2} \times \text{Image2}$$

where (operator) is an operation such as addition, subtraction, AND, or OR (among others). The Multipliers are constants.

If, for example, the operation is addition, then what the Image Arithmetic command does is this: it adds the pixel values in one image with the values of the corresponding pixels in the other image. It then puts the result in the output window. It is helpful to remember that computer images are nothing more than arrays of numbers, where each number represents an intensity value.

**Conditions:** Because this command operates on the ROIs of the two images, both ROIs must have the same dimensions. However, the images do not need to be the same size; just the selections. The data types of the two images must be the same. Also, when using both Sequence checkboxes, the Z and T depths of the images must be identical.
Operands: The two Operands have three components in the dialog box: the small Multiplier text boxes, the Window Name fields, and the Sequence checkboxes.

Multiplier: The small text boxes on the left hold the Multiplier constants. Each constant will be multiplied with the pixel values in its image. The #/V buttons beside these text boxes allow you to choose to enter the constants directly or to pull them from the specified IPLab numeric variable.

Window Name: The Window Name fields prompt you for two windows. Besides choosing or typing the window name of any open window, you can also choose a constant or the first, second, or last image. The Constant option uses that image's Multiplier as the operand. If, in the above dialog box, Constant had been chosen instead of First Image, then Operand 1 would be the equivalent of a window filled with pixels with an intensity of 5.

The First Image is the currently selected, front-most window. The Last Image is the one that looks like it is at the bottom of the stack of image windows.

The L/SV buttons let you choose to enter the window name directly (as a "literal" string of text) or to pull the window names from the specified string variable.

Sequence: The Sequence checkboxes makes it possible to perform arithmetic on image sequences. If you want this image to be treated as an image sequence, then check this box. If these boxes are not checked, then the command will use the two current frames.

When one single image frame is being used with an image sequence, it will be applied (added, subtracted, multiplied, or whatever) to each frame of the image sequence. This allows you to perform bias subtraction on Z-stacks. It complements The Multi Dimensional Acquire command, and helps when producing 3D projections.
When two sequences are being used, frame 0 will be applied to frame 0, frame 1 to frame 1, and so on. For sequence arithmetic, the Z and T depths of the images must be identical.

Operator:  
If you do division, pay attention to the option **Value if divide by 0**.

The **MAX** and **MIN** operators produce the maximum and minimum intensity values for each pixel, respectively. **AND**, **OR**, and **XOR** are bitwise operators.

**Place Result In:**  
Place the results in one of the operand images, or type the name of a new window to hold the results. You can also leave the title of the new window blank.

**Value if Divide by 0:**  
When using the division operator, this number will be used for any pixel where the denominator image has value zero, to avoid division by zero.

### 7.7.13 Merge Color Channels

This command combines images into a single color image. The **Merge** tab forms a new Color 24 or Color 48 image out of three grayscale images. The **Blend** tab mixes a fluorescent signal into a bright-field background image. **Blend** can also fuse two fluorescent channels to produce a co-localization image, and it can add a grayscale image to an existing color image.

**Merge Tab**

The dialog prompts you for the names of three data windows, which are the color components of the new color image. You may use the **Source Windows** drop-down boxes in each case to help you select the window names. Assign a color to each image by entering it in the appropriate **Red**, **Green**, or **Blue** text box.

**Merge Tab of the Merge Color Channels Dialog Box**

The dialog prompts you for the names of three data windows, which are the color components of the new color image. You may use the **Source Windows** drop-down boxes in each case to help you select the window names. Assign a color to each image by entering it in the appropriate **Red**, **Green**, or **Blue** text box.
(For HSV images, click in the HSV radio button and assign each image to Hue, Saturation, or Value.) The input images must all be of the same type: Byte, Unsigned 16 or Short Integer (Signed 16). The images must also all be the same size in all four dimensions.

When you select the RGB option, you may leave one or two of the window names blank. Any color coordinate with a blank window name is treated as having all 0 values. Use this feature if you grab only two images and, for example, you want to merge them as Red and Green. By leaving the Blue name blank, Merge Color Channels will create a new color image, which has no blue in it.

Select either the Color 24 or Color 48 option for the new image data type. The Color 24 option will generate a 24-bit color image and the Color 48 will generate a 48-bit color image. If the “Merge Raw Date, Not Normalized” option is checked when using the Color 48 radio button, the final image will maintain the original intensity data from each input channel.

Put your new color image into a new window by checking New Window and typing a name in the Destination text box. Put the new color image into an existing color window by unchecking New Window and choosing a target window from the Destination box.

**Blend Tab**

Use the Blend tab to:
- mix a fluorescent signal into a bright-field background image,
- examine co-localization of fluorescent labels by fusing two grayscale channels,
- add a grayscale image to an existing color image.

**Blend Tab of the Merge Color Channels Dialog Box**

First, choose your Fluorescent source window and choose the Input channel into which the fluorescent source image will be placed. If you choose Input: Green, for example, your fluorescent image will be colored...
green in the final image. Next, choose your **Brightfield** image. Then type the amount of blending in the **Blend %** field. The higher the blending percentage, the fainter the background will be.

Put your new color image into a new window by checking **New Window** and typing a name in the **Destination** text box. Put the new color image into an existing color window by unchecking **New Window** and choosing a target window from the **Destination** box.

The **Fluorescent** source image must be a grayscale image, but it can have any pseudocoloring. The **Blend** function uses the image's display values, so it will merge the **Fluorescent** channel's pseudocolors with the **Brightfield** image. The **Brightfield** image can be any data type, grayscale or color. Both **Fluorescent** and **Brightfield** images can be sequences; however, if both are sequences, then their Z and T depths must be the same.

For co-localization, select a grayscale image of a fluorescent label for each source window. To add a grayscale image to an existing color image, select the new image as the **Fluorescent** window, and select the color image as the **Brightfield** window.

### 7.7.14 Split Color Channels

This command operates only on an active data window of type color 24 or color 48. It splits the color image data in the active window into its color components.

![Split Color Channels Dialog Box](image)

The dialog allows you to select one of three standard coordinate systems when splitting the color image data: RGB, HSV, and RsGbB. These standard coordinate systems are described in the section of this manual on pages 95-97.

### 7.7.15 Convert Color Coordinates

This command converts color component images from one color coordinate system to another.
Convert Color Coordinates Dialog Box

You must tell IPLab how to treat the data in these three windows by selecting the appropriate From radio button. IPLab will transform the data in these three windows into the color coordinates you specify by the To radio button.

The dialog prompts you for the names of three data windows to be treated as the input components. The data in each of these three component windows must be Byte type. You may select the window names by clicking on the drop-down list boxes and choosing from the open windows.

No new windows are created; the data is transformed in-place. However, the names of the original image windows are modified to indicate the new color coordinates by appending the one-letter designation of the new color coordinates to the original names. If you are converting to CMY, the designation "Ye" is appended to the window containing the yellow component of CMY to avoid possible confusion with the Y component of the YIQ coordinate system.

7.7.16 Affine Color Transform

This command allows you to define your own color coordinates as an affine transformation on RGB or YIQ coordinates.
Affine Color Transforms Dialog Box

The dialog first prompts you for the **Transform Name**. You may select **RGB to YIQ**, **YIQ to RGB**, or a custom color space (which you can name by using the *Rename* button). When you choose a transform, the values for the corresponding color space matrix and vector will appear in the middle of the dialog box.

The equation beneath the **Transform Name** field prompts you for the components of the transformation matrix and vector. This is the formula that will be applied to each pixel in the component input images, B1, B2, and B3:

\[
\begin{bmatrix}
C_1 \\
C_2 \\
C_3 \\
\end{bmatrix} = \begin{bmatrix}
M_{11} & M_{12} & M_{13} \\
M_{21} & M_{22} & M_{23} \\
M_{31} & M_{32} & M_{33} \\
\end{bmatrix}\begin{bmatrix}
B_1 \\
B_2 \\
B_3 \\
\end{bmatrix} + \begin{bmatrix}
D_1 \\
D_2 \\
D_3 \\
\end{bmatrix}
\]

where **C** is the new color space, **M** is the 3x3 transformation matrix, **B** is the original color space of the source images, and **D** is the transformation vector.

To create your own transform, or to edit an existing transform, choose from the **Transform Name** field. Then type your new values for the color space's matrix and vector. When you click **OK**, *IPLab* will save all of your changes.

In the **Source Windows** section, enter the names of three open input windows by clicking on the drop-down text boxes labeled **C1**, **C2**, and **C3**, or by typing their names. All three windows must be the same data type (e.g. Byte, Short Int, etc.). When transforming from RGB, for example, these will be treated as the red, green, and blue components.

When you click **OK**, the command will transform the data within the existing windows, so save your data first! To indicate the new color coordinates, the codes "_C1", "_C1", and "_C1" will be appended to the original window names.
7.8 3D Menu

The 3D commands display and measure images with three or more dimensions. You can acquire 3D image data within the IPLab environment or by importing it from an external device such as a confocal microscope. Applications of the 3D commands include microscopy (both transmitted and multi-probe fluorescence), 3D reconstruction of a sliced object, and visualization of computer generated 3D sets of data.

*IPLab* simplifies image processing and archiving by acquiring and saving 4D images as different frames of a single image file, which can be saved in *IPLab* and TIFF file format. This image sequence can contain both Z (depth) and T (time) sequences.

7.8.1 3D Equalize

This command equalizes the intensity level or brightness of all frames in a Z or T sequence. It does this in two steps: first, it subtracts a background image or an offset value from all frames in the sequence, and then it applies a linear transformation to every pixel.

The image data in the active window may be of type Byte, Signed 16, Unsigned 16, or Color 24. The operation is always performed in place. That is, it changes the values in the original image. The command operates on the active window and is scriptable.

![3D Equalize Dialog Box](image)

**3D Equalize Dialog Box**

Operate on: These radio buttons control whether the command equalizes the Z sequence or the T sequence. If you choose Z Sequence, then the command will equalize intensities within all Z frames for the current time point. If you choose T Sequence, then the command will work upon all T frames for the current Z depth.
**Constant:**

When **Constant** is selected, **IPLab** subtracts this constant value from each of the sequence's pixels. If you do not want to apply background subtraction, enter a value of zero. Each pixel in the sequence undergoes the following transformation:

\[
value[x,y,n] = value[x,y,n] - Bgnd,
\]

where:

- \(value[x,y,n]\) is the pixel value at point \((x,y)\) in frame \(n\) of the original sequence
- \(Bgnd\) is the background constant.

**Window:**

When you select **Window**, **IPLab** subtracts the background image from each of the sequence's frames. Pick the name of the open background image from the associated pop-up box.

Each pixel in the sequence undergoes the following transformation:

\[
value[x,y,n] = value[x,y,n] - Bgnd[x,y],
\]

where:

- \(value[x,y,n]\) is the pixel value at point \((x,y)\) in frame \(n\) of the original sequence
- \(Bgnd[x,y]\) is the pixel value at point \((x,y)\) in the background image.

Equalization is only applied to the sequence if the box labeled **Equalize Using the ROI Mean** is checked. When equalization is applied, it is always done after background subtraction. This option calculates the average ROI mean of all frames. It then scales the pixel values in each frame so that the ROI mean of each frame equals this value (the average ROI mean). The equalization options are:

**Use Addition Only:**

When this option is selected, an additive transformation is used to equalize the sequence.

Each pixel in the sequence undergoes the following transformation:

\[
value[x,y,n] = value[x,y,n] + ROI_{Avg} - ROI_{Local},
\]

where:

- \(value[x,y,n]\) is the pixel value at point \((x,y)\) in frame \(n\) of the original sequence
- \(ROI_{Avg}\) is the mean of pixel values within the ROI of all frames
- \(ROI_{Local}\) is the mean of pixel values within the ROI of frame \(n\)

**Use Linear Scaling:**

When this option is selected, a linear scaling transformation is used to equalize the sequence.

Each pixel in the sequence undergoes the following transformation:

\[
value[x,y,n] = \frac{value[x,y,n] + ROI_{Avg}}{ROI_{Local}},
\]

where:

- \(value[x,y,n]\) is the pixel value at point \((x,y)\) in frame \(n\) of the original sequence
$ROI_{Avg}$ is the mean of pixel values within the ROI of all of the sequence's frames.

$ROI_{Local}$ is the mean of pixel values within the ROI of frame $n$.

**Note:** When equalizing a Color 24 image sequence, the $ROI_{Avg}$ and the $ROI_{Local}$ values are calculated from each channel separately. Each channel is equalized individually.

### 7.8.2 3D Filter

This command applies a tunable sharpening filter to a single frame or to an entire sequence. While this operation is not exactly equivalent to digital deconvolution, this filter can produce similar results. **3D Filter** sharpens an image using adjacent pixels within the same frame or neighboring frames. The filter mask is a cube with three pixels per side, where the pixel being processed is in the cube's center. For color data types, the filter is applied separately to each of the three channels.

The **3D Filter** command operates on the active window and is scriptable. The active window must contain Byte, Signed 16, Unsigned 16, or Color 24 data.

![3D Filter Dialog Box](image)
Adjacent-Frame Haze: This controls what percentage of haze from neighboring frames will be removed from the current frame.

Gain: This parameter controls the gain of the filter. **3D Filter** multiplies all pixel values by the gain value after the image is filtered. A gain of ten leaves the image unchanged.

In the case of Signed 16 and Unsigned 16 data, you may not see the effect of gain because the image is normalized when displayed (see **Normalization** in the Enhance menu).

Low Threshold: The threshold is the pixel value at which the filter starts sharpening. Only pixels with values above the Low Threshold value are processed.

This is especially useful for processing dark field images, which have features with pixel values higher than the background. (If your image does not fit this model, you may be able to use the *Invert* command in the Enhance menu before applying the 3D filter.) If you set the Low Threshold value higher than the background, then only the features of interest will be enhanced, and not the noise in the background.

Use Adaptive Filtering: Adaptive filtering produces a more natural-looking result for dark field images by modifying the way the processing is applied. With **Adaptive Filtering**, the level of filtering increases gradually with the intensity contribution of adjacent pixels. (This manual describes **Adaptive Filtering** on page 235.)

Note that you can always achieve a linear sharpening filter if you set the Low Threshold value to zero and do not check the Adaptive Filtering checkbox.

Background Correction: Check this box to automatically remove unevenness from the background.

For this to work properly, you must select the type of microscopy from the **Mode** box: **Dark Field**, **Bright Field**, or **DIC**.

Please read the description of the **Background Correction** command for more information about how this works. You will find it in the Processing Extensions section of the Extensions Manual.

Apply: Click the **Apply** button to preview the filtering in the current frame's ROI. You can change the filter settings and click **Apply** again and again to try out different settings.

For faster experimentation with filter settings, select a ROI and then click **Apply**. Only the ROI will be filtered. However, when you click **OK**, the entire frame will be filtered.

Restore: **Restore** removes any applied filtering, returning your image to its initial state.

Do All Frames (Z): Choose this to filter all Z frames in the sequence. If the image is also a time sequence, choose this option to filter all Z frames for the current T frame.

Do Frames (Z): Choose this option to only filter this range of Z frames. The others will be left as they are. If the image is also a time sequence, choose this option to filter this range of Z frames for the current T frame.

Apply to the Whole Sequence (T): Choose this to filter all the T frames in the sequence for the currently selected Z frame.
Create New Window:  When this box is checked, the filtered results will be placed in a new window. When this box is unchecked, the filtered results will replace the original data.

Click OK to filter the image sequence (either the entire sequence or the selected range of frames) for real. While clicking Apply filters only the ROI, clicking OK filters the entire width and height of the chosen frames. If you click Cancel, then no filtering will occur.

Note:  Processing a complete sequence may take some time. For fastest interactive results on large images, you should select a rectangular ROI before using this command. Smaller ROIs yield quicker results.

About Adaptive Filtering

Adaptive filtering produces a more natural-looking result for dark field images by modifying the way the processing is applied. Without adaptive filtering, the amount of filtering (the Delta value in the formulas below) is a step function. If the intensity contribution of adjacent pixels (the Blur value) exceeds the threshold value, the filter will be applied; otherwise, no filtering is done on that pixel. With Adaptive Filtering, the level of filtering increases gradually with the Blur value. The graphs shown below illustrate the differences between adaptive and non-adaptive filtering (Delta of 0.75, Threshold of 30).

\[
\text{value}[x,y,z] = \text{gain} \left( \frac{\text{Seq}[x,y,z] - \Delta_1 \ast \text{blur}_1}{1 - \Delta_1} - \Delta_2 \ast \text{blur}_2 \right)
\]

where \( \Delta_2 = 0 \) for single frames.

and by the following if \( \text{blur}_1 < \text{threshold} \):

\[
\text{value}[x,y,z] = \text{Seq}[x,y,z]
\]

The variable \( \text{blur}_1 \) is the average value of neighboring pixels in frame \( z \) and is determined by the following expression:
The variable $\text{blur}_2$ is the average value of neighboring pixels in adjacent frames. Since the frame of interest may or may not have adjacent frames, four cases must be considered.

1. If the image only has a single frame, then

$$\text{blur}_2 = 0$$

2. If the frame of interest (frame $z$) is the first frame, then

$$\text{blur}_2 = \frac{\sum_{i=1}^{1} \sum_{j=1}^{1} \text{Seq}[x + i, y + j, z + 1]}{9}$$

3. If the frame of interest is the last frame, then

$$\text{blur}_2 = \frac{\sum_{i=1}^{1} \sum_{j=1}^{1} \text{Seq}[x + i, y + j, z - 1]}{9}$$

4. If the frame of interest is a middle frame, with frames above and below, then

$$\text{blur}_2 = \frac{\sum_{i=1}^{1} \sum_{j=1}^{1} \text{Seq}[x + i, y + j, z - 1] + \sum_{i=1}^{1} \sum_{j=1}^{1} \text{Seq}[x + i, y + j, z + 1]}{18}$$

Expressions for Delta ($\Delta_1$ and $\Delta_2$) change when adaptive filtering is used. When adaptive filtering is not used, $\Delta_1$ and $\Delta_2$ are constants:

$$\Delta_1 = \frac{\text{sharpness}_{\text{in}}}{100}$$

$$\Delta_2 = \frac{\text{sharpness}_{\text{out}}}{100}$$

When adaptive filtering is used, $\Delta_1$ and $\Delta_2$ are functions of pixel intensity:

for $\text{blur}_1 - \text{threshold} < k$

$$\Delta_1 = \frac{\text{sharpness}_{\text{in}}}{100} \left( \sqrt[3]{\frac{\text{blur}_1 - \text{threshold}}{\sqrt{k}}} \right)$$

$$\Delta_2 = \frac{\text{sharpness}_{\text{out}}}{100} \left( \sqrt[3]{\frac{\text{blur}_1 - \text{threshold}}{\sqrt{k}}} \right)$$

for $\text{blur}_1 - \text{threshold} \geq k$
\[ \Delta_1 = \frac{\text{sharpness}_{\text{in}}}{100} \]
\[ \Delta_2 = \frac{\text{sharpness}_{\text{out}}}{100} \]

where:

\text{sharpness}_{\text{in}} \text{ is the In-Frame Sharpness value entered by the user}

\text{sharpness}_{\text{out}} \text{ is the Adjacent-Frame Haze value entered by the user}

The filtering level \( \Delta \) is zero at the threshold level, and reaches the maximum value at \( k \). The value of \( k \) depends on the data type. For Byte and Color 24 data, \( k \) is a constant:

\[ k = 127 \text{ for Byte and Color 24 data} \]

For Signed 16 and Unsigned 16 data, \( k \) is the midpoint in the range of pixel values in the sequence:

\[ k = \frac{\text{value}_{\text{min}} + \text{value}_{\text{max}}}{2} \]

### 7.8.3 3D ROI Sum Plot

This command measures the sum or mean of intensities within the ROI of a sequence's frames. It outputs a line plot of the sum or mean intensities. (It is always a line plot, but you can change it to a bar plot by using the View menu's View Options: Plot command.)

The command operates on the active window and is scriptable. The active window must be a sequence of at least three frames, containing Byte, Signed 16, Unsigned 16, Long Integer, or Floating Point data.

[3D ROI Sum Plot Dialog Box]

This command provides the following options:
Operate on: These radio buttons control whether the command measures the intensities within the Z sequence or the T sequence. If you choose Z Sequence, then the command will measure intensities within all Z frames at the current time point. If you choose T Sequence, then the command will work upon all T frames at the current Z depth.

All Frames: When this option is selected, the ROI Sum or Mean is calculated for all frames in the sequence.

Custom: When this option is selected, the ROI Sum or Mean is only calculated for the frames that you specify. The first frame and the last frame to be included in the calculations must be entered in the Start and End Frame text boxes. Please select a range of three or more frames (End - Start Frame ≥ 3).

Sum: When this option is selected, the sum of intensities within each frame's ROI is calculated and displayed in the plot.

Mean: When this option is selected, the mean of intensities within each frame's ROI is calculated and displayed in the plot.

The measurement results are displayed in a plot showing the sum or mean values (on the Y axis) versus the frame number (on the X axis).

An Example Plot of the Mean Intensities within the ROI

**7.8.4 3D Mosaic**

This command displays the ROI selection of an entire sequence in a single image. It does this by creating a new single-frame image and copying each frame of the original sequence to the next position in the new image. **3D Mosaic** operates on the ROI of the active window and is scriptable. The active window must be a sequence containing any type of data besides Color 48. However, you can add a border only to Byte and Color 24 data types (please see page 240).
3D Mosaic Example

The above mosaic shows every second frame (frames #0, #2, #4, etc.) in the "FITC Series" sequence. The mosaic orders the frames from left to right, top to bottom. The following dialog box produced this mosaic.

3D Mosaic Dialog Box
The top of the dialog box tells you that **3D Mosaic** works on the image sequence's Region of Interest. It also tells you that the image contains 18 Z frames (#0-17)

This dialog box provides the following options:

**Operate on:** These radio buttons control whether the command creates a mosaic of the Z sequence or the T sequence. Of course, you must pick a dimension that has more than one frame.

If you choose **Z Sequence**, then the command will mosaic all Z frames at this time point. If you choose **T Sequence**, then the command will mosaic all T frames at this Z depth.

**Scale to Fit in Monitor:** This option scales the mosaic image so that it automatically fits on the main screen. Choosing this option deactivates complementary the **Custom** options.

**Custom:** This option scales the mosaic image according to your setting. Use the associated menu and text boxes to enter the scale and the number of columns and rows to use. Choosing this option deactivates the **Scale to Fit in Monitor** option.

Set **Scale Frame by 1/n** to scale each frame to that fraction of its original size.

The number of columns and rows determines the number of frames to include in each row of the mosaic and the number of rows to include in the final image.

**Include Every n Frames:** Use this value to decrease the number of frames shown in the mosaic image. If you enter a value of 1, all frames are included. If you enter a value of 2, every other frame is included. If you enter a value of 3, every third frame is included, etc.

**Add Border:** When this option is selected, the command creates a black or white border around each frame. Use the associated **Black** and **White** radio buttons to specify the color.

**Add Border** works only for Byte or Color 24 data types. Adding a border might affect the image normalization for other data types.

**Border Size:** Enter the thickness, in pixels, of the border around each frame.

### 7.8.5 3D Extract Slices

**3D Extract Slices** creates orthogonal views of your 3D or 4D sequence's ROI. If you think of your image sequence as a cube, **3D Extract Slices** cuts that cube and shows you the cross-sections. When working with deep Z sequences, you can create image sequences of all of the XZ and YZ planes. When working with T (time) sequences, you can create image sequences of all of the XT and YT planes.

The command is scriptable. The active window must be a sequence of any data type except Color 48.
3D Extract Slices Dialog Box

Operate On: Choose the dimension in which you want to slice. The chosen dimension must have more than one frame.

Scale Z / Scale T: This factor scales the depth of your slice by interpolating frames in the Z or T dimension.

To determine the appropriate value, you should acquire an image of an object with a known size, such as a ruler or a grid. If the distance between pixels in the X or Y dimension is smaller than the distance between acquired planes, you need to enter an interpolation value. For example, assume you have a distance of 0.4 microns between pixels in the images, and a distance of 2.0 microns between optical slices.

Therefore, the recommended number of interpolated frames is:

\[(2.0 / 0.4) - 1 = 4\]

The Scale option uses bilinear interpolation to calculate pixel values in interpolated frames.

These checkbox labels change to match the type of sequence being operated upon:

- **XZ, YZ Plane:** Check this checkbox to create an image of all XZ planes or all YZ planes at this time point. When you choose XZ Plane, for example, you are actually choosing to create an image sequence of all XZ planes within the ROI.

- **XT, YT Plane:** Check this checkbox to create an image of all XT planes or all YT planes at this Z depth. When you choose XT Plane, for example, you are actually choosing to create an image sequence of all XT planes within the ROI.

The resulting images display the Z or T depth of the original image sequence:
7.8.6 3D Extended Focus

The 3D Extended Focus command constructs an in-focus view of an entire sequence of Z frames. The single-frame output flattens the 3D sequence and allows you to see all parts of it in focus at once. 3D Extended Focus produces less haze than 3D Stacked View. This command works best with reflective (bright field) data, but can be used with fluorescence data as well.

![3D Extended Focus dialog box](image)

**Output Frame:** Choose the type of image that 3D Extended Focus will produce.

For either type of output: For the neighborhood of every \((x,y)\) position, the 3D Extended Focus command finds the frame with the highest contrast, which probably means the best focus.

**Composite Focus:** This option makes an image from in-focus data from the entire sequence. Different areas of the resulting image will come from different frames. As a whole, the entire composite focus image will look as if it is in focus.

**Best Focus:** This option finds the frame within the sequence that has the most in-focus neighborhoods. It also creates a 'depth frame' to tell you the frame number of this best-focus image.
• You may find **Best Focus** useful when your sample drifts vertically through the microscope’s focal plane. You can capture more data than you need, and then extract the right one.

• You could create an auto-focus script by using the **3D Extended Focus** command along with the **Best Focus** option.

### Sharpness Map:
Pick from two methods of calculating contrast: **Local Contrast Map** and **Gaussian Contrast Map**.

#### Local Contrast Map:
This is best for images of reflective, solid objects. It preserves local details.

#### Gaussian … Map:
This is for general purpose use. It suppresses noise and uses a larger region than the **Local Contrast Map**.

### Neighborhood:
The command will examine each plane’s contrast within this **Small** or **Large** area.

### Smooth Filter:
Apply a blurring filter to remove artifacts from the final image. You can choose **None**, **Blur Little**, or **Blur a Lot**.

### Apply to T Sequence:
If you have a 4D image, check this box to make **3D Extended Focus** work on every Z sequence within the T sequence. (Your 4D image is a time series of 3D sequences.)

This option will produce a T sequence where each T frame is the in-focus view of the corresponding T frame in the original 4D image.

### Best Quality:
This option produces a higher-grade image, but takes longer.

### Sharpness Map Descriptions:
Descriptions of the **Sharpness Map** options will appear under the checkboxes.

### Apply, Restore:
Click **Apply** to use the selected settings without closing the dialog box. You can then improve the settings and click **Apply** again. Click **Restore** to close the new window.

### OK, Cancel:
Click **OK** to produce the in-focus image and close the dialog box. Click **Cancel** to close the dialog box without making any images.

In general, the best options to try first are: **Gaussian Contrast Map**, **Large** neighborhood, and **Blur: None**.

### 7.8.7 Generate Kymograph

Kymographs may be used for particle/cell tracking and motion analysis experiments. The kymograph feature consists of two commands: **Generate Kymograph** and **Measure Kymograph**. The **Generate Kymograph** command creates kymograph images from the stack image using the tracks drawn by the user. **Measure Kymograph** command measures the kymograph images and generates a table with the quantified data. Both commands work on byte, signed 16, unsigned 16 and color 24 data types. Please see the Tutorial section of this manual for an example.
In order to use the Generate Kymograph feature, please follow these steps:

1. Open a time sequence image and generate max or min projection using the 3D Time Stack View command located under the 3D Menu.

2. On the projection image trace along the path of the object of interest using the draw line tool. Each object can have its own trace.

3. Select the Generate Kymograph menu and select the images for generating the individual kymograph images. Each trace drawn will create an individual image, which can be measured using the Measure Kymograph command.

**Generate Kymograph Dialog Box**

- **Stack Image**: refers to the time series image.
- **Drawing from Image**: Projection image with the object track drawings.
- **Line width**: line width along the path trace that needs to be considered for intensity information.
- **Average**: The intensity information along the width is averaged used for generating the kymograph image. Each time point is represented by one row of data in the kymograph image.
- **Repeat**: The intensity information is copied along the path traced from the stack image to the kymograph image. Therefore, each time point has "line width" number of rows representing it.

**Note**: The kymograph images follow the naming pattern of `<original image name>_k0,<original image name>_k1` and so on...
The generated kymograph images have a special file tag ("Kymo Tag") attached to them. This information is used while using **Measure Kymograph** command.

### 7.8.8 Measure Kymograph

After the kymograph images are generated, the kymographs are analyzed using the **Measure Kymograph** command. The kymograph image is measured using the following steps:

1. Select a kymograph image.

2. Create a drawing along the line where the kymograph data needs to be measured using the draw line tool. The line can have multiple slopes (i.e. multiple sections) and measurements for each slope/section will be reported in a separate column.

3. Select the **Measure Kymograph** command

4. If the data was acquired using **IPLab** time lapse command then the data image will have timing information saved in them. The timing information (if available) is saved along with the settings used to generate kymograph images. Select the "Use Image Tag" radio button to automatically use the information saved with the image.

   If the images do not contain a kymograph tag, then select the “Custom Kymo Tag” radio button. The experiment parameters must be entered into the boxes as shown below.

**Note:** the kymo tag is not saved if there is no timing information present in the original time sequence data.
Image Tag: Choose this option when the images have the image tag in them.

Custom Kymo Tag: Choose this option if the kymograph image was generated outside of IPLab.

- **Time**: Enter the time information in seconds.
- **Line Width**: Thick line width in pixels that was used while generating the Kymograph image.
- **Number of Frames**: The number of time frames in the original time sequence image.

Compute Average Speed: Generates the average speed information using the start and end positions of the trace lines on the kymograph image. It ignores the multiple piece wise regions /sections of the line and assumes a single line from start to finish.

The results are placed in a table called Kymograph. The kymograph data from the same parent image can be appended to the table while the table is open.
Kymograph Data Table **showing data from two tracks.**

### 7.8.9 Generate Axial View

The **Generate Axial View** command operates on a Z-stack image and produces an axial view along the regions denoted by the user. The new image window represents Euclidean distance on the horizontal axis and z depth in the vertical axis. The command works on all data types.

**Generate Axial View Dialog Box**

**Stack image**: Refers to the Z-stack image. The user needs to draw lines denoting regions from which the axial view needs to be generated. The user can draw the lines using the line drawing tool.

**Line width**: Refers to the line width along the path trace that needs to be considered for intensity information. The intensity information along the width is averaged and used for generating the kymograph image. Each time point has one row of data.

**Interpolate frames**: The Z frames are interpolated based on a Z scaling value. The necessary interpolation factor is the relationship between the XY units of the image and the Z spacing (Z Step used during the image collection).

**Image**: The Z scaling is computed from the acquire information present on the input image.
**Custom**: The user can use a custom Z scaling value for the input image. This option needs to be used when there is no acquire information present in the input image.

The axial view images follow the naming pattern of <original image name>_AV0,<original image name> _AV1 and so on...

To generate an axial view, use the following steps:

1. Open a Z stack image.
2. Use the line drawing tool to draw the region or line, that will be used to generate the axial view.
3. Open the Generate Axial View dialog and select the appropriate image Z-stack. If the image contains the IPLab acquisition parameters, select the “Image” radio button. Enter the line width value.
4. Press the “OK” button to generate the axial view.

### 7.8.10 3D Projector

**3D Projector** creates a three dimensional projection of the active image sequence. The projection can be made so that it rotates around either the X or Y axis, or so that it tumbles in all three dimensions.

Image projection is extremely computer intensive, and the projection of large images can take several minutes. Image width, height, the number of frames, and the number of steps to make (see below) are all factors. Projection of color images takes longer since all colors are treated independently.

This command works on the entire image. In order to make a projection faster, you may want to make a smaller copy of the region you wish to project. To do this, select the region of interest (ROI) and choose **Duplicate Window (Window menu)**. Duplicate only the ROI and the Z frames that you want to see. This will make a smaller image that will take less time to project. **3D Projector** only works on images of type Byte and Unsigned 16. When working on images of other types, you can convert to byte or Unsigned 16 by using the **Change Data Type** command (Math menu).
3D Projector Dialog Box

**X Axis:** When this radio button is chosen, the projection will be made so that it rotates around a horizontal axis. In this extension, rotation in a positive direction means that points at the bottom of the window will rotate towards the user.

**Y Axis:** When this radio button is chosen, the projection will be made so that it rotates around a vertical axis. Rotation in a positive direction means that points at the right of the window will rotate towards the user.

**Tumble:** When this radio button is chosen, the projection will appear to tumble in all three directions in order to show off all of its sides.

**Starting Angle:** This is the angle, relative to the rotation axis, that the projection will start at. 0° is flush with the surface of the monitor.

**Ending Angle:** This is the angle, relative to the rotation axis, that the projection will finish at.

**Number of Steps:** This is number of pieces that the projection will be broken into. If the total rotation is to be 360°, and the **Number of Steps** is 10, as in the above example, then the projection will appear to have rotated 36° after each step.

**Interpolate Frames in Z:** Enter the number of frames to insert between each frame in the original sequence. Interpolated frames are merely duplicates of the preceding frame. You may want to add interpolated frames in order to increase the depth of the image.
You must interpolate at least one frame.

**Overview of 3D Visualization and Projection**

The visualization of 3D volumes obtained with a real world camera and microscope presents a number of challenges. The intensity values obtained form a three dimensional array of voxels. The rendering process tries to convey the three dimensional information into a two dimensional medium, such as your computer screen or a printed page. Each voxel in space contains information such as intensity, opacity and position. In the case of a color object, there are three values for intensity: red, green and blue.

In general, there is too much information available to display in a compact manner. Consequently, all 3D rendering packages make some assumptions about the data's nature in order to make a 2D presentation. Some packages will resort to displaying surfaces instead of voxel values (appropriate if displaying opaque solids). Others assume that voxels with a similar intensity value belong to a similar object class, with a common transparency value (which may be true when displaying clinical data such as computer aided topography scans or magnetic resonance imaging).

Neither of the above assumptions is appropriate if you are looking through fairly transparent objects (such as cells or tissue). For example, in the case of dark-field microscopy, an object has an intensity related to its light scattering properties (refractive index variations). In the case of fluorescence microscopy, an object with uniform loading has an intensity related to its thickness.

The 3D Projector command enables you to inspect your data set as a volume. The 3D Projector procedure for 3D visualization has been optimized for images taken with optical microscopes. The procedure is called *ray casting*. Every pixel in the 2D projection is the result of tracing (projecting) a ray through the object volume at a particular angle. The sections are considered to be transparent. The 3D Projector procedure has also been optimized for dark-field or fluorescence images (with bright objects on a darker background).

**7.8.11 3D Stacked View**

This command can be used to synthesize a sequence's data into a new, single-frame, 2D image. This enables you to readily examine the relative (x,y) positions of significant details within the 3D volume. 3D Stacked View performs one of four different mathematical operations on the sequence. The original image is left unchanged, and the result is displayed in a new, single-framed image window. For less haze from a reflective sample, use the 3D Extended Focus command (page 242).

The command can be applied to images of images of all data types. The resulting window is of the same data type as the original sequence, except when you select **Sum**. The **Sum** option cannot be used on color images, and always places the results in a Long Integer image.
3D Menu

Stacked View Dialog Box

Max: This produces an image of the maximum values present within the volume. It is recommended for use with dark-field and fluorescence images, where the objects of interest are brighter than the surrounding background. The value at each pixel's \((x,y)\) location is assigned the highest value for that location across all frames of the sequence.

Min: This produces an image of the minimum values present within the volume. The value at each pixel's \((x,y)\) location is assigned the lowest value for that location across all frames of the sequence. This option is useful when observing bright field images, where the objects of interest are darker than the surrounding background.

Average: The Average option improves the signal-to-noise ratio of an image series. Each pixel in the result contains the average value of pixels at that \((x,y)\) location across all frames of the original sequence.

Sum: The Sum option improves the signal-to-noise ratio of an image series, and to obtain the total pixel values for the entire sequence. Each pixel in the result contains the sum of pixel values at that \((x,y)\) location across all frames of the original sequence.

The result of a Sum option is always a Long Integer image. Sum cannot be applied to color images.

7.8.12 3D Time Stacked View

This command can be used to synthesize a time-lapse data sequence into a new, 2D image or a 3D through focus stack. This enables you to readily examine the relative \((x,y)\) positions of significant details over time. 3D Time Stacked View performs one of seven different mathematical operations on the image sequence.

The original image is left unchanged, and the result is displayed in a new, image window. The command can be applied to images of all data types. The resulting window is of the same data type as the original sequence, except when you select Sum. The Sum option cannot be used on color images, and always places the results in a Long Integer image.
Max: This produces an image of the maximum values present within the time lapse sequence. It is recommended for use with dark-field and fluorescence images, where the objects of interest are brighter than the surrounding background. The value at each pixel's (x,y) location is assigned the highest value for that location across all frames of the sequence.

Min: This produces an image of the minimum values present within the time lapse sequence. The value at each pixel's (x,y) location is assigned the lowest value for that location across all frames of the sequence. This option is useful when observing bright field images, where the objects of interest are darker than the surrounding background.

Average: The Average option improves the signal-to-noise ratio of an image series. Each pixel in the result contains the average value of pixels at that (x,y) location across all frames of the original sequence.

Sum: The Sum option improves the signal-to-noise ratio of an image series, and to obtain the total pixel values for the entire sequence. Each pixel in the result contains the sum of pixel values at that (x,y) location across all frames of the original sequence.

The result of a Sum option is always a Long Integer image. Sum cannot be applied to color images.

Std. Dev The Standard Deviation option produces an image of the standard deviation of the pixel intensity over time. The value at each pixel's (x,y) location is assigned the standard deviation value for that location across all frames of the sequence.

Var/Mean The Variance/Mean option produces an image of the pixel intensity variance divided over the mean pixel intensity for each (x,y) location across all frames of the original sequence. The Variance/Mean option is useful for identifying the location of intensity changes over time. This option is best used for identifying low frequency changes.

Diff.SD The Difference of the Standard Deviation option produces an image of the standard deviation of the differences over time for each (x,y) location across all frames of the original sequence. The Difference of the Standard Deviation option is useful for identifying oscillations or high frequency changes over time.
7.8.13 3D Time Difference View

The time difference view command can be used to analyze image differences between time points in time lapse experiments. The command will generate a new image sequence by subtracting the previous image in the sequence from the current one, the number of frames will be one less than the original. Each image in the new sequence will show the difference between the images over time, except for the unprocessed first frame in the sequence.

**3D Time Difference View Dialog**

7.9 Camera Menu

The Camera menu contains the commands for camera control and acquiring images. (This used to be called the Acquire menu.) Image acquisition, also called capture or grabbing, is the process of controlling the camera and receiving an image from the camera. IPLab for Windows has a device-independent acquisition interface. One set of commands works to acquire images from any supported camera.

Some video acquisition hardware is capable of integrating images (accumulating an exposure on the CCD over times longer than one frame, which is 1/30th of a second). In this case, integrate by setting the Exposure Time to more than 1 frame. Then all other settings that refer to “frames” will actually refer to “integrated frames.” Acquiring a sequence of five images, for example, will always acquire five images, regardless of the number of integrated frames.

It is very useful to remember that the exposure time used in the last acquisition is always stored in the numeric variable #255.

7.9.1 Select Camera

Use this command to select the type of camera or frame grabber device you are using (e.g. Scion frame grabber, Princeton Instruments camera, Sensicam camera, etc.). If you need information about installing additional camera controls, please see the Camera Control section of the Extensions Manual.
The Select Camera command brings up the above dialog box, which lets you choose the correct camera or frame grabber from a pull-down list. Once you've made your choice, click OK.

**Note:** This was formerly called the Select Acq. Device command.

### 7.9.2 Get Camera Info

This command calls a dialog box that stores camera-specific information such as the CCD type. The dialog differs for each acquisition device. For more information about information specific to cameras, please see the Camera Control section of the Extension manual.

**Note:** This was formerly called the Get Device Info command.

### 7.9.3 Acquire

In addition to capturing data, the Acquire command lets you set, save and review image acquisition parameters for a variety of uses. We have divided image acquisition parameters into "tabs." Each tab contains specific information regarding image acquisition. We discuss the features of each tab individually on the following pages:

- General Tab: page 256
- Exp. Tab: page 258
- Size Tab: page 259
- Devs Tab: page 261
- Time Lapse Tab: page 263
- and also the:
  - Progress Bar Palette page 264
  - Preview Control Panel: page 265

*IPLab* stores some of the acquisition parameters in tags within the image file. You can view this "acquire info" or "experiment log" via the window's button (described on page 12); copy them into variables through the Extract Image Info: Acquire Info command (Analyze menu, page 202), and transfer them from image to image via the Transfer Attributes command (Edit menu, page 134).
Configuration

The configuration field allows you to set and save acquisition parameters. We have preset the parameters for three configurations: Focus, Single and Full. There are also two custom configurations: Custom1 and Custom2. Each configuration with its associated parameters may be altered and saved under a name of your choice. You can set the name of a configuration by selecting the Rename button and entering the desired name in the available field. You may also copy the configuration parameters to another configuration name by selecting the Copy button and selecting the new location from the pull-down menu.

Selecting Cancel will return to the IPLab window and will not save any altered acquisition setting.

Selecting OK will perform the acquisition task specified by the given parameters.

Focus: The Focus configuration is intended to let you put the image in focus while viewing it on the computer monitor. The computer will continuously acquire and display images from the camera until you have completed focusing the image. This preview is particularly useful for microscopes that are not parfocal with the camera.

Single: The Single configuration is intended to capture a single image frame.

Full: The Full configuration is intended to capture single or multiple image frames.
**Current Settings Tab**

The Current Settings tab displays a summary of the configuration’s settings.

**General Tab**

The General tab contains features for viewing image data. The following options are available: *Preview*, *Image Destination*, *Source Channel*, *Process*, *Create Timing Window* and *Display After Each Grab*.

---

**General Tab of the Acquire Dialog Box**

**Preview:** If the **Preview** check box is checked, it allows you to see the image before capturing it. By selecting the **Preview** option, you also allow manipulation of several image acquisition options prior to data collection. See the description of the **Acquire Preview** dialog box below.

**Image Destination:** The **Image Destination** dialog allows the image to be saved into the **Front Window** or as a **New** window with a name of your choice. If you select **New**, the default name will be **Untitled**, but you may save the new image with a name of your choice.
Source Channel: The **Source Channel** dialog box allows you to select from the channels of data produced by your camera.

A color camera using the Scion CG-7 frame grabber, for example, produces three channels of data: red, green, and blue. If you like, you can choose to acquire only one of those channels. In order to acquire full color from a color camera, choose the **RGB Color** option.

When using a grayscale camera, simply select channel **1 RED or (B\W)**.

Process: When using video cameras, you have the option of averaging or summing frames of acquired images to improve the appearance of the resulting image (*i.e.* increase the signal to noise ratio).

When you choose either **Average** or **Sum Frames**, a second text box appears, called **Num**. Enter the number of frames to process in the **Num**. text box. The specified number of frames will be grabbed and added together pixel by pixel. When using the **Average Frames** option, the result will be placed into a byte or color 24 image. When using **Sum Frames** with a gray-scale camera, the results will be placed into a window of type unsigned 16. When using a color camera, however, the results will be placed into a window of type color 48. Since it takes some time to **Average** or **Sum Frames**, the subject of your image should not be moving. By selecting only a portion of the full field of view, summing or averaging image frames can be much faster than when operating over the camera’s full field of view.

When you do not wish to sum or average, select **No Processing**.

Fast Capture Mode Into Z

The **Fast Capture Mode into Z** option speeds up your acquisition by placing the data into a single image sequence instead of into multiple windows. Since this behavior depends on features of the camera, only some cameras will support this option.

To make use of **Fast Capture Mode**, go to the Size tab and enter a number of frames in the Z Depth field. The camera will pump this many frames into the Z dimension of a single image sequence. (This works for all cameras, but it works much faster when the camera supports **Fast Capture Mode**.)

Create Timing Window: When this box is checked, **IPLab** will record the time at which each frame is acquired. The times are recorded in seconds and are stored in a text-view window named "Timing."

Within the timing window, the first column (column #0) contains the starting time for each time point. One or more Z frames are contained in each time point, starting in column #1. The acquisition time for each Z frame is measured from the starting time, so the times in column #1 will always be 0 (0 seconds since the time in column #0).

Display After Each Grab: When this box is checked, each frame of a multiple image acquisition will be displayed as it is captured.

When you are concerned about acquisition speed, do not check this box. The program will then not have to waste acquisition time by updating the display on the screen.
**Exp. Tab**

The *Exp.* or Exposure Time tab allows you to enter the length of time that the camera should gather light.

---

**Exposure Time Tab of the Acquire Dialog Box**

**Exposure Time:** Enter the length of time that the camera should gather light. For digital cameras, time is measured in milliseconds. For video cameras, time is measured in frames, or thirtyths of a second. This is true despite the milliseconds label beside the *Exposure Time* box. The *Exposure Time* can be taken from a variable. Specify which variable by typing in the variable number and clicking the # button to V.

**Auto-Exposure:** *Auto-Exposure* is a function that automatically determines the appropriate exposure time. You would use this function if you do not know exactly what exposure time to use and you want the computer to calculate it. After you acquire the image, the exposure time produced by *Auto-Exposure* will be displayed in the *Exposure Time* text field and stored in variable #255.

In order to have an automatic exposure time calculated:

1. Enter your Initial Guess Exposure Time in the *Exposure Time* field.
2. Next, enter the Target Maximum Value into the *Target Max Val.* field.
3. Finally, click the **Calc. Now** button or choose from the radio buttons.

All of the options are described here:

**Exposure Time:** Enter your Initial Guess Exposure Time here. This is simply your first guess at what the exposure time should be. When the program calculates the automatic exposure time, it will begin its calculations using the Initial Guess Exposure Time. The first time you do this, just guess at how long the acquisition might take. A good first attempt for beginners would be 100 milliseconds (or 3 frames for a video camera).

**Target Max Val.:** The Target Maximum Value is the desired, highest pixel intensity in the final image. The auto-exposure function will calculate what exposure time would be best in order to produce an image whose highest pixel intensity is the Target Maximum Value. You should set the Target Maximum Value to be close to but lower than the maximum pixel value your camera can deliver. Otherwise, you would risk overexposing the image. (Without summing frames, the maximum pixel value a video camera can deliver is 255; the maximum value a 12-bit, digital camera can deliver is 4095.) For a video camera, you could enter 170. For a 12-bit, digital camera, you could enter 2700.

**None:** Choose this radio button when you do not want the exposure time to be automatically calculated when you click **OK** in the **Acquire** dialog box.

**Before First Frame:** When this radio button is selected, the exposure time will automatically be calculated when you click **OK** in the **Acquire** dialog box. If you are acquiring multiple frames (either with **Z Depth** > 1 in the **Size** tab or with **Iterations** > 1 in the **Time Lapse** tab), then the auto-exposure function will run once before the first frame, and that calculated exposure time will be used for each of the multiple acquisitions.

**Before Each Frame:** Selecting this radio button will cause the auto-exposure function to run before acquiring each and every frame of data. You would acquire multiple frames by setting **Z Depth** > 1 in the **Size** tab and/or **Iterations** > 1 in the **Time Lapse** tab. This option is particularly useful for counteracting photo bleaching when performing time lapse experiments.

**Calc. Now:** If you want **IPLab** to calculate the exposure time immediately, click the **Calc. Now** (Calculate Now) button. If you want the exposure time calculated after you click **OK** in the **Acquire** dialog box, then use one of the radio buttons described below.

**Size Tab**

The **Size** tab lets you set what size image to acquire. A number of the **Size** parameters can be taken from numeric variables by toggling the # buttons to read **V**.
Full Frame: Click on this radio button if you want the new image to be the full size that the camera can produce.

ROI on Window: This radio button enables you to acquire only part of the full image (i.e. a sub-region of the CCD). To do this, draw a ROI on an image. If you have already acquired an image, draw a ROI around a cell or feature. Next, select the Acquire command and click on this radio button. Select (or type) the name of the existing image from the pull-down box. The newly acquired image will only contain the cell or feature you selected. You can use a ROI drawn on any image.

If you draw the ROI on a binned image and acquire the sub-region with the same bin size, then the new image will be the same size as the ROI drawn. If you draw the ROI on an unbinned or newly created image, then the new image will be binned according to the Acquire command’s Bin Width and Height parameters.

Acquiring using the ROI on a window is very handy when you are acquiring many images and want to keep the image sizes small. Grab one full-size image first and draw a ROI around the important details. Next, acquire images with the size set to ROI on Window. Your acquisitions will proceed much faster and without taking up as much hard drive space.

Custom Rect: The Custom Rectangle radio button lets you specify the exact borders of the image you want to acquire. In the example dialog box above, the Custom Rectangle fields
are filled out to acquire a window 640 pixels wide by 480 pixels tall. The **Left**, **Right**, **Top**, and **Bottom** values are the locations of the edges of the rectangle. These locations are measured in pixels from the upper left corner of the CCD.

**Z Depth:**

The **Z Depth** command allows you to select the number of image planes you will collect. **IPLab** will acquire this number of image frames as fast as possible. The multiple frames of data will be placed within a single image file, where frame #0 is the first frame acquired, frame #1 is the next frame acquired, and so on. This **Acquire** command will not actually control a Z-axis focus motor.

If your camera supports Fast Capture Mode, it can pump multiple frames of data into the Z dimension of a single image sequence. To use Fast Capture Mode, check the option described on page 257 and then enter a number of frames in this **Z Depth** field.

**Bin Width/Height:**

A bin is a group of pixels made by counting a rectangular group of pixels out as if they were one. If two pixels side by side were counted out as if they were one pixel, we would say that they were binned 2x1, and the resultant image would be half as wide as normal, and brighter, too. Binned pixels are also called super pixels. Normal binning values are 2x2 and 4x4.

Because binning increases the brightness of the image, it decreases the exposure time needed. Please note that binning reduces the resolution of the image as well.

**Devs Tab**

The **Devs** or Devices tab allows you to select a shutter that you wish to control during image acquisition. It also lets you set **Camera Specific Settings**, using the **More** button.
Devs Tab of the Acquire Dialog Box

Shutter:
This control will make a shutter open just before and close just after the image acquisition, but before the camera reads out the data. The most common use for this is to protect a sample from exposure to too much light.

If you wish to use a shutter, you must first set up the device using the Select Devices command from the Control menu.

Select the shutter you wish to use from the Device Name pull-down menu. Then select the correct position name for open and close from the Open Position and Closed Position pull-down menus, respectively. String variables can be used to identify the Device Name, the Open Position, and the Closed Position. To do so, toggle the L (Literal) button to SV (String Variable) and then type the name of the proper string variable or choose it from the pull-down box.

Shutter Open Delay:
An extra delay may be needed to better handle cameras with a slower initialization rate. The range of delays is usually in the range of 5 ms to 120 ms; the maximum allowed is 5 seconds. If you think you need to change the Shutter Open Delay, add time to the Delay until the sum intensity of the image does not increase.

Camera Specific Settings:
The More button raises a dialog box containing device-specific settings such as black level and gain. For some camera systems, this dialog box will be the same on called by the Get Camera Info command (Camera menu). Not all camera systems have
camera-specific information to be displayed. Please see the information about specific cameras in the Camera Control section of the Extensions manual, for more details.

**Time Lapse Tab**

The **Time Lapse** tab allows you to acquire multiple images over time. When you perform a time lapse acquisition, **IPLab** will acquire a certain number of images with a set amount of time between each acquisition. This is extremely valuable when imaging live, moving, and/or changing samples.

After you start the time lapse acquisition, a progress bar palette appears. The progress bar is described on page 264.

**Use Time Lapse:** Click in this checkbox in order to perform a time lapse acquisition.

**Experiment Setup:** **IPLab** requires three values for the experiment: **Frames**, **Interval**, and **Experiment Length**. Click the radio button next to the value you want **IPLab** to calculate for you; that value will become grayed out. Then type in values for the other two.

**Frames:** This is the number of frames you want to acquire. (This used to be called **Iterations**.)
Interval: Interval is the length of time taken by one iteration. Interval can also be thought of as the time between starting to grab one frame and starting to grab the next frame.

Experiment Length: Experiment Length is the total amount of time taken by the time lapse experiment.

For example, clicking on Experiment Length will be gray it out. You would then have to enter the number of Frames and the length of each iteration into the Interval field. The dialog box would automatically calculate the Experiment Length.

Changing the units used for Interval and Experiment Length does have an effect on the calculated values. The available units of time are milliseconds (ms), seconds, minutes, and hours.

You can choose for any parameter (except the one to be calculated) to be taken from a numeric variable. Do this by toggling the # button so it reads V. Then enter the number of the variable where the parameter is stored. When a variable has been given for a parameter, the grayed out calculated value field will disappear. This is because the result of a calculation dependent on a variable cannot be displayed in real time.

Grab to Disk: The Grab to Disk option automatically saves each image immediately after it is acquired ("grabbed"). Images will be saved as indexed files, with a base name followed by a number. The numbered file names allow you to open the images sequentially at a later time. You can then convert them into a single-file sequence of images, or you can process each image in turn. You must be have checked the Time Lapse checkbox to be able to check the Grab to Disk checkbox.

Saving images to disk can be important if you are acquiring data for a long time. A power outage or computer malfunction could cause all data stored in memory to be lost. Any data saved on disk, however, would be safe.

If you are trying to acquire data as fast as possible, you would not want to use this option. You would not want to take the time to save each image immediately after acquisition.

Base Name: Enter the name to give the image when it is saved. This will only be the first part of the name; a number will be appended to the base name when the image is saved. If you check the Use Window Name checkbox, then the image will be saved with the window’s current name.

File Path: Enter the location on a hard disk or other storage device at which you want to save the images. It is practical to click the Browse button and use the standard file management dialog box to select a directory. An example file path would be "C:\IPLabDir\Images\0305_Data".

File Type: Select with which file type you want to save the images: IPLab format or TIFF.

Progress Bar Palette

The progress bar appears once you start a time lapse acquisition. It shows you how far along the acquisition has advanced. You can pause the experiment and turn on a "preview:"
The Progress Bar Palette

**End:** This button will completely stop data collection.

**Preview On:** Click this button to turn on the live "preview" between the image grabs. *IPLab* will grab data, show you a live view of the image, and then grab more data. *IPLab* will not save the live images shown between grabs. Click this button again to turn the preview off.

You can use **Preview On** to watch your experiment live while only saving data periodically. You may refocus your sample without interrupting the data collection.

**Note:** This feature will expose your sample to more light than usual, potentially causing photo damage.

**Pause / Continue:** Click this to temporarily stop the image acquisition. You may want to do this while adding reagents to the sample, for example. When you click **Pause**, it will change to the **Continue** button. Click **Continue** when you are ready to begin acquiring images again.

**Acquire Preview**

The **Acquire Preview** dialog box appears when you have checked the Preview option in the General tab and clicked **OK** in the **Acquire** dialog box. When you see the **Acquire Preview** box, you will also be seeing a live image from the camera. You can improve the live image by selecting a different preset **Configuration**, or by altering the data acquisition parameters currently entered.
Acquiring Grayscale Images

Acquiring Color Images

Acquire Preview Dialog Box

**Configuration:** This field allows you to select a different preset acquisition mode to be used for image acquisition.

**Exposure (ms):** This field allows you to change the exposure time. The time is listed in milliseconds (ms), which is the unit of measurement when using digital cameras. The unit for time when using video cameras is actually in frames (thirtieths of a second).

**ROI Min/Max:** Check this checkbox to see the minimum and maximum intensities present in the image. Speed up the acquisition slightly by unchecking this box.

**Norm:** This tab appears during grayscale captures. It normalizes the data, which improves the display of the image without altering the data.

**White Point:** This is the pixel value at which the image will appear white. This text box will be grayed out when **Use ROI Min/Max** is checked.

**Black Point:** This is the pixel value at which the image will appear black. This text box will be grayed out when **Use ROI Min/Max** is checked.
Show Sat. Pixels: By checking the **Show Sat. Pixels** checkbox, you will be able to see pixels that are saturated. The pixels in yellow are equal to or below the set black point and the pixels in red are equal to or above the set white point.

Use ROI Min/Max: If the **Use ROI Min/Max** is selected, then the minimum and maximum pixel intensities in the ROI will be used for the **Black Point** and the **White Point**, respectively. The **White Point** and **Black Point** options become grayed out when using the ROI min and max.

Color: This tab appears during color acquisitions. It normalizes color data, which improves the display of the image without altering the data.

Color Channel Menu: You can normalize the red, green, and blue channels individually or all together.

Norm Max: This is the pixel value at which the chosen channel will appear its brightest. This text box will be grayed out when **Use ROI Min/Max** is checked.

Norm Min: This is the pixel value at which the chosen channel will appear its darkest. This text box will be grayed out when **Use ROI Min/Max** is checked.

Use ROI Min/Max: Check this box to use the ROI's minimum and maximum pixel intensities for **Norm Min** and **Norm Max**.

Color Balance: The **Color Balance** feature removes unwanted tint from a color image. Select a region of interest on the image. Pick a region that should be black, white, or gray, or move the field of view to a neutral-colored region. Then click the **Color Balance** button.

See the **Color Balance** command on page 152 for a description of how this works.

Like the **Color Balance** command, this feature alters the data as it is acquired. Unlike the command, this feature stores the weight factors for the red, green, and blue channels in the **Set Color Balance Values** dialog. All subsequent color images will be color balanced just like this image, using these values.

Size: This tab controls the size and portion of the image being captured. Please see the description of the **Size** menu above, on page 259.

Devs: The Devices tab controls an external shutter and offers camera-specific options. Please see the description of the **Devs** menu above, on page 261.

Snapshot: By selecting the **Snapshot** button, you can acquire an image from the constantly updating preview window, and then continue to preview.

Histogram: By selecting the **Histogram** button, you can view a real time histogram for the live preview image.

Pause Live Preview: The **Pause** button will stop the preview without closing the window. Use this if you want to stop acquiring images (and exposing your sample) while you change the acquisition parameters.

If you have set up and are currently using a shutter, the shutter will close when you select the **Pause** button. You may open the shutter during the pause by selecting the **Devs** tab and clicking the **Open** button.
Live Preview: If you used the Pause button to stop the preview, the button will change to Continue. Click this button to restart the preview.

Cancel: The Cancel button will close the Acquire Preview dialog box and image acquisition parameter changes will NOT be saved.

OK: Click the OK button to begin grabbing images based on the parameters you entered.

7.9.4 Acquire (Using Last Config.)

The Acquire (Using Last Config.) command allows you to quickly acquire an image based on your last saved acquisition configuration. If you previously had the Preview check box selected, then Acquire (using last config.) will display a preview image and open the Acquire Preview dialog box. If Preview was not previously selected, then Acquire (using last config.) will acquire an image based on the configuration parameters of your last acquisition. Notice that the name of the command will change based on your last selected configuration, i.e., Acquire (Focus), Acquire (Single), Acquire (Full), or Acquire (Custom). If this command is used in a script, it will appear as Acquire using last config.

7.9.5 3 Pass Color

The 3 Pass Color command allows you to capture a color image using a grayscale camera and a wavelength switching device (e.g. filter wheel or tunable filter). It does this by capturing three images in succession using red, green, and blue filters. The three images are merged into a color 24 or color 48 image (for 8- and 12-bit cameras, respectively).

This command is only available if you have selected and set up both a camera and a wavelength switching device.

![3 Pass Color Dialog Box](image)

3 Pass Color Dialog Box

1. When this dialog box first appears, the Exposures and Image Size buttons will be grayed out.
2. Give your color image a name in the **Experiment Name** box.

3. Then click on the **Filters** button to assign three filters to be red, green, and blue.

4. After you do that, you will be able to fill in the rest of the dialog box, as described below.

5. Clicking **OK** will begin the acquisition.

**Display Preview**

Check this box to watch a live display of the color image while adjusting the exposure time and normalization. This dialog box appears during the preview:

![Preview Dialog Box for 3 Pass Color Command](image)

The preview will initially be paused. Click **Continue Live Preview** to begin the live acquisition.

The **Red**, **Green**, and **Blue** controls let you control the exposure times for each color channel. You can type the exposure time, in milliseconds, in the text field, or you can move the slider. If you clear a checkbox, **3 Pass Color** will stop acquiring that channel. You can speed up acquisition by unchecking one or two boxes.

The **ROI Min/Max** section displays the minimum and maximum intensities present in each channel.

You can improve the image's normalization with the **Calculate from ROI** tools.

1. First, click the **Pause Live Preview** button. The preview must be paused to adjust the normalization.

2. Select a small region of interest that should appear white, and click the **White** button.

3. Now select a small region of interest that should appear black, and click the **Black** button.

4. If you make a mistake, just click the **Reset** button.
The rest of the intensities in the image will be normalized to match the image’s white and black points. This improves the display without altering the data.

You can pause the acquisition by clicking the Pause Live Preview button. The button changes to Continue Live Preview, which you should click to restart the acquisition.

Finally, you can acquire the image by clicking OK, hitting Enter, or pressing the space bar.

**Exposures**

Enter the appropriate exposure times in this dialog box.

![Exposure Dialog Box](image)

### 3 Pass Color Exposures Dialog Box

**Exp. Time:** Enter an exposure time for each channel: Red, Green, and Blue. For video cameras, times are measured in frames. For digital cameras, times are measured in milliseconds.

**AE:** The auto-exposure function calculates the optimum exposure time. This function uses the number in the Exp. Time column as a first guess, and it uses the number in the Target Max column as the highest pixel value to aim for. Auto-exposure takes a single image from which to calculate the best exposure time. The ideal time generated by auto-exposure will be put into the Exp. Time field.

If the 3 Pass Color command is run with the AE box checked, the exposure time will be determined automatically using the values in the Exp. Time and Target Max columns.

**Target Max:** The auto-exposure function will aim for this to be the highest pixel value in the new image. To avoid saturating (overexposing) the image, enter a value lower than the highest value your camera can record. For 12-bit cameras, which can record values from 0 to 4095, we suggest using 3000 or 3200 as a target.

Clicking OK (or Cancel) will return you to the 3 Pass Color dialog box.
Image Size

This dialog box controls the size and binning of the new image. It is nearly identical to the Size tab described under the Acquire command; please see page 259 of this manual.

Filters

When 3 Pass Color is first called, the Filters button is the only one available. That is because it is crucial for you to assign filter positions to the three colors that will be acquired and merged.

Filters Dialog Box

The Device drop-down box will list all hardware that has been picked and set up using the Select Devices command in the Control menu (see page 293). Select the filter-changing device (e.g. CRI-Filter or Ludl Filter Wheel) that will create the three different channels of color.

The Position drop-down boxes (R, G, and B) will list all of the positions (such as filter ports in a filter wheel) that have been described in the Select Devices: Setup Device dialog box. For the tunable filter selected in the example dialog box above, those positions are named Red, Green, and Blue. It is not a requirement for the R Position (for example) to be set to a red filter. All three positions could be set to different UV filters, for example. Each filter's output, however, would be represented in the final image by red, green, or blue.

Clicking OK (or Cancel) will return you to the 3 Pass Color dialog box.

Open Shutter Only During Acquire

If you have an extra, motorized shutter in the microscope’s light path, you may want to close it when not acquiring images, to avoid damaging your sample. When this box is unchecked, the shutter will not be used at all. When this box is checked, a Shutter button will appear that allows you to choose which shutter to use. Press the button to see this dialog:
Use the **Open** and **Close** pop-up menus to pick the correct commands, or positions, for the shutter.

Once set up, this shutter will open only during acquisition, and will be closed at all other times.

The **Shutter Open Delay** field adds extra time before opening the shutter to better handle cameras with a slow initialization rate. The range of delays is usually in the range of 5 ms to 120 ms; the maximum allowed is 5 seconds. If you think you need to change the **Shutter Open Delay**, add time to the **Delay** until the sum intensity of the image does not increase.

### 7.9.6 Multi Dimensional Acquire

**Multi Dimensional Acquire** allows you to capture multi-spectral and three-dimensional data:

- Capture images of one wavelength or up to seven different wavelengths (multiple spectra)
  
  Multi-spectral data are images of the same sample acquired at different wavelengths. Data for each wavelength is stored in a separate image sequence. **IPLab** acquires these by switching filters in the light path, using a motorized filter switcher (e.g. filter wheel, slider, or liquid crystal filter) and then grabbing the images.

- Capture sequences of three-dimensional data
  
  3D sequences are linear series of images where each image is taken at a different height. When viewed as a movie (using the **Animate** command in the **View** menu), the image appears to be panning up and down through the sample. (These are also called *through-focus images, or Z-series*.)

- Capture 3D sequences of multi-spectral data

This is an extremely versatile command, giving you a lot of control over the collection of a large amount of data.

**Using Multi Dimensional Acquire:**

1. First, you must selected a camera using the **Select Camera** command (**Camera** menu), described on page 253.
2. Set up your filter-switcher and/or focus motor using the **Select Devices** command (**Control menu**), which is described on page 293.
   - For multi-wavelength acquisitions, you need the filter wheel, liquid crystal tunable filter, or other filter switcher.
   - For 3D acquisitions, you need the focus motor.

3. Select the **Multi Dimensional Acquire** command and fill in its options. Pages 273 through 280 describe the options in detail.
   - You can choose to begin the acquisition **immediately** by unchecking the **Preview** option.
   - You can also choose to begin the acquisition **interactively**, using the **Preview** dialog box to set up 3D acquisition and other parameters while viewing the live image.

   When using the **Preview** control panel, click the **Continue/Pause** button to toggle the continuous acquisition mode on and off. Acquisition will be paused when the preview mode first begins, to prevent unnecessary exposure of the sample.

   During the preview, you can see the effects of your changes to exposure times and Z positions. By clicking on the image window so that its title bar is highlighted, you can perform many **IPLab** functions upon the image while in the middle of setting up the three-dimensional acquisition.

4. When you are ready to acquire the data, click **OK**, and the full set of data will be collected for you automatically.

**Results produced by Multi Dimensional Acquire:**

**Multi Dimensional Acquire** produces one image sequence for each color acquired. If you use seven filters to capture seven different wavelengths, then you will get seven different image sequences. Each sequence will hold the data acquired with a different filter. Please note that this can amount to a lot of data requiring a large amount of RAM.

If you do not use the **Z-Step** (3D) or **Time Lapse** features, then each image "sequence" will contain one frame. If you do acquire a 3D and/or time-lapse sequence, then each image sequence will contain multiple frames. Click the Z and T buttons on each widow frame to step through the 3D sequences. You can also use the **Animate** command (**View** menu) to observe your data in motion.

**Multi Dimensional Acquire: General Tab**

We suggest you pay particular attention to the **Preview** option, as it gives you powerful, interactive control over your data acquisition.
General Tab of the Multi Dimensional Acquire Dialog Box

Preview:
Checking this box turns Multi Dimensional Acquire into an interactive command.

When the user checks Preview and clicks OK, the Preview dialog box appears and preview mode begins. The Preview dialog lets the user set up the multi-D acquisition while looking through the microscope or while looking at the image on screen.

The Multi Dimensional Acquire Preview dialog is described in detail starting on page 282.

Scripting:
If you are scripting the Multi Dimensional Acquire command, you should probably leave Preview unchecked.

Experiment Name:
The name you type in the Experiment Name dialog box will be given to the image windows. When using a filter switching device, the name of the filter used will be appended to the experiment name, and this will become the name of the window (for example, “Nematode sectioning - Dapi”).

Using the L/SV button, you can type the literal name (L) or choose the name of a string variable (SV).
Create Timing Window: When you check this box, *IPLab* will record the time after acquiring each set of colors.

For example, when acquiring red, green, and blue channels, *IPLab* will record the time after it grabbed the image of the blue channel. When acquiring 3D sequences, *IPLab* will record a time for each Z-step. The times will be recorded into a window named with the experiment name and the word "_Timing."

Display After Each Grab: When you check this box, each frame of a multiple image acquisition will be displayed as it is captured.

Speed: When you are concerned about acquisition speed, do not check **Display After Each Grab**. Then the program will not have to waste acquisition time by updating the display on the screen.

**Multi Dimensional Acquire: Size Tab**

The main dialog’s **Size** tab controls which portion of the CCD will be put into the window, and how much binning will be used.
Size Tab of the Multi Dimensional Acquire Dialog Box

**Full Frame:** Click on this radio button if you want the new image to be the full size that the camera can produce.

**ROI on Window:** This radio button enables you to acquire only part of the image's full frame (i.e. a sub-region of the CCD).

1. To do this, draw a ROI on an image. If you have already acquired an image, draw a ROI around a cell or feature.

2. Next, select the **Multi Dimensional Acquire** command.

3. Click on this radio button.

4. Select (or type) the name of the existing image from the drop-down box.

When you use this feature, the newly acquired image will only contain the cell or feature you selected. You can use an ROI drawn on any image.

If you draw the ROI on a binned image and acquire the sub-region with the same bin size, then the new image will be the same size as the ROI drawn. If you draw the ROI
on an unbinned or newly created image, then the new image will be binned according to the **Acquire** command’s **Bin Width** and **Height** parameters.

Acquiring using the ROI on a window is very handy when you are acquiring a lot of images and want to keep the image sizes small. Grab one full-size image first and draw a ROI around the important details. Next, acquire images with the size set to **ROI on Window**. Your acquisitions will proceed much faster and without taking up as much hard drive space.

**Custom Rect:**

The **Custom Rectangle** radio button lets you specify the exact borders of the image you want to acquire. The **Left**, **Right**, **Top**, and **Bottom** values are the locations of the edges of the rectangle. These locations are measured in pixels from the upper left corner of the CCD.

**Binning:**

Binning affects both the resolution of the image (the number of pixels that represent the data) and the exposure time needed to acquire the image.

A bin is a group of pixels made by counting a rectangular group of pixels out as if they were one. If two pixels side by side were counted out as if they were one pixel, we would say that they were binned 2x1, and the resultant image would be half as wide as normal, and brighter, too.

Because light from multiple pixels is being counted as one value, binning reduces the exposure time dramatically.

**Multi Dimensional Acquire: Shutter & Filters Tab**

The main dialog’s **Shutter & Filters** tab lets you pick the motorized shutters and filter switchers for the **Multi Dimensional Acquire** command to control.

1. Choose motorized shutters in the top portion of this tab.
   
   You can use two shutters for switching between two light sources, such as *multi-mode imaging*, acquiring both fluorescence and bright field data. Please see page 279 for more detail.

2. Pick the filter switcher in the tab’s bottom section.

3. If you do not have one or the other, simply choose "**None**" for that device.
Shutter & Filters Tab of the Multi Dimensional Acquire Dialog Box

For easiest use, fill in these options in the order they are described here:

**Shutters:**

**Shutter 1, 2;**

**Open, Close Pos:** Pick the motorized shutter that protects the sample from the light. Also choose the appropriate open and closed positions.

You can pick literal names for devices and position, or you can opt to use string variables.

**Keep Open During Z / Preview:** Check this box to keep the shutter open during preview mode or while acquiring a Z sequence.

When doing multi-mode imaging (using two light sources), you should not check this box for the bright field shutter. Please see page 279.
Shutter 1, 2
Open Delay: This extra delay may be needed to better handle cameras with a slower initialization rate.

The range of delays is usually in the range of 5 ms to 120 ms; the maximum allowed is 5 seconds. If you think you need to change the Shutter Open Delay, add time to the Delay until the sum intensity of the image does not increase.

Filter Switchers:
Filter Wheel: Pick the appropriate wavelength-changing hardware.

You can pick the literal names of the hardware, or you can choose a string variable representing the hardware.

Enable: Click an Enable checkbox for each filter you want to use. You can enable up to 7 different filters.

Filter Name: Pick the filters from the Filter Name boxes in the order you want them used.

If you set the L/SV icon to SV for any of the filter names, then the name of that filter will come from the specified string variable.

Shutter: Pick whether shutter 1 or 2 will be opened when IPLab switches to this filter. This controls which light source is used.

Exp. Time: You can use a different exposure time (in milliseconds) with each filter. For example, some filters transmit more light than others do, so you may want to use shorter exposure times with them.

If you set the #/Var icon to Var for any of the parameters, that parameter value will come from the specified variable.

AE: The Autoexposure function will calculate optimized exposure times for this filter when this box is checked. The Exp. Time: value will be used as the initial guess.

Tar. Max: The Target Maximum is the maximum intensity value for which the autoexposure function will aim. Set this about 2/3 or 3/4 as high as the camera’s maximum output. You want to approach but not reach the camera’s maximum value.

AE Retries: This is the number of times IPLab will try again to calculate a good autoexposure time.

To do multi-mode imaging (grabbing both fluorescence and bright field images), please follow these steps:

1. Assign the fluorescence and bright-field shutters to Shutter 1 and Shutter 2.

For this example, please assume that Shutter 1 is your fluorescence excitation shutter, and Shutter 2 is your bright field shutter.
If your system does not include a motorized, bright-field shutter, you may be able to use a motorized lamp power supply or a bright-field filter wheel as Shutter 2. You may need to set the Shutter 2 Open Delay to account for the duration of the lamp power-up, however.

2. Do not check the Keep Open During Z / Preview box for the bright field image.

   This is because if the bright field shutter remained open, the light would wash out the fluorescent signal.

3. Choose the Shutter to determine which lamp will be used for each filter (and therefore for each image).

   If the filter switcher is not in front of this lamp, then the Filter Name does not matter; pick anything. In the example dialog box above, filter #4 is set to "1-Empty" and uses Shutter #2, the bright field shutter. Because the filter wheel is in front of the fluorescence shutter, the filter name does not matter when used with shutter #2.

4. Click OK or set something else within Multi Dimensional Acquire.

**Multi Dimensional Acquire: Z-Steps Tab**

This tab lets you acquire 3D sequences (through-focus images). If you are also using the Time Lapse tab, then you can grab 4D images (time lapses containing 3D sequences).

All of these positions and distances are measured in microns.
Z-Steps Tab of the Multi Dimensional Acquire Dialog Box

**Use Z Step:** Check the **Use Z Step** box to acquire 3D sequences. Leave this box unchecked if you only want images of a single plane.

**Relative/Absolute:** Click the **Relative** radio button to set the starting and stopping positions relative to the Z-motor's current position. For example, setting **Start Pos.** to -5 and **Stop Pos.** to 5 would image a 10 micron thickness around the current position.

Click the **Absolute** radio button to measure the starting and stopping positions from the motor's origin. Note that the **Reset Current Position** checkbox effectively resets the motor's origin.

**Start, Stop Pos.:** Use the **Start Pos.** and **Stop Pos.** fields to enter the starting and stopping positions for the 3D acquisition. These are the initial and final distances of the focus motor from its zero (home) position. We recommend moving upwards, to avoid any adverse effects of the microscope's momentum.

**Step by:** In the **Step by** field, enter the interval distance between image planes. This is also called the Z-step size.
Reset Current Pos…: If you check the **Reset Current Position to Zero** checkbox, *IPLab* will define the Z-motor's current position as 0 microns in height. This lets you create an arbitrary origin for absolute movements.

**Note:** **Multi Dimensional Acquire** captures one image at the bottom of the sample, before stepping upwards. Thus, if your starting position is at 0 µm, your stopping position, is at 10 µm, and your step size is 1 µm, you will get *eleven* images, not ten: one image at the bottom of the sample, and ten more images above that, taken at 1 µm intervals.

The buttons on the **ZStage** tab of the **Multi Dimensional Acquire Preview** dialog box will change based on the **Relative / Absolute** setting:

- **If you use:**
  - **Relative:** Rel. Start and Rel. End buttons
  - **Absolute:** Abs. Start and Abs. End buttons

**Multi Dimensional Acquire: Time Lapse Tab**

This tab lets you acquire time-lapse sequences. If you are also using the **Z-Steps** tab, then you can grab 4D images (time lapses containing 3D sequences).
Time Lapse Tab of the Multi Dimensional Acquire Dialog Box

This tab is identical to the Acquire command’s Time Lapse tab. Please read the description of the Time Lapse tab starting on page 263.

To use this Time Lapse tab:

1. Check the Use Time Lapse checkbox.

2. Select one of the three radio buttons: Frames, Interval, or Experiment Length. IPLab will calculate this value for you.

3. Fill in the other two values.

4. If you want to save your data to disk during the experiment, check the Grab to Disk checkbox.
   a. Type a Base Name for an indexed name, or click Use Window Name
   b. Click Browse to select the directory for saving your data.
   c. Select a File Type for your data: either IPLab or TIFF.
Multi Dimensional Acquire Preview: Preview Dialog and Size Tab

This Acquire Preview dialog box appears when you check the Preview box and click OK in the main dialog box of the Multi Dimensional Acquire command. This dialog controls many aspects of the acquisition, letting you control the process while seeing the effects of your actions in the live image.

The main feature of this Acquire Preview dialog, however, is the ZStage tab and its options for interactively setting up the multi-D acquisition. This lets you scan through the sample on-screen, and then find the start and end points of the acquisition.

![Acquire Preview dialog box](image)

Multi Dimensional Acquire Preview Dialog Box, Showing Size Tab
The following features are always displayed on the **Acquire Preview** dialog box:

**Exposures:** This value is the exposure time for the filter shown in the **Filter Position** field. You can type in a new time, or change the time by clicking the up and down arrows. The new time will take effect automatically. Times are measured in milliseconds.

**AE:** Click this autoexposure button to calculate and use the optimum exposure time for the currently selected filter. The autoexposure function uses the Exposures value as the initial guess.

**AE Target Max:** When performing an autoexposure (using the AE button), the target maximum is the maximum intensity value for which the autoexposure function will aim. Set this about 2/3 or 3/4 as high as the camera's maximum output. You want to approach but not reach the camera's maximum value.

**Filter Position:** By selecting a filter from this list, you choose which window will be affected by the exposure time and normalization settings. You also bring the corresponding window to the front.

**ROI Min/Max:** Check this checkbox to see the minimum and maximum intensities currently in the front window's region of interest. This is an excellent basis for judging your exposure times. It is a good idea to have the min and max values span as much of the camera's capacity (e.g. 0-255 for 8-bit video, and 0-4095 for 12-bit digital) as possible without reaching the upper or lower limits-- saturating. You can see such saturation by using the **Norm** tab's **Show Sat. Pixels** option.

Speed up the acquisition slightly by unchecking this box.

**Continue/Pause:** The **Continue** button at the bottom of the dialog starts the acquisition. The **Pause** button temporarily halts the acquisition. You can use this button to halt the acquisition while you change the parameters in the **Preview** control panel.

Acquisition will be paused when the preview mode starts. You must click **Continue** to see your live image.

The **Size** tab's features let you quickly change the image's size:

**Resize Image To:** Use the **Full Frame** and **ROI** options to change the image size and the corresponding area of the CCD being read out to the computer.

- **Full Frame:** When you click this button, the full size image will be acquired, using the whole CCD.

- **ROI:** When you click this button, only the selected portion of the CCD will be acquired.
  
  To use this, select part of the image using the ROI tools. Then click this **ROI** button. The image will be resized to this region of interest. The rest of the CCD will be quickly read out and disposed of, making for a faster acquisition.

**Binning:** Binning reduces the image size while increasing the image intensity. Please read the description of binning on page 277 for more detail. You can choose **1x1**, **2x2**, or **4x4** bin sizes.
**Multi Dimensional Acquire Preview: Norm Tab**

The **Norm** (normalization) tab lets you improve the display of each image window without changing its data. These settings will affect whichever data channel is selected in the **Filter Position** field.
White Point, Black Point: These sliders select the data values at which pixels will be displayed as white and black. All data between these values will be shown as shades of gray. The **Use ROI Min/Max** option disables these sliders.

Show Sat. Pixels: When **Use ROI Min/Max** is checked, showing the saturated pixels will highlight pixels that have the minimum or the maximum intensity values (*e.g.* 0 or 4095 for a 12 bit camera). You may want to adjust the exposure times to bring these "saturated" pixels back within the camera's data range.

Otherwise, this option will highlight pixels that have values above the white point and below the black point.

High values are displayed as red; low values are displayed as blue.

Use ROI Min/Max: When this option is checked, the minimum and maximum data values in the image will be used as the white and black points.
**Multi Dimensional Acquire Preview: Dev Tab**

Use the **Z Stage** tab to enter the locations of the end points of your Z series and to calculate how many planes will make up the series. Use the **Relative** and **Position** controls to move the focus motor to the start and stop positions. You can also open up the **Stage Control** dialog box (**Control** menu). Click the **Rel/Abs Start** and **Rel/Abs End** buttons to record those positions. Then set the step size (**Step by** and **Calc # of Steps**) button.
ZStage Tab of Multi Dimensional Acquire Preview Dialog Box

Relative: Use the relative movement controls to move the focus motor up or down by increments of 1 micron or 0.1 micron. The size of the move will be determined by which radio button is selected. The stage will move when the up and down spinner arrows are clicked. You will see the change in the current position in the Position text box.

Get: Click the Get button to display the focus motor's current position in the Position box.

Go: Click the Go button to set the focus motor's position to the number typed in the Position field. The motor will start moving as soon as you click the Go button.

Position: The Position box reports the current position of the focus motor. The position is always reported in microns from the motor’s zero point. This box is also used as the text entry box for the Go button, described above.
**Set as Zero:** Click this button to define the focus motor's current position as its zero point. Afterwards, all absolute movements and locations will be measured from this point. This definition of the zero point is only used within the Multi Dimensional Acquire command. We recommend that users of piezo-electric devices not use this function.

**Offset:** This is the distance, in microns, between the focus motor's original origin and the point currently set as the zero point, using the Set as Zero button.

**Start:** When the focus motor is at the starting position of the Z stack, click the Start button to record the position for later use by the Multi Dimensional Acquire function. We recommend starting the Z series at the lowest point in the Z stack.

The names of the Start and End buttons change to match the type of movement chosen in the main dialog's Z-Steps tab. Relative or Absolute. Relative movements will be measured from the current position. Absolute movements will be measured from zero.

**End:** Click the End button to record the ending position of the Z stack.

**Relative Vs Absolute:** The meaning of the start and end positions values will depend on the type of movement chosen in the main dialog's Z-Steps tab. Relative or Absolute.

- **Rel. Start** and **Rel. End:** When you choose relative movements in the main dialog's Z-Steps tab, Multi Dimensional Acquire zeroes the focus motor at its current position. That means that the positions you record with the relative Start and End buttons will be relative to the focus motor's position when you chose this command.

  Record the endpoints of the focus motor's movement for later use by the Multi Dimensional Acquire function. When you are focused on the starting position of the Z stack, click the Rel. Start button to record the position. We recommend starting the Z series at the lowest point in the Z stack. Then focus on the ending position of the Z stack and click the Rel. End button.

- **Abs. Start** and **Abs. End:** Record the endpoints of the focus motor's movement for later use by the Multi Dimensional Acquire function. When you are focused on the starting position of the Z stack, click the Abs. Start button to record the position. We recommend starting the Z series at the lowest point in the Z stack. Then focus on the ending position of the Z stack and click the Abs. End button.

**Step by:** Enter the amount by which the motor should step, which is the distance between acquisition planes. Please give this in units of microns.

**Calc # of Steps:** After entering the step size in the Step By box, click this button to calculate the number of images that will be acquired. If the number calculated is not satisfactory, enter a new step size and click this button again.

### 7.9.7 Set Color Balance Values

The Set Color Balance Values command stores the scaling values used by the Acquire command's Color Balance feature. These values are multipliers that modify the data collected by the image.
All color images captured from single-pass color cameras use these values. Once you color balance an acquisition, all future acquisitions will be color balanced the same way.

Single-pass color cameras (with a built-in mosaic filter) collect red, green, and blue data in one exposure. Images from these cameras may have an undesirable tint. You can remove that tint by pressing the Color Balance button on the Acquire command’s Preview dialog box.

Set Color Balance Values Dialog Box

Two ways you can color balance the images from your single-pass color camera are:

The Easy Way: Use the Acquire command and display the preview. Click the Color Balance button on the Color tab. This will calculate the color balance values and use them upon the image. If you want to see the values, choose the Set Color Balance Values command.

The More Control Way: Enter your own color balance values in the Set Color Balance Values dialog box. This option is for users who want the highest level of control over the color balancing.

7.9.8 Select TWAIN Device

Use this command to select the TWAIN device installed on your computer. If software for more than one TWAIN drivers is installed on your computer, a list of all available devices will be shown.
7.9.9 **TWAIN Capture**

This command will launch the TWAIN interface supplied by the device manufacture. When the settings are adjusted for a particular experiment, the image will be acquired and displayed within IPLab. Once the image is in the IPLab environment, the image may now be processed, analyzed or saved.

7.9.10 **Edit Acquire Info**

This command is used to edit or add information to the acquisition parameters stored with IPLab images. Images acquired with **IPLab** v3.6.3 or above will automatically contain this information. However, if you have images acquired by other means or programs, important information may be added to the image with this command and the information may later be used by other commands within **IPLab** or **IPLab** extensions on the image has been saved as an IPLab image.

Note: The acquisition parameters may also be transferred from one image to another by using the **Transfer Attributes** command, located in the **Edit** Menu.

![Edit Acquire Info Dialog Box](image)

7.9.11 **Export Acquire Info.**

The command will save the acquisition parameters as a text file.
7.10 Control Menu

The Control menu contains all commands that control microscope hardware. The commands described below are device independent, insofar as they and their dialog boxes remain the same regardless of the identity of the hardware.

7.10.1 Select Devices

This command is used to tell IPLab what hardware is available and how it is set up. Only devices for which you have installed device modules (*.ipd files) can be selected.
**Select Device**

**XY and Z Stages**

The **XY** and **Z Stage** drop-down boxes let you select motorized XY stages and Z motors (a.k.a. focus motors). Choose the correct port (**COM1, 2, 3, or 4, LPT1, or preset***) that the hardware is connected to. Finally, click the **Setup XY** and **Setup Z** buttons to define how many steps will move one micron. Please see the **Motion Control** chapter in the Extensions manual.

- Only use the **preset** port for devices whose name contains the text, "(preset)". For example, the virtual XY stage’s name appears as, "Virtual-XY Stage(preset)".

**Other Devices**

You can use the **Other Devices** section to select and then set up non-stage hardware, such as filter wheels or shutters. Do this by using the **Add** and then the **Setup Device** buttons.

Click the **Add** button to assign new hardware to the **Other Devices** list.
The **Device** drop-down box will list all hardware for which device drivers have been installed. If the controller box describes a filter wheel or shutter as number one, then you should select that device as being number one, and not two or three. Then select the port (COM1, 2, 3, 4, LPT1, or **preset**) that the device is connected to. After clicking **OK**, you will see that device on the list of **Other Devices**. Repeat this step for each device you have available.

* Only use the **preset** port for devices whose name contains the text, "(preset)". For example, the virtual filter wheel's name appears as, "Virtual-Filter(preset)".

**Note:** If your filter wheel contains a built-in shutter, then these will be treated as two separate devices: a filter wheel and a shutter. You need to select both of them: "MyCorp-Filter Wheel 1" and "MyCorp-Shutter 1".

**Note:** If you are not using an automated microscope with motorized objective, please use the “Virtual Objective” device. IPLab will use the objectives or the virtual objectives to set the image calibration once the system has been calibrated.

Use the **Setup Device** button or double click on the device to label hardware positions after adding a device like a filter wheel or a motorized objective turret. Positions for hardware such as lamps and shutters have already been labeled for you.

To label positions, select a device from the **Other Devices** list. Then click the **Setup Device** button or double click on the device.
Control Menu

Setup Devices Dialog Box

The **Add** button allows you to add one position name at a time for each position on the hardware. The **Edit** button lets you change a selected name. The **Remove** button deletes a selected name. Use the **Port** pull-down box at the bottom-left to change the serial port being used to communicate with the hardware.

**Note:** If you are removing a position from a device, start from the last position in the list. If 10 positions are listed and there are only 8 true positions, first remove position 10 and then position 9.

The **Add** and **Edit** buttons bring up this dialog:

**Add / Edit Dialog Box**

A good example of a filter name would be "1 Dapi" for a filter in position 1 used to excite DAPI. Other examples could be "2 Fitc," "3 547nm," "4 Dual" for a dual-pass filter, or "5 Empty." Since this name is used as a button label in the device driver's interface, it is a good idea to keep it brief.

Having added and set up your devices, you are now ready to use them.
Setup Ports

You can use this dialog box to change the settings for each port.

Consult your hardware manual for the correct settings. Information in this dialog will not be recorded when the Select Devices command is scripted.

7.10.2 Microscope Control

One way to control your filter wheels, shutters, and other non-stage hardware is through the Microscope Control command. This is also the method you will use when writing a script to automate your image acquisition protocols.

Note: This command was formerly called Device Control.
1. Select the piece of hardware from the Set Device pull-down box.

2. Choose a hardware position by using the Number or the Name option.
   - Click the Number radio button and typing in the position number.
   - Click the Name radio button and choose a hardware position from the pull-down box.

3. Check the Wait Until Done checkbox to stop IPLab from doing anything else until the hardware has completed your last command. This is handy for preventing image capture until after microscope parts have stopped moving.

4. Clicking the Do It button causes your hardware to move to that position.

   That is, your filter wheel will switch to that filter, your shutter will open or close, and so on.

The #/V button next to the Position Number field lets you choose to enter the position as a number (#) or as a numeric variable (V). The L/SV buttons next to the Set Device and Position Name fields let you choose to enter the device and position names as a "literal" string of text (L), or as a string variable (SV). The Microscope Control command will use the contents of the variables as the device or as the position. This is tremendously powerful in scripts. More detailed information on IPLab variables and their use can be found on these pages:
   - about numeric variables: Page 84
   - about string variables: Page 86
   - about scripting: Page 99

### 7.10.3 Stage Control

Stage Control provides you with the ability to move the microscope stage in three directions to absolute and relative positions, all measured in microns. You can also step the X, Y, and Z motors in increments of 1 or 0.1 microns. Because the Stage Control dialog box is a floating window, other commands can be given while using Stage Control.

You can keep this dialog open while also using other commands, including the Record Position and Move to Recorded Position commands.
Stage Control Dialog Box

Spinner Section: The left section of the Stage Control dialog box is for interactively moving the stages in steps of 1 or 0.1 microns.

1 μ / 0.1 μ: Click on either the 1 μ or 0.1 μ radio buttons to choose the step size. The motor will move this amount when you click an arrow button.

X and Y, Z Step: The X Step, Y Step, and Z Step spinners (the pairs of arrows) allow you to repeatedly step the microscope stage by 1 or 0.1 micron.

The buttons can be held down for continuous movement.

Move Section: The Move section on the right is for moving the stage by amounts that you type:

Absolute / Relative: The Absolute and Relative radio buttons determine whether the typed distances will be measured from the stage’s origin, or zero point, or from the stage’s current position. They only affect the Move section of the dialog box.

- Absolute movements are useful for returning to a known position.
- Relative movements are useful for methodical stepping from one position to the next.

- Refer to the manufacturer’s manual for your stage to determine how to find or set the origin. Some stages set their position at startup as their origin, while others have fixed origins. For example, the Physik Instrumente piezo-electric focusing device has a fixed zero point at the bottom of its range of motion.

X & Y, Z radio buttons: Numbers entered in those boxes represent distances in microns, and can be entered as positive or negative.

XY Home: The XY Home option lets you return the XY stage to its origin, (0,0).
**XY Center:**  The **XY Center** option lets you return the XY stage to the center of its range of motion. When centering itself, the stage will move to its limits to find its center.

**Wait Until Done:**  Checking the **Wait Until Done** box prevents any commands from prematurely being sent to the stage motors until the last commands have been completed. This is a good idea when the next step in your experiment is an image acquisition and the stage must have finished moving.

**Do It:**  Click the **Do It** button to order the stage to move using the settings in the **Do It** side of the dialog box. The dialog box remains open, so you can move the stage repeatedly.

When scripting this command, the **Do It** button is replaced by **OK** and **Cancel** buttons.

Next to the **X**, **Y**, and **Z** boxes are buttons that toggle between **#** and **V**. When these buttons are up and read **#**, then your stage will move according to the number typed in the box. When the button has been pressed and reads **V**, then the number represents a variable. Your hardware will move according to whatever value is stored in that variable. This is useful for scripting the stage movements used in raster scans and Z-sectioning. For more information on **IPLab** variables and how to use them, please see page 83.

### 7.10.4 Record Position

This command records the current position of your stage to a floating point data table. XY and Z positions can be recorded separately or together. The data can be saved for describing the locations of images within a sample. Scripted computations can refer to this data window. The **Move to Recorded Position** command will move the stage to positions recorded by this command. The numbers in all three columns, **X**, **Y**, and **Z**, represent distances in microns from the stage’s origin.

You can keep this dialog open while also using other commands, including the **Stage Control** and **Move to Recorded Position** commands.
Selecting the New Window radio button creates a new data table named Position Window. Checking the Clear Row Counter box forces new recordings to start from the first row, which is row number 0. After the Position Window is created, the Window radio button becomes selected.

The Window drop-down box lets you record stage positions to any three-column, floating point data window that already exists. It can be selected from the Window pull-down box.

The Row box lists the data table row that the position will be recorded into. You can increment or decrement this number using the up and down arrows on the right edge of the box. If the # button to the right is clicked so that it changes to a V, then the number in the Row box represents a variable. The row recorded to will be the value within that variable. The value of the variable can be changed up or down using the up and down arrows on the border of the Row box. For more information about variables and how to use them, please see page 83. If the Increment After Record check box is checked, the value within the Row box will be incremented automatically after each recording.

The two check boxes at the bottom, Record: X&Y and Z, control what positions are recorded to the table. One or both boxes can be checked. Only the checked dimensions will be recorded.
The Do It button triggers the recording. The Record Position window remains open, so other measurements can be taken. Since this is a floating window, other commands (such as Stage Control movements) can be given without closing this window.

### 7.10.5 Move to Recorded Position

This command moves the stage to a position read from a data table. Usually, the data window will be the Position Window written by the Record Position command, but it can be a three-column table of numbers entered by any means.

You can keep this dialog open while also using other commands, including the Stage Control and Record Position commands.

![Move to Recorded Position Dialog Box](image)

Choose the data table that holds the desired positions from the Window pull-down box.

Enter the row that holds the stage position in the Row box. This box is otherwise the same as the Row box in the Record Position dialog described above.

The Move: X&Y and Z check boxes control which motors are moved. One or both can be checked, and only the checked motors are moved.

### 7.10.6 Array Setup

The Array Setup command records the corner positions of multi-well plates and other arrays of samples on a motorized XY stage. It then calculates the position of every well on the stage and stores that information in an array window. The Appendix details the array window format on page 353.

Array Setup makes automatic image acquisition possible by telling IPLab where the wells are placed on the XY stage. You would use the Array Move command (Control menu, p.307) and/or scripts provided with IPLab to automatically acquire images of every well within the plate.

This command requires a motorized XY stage, of course.
You can use **Array Setup** for a single array, such as a single 96-well plate, or for multiple arrays, such as several 96-well plates arranged in a grid. Multiple multi-well plates arranged in rows and columns are called a *super-array*; the rows and columns of plates are called *super-rows* (or "srows") and *super-columns* (or "scols").

**Using Array Setup**

Follow these steps to use **Array Setup**. Please read the description of the dialog box’s fields and buttons on page 304.

1. If you wish to use an array window that was created earlier, open it up first.
2. Choose **Array Setup** from the **Control** menu.
3. If you are using a pre-existing, open array window, choose it from the **Array Window** field. Otherwise, click the **Create New Window** checkbox and type the new array window’s name in the **Array Window** field.
4. In the **#Rows** and **#Cols** fields, type the number of rows and columns of wells within each multi-well plate.

<table>
<thead>
<tr>
<th>5a. If you are using only a single multi-well plate...</th>
<th>5b. If you are using more than one multi-well plate on the stage:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• ...and if the plate’s wells are arranged in a perfect rectangle, then check the <strong>Corners Only</strong> checkbox. You only need to specify the positions of the plate's top-left and bottom-right corners.</td>
<td>• click on the <strong>Advanced</strong> arrow to display the advanced section, and check the <strong>Multiple Array Setup</strong> checkbox. The label &quot;Single Array&quot; will be replaced with &quot;Array n&quot;.</td>
</tr>
<tr>
<td>• ...and if the plate’s wells are skewed away from a perfect rectangular grid, then uncheck the <strong>Corners Only</strong> checkbox. All four of the corner positions will now become available. You must specify the positions of the plate’s four corners.</td>
<td></td>
</tr>
</tbody>
</table>

6a. To tell **IPLab** the position of a plate’s corner, you must first click the radio button next to the corner’s X and Y fields in the dialog. In the example dialog on page 304, the bottom-right corner (H-12) is selected.

7a. Move the motorized stage so that the corner is centered in the camera’s field of view. Use the stage’s joystick, the **Stage Control** command (**Control** menu), or type a position into the X and Y fields and click **Goto**.

8a. Click the **Record** button.

9a. Record a position for all active (not grayed-out) corners by repeating steps b through d.

10a. Click **Update Array Window** or **Create Array**

| 6b. Enter the number of arrays (multi-well plates) on the stage and the number of array rows and array columns in which they are arranged. | |
| 7b. Choose a **Definition Type** based on how regularly your plates and wells are laid out. | |
| 8b. Click on Array 1 in the picture under **Definition Type**. The basic, top half of the dialog now displays the positions for Array 1’s corners. | |
| 9b. Record positions for this array’s corners: | |
| a. To tell **IPLab** the position of a plate’s corner, click the radio button next to the corner’s X and Y fields in the dialog. In the example dialog on page 304, the bottom-right corner (H-12) is selected. | a. Move the motorized stage so that the corner is centered in the camera’s field of view. Move the stage by using the stage’s joystick, the **Stage Control** command (**Control** menu), or by typing a position into the X and Y fields and clicking the **Goto** button. |
**Window. Array Setup** will calculate the positions of wells within the array and store this information in the array window.

c. Click the **Record** button.

d. Record a position for all active (not grayed-out) corners.

10b. Click on the next array and record positions for its corners, too.

11b. The red corners within the picture of the array indicate corners whose positions are in conflict with the positions of other corners, and whose positions need to be recorded. Green circles indicate corners not in conflict.

12b. Click **Update Array Window** or **Create Array Window**. **Array Setup** will calculate the positions of wells within the arrays and store this information in the array window.

---

**Basic Dialog**

**Array(s) Setup**

**Array Window:**

**Array Setup** stores the well positions in the array window. Pick the array window from this pop-up box, which lists all open windows. If an array window is not already open, click the **Create New Window** checkbox.
Create New Window: Check this checkbox when an array window is not already open. The Update Array Window button becomes the Create Array Window button. You can type a name for the new array window in the Array Window field. When you click the Create Array Window button, Array Setup will create a new window, which will contain the well positions.

#Rows, #Cols: These are the number of rows and columns in a single multi-well plate. For example, the standard 96-well plate has 8 rows (lettered A-H) and 12 columns (numbered 1-12).

A-1... These are the corners of the multi-well plate. A-1 is the top-left corner, and the other three (shown above as A-12, H-1, and H-12) are the top-right, bottom-left, and bottom-right corners.

To set a corner's position, move the microscope stage so the corner is centered within camera's field of view. Click the corner's radio button and then click the Record button. This records the motorized stage's (x,y) position into the corner's X and Y fields. IPLab measures the position in micrometers from the stage's origin. You can also type the position into the X and Y fields.

Goto: Select a corner's radio button and click this button to move to the position shown for the corner.

Record: Click the Record button to record the current position into the corner's X and Y fields. IPLab measures the position in micrometers from the stage's origin.

To set a corner's position, move the microscope stage so the corner is centered within camera's field of view. Click the corner's radio button and then click the Record button.

Note: Record only places the position into the Array Setup dialog box; you must click the Update / Create Array Window button to place the position into the array window.

Corners Only: Check this checkbox when your multi-well plate is perfectly rectangular. The bottom-left and upper-right corners will be grayed out, and you will only need to record two positions to describe the array.

If your plate is not rectangular, uncheck this box. You will need to record the positions of all four corners to compensate for the plate's skew.

When using the Advanced: Multiple Array Setup option, the Definition Type option replaces the Corners Only option.

Update / Create Array Window: Click the Update / Create Array Window button to store the position of every well in the array window.

If you get the message "Array Window not Found!" when you click the Update... button, then check the Create New Window box and click the Create Array Window button.

Close: Close this dialog box. This does not update the array window.
**Advanced Dialog: Multiple Arrays**

To set up imaging of more than one array on your XY stage, click the **Advanced** arrow so that it points down, and check the **Multiple Array Setup** checkbox. The advanced section lets you specify the number of arrays, their arrangement, and the level of care that needs to be taken to pinpoint all of the wells within the arrays.

The **Advanced Section of the Array Setup Dialog Box**

**Multi-Array Setup:** Check this if you have more than one multi-well plate on your motorized stage.

**#Arrays:** Enter the number of multi-well plates you want to scan.

**#Array Rows, Cols:** Type the quantities of rows and columns of multi-well plates. Also called the quantities of super-rows and of super-columns.

**Definition Type:** Use this setting to specify how many measurements need to be taken in order to pinpoint the locations of every well within the arrays.

**Minimum:** Use **Minimum** if your plates are rectangular, without significant deviations, and are parallel and lined-up with each other.

**Array Setup** will only require the positions of the top-left and bottom-right corners of the first plate, and of the top-left corner of the plate diagonally below and to the right of that. That last position tells **iPLab** the distances between the last rows and columns within an array and the first rows and columns of the adjoining arrays.
Control Menu

Medium: Use Medium if your plates are rectangular and parallel with each other, but are not lined up.

Array Setup will require the top-left and bottom-left corners of the first plate, and the top-left corner of every other plate. The positions of the top-left corners tell IPLab where to find each plate.

Complete: Use Complete if your plates are not rectangular and/or are not parallel with each other.

To completely define the positions of multi-well plates on your XY stage, you must record the position of every corner of each plate.

7.10.7 Array Move

The Array Move command moves a motorized XY stage from well to well within multi-well plates, and runs a script (e.g. an image acquisition script) at each well. Array Move can be used with other types of arrays, as well. At each well, Array Move can run anything from a simple image capture script to a complicated 3D, multicolor, acquisition-and-analysis script. Array Move itself can be run from a script.

This command requires a motorized XY stage, of course.

Using Array Setup

To acquire images of multi-well plates and other arrays,

1. Use the Array Setup command (Control menu, page 302) first, because it creates the array window that gives the positions of wells to Array Move.

2. Fill out the Array Move dialog box. The dialog’s parameters are described below.

3. Click Do It (or run a script containing the Array Move command).

You can edit area masks or scripts before or after opening the Array Move dialog in step 2. To do so after opening Array Move, finish filling out the dialog box and click Close. After editing area masks or scripts, choose Array Move again and click Do It.

• If you want to use an area mask to control movement through the arrays, edit the array window as described in the Masks section on page 309.

• If you do not want to use an image acquisition script provided with IPLab, you can write one yourself. A very simple image capture script would acquire an image, save it with an indexed name, and close the image window.
**The Dialog Box**

**Array Move Dialog Box**

**Array Window:** Before you open this dialog, make certain that your array window is open. You can choose any open array window, using the literal (L) window name or a string variable (SV).

**Area:** Choose the portion of the array that the stage should scan.

**All:** With this option, the stage will move to every well within your arrays.

**Movement Type:** Choose the pattern you want the stage to use when scanning through your arrays. The serpent patterns scan back and forth, while the raster scans always start at the left or top side. "LR" means left-to-right; "TB" means top-to-bottom.

**Mask:** With this option, the stage will only move to wells selected within your image mask. Please read the section on masks, on page 309 to learn how masks work and how to create one. Choose a **Movement Type** (described above), which is the pattern the stage will use when scanning through your arrays.

---

**Array Move Dialog Box**

---

**Array(s) Move**

---

**Array(s) Move**
Point: The Point option moves the stage to a single well (a single element within an array). The Point option has its own fields, shown in the dialog above and on the right.

Specify a well by Row and Col (Column). You can pick the row either by letter or by number.

If you have more than one plate on your stage, identify the desired plate by SRow and SCol. When multiple plates are arranged in rows and columns, their rows and columns are called super-rows, or SRows, and super-columns, or SCols.

Run Script… Check the Run Script at Each Position checkbox to make IPLab do something at each well to which it moves.

Select the script in the field below the checkbox. You can Browse your file directory to pick your script from a standard Open dialog. Scripts would usually be image capture scripts that acquire at least one image of the current well or sample.

Wait Until Done: When this is checked, Array Move will not move to the next well until the script has stopped running.

When this is unchecked, Array Move will move to a location, run the script, and then move to the next location whether the script has finished or not.

Close: This button closes the Array Move dialog so you can do other tasks within IPLab. For example, you could make some final modifications to your script. When you open Array Move again, the dialog will contain the same settings.

Do It: Click Do It to start the stage moving from well to well, running your script at each location (if so directed).

OK, Cancel: The Close and Do It buttons change to Cancel and OK when you script the Array Move command. Click OK to record the command in the script.

Masks
The mask is a binary* image that tells Array Move which areas to visit and which areas to skip.

You can use this feature to save time during acquisition, by skipping undesired regions, and to record the locations of interesting wells. If Array Move runs a script that edits the mask during your preliminary scan of the arrays, it could edit a mask to be used by a more thorough, secondary scan. A mask-editing script could even edit the mask being used for the current scan, allowing your script to decide whether to continue imaging part of the array based on the current image.

* The mask is really a Floating Point image, but we only store "off" and "on" in it. All locations that equal 0 are "off;" Array Move will not move to that location in the arrays. All locations with values greater than 0 are "on;" Array Move will move there.

Array Move’s mask is stored in frame z=3 of the array window.

To edit the mask by hand,

1. Display the array window as text (so it looks like a spreadsheet). Each cell represents a well within your multi-well plates.
2. Switch to frame z=3. (Use the Z arrow buttons on the window’s border.)

3. Click on a cell to select a single well; click-and-drag to select a region. You can only select a single region at a time, but you can use the selection tools to select different-shaped regions.

4. Type Control-Enter or choose Set ROI Value from the Edit menu.

5. Set the ROI to zero for wells that you do not want to visit.
   Set the ROI to one (or anything greater than zero) for wells that you do want to visit.

### 7.10.8 Interfaces

Control extensions such as Motion Control, Shutters & Filters, and Scope Control add interface commands to the end of the Control menu. These interfaces allow easy and complete control of certain hardware. Detailed information about these interfaces can be found in the Motion Control part of the Extensions Manual.

### 7.11 Ext. Menu

The Extensions menu contains all commands that come with processing extensions (such as MultiProbe), as well as the Port Control extension’s commands. This menu does not appear at all unless one or more processing extensions are installed. Because all commands in this menu come from extensions, look for descriptions of the commands in the appropriate part of the Extensions Manual.

### 7.12 Script Menu

The Script menu contains commands to write and control scripts. The script window must be the active window to use most of the Script menu commands.

Please read the Scripting chapter for more information on how to write and use scripts.

#### 7.12.1 New Script

This command creates a new, empty script window.

#### 7.12.2 Open Script

Use this command to browse through and open a saved IPLab script.

#### 7.12.3 Run Script

This command prompts you for the script you wish to run. This is a standard Windows file management dialog. Use the Look In tools to specify the path where the script file is found. Give the name of the script file in the File Name field.
When you click on the **Open** button, the highlighted script is read from the disk and its contents are executed. No script window is created by this command unless the script is stopped by an error or by the user pressing the Escape key. In those cases a script window will be opened to show the script. If an error stopped the script, the command that gave the error will be highlighted. Otherwise, the next command to execute will be highlighted so that you may continue the script with the **Continue** button.

**Run Script from within Scripts**

The **Run Script** command may be placed into a script. When executed, the command runs a second script from within the first. The ability to run one script from another can make it easier to write new scripts by having them call existing scripts. **Run Script** has a completely different dialog when it is recorded in a script:

![Run Script Dialog Box](image)

**Run Script Dialog Box when recorded in a Script**

- **Script Path & Name**: Enter an absolute path to point to the script you want to run. The **Browse** button is very helpful in making sure that the correct script is found and run. The **Browse** button will bring up a standard **Save / Open** dialog from which you can select the directory path and the file name of the script you want to run.

- **IPLab Scripts Dir…**: This option identifies scripts relative to the **IPLab** "Scripts" directory. This is important because when you include **Run Script** commands in a script, you must be able to identify the location of the scripts to be run. While the **L/SV** button reads **L**, you can simply enter the name of any script in the "Scripts" directory, and it will be run.

  You can also list a path of directories within the "Scripts" directory, as long as those directories already exist. For example: "testA\Setup_2.IPS", so long as the directory and file "IPLab 3.7 Folder\Scripts\testA\Setup_2.IPS" already exist.

- **Preferred Scripts…**: This option identifies scripts relative to the preferred scripts directory, which you set up using the **Set Preferred Directory** command (File menu). Just like the **IPLab** "Scripts" directory, this lets you identify the location of scripts to be run.
This dialog also lets you identify the script with a string variable. Click on the L/SV button so that it reads SV. The text box will become a pull-down box from which you can select the appropriate string variable (e.g., "Setup Script"). By using the Script menu command Enter String Variables, you can ask the user of a script which script to run. The name of the script would be stored in a string variable and then used here in the Run Script command.

### 7.12.4 Set Variable

This command sets and modifies the values of IPLab variables. You can see these in the IPLab Variables window (choose Show/Hide Variables Window from the Window menu).

The dialog asks for the variable number (i.e., its index) and provides several options for setting its value.

#### Set Variable Dialog Box

Set the variable's value by choosing one of the three radio buttons:

A. Variable equals the value of this formula.

    You can add, subtract, multiply, divide and find the binary maximum or minimum between a variable and either a constant or another variable.

    • You set the variable to a specific value by selecting the NoOp option from the operation drop-down list in the center of the formula.
Variable #10 will equal 23. No operation will be done to the constant value 23.

- Set the variable to the value of another variable.

Variable #10 will equal the value of variable #23. No operation will be done to the value of variable #23.

- Set the variable to a calculated value by selecting an operation.

Variable #10 will equal (100 + the value of variable #255).

Both sides of the formula could contain variables or constants.

B. Variable equals the pixel value at the \((x,y)\) location in this window.

Enter the \((x,y)\) coordinates and choose an open window from the In Window pop-up box.

This is useful for setting a variable to a value stored in a measurement results window.

An Example Measurement Results Window
For example, you could set a variable to equal the area from measurement #1. The \((x,y)\) coordinates are \((0,25)\) in the window "Meas Rslt orig".

Make sure you look at the row and column numbers given in the Text view. Do not mistake the "Measurement #" column for the row numbers, which are in the dark grey column on the far left. Also note that columns 1-24 are hidden.

C. Variable equals 1 if the chosen window is open, and 0 if it is not open.

Use this option to check if a desired window is open or not. Pick the desired window from the pop-up list of all open windows. You can also type the window name into the field.

### 7.12.5 Set String Variable

This command gives a value to a string variable, letting you store a chunk of text in a special variable for later use.

In the dialog above, we set the value of the string variable "Image Name" to the contents of the string variable "Custom5" plus the text "_Red_Channel."

String variables can only contain up to 31 characters. If you try to give to a string variable a value longer than 31 characters, the excess characters will be ignored.

**Variable to Set:** Pick one of the existing string variables from this combo box. You will be changing this string variable's value.

**Note:** If you want to add, edit, or remove a string variable, you must use the String Variables command, described on page 315.
From Front Window Name: When you choose this radio button, the string variable will be set to the name of the active image window.

User Defined: Use this option to build your own text expression.

When the button beside the text-entry box shows an L (for Literal string), type in any line of text that you like. When the button shows an SV, choose a string variable from the combo box. By using the SV option, you can make one string variable equal to another one, or equal to another one plus some additional text.

NoOp: Selecting the No Operator (NoOp) option means that nothing will be added to the text box's contents. When NoOp is selected, only one text box will appear beneath the User Defined option.

+ String: The + String operator connects (concatenates) the two text boxes under the User Defined option. If you toggle the L/SV button from L to SV, then either or both boxes can contain names of string variables. That allows you to concatenate text with text, string variables with text, or two string variables with each other.

In the example dialog box, above, the string variable "Custom5" is being concatenated with the text "_Red_Channel" and placed into the string variable "Image Name." If "Custom5" contains the text "Multifluor," for example, then the string variable "Image Name" will be given the final value "Multifluor_Red_Channel." We can then use that value later, as the name of an image window.

+ Value: The + Value operator connects (concatenates) the text box with a number-entry box. The text box can contain text or a string variable, and the number-entry box can contain a plain number or a numeric variable. Otherwise, this option is just like the + String option.

From Device Info: This box lets you set the string variable to the name of a hardware device or one of its positions. The From Device Info box lists all of the non-stage devices selected in the Select Devices dialog box (Control menu), and all of their positions (e.g. the "red" position for an RGB liquid-crystal filter switcher). This makes it very easy for you to enter device names or position names into one of the preset string variables provided by IPLab. (See the String Variables command, below).

7.12.6 String Variables

The String Variables dialog box allows you to view and edit all of IPLab’s string variables. Please see the IPLab Variables section of this manual (on page 86) for a detailed description of what a string variable is and how to use it.

This dialog box has two groups of string variables: User Defined and Preset. You cannot add or remove string names from the preset list. All string variables have a string name and a string value. The name identifies the variable, while the value is a quantity of text to be used as a setting within a command’s dialog box.
Click the **Add** button to add a string variable to the **User Defined** list. (The **Add** and **Remove** buttons are grayed out in the picture above because you cannot add variables to or remove variables from the **Preset** list.) When you click the **Add** button, this dialog appears:

### Add String Variable Dialog Box

Type the name of the string variable in the upper text box, and the value of the string in the lower text box. String names and values can each be 31 characters long. When you click **OK**, the string variable will be added to the current list.

Pressing the **Edit** button allows you to change either the string name, value, or both.

The **Remove** button instantly deletes whichever string variable is currently selected. **Note!** There is no warning before the string variable is deleted!

Clicking the **Cancel** button on the **String Variables** window exits the command without saving any of the changes that you made. Clicking **OK**, of course, exits the command after saving all of the changes you made.
7.12.7  Enter String Variables

The **Enter String Variables** command opens a dialog box that gives you the choice of string values, which are mapped to the string name that you have selected.

**Enter String Variables Dialog Box**

<table>
<thead>
<tr>
<th>Title</th>
<th>String Name</th>
<th>Prompt</th>
<th>Select From</th>
<th>Default</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the required information.</td>
<td>Custom1</td>
<td>Enter the exp name</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom2</td>
<td></td>
<td></td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Title:** The **Title** box allows you to enter a descriptive name or message to the user.

**String Name:** The **String Name** allows you to select several preset string variables or to add a new string variable name. If a new string name is added, the string will be added to **IPLab**’s user defined string variables list. We currently allow 50 user defined strings.

**Prompt:** The **Prompt** fields appear when a string name is selected. Use the **Prompt** fields to enter more specific instructions.

**Select From:** The **Select From** field facilitates your selection of a string value. Currently, we offer three choices to narrow the selection. Depending on which option you choose, the **Select From** box will appear differently when you run the script. If you choose **Devices**, then the pull-down box will be filled with the names of the devices that were previously added to the system. If you choose **Positions**, the pull-down box will be filled with the positions of the devices that have been added to the system. (Examples of these positions would be Open, Closed, Filter1, Filter2, etc.) If you choose **None**, then the user can type in any value.

**Default/Default Value:** The **Default** check box allows you to have a particular string value appear to the user every time the script is run. For example, if the **Select From** pull-down box has **None** selected, and the **Default** check box is checked, the text added to the **Default Value**
text edit box will appear when the user runs the script. The **Default Value** text will keep appearing every time the script is run, regardless of what the user entered in the dialog last time. Similarly, if the **Select From** pull-down box has **Devices** or **Positions** selected, and the **Default Value** check box is checked, then the **Default Value** control will be a pull-down box filled with the devices or positions on the system, respectively. If a particular device or position is selected, that value will appear as selected in the dialog pull-down box every time the script is run, assuming the position or device is on the system during the script's run-time.

If the device or position is no longer on the system, then the pull-down box will say "None" when the script is run.

Using the **Default** check box causes the **Enter String Variables** command to behave like the **Enter Variables** command, in that the same values appear by default, regardless of what you selected the last time the script was run.

When the **Default** check box is not checked, and the script is run, the dialog will display whatever string value that was entered in the previous run of the script. This will relieve the user of the need to make the same changes each time the script is run (unlike the **Enter Variables** command). If the string value is a device or position name, and that device or position is no longer on the system, then the dialog's pull-down box will read "None."

### 7.12.8 Copy String Value

The **Copy String Value** command copies the value of one string variable to the value of another string variable. It is mainly used in loops for finding the value of one string variable after another.

The **Copy String Value** dialog box is shown below:

![Copy String Value Dialog Box](image)

**Copy String Value Dialog Box**

Please use the **Copy String Value** fields in the order they appear:

**Copy the Value From String Name:**

- **Parameter:** In this field, enter the source string name from which entered values will be copied. This string name must already exist for the command to work.
**Concat With Var:** The string name may be concatenated with a numeric variable. To concatenate, select the **Concat With Var** check box and type the variable number in the field to the check box’s right.

**Display field:** This gray text field will show the information that will be copied into the destination string.

**Into String Name:** Choose the destination string name from the **Into String Name** pull-down box. If the destination string name does not already exist, it will be created by this command.

**OK:** When you click **OK**, the string variable value will be copied from the source variable to the destination variable.

**Concatenating Strings and Numeric Variables**

One reason you might want to concatenate the given string name with a variable is if you want to copy one string variable after another. To do this, the string variables in question must be sequentially numbered.

For example, assume you want to copy the string variables Parameter001, Parameter002, Parameter003, etc.

1. You would enter "Parameter" in the field **Copy the Value From String Name**.
2. You would concatenate with a variable (variable #5 for this example).
3. You would put the **Copy String Variable** command in a loop.
4. You would also increment the value of variable #5 each time you went through the script (using **Set Variable** from the **Script** menu).

Then the values of successively named string variables would be copied into the destination string.

### 7.12.9 Record Timer

The **Record Timer** command stores a coded representation of the current time, measured in seconds, in numeric variable #8. The value stored with this command is generally used by the command **Wait For Timer** (see below) to calculate the time elapsed since the **Record Timer** command.

### 7.12.10 Wait For Timer

The **Wait For Timer** command displays a dialog where you can enter a timer delay in seconds.
Wait For Timer Dialog Box

The value can also be referenced from an *IPLab Variable* by using the pull-down box provided. The command is used within a script to pause until the timer delay has elapsed.

When the command is done waiting and is about to pass control of the script on to the next command, the time is recorded again to numeric variable #8.

A very basic script might look like this:

```plaintext
Record Timer
Top Label
Acquire
Wait for Timer (5 seconds)
Loop (to Top Label)
```

### 7.12.11 Script Commands

The *Script Commands* hierarchical menu stores most of the commands located on the script window's toolbar, including: *Label, Jump, Loop, Pause, If, Query, Alert*, and *Enter Variables*.

**Run, Single Step, Run Selected, and Continue**

These commands allow you to control the activity of an open script.

Choose the **Run** button to start the script beginning at the first command. Use the **Continue** button to start the script at the first highlighted command. Click on the **Run Selected** command to execute only those commands in the script that are highlighted. Use the **Step** command to execute only the next command in the script.

The script immediately becomes minimized while each of its commands is executed. If an error occurs which stops the script, the script window is shown with the offending line highlighted. If you press **Escape** to stop the script, the next command to be executed is highlighted so that you may press the continue button.

After you start a script running, it continues to run until one of three things happen:
- The **END** command is reached,
- You stop the script by hitting the **Escape** key, or
- An error condition is encountered.

When the script stops running, the script window is opened so that you may edit it or run it again.
If you stop a script by hitting the **Escape** key, the script finishes the command it is executing when the interrupt occurs, and then stops. The script window appears with the next command highlighted. At this point you may activate other windows and perform any interactive operations you wish. Use the **Continue** command to continue running from the point at which the script was stopped.

### Jump

This places an unconditional jump in the script. A dialog prompts you for the target label. After the script runs the **Jump** command, the script continues running from that label. Control of the script is transferred to the target label’s position. You can jump to any label in the script.

![Jump Dialog Box](image)

### Loop

The **Loop** command provides simple backward looping capability in the script. You can control the number of times the script will return to the same label. A dialog prompts you for the label of the position to receive control and the number of iterations to perform. The **# of Iterations** parameter can be read from an **IPLab** variable by toggling the “#” symbol to the “V” symbol. This lets you control the number of iterations by controlling one of the **IPLab** variables.

![Loop Dialog Box](image)

If you enter 1 for the number of iterations to perform, the **Loop** command transfers control to the next command in the script without looping. This is because the script has already performed one iteration simply by running down to the **Loop** command. The iteration count is maintained only within the **Loop** command. Stopping the script does not automatically reset it. Selecting **Run** or **Run Select** will reset the loop count. This
allows you to continue the script execution exactly where you stopped it, simply by clicking on the Continue button in the script.

The iteration count that you see in the dialog of a Loop command is not directly available to any other command in the script. If you wish to use the iterations count in another command, you must allocate an IPLab variable to the count and use the Set Variable command to add one to that variable each time through the loop. Then you may use the IPLab variable within the other commands. Alternatively, you may want to consider using the If statement to perform looping. IPLab also permits nested loops.

Pause

Pause allows you to insert a time delay into your script. The Pause dialog prompts you for the delay time in seconds, for which you must enter a non-negative value.

Pause Dialog Box

When the Pause command is encountered by a running script, command execution is suspended for the time period specified by the Delay. A special cursor indicates that the script is pausing.

You may stop the script during this pause by pressing the Escape key on the keyboard.

If you press any key other than the Escape key, the script immediately resumes running, independent of what the originally selected delay time is. If you do nothing, the script simply continues with the next command after the selected delay time period.

The Pause command is also useful in displaying a sequence of images as a slide show. Create the following script:

```
Set Index Info  (Point to a set of images you want displayed)
Top             (A label for looping)
Open Indexed    (Forces the Front Image to update so you can see it)
Force Update    (Use a long default delay, such as 18000 seconds, or 5 minutes)
Pause           (Remove the image window without prompting the user to save)
Dispose Window  (Loop back up to the label Top)
Loop
```

Whenever this script is run, the images in the indexed files are opened and displayed one at a time, with time provided for viewing.
**If**

The if command provides a conditional jump control structure. That just means that the if function will consider whether or not the given equation is true, and if it is, then the script will continue from the chosen label.

The if dialog box prompts you to enter:

- a logical relationship (e.g. variable 151 = 0) and
- a line label to jump to if the relationship is true.

The logical relationships available are, from left to right:

- greater than
- less than
- greater than or equal to
- less than or equal to
- equal to
- not equal to

The label name entered at the bottom of the dialog box must exactly match the line label placed earlier in the script.

**Using If with Numeric and String Variables**

When the Numeric option is selected, numbers or numeric variables can be entered into either text entry box. Click the #/V buttons to toggle between number and variable. When the String option is selected, literal text or string variables can be entered into either text box. Click the L/SV buttons to toggle between literal text and string variable.

![If Dialog Box with Numeric Option Selected](image)

When you toggle the # symbol to the V symbol for one of the parameter values, and you enter a constant for the other parameter, you are comparing the specified IPLab variable to a constant. If you select the V symbol for both parameters, you are comparing one IPLab variable to another. Control in the script is transferred to the labeled position if the stated relationship is satisfied. Otherwise the next command in the script is executed. In the example dialog pictured above, if the number stored in variable 151 equals 0, then the script will jump to the label Top and begin executing commands from there.
If Dialog Box with String Option Selected

The if statement works the same way with string variables. In the example dialog above, the statement is true if the string variable Query Result contains the value Yes. The value in the if dialog and the string value must have the same spelling. However, you could use successive if statements to check if Query Result equals (contains) misspellings and other acceptable values.

Making Interactive Scripts

Since you can jump to a label located anywhere in the script, it is possible to use the if button along with the Query command (Script menu) to make your script interactive. For example, you could use Query to ask the user if he wants to animate a sequence. A different number is returned depending on whether the user answers Yes or No (see the section describing Query on page 325). You would then use an if statement: If the variable holding the answer equals 1 (which would mean No), then Jump over the Animate command.

Cut, Copy, Paste, Clear

These commands let you edit an open script window. To use Cut, Copy, or Clear, simply select the desired commands within the script and then choose Cut, Copy, or Clear. When using Paste, the pasted commands will be placed above your selection.

Label

This button lets you label a line within the script. Labels mark positions in a script, which are referred to by the IF, Jump, and Loop commands. You must enter a unique text string to identify the label. Labels then appear with a special tag in the first column, under the “*” heading. In the example script on page 99, “Top” and “AcquireLoop” are labels.

Alert

An alert is a simple dialog box that contains a message to the user and Abort and Continue buttons. When you insert the Alert command into a script, you will type the message into the dialog box. When the script is run, the user will see the message along with the two buttons. If the user clicks Abort, the script will end immediately. If the user clicks Continue, the script will continue executing.
The Alert Dialog Box, Seen By the Scripter

This is an excellent method for informing the user what the script is doing, or for telling the user to move a non-motorized piece of the microscope.

To break a line of text within the alert, type Control-Enter.

Query

The Query command is used in scripts to prompt the user to choose from two or three options. Depending on which button the user clicks, the command returns a 1, 2, or 3 to the chosen variable. This can be used for choosing between three filters, for example, or used within If statements to determine what course of action the user wants to take next.

Query Dialog Box In Set Up and In Use

When you enter the Query command in a script, the dialog box shown above and on the left appears. Type a message to the user in the large text box to tell the user what the choices are for. Click on each button to edit the text that will appear on it. If you do not want a button to appear to the user, delete the text from that button. Finally, choose a variable to store the results in.
The buttons are numbered, from right to left: 1, 2, and 3. One of these values will be entered into the chosen variable when the user clicks a button. In the example above, if the user clicks on FITC, the value for FITC (2) will be entered in variable 23. Your script will know that the user chose the FITC filter because variable 23 contains the value 2.

When the script is run, the dialog box pictured above and on the right appears. This simply presents your Query message and the buttons. When the user clicks on a button, the appropriate value will be entered into the variable you chose, and then the script will continue.

**Enter Variables**

The Enter Variables command is used in scripting to prompt the user for experimental parameters, which will be stored in numeric variables. In the example below, the Enter Variables dialog box is being used to prompt the user for exposure times. On the right, default values appear in the Value column, which the user can then change.

In the example dialogs above, the constant default for Wavelength 1 is two seconds. Wavelength 2 does not have a constant default, however, so it defaulted to the current value of variable #1.

Finally, in the Variable fields, enter the numbers of the variables in which to store these parameters. Every active Constant and Variable field must have a number entered in it. When you click OK, these settings will be recorded in the script.
If you leave the **Use Constant** checkbox clear, then the new value for that variable will appear in the **Value** field each time the scripted **Enter Variables** command runs. If you check **Use Constant**, then the contents of the **Constant** field will always be displayed as the default value in the **Value** field when the command runs.

When the script is run, the dialog box shown above and on the right appears. In this dialog box, only the rows you entered **Prompts** for appear. After the user changes the default values (or not) and clicks **OK**, the **Value** entries will be assigned to their variables and the script will continue.

### 7.13 Window Menu

#### 7.13.1 Show/Hide Status Window

This command shows the **Status Window** if it is not currently visible, and hides it if it is already visible. For more details on the **Status Window**, please see page 25. The keyboard shortcut for this command is Control + U.

When you script the **Show/Hide Status Window** command, you will see the following dialog box:

![Dialog Box for scripting Show/Hide Status Window](image)

Your script can either **Hide** the **Status Window**, or it can show the **Status Window** with a particular page visible.

#### 7.13.2 Show/Hide Variables Window

The **IPLab Variables** window is always available, but it may be hidden. Use this command to show the **IPLab Variables** Window, or, if the window is already shown, to hide it. You may use this command to bring the window to the front whether or not the **IPLab Variables** window is currently open. For more details on using variables, please start reading at page 83.

When you add this command to a script, a dialog box allows you to choose whether the window is to be shown or hidden.
7.13.3 Show/Hide Message Window

The **Messages** window lists all error messages produced by **IPLab**, as described on page 31. This command displays or hides the window. It is not scriptable. The keyboard shortcut for this command is Control + M.

7.13.4 Dispose Window

This command closes the active data window without saving. This is just like the **Close** command except that **Dispose Window** never asks if you wish to save the data. The keyboard shortcut for this command is Control + K.

This command is scriptable. When you add it to a script, a dialog allows you to choose which window the script should dispose. You may dispose the front window, or any other named window. Remember that the scripted **Dispose Window** command will not prompt the script's user to save the data, either!

7.13.5 Dispose All Views of Front Image

This command is like **Dispose Window**, except that it closes all data windows which contain views associated with the data in the active window. It is the same as using the **Dispose Window** command on each view of the data. **Note that you will not be asked if you wish to save the data.**

You can make new views of an image by choosing the **New View** command from the **View** menu.

When scripted, this command can dispose all views of any open image. This dialog box appears:

![Dispose Document Dialog Box](image)

**The Scripted Dispose All Views… Dialog Box**

Pick an open window name. When the script runs this command, all views of that window will close **without** any warning to the user.

7.13.6 Dispose All Windows

This command closes all data windows. It is the same as using the **Dispose Window** command on each open window. **Note that you will not be asked if you wish to save the data.**

This command is scriptable, but does not have an options dialog box.
7.13.7  Rename Window

Use this command to rename the active data window.

![Rename Window Dialog Box]

The **Window to Rename** field lets you pick any open window. You can pick by name, or you can pick the **First** (active), **Next**, or **Last Window**.

The **Set Name To** field prompts you for a new name. If you check the Append Number box, then that number will be added to the end of the new name. If you leave the **Set Name To** field blank, then the number will be added to the end of the existing window name. Appended numbers are zero-filled, five digit numbers with no space between them and the file name.

The **#/V** button next to the **Append Number** field lets you choose to enter the number as itself (#) or as a numeric variable (V). The **L/SV** buttons next to the window name fields let you choose to enter the names as a "literal" string of text (L), or as a string variable (SV). This is tremendously powerful in scripts. More detailed information on **IPLab** variables and their use can be found on these pages:
- about numeric variables: Page 84
- about string variables: Page 86
- about scripting: Page 99

7.13.8  Duplicate Window

Use this command to create a new window containing some or all of the data within the active window.
If you do not enter a new name in the Name of New Window text box, then the duplicate will have the same name as the original, but with a “%” symbol appended to the end.

If you check the box Dispose of Original Document, all windows with any views of the original image are disposed after the duplicate image is created. Note that you will not be asked if you wish to save the data.

The Portion to Duplicate section of the dialog box allows you to specify which portion of the current window to duplicate. You can choose to duplicate the entire image or just the ROI. For multi-dimensional data sets, you can select a portion of the Z range and T range of frames as well.

You also use this command to crop an image. First, use one of the ROI tools to select the portion of the image you wish to keep. Then use the Duplicate Window command with the Portion to Duplicate set to ROI. This creates a new, cropped image containing only the portion you have selected from the original.

7.13.9 Change Window

Use this command to change the active window. This is particularly useful in scripts.
From the pop-up list of open windows, choose the name of the window you want to become the active window.

The L/SV button lets you choose to enter the window name as a "literal" string of text (L), or as a string variable (SV).

When making a script, Change Window allows you to enter any window name, whether or not the window exists at the time you are editing the script. That way, a running script can activate a window that is created earlier in the script.

7.13.10 Place Window

Use this command to move a window around the screen, size it, minimize it or restore it.

Place Window is most useful in scripts where you may want to move one or two windows to see them better without performing a Tile or Cascade on all of the open windows.

Window to Place: First, choose one of the open windows. Then choose one of the placement methods:

Minimize/Restore: The Minimize option shrinks the window to a title bar at the bottom of the screen, while Restore reverses this effect.
Move: When this radio button is clicked, only the Left and Top text boxes are available. The coordinates entered in those two boxes specify the new location of the window’s upper left corner.

Set: When this radio button is checked, all four text boxes (Left, Top, Right, and Bottom) are available. The coordinates entered in these specify the new locations of the left, top, right, and bottom edges of the window, respectively.

### 7.13.11 Frames to Sequence

With this command, you can create a single, multi-frame image (a sequence) from multiple, single-frame images.

The names of the individual images must end with sequential index numbers (e.g. Image_00000.IPL, Image_00001.IPL, Image_00002.IPL...). The images will be added to the sequence in numerical order starting with your chosen first frame. Sequencing stops when the command fails to find the next index number.

![Frames To Sequence Dialog Box](image)

**Frames To Sequence Dialog Box**

The New Sequence Name is the designated name given to the newly created image sequence. You may create a Z Sequence (Z-stack) or a T Sequence (time lapse). To sequence open images, click Start with Front Window. (First, make certain the correct window is in front.) To sequence saved files, click Choose File Containing First Frame and Browse to the file.

### 7.13.12 Sequence to Frames

This command converts a single, multi-frame image (a sequence) to multiple, single-frame images.

This command will convert sequences that have only Z or T frames, but it will not convert sequences that have both Z and T frames.
Sequence To Frames Dialog Box

The **Base Name** will be the root of the new file names, followed by index numbers (e.g. Nom_00000, Nom_00001, Nom_00002…). You can type a new base name in this field, or you can check **Use Sequence Name** to use the window’s name as the base name.

Check the **Save Immediately** checkbox to automatically save the new files to disk. Click the **Browse** button to pick the file directory. Use the **File Type** pop-up list to pick IPLab or TIFF file type. Finally, check the **Keep Windows Open** checkbox to keep the newly-saved images open.

If you do not check the **Save Immediately** box, the files will remain open on the **IPLab** desktop, but they will only be stored in memory.

### 7.13.13 Cascade

Use this command to stack the open windows, in an overlapping pattern, from top to bottom on the display screen.

### 7.13.14 Tile

Use this command to distribute the open windows as well as possible, without overlap, around the display screen.

### 7.13.15 Dual Monitor Setup

The **Ratio Plus** extension places many control panels around the window. If you have two monitors, then choose **Enable** in this dialog box. **Ratio Plus** will then put all of its control panels on your second monitor.
7.13.16  *Arrange Icons*

This command is similar to the *Tile* command, except that it only moves window icons. Icons are the window title bars after the window is minimized. If you have moved these bars around, *Arrange Icons* will move them neatly to the bottom of the *IPLab* window for you.

7.13.17  *Toolbars*

Use this command to show or hide the *IPLab* toolbars. The description of the toolbar tools starts at page 16 of the chapter of this manual.

Unlike the other toolbars, the Status Bar is part of the image window, and not part of the application desktop. There is a status bar at the bottom of each and every image window. The status bar shows the intensity and position values for the cursor’s location. Deselecting *Status Bar* with the *Toolbars* command hides the active window’s status bar.

7.13.18  *Window List*

A list of the currently open windows follows the *Window* menu commands. Click on any name in the list to make that window active and bring it to the front.
8 Writing Extensions

8.1 Introduction

Sometimes you want to control special equipment in your laboratory or implement some special algorithm that cannot be done using IPLab scripts or one of the optional extensions provided by Scanalytics or some other vendor. In such a case you may want to write your own IPLab extensions. When you do, your extensions will appear in the Ext. menu and you can access them exactly as you would any other command in IPLab. IPLab comes with all you need, except the compiler to write your own extensions. We even provide you with example source code to get you started. Our example code is written in Microsoft Visual C++™, but you could theoretically write extensions in any language or development environment.

8.2 The Basic Concepts of Extensions

An extension is a dynamic link library (DLL) with a special structure. This special structure allows IPLab and the extension to communicate efficiently. Because an extension is a special DLL, we require the name to be Name.IPX where Name is any legal file name you choose.

When IPLab starts up, it looks in its own folder for files whose names end in ".IPX". It then interrogates those files to see if they are legitimate IPLab extensions. Therefore, in order to use your extensions, you must put them in the same folder where IPLab.exe resides.

Each extension has two entry points, CmdEntryInit, and CmdEntryExtension. IPLab calls CmdEntryInit once as the program starts up to get information from the extension about the number of commands it contains. IPLab then calls CmdEntryExtension at different times with different action codes to tell your extension which command to execute and what that command should do (for example display a dialog, save or restore dialog parameters, etc.).

Your extension may also call functions in IPLab to learn about its environment. These functions in IPLab are called "callback" functions. Certain callbacks allow you to get a data reference pointer to an open IPLab window. You then pass this data reference pointer to other callbacks to get information about or to change the data associated with those windows. Another callback allows you to create a new data window in IPLab, which you can use to display an image or other data.

The sample projects contain example source code and provide you with the easiest way to learn how to write extensions. You should look at these samples to learn the specific details of writing extensions.

8.3 Create An Extension

8.3.1 From Sample Projects

The easiest way to get started making your own extensions to IPLab for Windows is to start with our example source code. You can start from the code in either the SampleExt1 project or the SampleExt2 project. SampleExt1 contains two commands in the same file and shows how to use dialogs. The first command requests the user to enter a value, which specifies the dimensions of a new window. It then creates
the window and fills the data with a pattern. It also cycles though all the open windows, but does nothing with them. The second command displays the same dialog, but does nothing.

SampleExt2 is simpler, containing only one command and no dialogs. This command looks for each open data window, and inserts a pattern in each, except for the Variables window.

You can use one of these sample extensions as a starting point for making your own extension. If you plan to put a dialog in your extension, start with Sample 1. Otherwise, start with Sample 2. First make a copy of the folder, which contains the extension you chose. You should keep the folder for your extension in the folder called MakeExt. This is because the projects are set up to use files in the enclosing directory.

Then simply start modifying the code to add your own features. The first change you must make to your extension source code is to change the Command ID so it does not conflict with other extensions. To do this:

Open the .cpp file for your new project. Find the line(s):

```
#define kCmdID1       xxxxx
#define kCmdID2       xxxxx
```

(This line appears in SampleExt1)

If you plan to use your extension only within your own group of researchers, you can replace the xxxxx with any number in the range 39500 - 39999. The sample extensions use Command IDs 39500, 39501, and 39502. If you make additional extensions, you must assign different Command IDs to each one.

If you are a developer, or if you wish to distribute your extensions to other IPLab users, you should call Scanalytics to obtain a distinct set of command ID’s in the range of 49000 - 49999.

### 8.3.2 Create Your Own Project

If you are an experienced programmer and you want to know all the details of your project, you can start from scratch when creating the code, which you will use for your extension. This takes somewhat more time to get started, but it can give you more control. In theory, you can use any development environment to create your extensions. Here are the steps for using Microsoft Visual C++ (version 6.0):

1. Click **New** under the **File** menu. After that, choose the **New Project Tab**.
2. Select **MFC AppWizard** (dll).
3. Enter a project name and location, and check **Win32**, and click on **OK**.
4. A new dialog box will open: **MFC AppWizard Step 1 of 1**.
   - On that, select **MFC Extension DLL** (using shared MFC DLL) (This is important if you want to use MFC to make dialogs.)
5. Click on **Finish** and then **OK** to finalize the project creation.
6. Go to the **Project** menu and select **Settings**.
7. Select the **C/C++** tab.
8. In the **Category** field pop up menu, select **Code Generation** and be certain the structure member alignment says **8 Bytes**.
9. Select the **Link** tab.
10. In the **Category** field, select **General** from the pop-up.

11. Enter following output filename: "C:\IPLabDir\MyExt.IPX" (Enter desired name for MyExt).

12. In the **Category** field, select **Input** from the pop-up.

13. In Object/Library **modules**, enter "..\CallBack.lib".


15. Select the **Debug** tab.

16. In the field for **Executable**, enter "C:\IPLabDir\IPLab.exe".

17. Click **OK** in the **Project Settings** dialog.

18. Open the .def file for your new project and insert two lines after **EXPORTS**:  
   
   ```
   CmdEntryIni
   CmdEntryExtension
   ```
   
19. Save the .def file and close it.

20. Open SampleExt1.cpp (or SampleExt2.cpp, whichever best matches your starting requirements).

21. Copy all the contents and close the SampleExt1.cpp (SampleExt1.cpp2) window.

22. Open the .cpp file for your new project and paste over all the contents with the code you copied from the SampleExt1.cpp (SampleExt1.cpp2) file.

23. Find the following line(s) in the .cpp file for your new project:

   ```
   #define kCmdID1 xxxxx
   #define kCmdID2 xxxxx  
   ```

   (this line appears in SampleExt1)

   and replace the value with a number in the range 39500 - 39999.

   If you are a developer, or if you wish to distribute your extensions to other **IPLab** users, you should call Scanalytics to obtain a distinct set of command ID's in the range 49000 - 49999.

24. Save your .cpp file and close the SampleExt1.cpp window.

25. If you are starting with SampleExt1, you must transfer some dialog resource information.


27. Expand the dialog resource list.

28. Drag-select IDD_SampleDLL1 and IDD_SampleDLL2, and copy them.


30. Open the .rc file for your new extension and paste in the resources you copied from SampleExt1.

31. Go to the **Build** menu and select **Configurations**.

32. In the **Configurations** dialog, highlight **Win32 Debug** and click on the **Remove** button, and then **Close**.
33. Now you can build your new extension.

8.4 Callback Functions

Callback functions are routines within IPLab that you can access from your extension. The primary use of callback functions to provide you with information about the images, which are displayed in the IPLab window. Many of these functions require a dataRef. A dataRef is a pointer to a block of information about an IPLab data window. To get a dataRef for an image, you must call one of the callback functions that returns a Data Reference pointer, namely GetDataRef, GetFrontWindow, GetNextWindowIPL, or GetVariables.

Here is a listing of the prototypes for all the currently available callback functions. Any constants and types that appear in these functions but are not defined here can be found in the file GlobalConstDev.h.

```c
#define ksFirstImage "*First Image*

typedef char NameString[kNameLength + 1];

typedef double TLabDouble,
TLabExtend,
*DoublePtr,
*ExtendPtr;

extern void CallBackInit(
    void* pFunc);

Must be called before any other callback.

extern long GetDataDimensions(
    void* dataRef,
    long& width,
    long& height,
    long& nchannels,
    long& nz,
    long& nt,
    DataTypes& dType);

Returns width and height, z depth and t depth, and data type for data window.

extern void* GetDataPtr(
    void* dataRef,
    long x,
    long y,
    long c,
    long z,
    long t);

Returns pointer to the data at given location.

extern void* GetDataRef(
    NameString name);

Returns the Data Reference pointer for the named window. Can use "*First Image*" to get DataRef for first image. If the named window is not a data window or is not found, returns NULL.

extern void* GetFrontWindow(

Returns: dataRef if the window is a data window;
```
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HWND *h, NameString name);</td>
<td>Fills h with the Windows handle to the front window. Fills name with the name of the window.</td>
</tr>
</tbody>
</table>
| extern void* GetNextWindowIPL( HWND *h, NameString name); | Returns:
| | dataRef if the window is a data window;
| | otherwise NULL. |
| GetNextWindowIPL assumes you pass a valid window handle in h (like you might get from a previous call to this routine or to GetFrontWindow). |
| extern long NewData( long w, long h, long nz, long nt, DataTypes dt, NameString name); | Creates a new, blank data window of the given width (w), height (h), z depth (nz), time depth (nt) and data type. |
| extern long UpdateAllViews( void* dataRef); | Updates views associated with the dataRef. |
| extern void* GetVariables(); | Returns the dataRef of the Variables. |
| extern long SetZoom( float); | Set the magnification of the front doc's active view. See the function SetZoom for a description of the zoom factor. |
| Acceptable values for zooming in (i.e. making larger) are 1, 2, 3, 4, and 5. These values expand the image by 1, 2, 4, 8, and 16 times, respectively. |
| Acceptable values for zooming out are 0.5, 0.25, 0.125, and 0.0625. These values directly set the demagnification factor. |
| extern float GetZoom( void* dataRef); | Returns the magnification of the front doc's active view. See the function SetZoom for a description of the zoom factor. |
| extern void AttachTagData( void* dataRef, void* theTag); | Attaches the specified file tag to the document. This tag is saved with the image in IPL format. For a full description of the IPL tagged file format, see the part of the manual on file formats. |
| extern void* GetTagData( void* dataRef, char tagName[4]); | Returns a pointer to the information at the specified file tag, or nil if this tag is not attached to the image. |
```c
struct ROIStruct
{
    float    version;
    void*    *dataRef;
    int       roiType;
        // = 0 for rectangular type, 1 for ellipse type
    CRect     roiBounds;
    long      numPolyPoints;
    CPoint    *poly;
};
```

```c
extern long DefineROI(
    long    roiType,
    long    left,
    long    top,
    long    right,
    long    bottom);
```

Set a rectangular or oval ROI on the front image.

```c
extern void GetROI(
    void*    dataRef,
    ROIStruct*    roiStruct);
```

Returns the ROI information: type, bounds, and polygon of the dataRef (front data if dataRef is nil). Possible return values for roiType within the roiStruct are:

- 0 = Rectangular
- 1 = Ellipse
- 3 = Closed Polygon of numPolyPoints
- 5 = Open Polygon of numPolyPoints

```c
extern void DisplayROIOnly(
    int    mode);
```

Sets the display mode on the front image when viewed in Image View. Valid mode values are:

- 0 = Whenever a display update is issued, update only the image pixels within the ROI.
- 1 = Whenever a display update is issued, update the entire image.
- 2 = Toggle the current setting. (When you do not know what the mode setting is, but you want to change it.)

```c
extern void SetDisplayRange ( 
    void*    dataRef, 
    int      style, 
    TLabExtendbp, 
    TLabExtendwp, 
    TLabExtendmp, 
    long     c);
```

Sets the normalization parameters for the image. In normalization, values in the image at or above the White Point (wp) are mapped into display white. Values at or below the Black Point (bp) are mapped into display black. All image values between are mapped according to a gamma function which is defined by the parameter mp.

The parameter `style` defines the way in which IPLab performs normalization. Parameter values are:

- 0 = compute the min and max values on the displayed image frame and use these for bp
and \( \text{wp} \), with \( \text{mp} = 50.0 \)

1 = custom, using the passed in values of \( \text{bp} \), \( \text{wp} \), and \( \text{mp} \)
2 = ROI min max

\( \text{bp} \) is the image value that gets mapped into Black
\( \text{wp} \) is the image value that gets mapped into White
\( \text{mp} \) describes the shape of the curve. The value of \( \text{mp} \) ranges from 1 to 95, which generates a gamma value according to the formula:
\[
\gamma = -0.69707645869983 \div \log(\text{mp} / 100).
\]
To get a gamma of 1, use \( \text{mp} = 50.0 \)

```c
extern void GetDisplayRange ( void* dataRef, int *style, TLabExtend*bp, TLabExtend*wp, TLabExtend*mp, long c);
```

gets the image normalization parameters. See the function SetDisplayRange for a description of the parameters \( \text{bp} \), \( \text{wp} \), and \( \text{mp} \).

```c
struct StatusStruct
{
    float version; //the callback libs version
    float IPLabVer;
    // the version of IPLab
    BOOL isEval; //true if IPLab is an eval copy
    char reserved[63];
    // reserved for Scanalytics use
};
```

```c
extern StatusStruct GetStatus();
```

returns information about the instance of \( \text{IPLab} \) currently running.

```c
extern BOOL IsEval();
```

returns true if \( \text{IPLab} \) is an eval

```c
extern float GetIPLabVersion();
```

returns the version number of the instance of \( \text{IPLab} \) currently running.
## 9 Appendix

### 9.1 Numeric Variables Reserved by IPLab

Some **IPLab** commands store their data in numeric variables. You can use these variables, too; just remember that **IPLab** may overwrite any information you place in these variables. We do encourage you to reference these variables when writing your own scripts. For example, it's very useful to employ variable #255, the last exposure time used, within the **Acquire** command.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Information stored in this variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>ROI left</td>
</tr>
<tr>
<td>201</td>
<td>ROI top</td>
</tr>
<tr>
<td>202</td>
<td>ROI right</td>
</tr>
<tr>
<td>203</td>
<td>ROI bottom</td>
</tr>
<tr>
<td>204</td>
<td>ROI Width</td>
</tr>
<tr>
<td>205</td>
<td>ROI Height</td>
</tr>
<tr>
<td>206</td>
<td>Document Width</td>
</tr>
<tr>
<td>207</td>
<td>Document Height</td>
</tr>
<tr>
<td>208</td>
<td>Current Z</td>
</tr>
<tr>
<td>209</td>
<td>Z Depth</td>
</tr>
<tr>
<td>210</td>
<td>Current T</td>
</tr>
<tr>
<td>211</td>
<td>T Depth</td>
</tr>
<tr>
<td>212</td>
<td>DataType</td>
</tr>
<tr>
<td>213</td>
<td>XY Unit Factor</td>
</tr>
<tr>
<td>214</td>
<td>Binning Factor X</td>
</tr>
<tr>
<td>215</td>
<td>Binning Factor Y</td>
</tr>
<tr>
<td>216-219</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Red White Balance Value</td>
</tr>
<tr>
<td>221</td>
<td>Green White Balance Value</td>
</tr>
<tr>
<td>222</td>
<td>Blue White Balance Value</td>
</tr>
<tr>
<td>223</td>
<td>Segmentation Min(1)</td>
</tr>
<tr>
<td>224</td>
<td>Segmentation Max(1)</td>
</tr>
<tr>
<td>225</td>
<td>Segmentation Min(2)</td>
</tr>
<tr>
<td>226</td>
<td>Segmentation Max(2)</td>
</tr>
<tr>
<td>227</td>
<td>Segmentation Min(3)</td>
</tr>
<tr>
<td>228</td>
<td>Segmentation Max(3)</td>
</tr>
<tr>
<td>229-231</td>
<td></td>
</tr>
<tr>
<td>232</td>
<td>Thresholding for Auto Segmentation</td>
</tr>
<tr>
<td>233</td>
<td>(Reserved for Auto Segmentation not implemented)</td>
</tr>
<tr>
<td>234</td>
<td>(Reserved for Auto Segmentation not implemented)</td>
</tr>
<tr>
<td>235</td>
<td>Last Row-Position</td>
</tr>
<tr>
<td>236</td>
<td>Last Col-Position</td>
</tr>
<tr>
<td>237</td>
<td>Last Super Row-Position</td>
</tr>
<tr>
<td>238</td>
<td>Last Super Col-Position</td>
</tr>
</tbody>
</table>
The IPLab file format (name extension .IPL) consists of a series of blocks of information. Each block consists of a unique identifier called a “tag”, a size field, and a data field. The tags tell the reader how to interpret the information. Tags must be described in a library so that everyone agrees what each tag means. The size field tells how large the data field is. This permits variable sized blocks, but still lets a general reader pass over blocks which it does not understand. So far this description of the IPLab file format sounds like a TIFF (Tagged Image File Format) file. However, we have altered the TIFF idea somewhat to accommodate features we regard as important in saving image files.

The tag is four consecutive bytes. All tags used by Scanalytics consist of lower case ASCII letters only. Tags containing other characters are currently undefined, but reserved for future use by Scanalytics.

The size field is a four byte unsigned long integer. The value may be zero. If it is non-zero, it is the number of bytes in the data field for this tag. After reading the size field, skipping ahead by the number of bytes indicated by the contents of the size field will move you to the next tag in the file.

The tag defines the data field contents and its length is equal to the value given in the size field.

Thus every block of information in an IPLab file always looks like this:

<table>
<thead>
<tr>
<th>Start Byte</th>
<th>Field</th>
<th>Field Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Tag</td>
<td>4 byte ASCII field.</td>
</tr>
<tr>
<td>4</td>
<td>Size</td>
<td>Unsigned long.</td>
</tr>
</tbody>
</table>
Appendix

8 Information Interpret according to definition of the tag. The
Size field specifies the Length of this field.

The Size field of every block tells how many bytes remain in that block. A typical reader will first read the first 8 bytes of a block. Then it will determine if it knows how to handle the information in the block by comparing the tag field to its own library of known tags. If the reader can interpret the information field, it will read it and use it. Otherwise the reader may skip the information field (skip Size number of bytes) and continue with the next block.

Scanalytics has pre-defined several tags. Three of these tags are required, and the rest are optional. Anyone wishing to write files using this specification must write these tags so that IPLab can read the files. More tags may be added at any time by Scanalytics or any IPL file writer. An IPL file reader should read and re-save all tags, even though it cannot use tags it does not understand.

9.2.2 Required Tags and Their Order

The first two tags in the file must always be the byte-order flag, and the data-set tag. This restriction creates a fixed length header to the raw image data. This allows a simple reader to read the image data-set in the file by using a fixed offset into the file. Once this initial (variably sized) data set is read, the rest of the file must be read in a “streaming” fashion.

Byte-Order

The file always begins with a byte-order tag and always contains only one byte-order tag. The byte-order tag defines the byte ordering for two-byte, four-byte and eight-byte numbers. It also contains a version number. The size field is affected by byte ordering, as well as the contents of the data field. There are currently two options for this tag: ‘iiii’ or ‘mmmm’.

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Data Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>‘iiii’</td>
<td>All numerical contents in this file are to be interpreted as Intel byte ordering</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>4L</td>
<td>The size of the following data is 4 bytes</td>
</tr>
<tr>
<td>Data</td>
<td>explicit</td>
<td>0x100f</td>
<td>Version number of this file format. There may be a few files written with version number 0x100e.</td>
</tr>
</tbody>
</table>

or,

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>‘mmmm’</td>
<td>All numerical contents in this file are to be interpreted as Motorola byte ordering</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>4L</td>
<td>The size of the following data is 4 bytes</td>
</tr>
<tr>
<td>Info</td>
<td>explicit</td>
<td>0x100f</td>
<td>Version number of this file format.</td>
</tr>
</tbody>
</table>

In early releases of IPLab for Windows, the version field contained the value 0x100e. The only tag which this affects is the Normalization tag, where the source field of the saved parameter structure was interpreted differently in the earlier version. Since Normalization is an optional tag, it is may safely be ignored in any file where a reader encounters version number 0x100e in this first tag.
**Data Set**

The Data Set block must be the second block in the file. The Data Set block contains an array of descriptive information in the form of a header, followed by the raw image data. Image data can have the following 5 dimensions:

Width, Height, Color Channels, Z Depth, T Depth.

Image data is written as a 5-dimensional array with the indices varying most rapidly in the order given above, *i.e.* in “C” it would be a nested loop as follows:

For \( t = 0; t < t\)Depth; \( t++ \)  
\[
\text{for} \ (z = 0; z < z\)Depth; z++ \]  
\[
\text{for} \ (c = 0; c < \text{channels}; c++) \]  
\[
\text{for} \ (y = 0; y < \text{height}; y++) \]  
\[
\text{for} \ (x = 0; x < \text{width}; x++)
\]

If there is no data set in the file, the writer must still include a data set tag, with width and height set to 0.
<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'data'</td>
<td>This is a data set, consisting of a header of descriptive information followed by the raw image data.</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>28 + size of image data in bytes</td>
<td>The header information takes up 28 bytes.</td>
</tr>
<tr>
<td>Info</td>
<td>long</td>
<td>width in pixels</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>height in pixels</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>number of (color) channels per pixel. 1 for grayscale 3 for RGB color</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>number of Z-planes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>number of T-volumes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>data type</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = unsigned byte, 8 bits no sign 1 = signed short, 16 bits with sign 2 = unsigned short, 16 bits no sign 3 = signed long, 32 bits with sign 4 = single precision Floating Point, 32 bit IEEE Floating Point number 5 = Color24 6 = Color48 7 = (reserved) 8 = (reserved) 9 = (reserved) 10= double precision Floating Point, 64 bit IEEE Floating Point number (+/- INF legal, NAN illegal)</td>
<td>variable length raw image data without padding</td>
</tr>
</tbody>
</table>

**Finish Tag**

The last tag in the file is always the finish tag. This tag marks the end of the list of tags and readers do not have to read beyond it.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'fini'</td>
<td>Finish tag</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>0L</td>
<td>The size of the following data is 0 bytes</td>
</tr>
<tr>
<td>Info</td>
<td>None</td>
<td></td>
<td>No data associated with this tag</td>
</tr>
</tbody>
</table>

**9.2.3 Optional Tags**
These tags may or may not appear in a file. They include additional information which IPLab or its extensions may use. If they do appear, they must come after the ‘data’ tag and before the ‘fini’ tag. Aside from that restriction, they may appear in any order.

**Color Lookup Table**

There are two possible blocks here depending on the color table type. The first is an indexed color table (CLUT) which uses less storage space.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'clut'</td>
<td>Holds the Color Lookup Table for the image data</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>8</td>
<td>Uses two fields of longs for total of 8 bytes</td>
</tr>
<tr>
<td>Info</td>
<td>long</td>
<td>0</td>
<td>CLUT of type 0 (index into set of pre-defined CLUTs)</td>
</tr>
<tr>
<td></td>
<td>long</td>
<td></td>
<td>Index</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 = Monochrome</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Reverse monochrome</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Blue, Green, Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = Classify</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 = Rainbow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 = Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 = Green</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7 = Blue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8 = Cyan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 = Magenta</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10 = Yellow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11 = Saturated Pixels</td>
</tr>
</tbody>
</table>

The second possible block describes an explicitly defined color table, where each entry in the color table is given as an RGB entry in an array.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'clut'</td>
<td>Holds the color lookup table for the image data</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>772</td>
<td>Uses 4 bytes for the CLUT type plus the explicit CLUT</td>
</tr>
<tr>
<td>Info</td>
<td>long</td>
<td>1</td>
<td>CLUT of type 1 (explicit description of the CLUT)</td>
</tr>
<tr>
<td></td>
<td>long[256][3]</td>
<td></td>
<td>An array of 256 RGB triplets. Each RGB triplet consists of three bytes, representing red, green and blue values.</td>
</tr>
</tbody>
</table>

**Normalization Information**

This block describes how the user last set the normalization parameters. Using these parameters allows IPLab to display the image in exactly the same way as the last time it was saved.
### Field Type Value Description

**Tag** 4-Byte ASCII 'norm' Holds the normalization settings for each channel of this image.

**Size** long 44*number of channels Each channel has its own normalization data.

- = 44 for grayscale data
- = 132 for Color24 and Color48 data

**Info** long Source of normalization parameters

- 0 = user (custom)
- 1 = plane min/max
- 2 = sequence min/max
- 3 = saturated plane
- 4 = saturated sequence
- 5 = ROI min/max

**double** min, *i.e.* value assigned to black point

**double** max, *i.e.* value assigned to white point

**double** gamma, coded as a value between 1 and 95

**double** display black value (normally 0)

**double** display white value (normally 255)

The source field was defined differently in file version ‘100e’. The normalization tag is the only tag which changed between file version 0x100e and 0x100f. Since Normalization is an optional tag, it may safely be ignored in any file where a reader encounters version number 0x100e in the first tag.

### Header Labels (Row/Col Text Labels)

This block stores text labels for heading rows and columns in text view. The user adds these labels with the **Set Row/Col Label** command (**Edit** menu).

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'head'</td>
<td>Holds header labels for the text view columns.</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>2200</td>
<td>For(i = 0; i &lt; 100; i++)</td>
</tr>
</tbody>
</table>

```c
{
    short headerNum;
    char name[20];
}
```
## ROI Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'roi '</td>
<td>Holds the ROI type and information. Note that the tag is four characters: &quot;roi&quot; followed by a space.</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>??</td>
<td>Size depends on the ROI.</td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>roiType</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>roiLeft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>roiTop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>roiRight</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>roiBottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>numRoiPts</td>
<td></td>
</tr>
</tbody>
</table>

For (i = 0; i < numRoiPts; i++)
{
    long ptX;
    long ptY;
}

## Segmentation Mask

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'mask'</td>
<td>Segmentation mask</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>??</td>
<td>Size depends on the mask's size.</td>
</tr>
<tr>
<td></td>
<td>long</td>
<td>maskSize</td>
<td></td>
</tr>
<tr>
<td></td>
<td>char</td>
<td>*ptr[maskSize]</td>
<td>Array of characters the size of maskSize</td>
</tr>
</tbody>
</table>

## Units

This block stores the image's XY units, as set by the **Set XY Units** command (Analyze menu)
### Field Type Value Description

<table>
<thead>
<tr>
<th>Tag</th>
<th>4-Byte ASCII</th>
<th>'unit'</th>
<th>Units defined for the document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>long</td>
<td>48</td>
<td></td>
</tr>
</tbody>
</table>

```c
For (i = 0; i < 4; i++)
{
    long xResStyle;  // kDiscreet or kContinuous
    float xUnitsPerPixel[1];
    short xUnitNameIndex;
}
```

## View

This block stores the type of view in use by the document (for example, image, text, or plot view).

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'view'</td>
<td>The type of image view used by the document</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

## Plot

This block stores the settings for a plot, as set by the View Options: Plot command (View menu).
### Field | Type | Value | Description
--- | --- | --- | ---
Tag | 4-Byte ASCII | 'plot' | Plot options for the document
Size | long | 2508 | RGBTriplet is a structure of three unsigned chars representing red, green, and blue.

```c
for(i = 0; i < 35; i++)  // plot line info
{
    long column;
    long pattern;
    long width;
    long token;
    BOOL plotThis;
    RGBTriplet lineColor;
    RGBTriplet tokenColor;
}
```

#### X Axis
- long tickMarks
- long format
- long precision
- Bool useDataMinMax
- float min
- float max
- float delta
- RGBTriplet color

#### Y Axis
- long tickMarks
- long format
- long precision
- Bool useDataMinMax
- float min
- float max
- float delta
- RGBTriplet color

```c
for (i = 0; i < 10; i++)  // plot label info
{
    LOGFONT font;
    RGBTriplet color;
    CRect clickBox;
    char label[64];
```
Appendix

RGBTriplet  backColor
RGBTriplet  gricColor

Notes (Image Info)

This block stores the image information, also called the notes, about the document. This information is set by the Set Image Info and Edit Image Info commands (File menu).

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>4-Byte ASCII</td>
<td>'note'</td>
<td>Notes about the image</td>
</tr>
<tr>
<td>Size</td>
<td>long</td>
<td>576</td>
<td></td>
</tr>
<tr>
<td></td>
<td>char</td>
<td>descriptor[64]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>char</td>
<td>notes[512]</td>
<td></td>
</tr>
</tbody>
</table>

9.3 Format of Array Window Data

The Array Setup command (Control menu), described on page 302, creates an information-storing "array window" whose data type is Floating Point. The array window contains the positions of all elements within one or more arrays. When examining 96-well plates and other multi-well plates, these would be the positions of wells in plates held on a motorized XY stage.

The array window has six frames, numbered z = 0 to 5.

<table>
<thead>
<tr>
<th>Frame Number</th>
<th>Information Stored</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame z = 0</td>
<td>The x position of every well.</td>
</tr>
<tr>
<td>Frame z = 1</td>
<td>The y position of every well.</td>
</tr>
<tr>
<td>Frame z = 2</td>
<td>The z position of every well.</td>
</tr>
<tr>
<td>Frame z = 3</td>
<td>The mask used by the Array Move command (Control menu).</td>
</tr>
<tr>
<td>Frame z = 4</td>
<td>Reserved for use by Scanalytics.</td>
</tr>
<tr>
<td>Frame z = 5</td>
<td>Information about the arrays is stored in the individual pixels of this frame:</td>
</tr>
</tbody>
</table>

  (0,0) The number of arrays on the stage
  (1,0) The number of rows in each array.
  (2,0) The number of columns in each array.
| (3,0)   | The number of rows in which the arrays are arranged. |
| (4,0)   | The number of columns in which the arrays are arranged. |
### 10 Index

| # / V button ................................................ | 83, 85 |
| + symbol (in scripts) See Script: Interactive commands | 231 |
| 3D .......................................................... | 231 |
| 3D acquire See Multi Dimensional Acquire | 231 |
| 3D reconstruction ........................................ | 231 |
| Skewed 3D view ............................................. | 141 |
| 3D Equalize ................................................ | 231 |
| 3D Extended Focus ....................................... | 242 |
| 3D Extract Slices ....................................... | 240 |
| 3D Filter .................................................. | 233 |
| 3D Merge Sequences See Merge Color Channels | 238 |
| 3D Mosaic .................................................. | 238 |
| 3D Projector ............................................... | 248 |
| 3D ROI Sum Plot ......................................... | 237 |
| 3D Stacked View .......................................... | 242, 250 |
| 3D Tracer See 3D Extract Slices | 268 |
| 3-Pass Color .............................................. | 268 |
| 96-well plate ............................................. | 302, 307 |
| Acquire ..................................................... | 53, 56, 57, 254 |
| Acquire Preview dialog .................................. | 265 |
| Configuration ............................................. | 54, 255, 268 |
| Current Settings tab .................................... | 256 |
| Devs (devices) tab ....................................... | 54 |
| Devs (devices) tab ....................................... | 261 |
| Exp (exposure time) tab .................................. | 258 |
| Exp(eriment) log ........................................ | 135, 202 |
| Fast capture mode ....................................... | 57 |
| General tab ............................................... | 256 |
| Size tab ................................................... | 259 |
| Time Lapse tab ............................................ | 56, 59, 263 |
| Acquire (Using Last Config.) ......................... | 268 |
| Acquire info See Exp(ерiment) log | 28 |
| Acquire menu ............................................... | 253 |
| Acquiring images ........................................... | 53 |
| 3D images See Multi Dimensional Acquire | 254 |
| Acquire command ......................................... | 254 |
| Acquire Preview dialog .................................. | 265 |
| Color images ............................................... | 268 |
| Fast ........................................................ | 57 |
| Set Color Balance Values ................................ | 290 |
| Setting up the camera .................................. | 53, 253, 254 |
| Time-lapse images ....................................... | 55, 59 |
| to RAM, to memory ....................................... | 57 |
| Active window See Front Window | 235 |
| Adaptive filtering ....................................... | 235 |
| Add Pattern ............................................... | 221 |
| Add two images .......................................... | 224 |
| Drawing objects ......................................... | 210 |
| Affine Color Transform .................................. | 229 |
| Alert ....................................................... | 104, 324 |
| Angles ....................................................... | 191 |
| Animate ..................................................... | 16, 148 |
| Stop animating ........................................... | 149 |
| Annotation tool ......................................... | 24 |
| Ants, Marching See ROI | 88 |
| AOI See ROI ................................................ | 151 |
| Area of Interest See ROI | 224 |
| Arithmetic ................................................ | 334 |
| Arrange Icons ............................................. | 334 |
| Array Move ................................................ | 307, 353 |
| Masks ....................................................... | 309 |
| Array Setup .............................................. | 302, 307, 353 |
| Array window ............................................ | 302 |
| Format ..................................................... | 309, 353 |
| Arrows ........................................................ | 16 |
| Arrow buttons ............................................ | 16 |
| Arrow keys ................................................ | 88 |
| Brightness, Contrast, and Gamma ....................... | 151 |
| Assign Function Keys .................................... | 26, 131 |
| Automatic measurement, analysis ...................... | 47, 50 |
| Automatic segment algorithm | 178 |
| Midpoint algorithm ...................................... | 178 |
| Triangle algorithm ...................................... | 178 |
| Automatic segment algorithms | 178 |
| Iterative algorithm .................................. | 178 |
| Automatic segmentation See Autosegment | 178 |
| Autosegment ............................................... | 47, 50, 52, 174 |
| AVI movie ................................................ | 65 |
| Background Correction .................................. | 158 |
| Background subtraction ................................ | 154 |
| Barrel shift ............................................... | 215 |
| Batch file processing ................................. | 51, 89, 115 |
| Binarize .................................................... | 220 |
| Binning .................................................... | 261 |
| Blend color channels ................................... | 226, 227 |
| Blend Color Channels 42, 44 See also Merge Color Channels | 227 |
| Brightness ................................................. | 46. See Normalization | 268 |
| Byte data .................................................. | 93, 94, 214 |
| Byte order ................................................ | 120 |
| Calibrate See Define XY units | 218 |
| Camera configuration .................................... | 268 |
Camera menu ........................................ 253
Cascade .............................................. 331, 333
Change Data Type .................................. 214
Change Segment Color .............................. 208
Change Window ..................................... 330
Circularity ............................................ 181, 182
Classify Segments ................................. 50, 52, 187
Clear ................................................. 125
  in scripts ........................................ 102
Clipboard ........................................... 97, 124
Close .................................................. 89, 109
  Without saving .................................. 328, 330
CLUT .................................................. See also Color table
  Definition ........................................ 94
  In text view ....................................... 137
Pseudocoloring .................................... 156
Co-localization ..................................... 227
Color
  Acquiring from a grayscale camera ............ 268
  Color 24 data ..................................... 94
  Color 48 data ..................................... 94
  Color coordinates .............................. 95, 173, 226, 228, 229
  Color look up table ............................. See CLUT
  Color to Grayscale ................................ 156
  Color transform ................................ 229
Data types .......................................... 93
Color Balance ..................................... 290
Color Balance ..................................... 152, 267
Color table .......................................... See also CLUT
  Edit ............................................ 157
  Extracting ....................................... 201
  Transferring to other images .................. 135
Complex ............................................ 217
Compression method ................................ 66
Computer compatibility See System requirements
Contour view ....................................... 141
Contrast ........................................... 46, 149
  Equalize Contrast ................................ 154
Control key ........................................ 88, 209
Control menu ...................................... 293
Convert Color Coordinates ....................... 228
Convert T Series to Z ................................ 131
Convert to 8 or 24 Bit ................................ 214
Convert Z Series to T ................................ 131
Coordinates ........................................ 8
  Extracting ....................................... 202
Copy ............................................... 124
  in scripts ...................................... 102
  Segments ........................................ 207
Copy String Value .................................. 318
Count objects and particles ...................... 47, 50
Create Drawing Object at ROI ................... 213
Create Segment at Drawing Object .............. 208
Crop an image ..................................... 330
Cut ................................................... 124
  in scripts ...................................... 102
  Segments ........................................ 207
Data type .......................................... 93
Changing ........................................... 214
  Complex .......................................... 217
  Extracting the type as data .................... 202
  Unsigned <-> signed ........................... 214
Data Type .......................................... 97
Data window See Windows
Deconvolution ..................................... 233
Digital .............................................. 233
Define Foreign Format ............................. 118
Define linear filter ................................ 162
Define ROI .......................................... 125, 201
Define XY Units ................................... 194, 196
Displaying units ................................... 137
Delete
  Delete File ....................................... 110
  Delete Frames .................................... 129
  Drawing objects ................................ 212
  Delete using Selected File List ................ 118
  De-magnify ...................................... 18, 147
Descriptor See Image info
  Device control ................................... 297
  Device Toolbar .................................. 27, 65, 138
DIC .................................................. 42, 44, 45
Dimensionality ..................................... 7, 9
Direct color ....................................... 93, 95
Display ROI Only .................................. 148
Dispose All Views .................................. 328
Dispose All Windows ................................ 328
Dispose Window .................................... 109, 328
Distance contour algorithm ....................... 180
Divide two images ................................ 224
Drawing Object Selector tool ................. 21
Drawing Objects
  Add ............................................... 210
  Create drawings at ROI ......................... 213
  Delete ........................................... 212
  Drawing layer ................................... 11
  List all drawing objects ....................... 209
  Modify ........................................... 211
  Segmenting drawing objects .................... 208
  Selecting ......................................... 213
  Showing and hiding ............................ 209, 211
Tools See Drawing Tools toolbar
  Transferring to other images ................... 135
Transform grid cells to drawings .............. 213
Drawing Tools Toolbar ........................... 21
Drawings See Drawing Objects
Dual Monitor Setup ................................ 333
Hide/Show Image .............................................. 146
Hide/Show Message Window .......................... 328
Hide/Show ROI ................................................. 148
Hide/Show segment ........................................... 203
Hide/Show Status Window ............................. 25
Hide/Show Status Window ............................... 327
Hide/Show Variables Window ......................... 327
Histogram ....................................................... 198
View as histogram ......................................... 138
Home Image ............................................... 146
HSV, Hue-Saturation-Value .......................... 96
i button ......................................................... See Image info
If 103, 323
Image
Acquisition See Acquiring images
Coordinates See Coordinates
Definition ...................................................... 7
Sequence See Sequences
Image Arithmetic ........................................... 218, 224
Image info
Descriptor .................................................... 13, 112, 113
Edit Image Info ............................................. 112
i button ......................................................... 12
Notes ............................................................. 13, 113
Set Image Info ............................................... 111
Image ratios
Flat field ....................................................... 154
Optical density ............................................. 154
Image Ratios .................................................. 153
Image view ...................................................... 91, 138
Homing the image ......................................... 146
Showing/hiding the image ............................ 146
Update image display ................................... 148
Image window See Windows
Import
Text files ....................................................... 90
Indexed color .................................................. 93, 94
Indexed files .................................................... 333
Open Indexed ................................................. 114
Save as Indexed ............................................. 114
Set Index Info ................................................ 113
Indexed Files ................................................... 113, 137
Automatic numbering of duplicate windows 138
Batch file processing with ......................... 51, 115
Open Indexed .................................................. 51
Save As Indexed ............................................ 51
Set Index Info ................................................ 51
Insert Frames ............................................... 128
Installation ...................................................... 2
System requirements ...................................... 1
Intensity contour algorithm ......................... 179
Interactive
Function key commands ................................. 132
Script commands ........................................... 320
Interface ......................................................... 310
Device Toolbar tools ...................................... 27
Invalid bounds .............................................. 204
Invert ............................................................. 155
IPL file format ................................................... 93, 344
IPLab Mac file format ....................................... 93
Iterative algorithm ......................................... 178
Jump ............................................................. 102, 321
L / SV button ..................................................... 83, 87
Label ............................................................. 52, 102, 324
Annotating the image ..................................... 24
Device Toolbar button labels ......................... 138
Setting row/column labels ............................. 133
Last window ................................................... 330
Lengths
Displaying units ............................................. 137
Measure Lengths ............................................ 193
Transferring units to other images .................. 135
Levels See 46. See Normalization
Line Drawing Object tool .............................. 23
Line ROI tool ..................................................... 17
Line Segment tool .......................................... 20
Linear Filter ............................................... 161
Linear Profile view ........................................... 139
Literal values ................................................... 87
Long integer data ............................................. 93
Loop See also Script: Looping
Macintosh files ............................................. 109
Magnify ......................................................... 18, 147
Magnify views ............................................... 138
Main Toolbar ................................................... 16
Manual selection tools .................................... 17
Marching Ants See ROI
Marquee See ROI
Mask ............................................................. 205, 220, 309
Masks .............................................................. 233
Max or min between two images ..................... 224
Measure Angles ............................................. 191
Measure Lengths ............................................. 193
Measure Seg/ROI ............................................. 50, 186
Measurement Options .................................. 49, 183
Scripted ........................................................... 76
Measurement results ................................... 186, 190
Measurements
3D ................................................................. 240
Measuring ....................................................... 172, 174, 187
Angles ............................................................ 191
Lengths ........................................................... 193
Measure Segments/ROI ................................. 186
Measurement results ................................... 186
Options .......................................................... 183
Picking measurements to perform ................... 180
Quantify Segments ....................................... 185
Row/Column Plot ........................................ 199
Units ......................................................... 194, 196
Median Filter .............................................. 164
Menu bar ..................................................... 4
Merge Color Channels ................................. 42, 226
Blend tab ..................................................... See Blend Color Channels
More images ............................................... 45
Message bar ............................................... 31
Message level ............................................... 31
Messages ..................................................... 136
Showing and hiding ....................................... 328
Messages window ........................................ 31
Motorized stage .......................................... See Basic Hardware control
Motorized stage .......................................... See also Hardware control
Motor Control ............................................. 297
Microsoft Excel® .......................................... 91, 121
Mid point ...................................................... 152
Midpoint algorithm ...................................... 178
Minify ........................................................ 18, 147
Minimize window ....................................... 331
Minimum diameter ..................................... 182
Modify drawing objects ................................ 211
Modify ROI ................................................ 126
Modify segments ......................................... 204

**Morphological gradient filter** .................................. 165
Morphology .................................................. 218
  Modifying segments ..................................... 204
Mosaic .......................................................... 170, 238
Mosaic Sequence .......................................... 171
Motorized stage ........................................... 294, 298, 302, 307
Move to recorded position ............................. See Array Move
Move to Recorded Position .............................. 302
Move window ............................................... 331
Movie
  Sequence to movie .................................... 120
  Viewing sequences within **iPLab** ................. See Animate
Multi Dimensional Acquire ....................... 59, 62, 272
  Acquire Preview ...................................... 64, 284
  Exp(eriment) log ...................................... 135, 202
  General tab ............................................. 273
  Shutter & Filters tab .................................. 59, 62, 277
Size tab .................................................... 275
Time Lapse tab .......................................... 60, 282
Z-Steps tab .............................................. 63, 280
Multi-dimensional images ......................... 59, 62
  3D projections ........................................ 248
  Acquiring ................................................ 272
  Stacked views ........................................ 242, 250
Multi-line Drawing tool .......................... See Line Drawing Object tool
Multi-line ROI tool .................................. See Line ROI tool
Multi-mode imaging ................................. 60, 62, 277, 278, 279
Multiply two images .................................. 224
MultiProbe
  MultiProbe data type ................................. 94
Multispectral 3D .......... See Multi Dimensional Acquire
Multi-well plate ......................................... 302, 307
New Data .................................................. 107
New Script ................................................ 73, 99, 310
New View .................................................. 138
Next window .............................................. 330
Noise
  Adding .................................................. 221
  Removal by median filter .......................... 164
  Removal of multiplicative noise .................. 154
  Removing periodic noise ............................ 166
Normalization ............................................. 46, 149, 214
  Color balancing ...................................... See Color Balance
  Equalize Contrast ..................................... 154
  in Multi Dimensional preview ..................... 286
  Transferring to other images ........................ 135
Notes ......................................................... See Image info
Objects ..................................................... See Drawing objects
On/Off ....................................................... 101
On/Off ....................................................... 108
Open .......................................................... 111
Set default directory .................................. 111
Open File from Selected File List .................. 118
Open Indexed ............................................. 51, 114
Open Script ............................................... 310
Optical density .......................................... 154
Options ..................................................... 92, See Preferences
  Oval Drawing Object tool ......................... 22
  Oval ROI tool .......................................... 17
  Oval Segment tool .................................... 20
Overlay ..................................................... 11, 203
Stamp on image ......................................... 135
Particle distribution analysis ....................... 50
Particle size .............................................. 182
Paste ......................................................... 125
  in scripts .............................................. 102
  Moving paste regions ............................... 88
  Segments ............................................... 208
  Undo ...................................................... 89
Paste buffer ............................................. 97
Script paste buffer .................................... 97, 102
Pause ......................................................... 103, 322
Performance with undo ................................ 124
Persistence ............................................... 92
Phase data .................................................. 45
Pixel Shift ............................................... 215
Pixels .......................................................... 8
Place Window ............................................ 331
Plates ....................................................... 302, 307
Plot
  Plot view ............................................... 138
  Row/Column Plot ..................................... 199

Index 359
Transferring segments........................................24
Registration marks..........................................168
Registration Drawing Object tool.........................24
Registration Marks
Transferring to other images.................................135
Rename Window..............................................329
Repeat Last Command........................................124
Requirements for installation................................11
Registration Marks..........................................135
Restore window..................................................331
Revert to Saved...............................................110
RGB..................................................................96
Roberts edge filter..............................................165
ROI....................................................................9
Boundaries.........................................................10
Defining................................................................125
Defining................................................................17
Display ROI Only..................................................148
Extract data values..............................................201
Extract locations of ROI bounds...........................202
Moving...............................................................11, 88, 126
Resize ................................................................88, 126
RGB..................................................................96
Saturation.............................................................128
Saturation.............................................................127
Show/Hide............................................................148
Transferring to other images.................................135
ROI Sum Plot......................................................135
ROI Tools toolbar...............................................17
ROI tools toolbar................................................17
Rotate & Scale.....................................................169
Rotate image.......................................................167, 168, 169
Row/Column Plot...............................................199
Scan GSB............................................................97
Run Script...........................................................82, 132, 310
Save................................................................109
Save as Default file format for saving..................137
Save as Default file format for saving..................137
Save as Indexed.................................................114
Save as Indexed.................................................114
Save File from Selected File List........................118
Save File from Selected File List........................118
Scale image.......................................................168, 169
Scale image.......................................................168, 169
Script
Analysis within scripts......................................224
Batch file processing..........................................51, 89
Closing...............................................................105
Continue...........................................................104, 320
Controlling the sequence....................................102
Creating............................................................99
Editing a script..................................................102, 137, 324
Error messages...................................................136
(index page)
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>93</td>
<td>Getting window information within scripts ...</td>
<td>202, 314</td>
</tr>
<tr>
<td>Interaction with If</td>
<td>103, 324</td>
<td>Interactive commands</td>
<td>80, 101</td>
</tr>
<tr>
<td>Looping</td>
<td>318, 320, 321</td>
<td>Nested</td>
<td>105, 311</td>
</tr>
<tr>
<td>New</td>
<td>73, 310</td>
<td>Opening scripts</td>
<td>108, 310</td>
</tr>
<tr>
<td>Paste buffer</td>
<td>97, 102</td>
<td>Run</td>
<td>104, 310, 320</td>
</tr>
<tr>
<td>Run one from another</td>
<td>105, 311</td>
<td>Run script</td>
<td>105</td>
</tr>
<tr>
<td>Save script</td>
<td>104, 320</td>
<td>Saving scripts</td>
<td>79</td>
</tr>
<tr>
<td>Selecting drawing tools</td>
<td>25</td>
<td>Selecting ROI tools</td>
<td>18</td>
</tr>
<tr>
<td>Selecting segment tools</td>
<td>20</td>
<td>Step</td>
<td>104, 320</td>
</tr>
<tr>
<td>Stop</td>
<td>104, 320</td>
<td>Stop</td>
<td>104, 320</td>
</tr>
<tr>
<td>Turning it off</td>
<td>101, 137</td>
<td>Tutorial, basic</td>
<td>72</td>
</tr>
<tr>
<td>Script Commands</td>
<td>320</td>
<td>Alert</td>
<td>324</td>
</tr>
<tr>
<td>Copy String Values</td>
<td>318</td>
<td>Copy String Values</td>
<td>321</td>
</tr>
<tr>
<td>Enter String Variables</td>
<td>317</td>
<td>Enter Variables</td>
<td>326</td>
</tr>
<tr>
<td>If 323</td>
<td>324</td>
<td>Jump</td>
<td>321</td>
</tr>
<tr>
<td>Loop</td>
<td>321</td>
<td>Pause</td>
<td>322</td>
</tr>
<tr>
<td>Query</td>
<td>322</td>
<td>Record Timer</td>
<td>325</td>
</tr>
<tr>
<td>Wait For Timer</td>
<td>319</td>
<td>Set Measurements</td>
<td>198, 186</td>
</tr>
<tr>
<td>Segments</td>
<td>75</td>
<td>Script menu</td>
<td>320</td>
</tr>
<tr>
<td>Segments</td>
<td>19</td>
<td>Segments</td>
<td>47, 50, 172, 174</td>
</tr>
<tr>
<td>Add</td>
<td>203</td>
<td>Manual segmentation tools</td>
<td>19</td>
</tr>
<tr>
<td>Add at drawing objects</td>
<td>208</td>
<td>Scripted</td>
<td>75</td>
</tr>
<tr>
<td>Change color</td>
<td>208</td>
<td>Set Pattern</td>
<td>221</td>
</tr>
<tr>
<td>Copy</td>
<td>207</td>
<td>Set Preferred Directory</td>
<td>111</td>
</tr>
<tr>
<td>Cut</td>
<td>207</td>
<td>Set Print Resolution</td>
<td>123</td>
</tr>
<tr>
<td>Delete</td>
<td>207</td>
<td>Set ROI Color</td>
<td>128</td>
</tr>
<tr>
<td>Eraser tool</td>
<td>20</td>
<td>Set ROI Value</td>
<td>127</td>
</tr>
<tr>
<td>Making</td>
<td>20</td>
<td>Set Row/Column Label</td>
<td>133</td>
</tr>
<tr>
<td>Measuring</td>
<td>185, 186</td>
<td>Segment Color</td>
<td>19</td>
</tr>
<tr>
<td>Modify</td>
<td>204</td>
<td>Segment layer</td>
<td>11</td>
</tr>
<tr>
<td>Paintbrush tool</td>
<td>20</td>
<td>Showing and hiding</td>
<td>203</td>
</tr>
<tr>
<td>Paste</td>
<td>208</td>
<td>Transferring to other images</td>
<td>135</td>
</tr>
<tr>
<td>Select acquisition device</td>
<td>253</td>
<td>Select Devices</td>
<td>293</td>
</tr>
<tr>
<td>Select Display Channels</td>
<td>147</td>
<td>Select Devices</td>
<td>293</td>
</tr>
<tr>
<td>Select Drawing Objects</td>
<td>213</td>
<td>Select Display Channels</td>
<td>147</td>
</tr>
<tr>
<td>Select File List</td>
<td>115, 118</td>
<td>Select Frame</td>
<td>146</td>
</tr>
<tr>
<td>Select Frame</td>
<td>146</td>
<td>Select ROI</td>
<td>See ROI</td>
</tr>
<tr>
<td>Select ROI</td>
<td>See ROI</td>
<td>Sentinel key drivers</td>
<td>2</td>
</tr>
<tr>
<td>Sequence to Frames</td>
<td>332</td>
<td>Sequence to Frames</td>
<td>65, 120</td>
</tr>
<tr>
<td>Sequence to Movie</td>
<td>65, 120</td>
<td>Compression method</td>
<td>66</td>
</tr>
<tr>
<td>Exporting</td>
<td>65</td>
<td>Sequences</td>
<td>8, 272</td>
</tr>
<tr>
<td>Frames</td>
<td>129</td>
<td>AVI movies</td>
<td>65</td>
</tr>
<tr>
<td>Joining in a mosaic</td>
<td>171</td>
<td>Convert T &lt;&gt; Z</td>
<td>131</td>
</tr>
<tr>
<td>Movies</td>
<td>65</td>
<td>Converting to frames</td>
<td>332</td>
</tr>
<tr>
<td>Navigating</td>
<td>88</td>
<td>Delete Frames</td>
<td>129</td>
</tr>
<tr>
<td>Selecting frames</td>
<td>8</td>
<td>Exporting</td>
<td>65</td>
</tr>
<tr>
<td>Transfer Frames</td>
<td>130</td>
<td>Insert Frames</td>
<td>128</td>
</tr>
<tr>
<td>Select Frame</td>
<td>146</td>
<td>Joining in a mosaic</td>
<td>171</td>
</tr>
<tr>
<td>Set Color Balance Values</td>
<td>267, 290</td>
<td>Movies</td>
<td>65</td>
</tr>
<tr>
<td>Set Index Info</td>
<td>51, 113</td>
<td>Navigating</td>
<td>88</td>
</tr>
<tr>
<td>Set Print Resolution</td>
<td>123</td>
<td>Select Frame</td>
<td>146</td>
</tr>
<tr>
<td>Set Measurements</td>
<td>48, 50, 180, 186</td>
<td>Set ROI Color</td>
<td>128</td>
</tr>
<tr>
<td>Set ROI Value</td>
<td>127</td>
<td>Set Row/Column Label</td>
<td>133</td>
</tr>
<tr>
<td>Set String Variable</td>
<td>86, 314</td>
<td>Set String Variable</td>
<td>86, 314</td>
</tr>
<tr>
<td>Set Variable</td>
<td>84, 312</td>
<td>Set Variable</td>
<td>84, 312</td>
</tr>
<tr>
<td>Set XY Units</td>
<td>194, 196</td>
<td>Settings</td>
<td>92. See Preferences</td>
</tr>
<tr>
<td>Short integer data</td>
<td>93</td>
<td>Sharpening filter</td>
<td>161</td>
</tr>
<tr>
<td>Show/hide drawing objects</td>
<td>211</td>
<td>Shift</td>
<td>209</td>
</tr>
<tr>
<td>Show/Hide Drawing Objects</td>
<td>209</td>
<td>Shift image</td>
<td>168, 215</td>
</tr>
<tr>
<td>Show/Hide Drawing Objects List</td>
<td>209</td>
<td>Short integer data</td>
<td>93</td>
</tr>
<tr>
<td>Tutorial, basic</td>
<td>72</td>
<td>Shift</td>
<td>209</td>
</tr>
</tbody>
</table>

**Index** 361
Show/Hide Image .................................. 146
Show/Hide Message Window ................. 328
Show/Hide ROI .................................. 148
Show/Hide segment ............................ 203
Show/Hide Status Window .................. 25
Show/Hide Status Window ................. 327
Show/Hide Variables Window ............ 327
Shutters & Filters
  Control .................................. 297
  Setting up ................................ 294
Shutters & Filters ............................ 310
Signed to Unsigned......................... 214
Size window .................................. 331
Sizes ........................................ 202
Skewed 3D view ................................ 141
Slice (Extract Linear ROI) ......... 201
Sobel edge filter .............................. 165
Sort Data .................................. 216
Speed .................................... 1, 57, 124, 137, 149, 170, 243, 257, 269, 275
Split algorithms
  Distance contour algorithm ............ 180
  Intensity contour algorithm ........... 179
Split Color Channels ......................... 228
Stacked TIFF ............................... 93
Stacked View ................................ 242, 250
Stage Control ................................ 298
Stamp Overlays on Image .............. 135
Status bar .................................. 16
Status window
  ROI ....................................... 10
  Showing and hiding ..................... 327
Status Window ................................ 25
Stop Animating Document ............ 149
Streaming data ................................ 57
String variables......................... See Variables, string
Subroutine .................................... 105
Subtract two images .................... 224
Super-array .................................. 303
SV / L button .................................. 83, 87
System requirements ....................... 1
T button .................................... 16
Tagged Image File Format .............. See TIFF
Text Drawing Object tool .............. 24
Text files .................................. 90
Text view .................................. 91, 138
  Sort data ................................ 216
Text view options ....................... 142
Three dimensional ....................... See 3D
Thresholding ......................... See Segmentation
TIFF ....................................... 93
Stacked .................................... 93
TIFF stacks .................................. 137
Tile .......................................... 331, 333
Time Lapse - FKey ......................... 132
Time-lapse
  Acquisition ................................ 55, 59. See also Acquiring images:
    Time-lapse images
  Sequence .................................. 42, 44
  Time-lapse acquisition ................. 59
  Timer ..................................... 319
  Tint removal ............................ 192, 290
  To Byte as Shown ...................... 214
  Toolbars ................................ 12, 334
    Device Toolbar ......................... 27, 138
    FKey Toolbar ........................... 26
    Main Toolbar ............................ 16
  ROI Tools ................................ 17
  Scripting the drawing tools .......... 25
  Scripting the ROI tools .............. 18
  Scripting the segment tools ........ 20
  Segment Color ........................... 19
  Segment Tools ................................ 19
  Status bar ................................ 16
  Z and T Arrows ........................... 16
Transfer Attributes ................. 134
Transfer Frames ............................ 130
Transform (picture manipulations)
  Flip ..................................... 167
  Rotate ................................... 167
  Rotate & Scale ......................... 169
Transform Grid Cells to Objects ....... 213
Transforms ................................ 166, 200
Triangle algorithm ....................... 178
Undo ....................................... 124, 137
  Pasting .................................. 89
  Purge buffer for speed ............ 124
Units ..................................... 194, 196
Unsigned 16 data ......................... 93
Unsigned to Signed ....................... 214
Update image display .................... 148
  V / # button .............................. 83, 85
Variables, numeric ....................... 83, 84
  Acquisition time ...................... 253
  Interactive ............................. 326
  Reserved ................................ 343
  Setting .................................. 84, 312, 326
  Showing and hiding .................... 327
  Using .................................... 83, 85
  Variables window ....................... 27
  Viewing .................................. 27
Variables, string ......................... 83, 317
  Copying .................................. 318
  Creating ................................. 86
  Interactive .............................. 317
  Setting .................................. 86, 314, 317
Index

String Variables command .................................. 315
Using ...................................................................... 83, 87
View ........................................................................ 91
Contour ................................................................. 141
Histogram............................................................. 138
Image ..................................................................... 138
Linear Profile.......................................................... 139
Plot ......................................................................... 138
Plot Options ............................................................ 142
Skewed 3D ............................................................. 141
Text ........................................................................ 138
Text Options ............................................................ 142
View Options ........................................................... 142
Wait for Timer .......................................................... 319
Wavelength-switching devices
  Control ................................................................. 297
  Setting up ............................................................ 294
White balance...................................................... See Color Balance
Windows ............................................................... 327. See also Files
  Active .................................................................... 333
  Cascade ............................................................... 333
  Change (next/ previous) ....................................... 330
  Closing .................................................................. 109
  Crop ....................................................................... 330
  Duplicate names .................................................. 138
  Duplicating .......................................................... 329
  Front ...................................................................... 329
  Getting window information ................................ 202
  Homing the image ................................................ 146
  Image ..................................................................... 7

Joining ........................................................................ 170
Minimize ................................................................. 331
New Data .................................................................. 107
Open windows, list of ............................................ 334
Open windows, testing existence of ....................... 314
Opening .................................................................... 108
Place ........................................................................ 331
Renaming ............................................................... 329
Restore ..................................................................... 331
Showing/hiding the image ...................................... 146
Size .......................................................................... 331
Status ....................................................................... 327
Testing status of ..................................................... 314
Tile ............................................................................ 333
Update image display ............................................. 148
Variables ............................................................... 327
Windows NT, 2000, XP ............................................. 2
XY button ............................................................... 29
XYZ stages ............................................................ 302, 307
  Control ................................................................. 298
  Move to recorded position .................................... 302
  Record position .................................................... 300
Z button ................................................................. 16, 29
Z motors
  Acquiring Z series............................................... See Multi Dimensional Acquire
  Control ................................................................. 65
  ZeissMover ........................................................... 310
Zoom ........................................................................ 18, 147
Magnify views ........................................................ 138